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1
Updates in this release

Summary of documentation updates in this release.

Version Changes

25R1 GA (6.9.0) Report Designer :
• The Template label in the report designer's settings page now includes

a tooltip notifying users of the supported file types.

25R1 (6.8.5) The OpenAPI can now call actions using server URLs, hosts, and paths
defined in the Swagger/OpenAPI metadata, not just the base URL from
the credential object.

24R2 SU III (6.8.4) -

24R2 SU II (6.8.3) Configuring an SSO with a new IAM Client. See: Configuring SSO with a
new IAM client

24R2 SU I (6.8.2) • Users can now attach the required SSH file and successfully schedule
reports via SFTP

• It's now possible to create a Queue Progression flow in Email and
Chat, utilizing the newly introduced 'Send WhatsApp Templated
Message' node, which triggers a templated WhatsApp message when
the script is executed.

24R2 GA (6.8.0) • Clarification of the file type to use when saving Excel spreadsheets as
report templates.

• Explanation of how the setting Days to Wait Before reseeding Survey
now works when sending scheduled survey invites. Creating a survey.
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Version Changes

24R2 EA (6.8.0-rc1) • Additional information on adding addresses, end users, and Twilio
regulatory bundles. See Twilio regulatory requirements.

• Additional information on the retry count for surveys. See Creating a
survey.

24R1 SU4 (6.7.4) Updated information on setting the queue target when configuring
campaigns.

24R1 SU3 (6.7.3) • Twilio regulatory requirements
• Correction to the SSML snippet shown in Text to speech API where a

space is needed to separate the two parameters inside the speak tag.

24R1 SU2 (6.7.2) Correction to the action filters shown on the Add global action set to get
customer details page.

24R1 GA (6.7.0) -

24R1 EA (6.7.0-rc1) • Different presentation modes for displaying the survey when
configuring chat. See Add Survey Candidate.

• Configuring Last-Mile Customer Portals for Work Order Handling. See
Last-Mile Customer Portal.

• Adding registered sites for use with the CAPTCHA element in
Designer.

• Adding an SSL certificate and domain for a public portal.
• Consumption reports.
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2
Samples

Download the examples described here from the Knowledge Base.

Chat Client

Note  Fully-featured tenants only: Download the example chat client

IFS Customer Engagement provides an example chat client (web page). In addition, a built-in chat
client for testing and debugging purposes is included with every chat service installation, and can
be accessed by a user authenticated by logging onto either Admin Portal or Agent Desktop at

https://{data region FQDN}/tenant_name/ce/chat/main/index.html?

chatdefinition={definition name}

For background information, see Using the demo chat client.

Call backs

Note  Fully-featured tenants only: Download call backs example.

An example workflow definition for call backs is available. This is configured for the default Studio
app for workflows. For background information on call backs, see Configuring call backs.

Extract this from the zip file and import it into the Admin Portal using the option Workflow
Management > Import Workflow.
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Campaign calls

Note  Fully-featured tenants only: Download campaigns example

An example workflow definition for making outbound campaign calls is available. This is
configured for the default Studio app for Outbound Campaign Calls. For background information
on campaigns, see Outbound campaigns.

Extract this from the zip file and import it into the Admin Portal using the option Workflow
Management > Import Workflow.

Automated outbound call dialing

Note  Fully-featured tenants only: Download example

An example is available that shows how to make automated outbound calls.

To run this example, you need a workflow definition, a media queue progression script. For further
details, see Example of automated outbound call dialing.

Creating and managing work objects from chat or social media

Note  Fully-featured tenants only: Download example

An example is available that shows how to create a work object from a chat session and then
update the work object in a different chat session. The principles shown here apply to other media
types.

To run this example, you need a workflow definition, a chat queue progression script and a global
action set. For further details, see Example of creating and managing work objects from chat or
social media.

How to invoke a provider action from a workflow definitions

Note  Fully-featured tenants only.

An example workflow definition showing how to configure the Invoke Provider work action is
available here.
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Example rules for Last-Mile Customer Portal
Download example

Some example rules to show how rule configuration works in the Admin Portal. Import these on
the Last-Mile Technician Portals > Rule Configuration page:
• Engineer allocated.json
• New engineer allocated to task.json
• ETA Change.json

Example of automated outbound call dialing
Download example

An example is available that shows how to make automated outbound calls:

Workflow definition WorkflowDefinition-AutomatedOutboundCallExample-
v1.json

Media queue progression script Script-AutomatedOutboundCallExample-v1.json

A wav file to use as the greeting
message

unattended-dialouts-greeting_en.wav

Follow these steps to configure your contact center to run this example:
1. Import the media queue progression script from the zip file:

a. On the Media Management > Media Queue Progression page, create a new media
queue progression definition.

b. Click Queue Progression.
c. Enter a description.
d. Choose the script from the zip file and then click Import.

2. Import the wav file or create one yourself:
a. Go to Contact Center > Voice Prompts.
b. Select IVR Resource as the Prompt Type.
c. Select MediaQP as the IVR Type.
d. Select the imported script as the Media Queue Progression Definition.
e. Choose the wav file from the zip file.

3. Edit the imported queue progression script to use the wav file:
a. Go to the Media Management > Media Queue Progression page.
b. In the Queue Progression pane, expand the Call Answered event.
c. Select the Request Caller Data option.
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d. In the Initial Prompt field, select the wav file you imported.
4. Import the workflow definition:

a. Go to the Workflow Management > Import Workflow page.
b. Import the workflow definition from the zip file.

You now need to complete the configuration of the workflow definition.
c. Go to the Workflow Management > Workflows page.
d. Select the imported workflow definition.
e. From the More button, select Action.
f. Locate the E_POP event and in the Queue Progression field, select the queue progression

script you imported.

For further information about this example and how to run it, see Workflows for automated
outbound calls.

Example of creating and managing work objects from chat or
social media

Download example

An example is available that shows how to create a work object from a chat session and then
update the work object in a different chat session. The principles shown here apply to other media
types.

A chat caller is given options to ask an agent to call them back (the call back) or to update an
existing call back request. Requesting a call back, creates a work object. The work object uses the
phone number as the reference to retrieve the work object again later.
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Example chat script

To run this example, you need a workflow definition, a chat queue progression script and a global
action set.

Import the files

1. Download the example (see above) and extract the files.
2. In the Admin Portal, go to the Workflow Management > Import Workflow page.
3. Import the workflow definition: WorkflowDefinition-CreateCallback-Iss1.json.
4. Go to the Media Management > Chat page.
5. Select a chat definition or create a new one.
6. Click Queue Progression.
7. Import the chat script: Script-CreateCallback-Iss1.json.

Set up the global action set

The queue progression script uses the option Invoke Provider Action. This is configured to find the
work object using the phone number.
1. In CE Studio Designer, create a new global action set as shown below.
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Note that WorkObjects | Reference is mapped to a placeholder called PhoneNumber.

Edit the imported queue progression script

You need to update the queue progression script to reference the imported workflow definition and
your global action set:

1. In the Functions section of the imported script, find CreateNewCallBack().
2. Go to the Create Work Object option.
3. Set the workflow definition to the one you imported.
4. Map the following work elements as shown in the screenshot:
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5. In Functions, find the NewPhoneNumberHander().
6. Go to the Post Work Event option and set the following as shown in the screenshot:

• The workflow definition to the one you imported.
• The workflow event to E_RESCHEDULE
• Map the W_CLI work element to the NewPhoneNumber variable
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Test the example

1. Make the script live.
2. Test in your chat client.
3. Click Request Callback to create the call back. You can see the work object on the Workflow

Management > Work Objects page. Edit the work object to see the data saved in the work
object.

4. Start a new chat session to update the work object. Click Rearrange Callback to test this
process.

5. Sign onto Agent Desktop to see the Work objects present to you. The activations use the IFS
CE Callback Template, however, you cannot cancel or complete the work objects using this
CE Studio app because the actions in the template are configured for a different workflow
definition.

To create an app to handle these activations, you need to copy the IFS CE Callback Template
and then modify the actions for the imported workflow definition.

Removing unwanted work objects

Follow these steps to remove unwanted work objects:

1. Go to the Workflow Management > Work Objects page.
2. Select the work object.
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3. Click Edit.
4. In Lock with Reason, enter some text and then click Lock.
5. From the State Change list, select the cancelled or completed state and then click Change.
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3
Configuring self-service tenants

You use the Admin Portal to complete the configuration of self-service tenants. Specifically to:
• Set up credentials for creating providers in CE Studio Designer.
• Set up SMS-enabled phone numbers for outbound SMS. You need to comply with Twilio

regulatory requirements - see Twilio regulatory requirements for details.

For additional information on configuring SMS, see SMS configuration.
• Set up response templates if using authentication for the public portal on the Media

Management > Response Templates page. The language of the response templates is
selected on the Contact Center > Manage Language page.

• Design custom reports in Report Designer.
• Configure Last-Mile Customer Portal, including the survey.
• Add users, such as Managers, Portal Users and Studio Administrators.
• Configure user groups for SSO deployments, for example, for use with CE Studio providers.

Contact center and contact center unit

The main organizational unit for self-service tenants is referred to as a contact center. Self-service
tenants don't have a contact center - this is just a convenient way to show basic information about
the tenant:
• Organization's name is shown on the Contact Center > Contact Centers page. To change the

name, raise a request in the IFS Service Center.
• Address and contact details are on the Contact Center Unit > Contact Center Units page.

Any user with the Manager or Global Manager role can change these details.

Note  Outbound email addresses and SMS numbers are grouped by contact center unit.
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Tenant type and services

To change other details of your tenant, raise a request in the IFS Service Center. Use this to, for
example, to change the maximum number of users allowed to access the portal at any one time.

Configuring trunk groups for SMS
Before you can use phone numbers on a Twilio or custom trunk group for SMS you need to
update the trunk group to use one of your configured SMS providers.

Finding the trunk group for Twilio phone numbers

If you do not know which trunk group a Twilio phone number is on then follow these steps:
1. In the Admin Portal, go to the Voice Service > Inbound Number Ranges page.
2. Select the phone number that you want to configure for SMS.

The name of the trunk group is shown in the Inbound Number Range Detail pane.

Update the Twilio trunk group with an SMS provider

To update the trunk group with an SMS provider:
1. In the Admin Portal, go to the Voice Service > Trunk Groups page.
2. Select the trunk group.
3. In the trunk group detail area, select the provider from the SMS Provider list.

You can select Twilio as the provider or a custom provider if one is configured.
4. Save the trunk group.

Creating a custom trunk group for SMS

To create a custom trunk group for SMS that is not provided by Twilio:

1. In the Admin Portal, go to the Voice Service > Trunk Groups page.
2. Select the contact center that will use the trunk group.
3. Enter a unique name for the trunk group, such as BulkSMS_EU.
4. Leave the other fields empty.
5. Click Save.

There is a short delay while the custom trunk group is created for you.
6. Update the custom trunk group with an SMS provider as described above.
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Configuring SMS numbers
Before you can send outbound SMS messages, you need to the configure SMS-enabled phone
numbers on the Media Management > Social Media page.

To create a social media definition for SMS:

1. In the Admin Portal, go to Media Management > Social Media.
2. In the Social Media Detail area, select the contact center and the contact center unit.
3. Enter the details of the social media definition:

Field Description

Name The internal name of the SMS definition.

Type Select SMS.

Disabled Select this option if you are not yet ready to allow traffic on this
SMS number.

Description Any notes that you want to enter, for internal use.

SMS Number Select the SMS number you are configuring.

4. Click Save.

About the system email address
The system email address for the tenant is used to send outbound emails and system emails,
such as automatically-generated reports.

To see the system email address:

1. In the Admin Portal, go to Media Management > Emails.
2. From the Email Address list, select the email address prefixed System-ce.

The System Email option is selected and this indicates the system email address. You cannot
change this.
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4
Configuring contact centers and units

Note  The information in this section does not apply to self-service tenants.

The IFS Cloud Operations team create the contact centers. By default, each contact center has
one contact center unit. You can configure the contact center, the default contact center unit and
add additional contact center units at any time using the Admin Portal.

Configuring contact centers
You can’t add or remove contact centers in the Admin Portal, but you can configure them, for
example add system email addresses, set up auto answering for live callers and so on. You can
also view details of the configuration, such as the storage areas and media hubs (for the media
hubs, go to Voice Service > Voice Services).

Steps

1. In the Admin Portal, go to Contact Center > Contact Centers.
2. Select the contact center. You can set or modify the following options for the contact center.
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Field Description

Backup Contact Center
Note  Only available where the tenant
has contact centers in different data
regions.

The cloud infrastructure provisioned for
each contact center is highly available. This
means that the associated server instance
automatically fails over to a backup instance
in the same media hub as necessary.

However, although the cloud infrastructure
is highly available, some businesses may
require an additional layer of security. In this
case, it is possible for a contact center to fail
over to the media hubs of another contact
center if there is an issue with their own.

See also Disable Faillback Processing.

Require User Time Keeping By default, in Agent Desktop all agents must
select give a reason for going into Do Not
Disturb mode. The reason codes can then be
reported on.

Note  You can also set this option on or
off for individual users.

Contact Center Unit for Logging Agent Calls If you have multiple contact center units,
then when an inbound call is connected to an
agent, the call is logged to the contact center
unit you enter here. This makes it possible
to identify inbound calls from other internal
system calls.

Default Contact Center Unit If you have multiple contact center units, and
the agent does not explicitly select a contact
center unit, then any calls they make will be
logged against this one.

3. If required, enable Call Auto Answer for the contact center.
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Field Description

Call Auto Answer Timeout Automatic call answering for voice or chat
takes over after the number of seconds
entered here.

Call Auto Answer Select Enabled if you want Agent Desktop to
automatically answer inbound calls after the
given number of seconds has lapsed.

This means that the agent doesn’t have
to click to accept the call. This is required
for campaigns in order to maximize call
efficiency.

4. If required, specify how long you to want to store call recordings and email attachments.

Field Description

Percentage of Inbound Calls to Retain at
Datacentre for Training Purpose

By default, if you choose to retain inbound
calls for training purposes then all inbound
calls are retained in a Cloud storage account
specific to the tenant. You can choose to store
a percentage of these if you wish. Default:
100.

Percentage of Outbound Calls to Retain at
Datacentre for Training Purpose

Similar to Percentage of Inbound Calls to
Retain at Datacentre for Training Purpose.
Default: 100.

Maximum Number of Agents Allowed to be on
‘Record All Calls’ Setting

Leave this setting empty. It is not normally
necessary to set any limit on the number
of users on the Record All Calls setting.
Default: 0.

The following fields at the bottom of the Contact Center Detail page show information about the
storage areas for the tenant, and the length of time that call recordings are stored before being
permanently deleted. The minimum storage period is 1 day.

Note  Contact IFS Service Center if you require direct access to your storage accounts.
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Field Description

Call Recording Storage Shows the name of the account for storing for call
recordings. All the contact center units for the contact
center will use the same storage account.

Calls are retained for the number of days set above.

No of Days in Hot Tier By default, a call recording is stored for 1 day in the
hot tier and then moved to the cool tier. You can
download the recording on the Standard Reports >
Inbound Call page. After 1 day, it is moved to the cool
tier.

Note  The minimum storage period is 1 day
(even if you enter 0 as the number of days).

No of Days in Cool Tier By default, a call recording is stored for 365 days in
the cool tier. You can download the recording on the
Standard Reports > Inbound Call page. After 366
days, it is moved to the archive tier (that is 1 day in
hot tier + 365 days in cool tier).

No of Days in Archive Tier By default, a call recording is stored for 2100 days
in the archive tier (5.7 years). The recording can still
be downloaded but there will be a delay of 24 hours
before the recording becomes available.

Call recordings are automatically deleted after 2466
days (that is 1 day in hot tier + 365 days in cool tier +
2100 days in archive tier).

Note  The date shown on the Call Recording
Detail page is the last date before the recording
is deleted.
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Field Description

Studio Application Storage Shows the name of the account for storing any file
attachments required for CE Studio applications. All
the contact center units for the contact center use the
same storage account.

Note  Currently email attachments are retained
indefinitely.

Media Script Storage Shows the name of the account for storing the queue
progression scripts that handle interactions with
clients through voice (IVR), email, chat and so on.

5. Set up the contact email addresses to be used. These are for the client's internal use.

Field Description

Main Contact Email The email address that’s used when no
more specific email address is configured
for the contact center. Typically, this is the
email address of the person responsible for
managing the contact center.

For example, this address is used:

• When a call comes into the system but
there’s no one available to take it then a
warning email is sent.

• When an error occurs in a running IVR/
queue progression script but there’s no
email address associated with the script.

• When using workflow definitions.

Note  You can add a different email
address for each contact center unit.

Main Contact Name The name associated with the email address.
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Field Description

Support Email The email address that’s used when errors
occur in a running IVR/queue progression
script but there’s no email address associated
with the script.

Note that trace logs are not sent to this email
address.

Support Email Name The name associated with the support email
address.

6. Ignore the following fields which are intended for an on-premise exchange server:
• Inbound Email Server
• Email Public Folder
• Email Server Username
• Email Server Password
For details, see Email configuration.

Configuring contact center units
By default, there is one contact center unit created for each contact center. You can configure this
in the Admin Portal. You can also create additional contact center units.

Steps

1. In the Admin Portal, go to Contact Center Unit > Contact Center Units.
2. Select the contact center.
3. Enter the following details for the default contact center unit or click New to add another

contact center unit to the selected contact center.

Field Description

Number The 6-digit number that identifies the contact
center unit.

Name Required – name that’s unique to the tenant.
You can change the name later if required.
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Field Description

Contact Center The unit belongs to this contact center.
You can select a different contact center if
required.

Note  Since a contact center unit is a
logical grouping you can always move
it to a different contact center later.
However, if you do this, you should review
how the skillsets are set up in the new
contact center.

Street, District, Town, County, Zipcode/
Postcode

Contact Name, Telephone Number, Fax
Number

Optional.

Additional contact details for the contact
center unit.

Email The contact email address that’s used for
activity specific to this contact center unit
instead of the Main Contact Email address set
for the contact center.

Typically, this is the email address of the
person responsible for managing the contact
center unit. The emails are also sent to the
email address in the Manager field.

Manager Select the name of the user who is the
manager for this contact center unit. Copies
of email sent to the email address in the
Email field are also sent to this user.

The manager is the user who is listed on the
User Management > User Contact Center
Unit page.
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Field Description

Status The contact center requires a status. Use
either:
• Being Setup
• Live

For example, select Live once configuration
is complete and the contact center unit is
ready to accept activations.

See also Disabling a contact center unit.

Public Holiday Zone There is no default setting. You need to
set this up using Contact Center > Public
Holiday Zones. See Public holidays and
open hours.

Disable Secondary Call Distribution If there are multiple contact centers then you
can configure primary and secondary centers
where activations coming into the primary
center are distributed to the secondary
centers according to the settings on the
Contact Center Access page.

Use this setting to disable this arrangement
so that all inbound activations at the primary
contact center remain at the primary contact
center.

See Sharing workload between contact
centers for details.
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Field Description

Disable Failback Processing This only applies to contact centers that have
a backup contact center and covers backend
processing for workflows.

The main contact center performs backend
processing for all workflows for the contact
center. The backup contact center takes over
backend processing if it detects that the main
contact center is unavailable.

The backup contact center relies on a
communications link to detect the state of
the main contact center. If, however, it’s the
link that is down and not the server itself then
there is a risk that backend processing will
be duplicated. For example, duplicate emails
might be sent.

Select this option to avoid this risk. This
means that rather than duplicate backend
processing, you delay processing instead.

Timezone Select the timezone for the contact center
unit.

4. The next step is to set the default priority for call, email, chat priority and to make the contact
center unit live. See Setting default activation priorities.

Setting default activation priorities
You can set the default priority for each of the different activation types when queuing for an agent
at a contact center. Priority is a range from 1–9.

In the following example, chat at this contact center unit will always take priority over emails when
queuing because chat has a higher priority than email:
• Default Call Priority: 6
• Default Chat Priority: 5
• Default Email Priority: 3
• Default Social Media Priority: 2

You can adjust the priority for a specific inbound number (DDI or DID), chat definition and so on as
part of its configuration. For example, so that phone calls to a specific inbound number queue at a
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higher priority to chat. You can also override the priority in the queue progression script based on
other criteria.

Note  If you change the priorities once the contact center unit is live then the changes take
place in near real time but generally do not apply to items (calls, chat) already in the queue.

To set up the default priorities at a contact center unit:
1. In the Admin Portal go to Contact Center Unit > Access to Contact Center.
2. In Primary Contact Center, select the contact center.
3. If this is a new entry then:

• In Contact Center Unit, select its contact center unit.
• In Secondary Contact Center, select the same contact center that you selected in Primary

Contact Center.
4. Set up default priorities as described below, ignoring the other fields on the page:

Note  For details of the other fields on the page, see Sharing workload between contact
centers and Setting the queue quotas.

Field Description

Default Call Priority This sets the default priority for all voice calls at this
contact center unit. You can adjust the priority for a
specific inbound number as part of its configuration.

Default Chat Priority This sets the default priority for a new chat session when
queuing for an agent. You can adjust the priority for a
specific chat definition as part of its configuration.

Default Email Priority This sets the default priority for all inbound email
addresses when queuing for an agent at this contact
center unit. You can adjust the priority for a specific email
address as part of its configuration.

Default Workflow Priority This sets the default priority for the workflow objects such
as call backs and campaign calls that use preview mode.
You can adjust the priority for a specific workflow as part
of the workflow definition.

Social Media Priority This sets the default priority for all Facebook and Twitter
messages.
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Setting the queue quotas
You can set the maximum number of calls, emails, work objects and so on that are queued for
agents at each contact center unit. For each activation type, you need to set a quota that's high
enough to provide sufficient work for the number of available agents. If the quota is too low then
some agents may be left in the idle state waiting for the next call, work object to arrive. You should
aim to avoid the queue dropping to 0.

To set the queue quotas:
1. In the Admin Portal go to Contact Center Unit > Access to Contact Center.
2. In Primary Contact Center, select the contact center.
3. If this is a new entry then:

• In Contact Center Unit, select its contact center unit.
• In Secondary Contact Center, select the same contact center that you selected in Primary

Contact Center.
4. Set up the queue quotas as described below, ignoring the other fields on the page:

Note  For details of the other fields on the page, see Sharing workload between contact
centers.

Field Description

Work Flow Queue Quota Maximum number of work objects that can be added to
the queue at the contact center. For example, 100 work
objects may exist in the system, but you don't want to add
more than 10 to the queue at any one time.

For campaigns, the quota should reflect the number of
available agents. For example if there are 100 agents,
then you may need a quota of 50. See Preparing to run
campaigns.

Default: 5.

Email Queue Quota Maximum number of emails received at the contact center
that can be on the queue at any one time.

Default: 5.

Quotas for the other media types are set separately in the Admin Portal:
• For each inbound number, on the Media Management > Voice page.
• For each chat definition, on the Media Management > Chat page.
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• For each social media definition, on the Media Management > Social Media page.

Sharing workload between contact centers
Contact centers can cooperate with other contact centers to share the workload. This applies to all
the tenant's communication channels, such as voice, email, chat.

For example, one contact center (referred to as the secondary center) might provide an out-of-
hours service for another contact center (the primary center) or take calls for them when their
agents are overloaded.

The Contact Center Access Detail page in the Admin Portal sets the access level for the
secondary contact center and lets the secondary contact center prioritize the work or disable the
call distribution altogether. The primary contact center disables call distribution on the Contact
Center Unit page.

To set up workload distribution at each of the contact center units:
1. In the Admin Portal go to Contact Center Unit > Access to Contact Center.
2. Click New and select the contact center and unit:

• In Primary Contact Center, select the primary contact center.
• In Contact Center Unit, select the unit in the primary contact center that needs to distribute

some of its workload.
• In Secondary Contact Center, select the contact center and/or contact center unit that will

accept the work.
Notice that you cannot change this once you have saved the configuration.

3. Set up options that apply to the primary contact center:

Field Description

Access Level The level of control that the primary contact
center gives to the secondary contact
center to set its own priority and quotas. For
example:

• Operator – secondary contact center
cannot set its own priority and quotas

• Manager – can set priority and quotas

4. Set up the options that apply to the secondary contact center. These options are typically set
by the secondary contact center to meet their own requirements:
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Field Description

Is Live Whether work is currently being distributed:

• Yes – the secondary contact center is
available to accept work from the primary
center.

• No – the secondary contact center is not
able to accept any work.

Default Call Priority

Default Chat Priority

Default Email Priority

Default Workflow Priority

When sharing is live then activations are
queued at the secondary contact center at
the default priorities for the secondary contact
center as set here.

For details of how the default priority is used,
see Setting default activation priorities.

Secondary Call Distribution Priority Use this field to ensure that agents at the
secondary contact center answer local calls
before calls from the primary center. To
achieve this, give calls from the primary
center a lower priority than local ones.

Secondary Call Distribution Delay The secondary contact center adds the call
to its queue only after it has queued for the
number of seconds set here.

For example, calls might queue at the primary
contact center for 60 seconds, after which
they are added to the queue at another
center. Where there are multiple centers
sharing the workload then you might stagger
the distribution delay so the call queues first
at the nearest secondary center and then
later at one further away.

External Programs Legacy option. Leave this field empty.
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Field Description

Work Flow Queue Quota Number of work objects from the primary
contact center, such as call back requests,
in the queue at the secondary center. For
example, the system might transfer 100 work
objects, but you don't want to add more than
10 to the queue at any one time.

Default: unlimited.

Email Queue Quota Number of emails received at the primary
center that can be on the queue at the
secondary center.

Default: unlimited.

SCD Quota Number of calls (Secondary Call Distribution)
that the secondary contact center can accept
at any one time.

Default: unlimited.

Auto Answer Setting Select
• Default to use the Call Auto Answer

setting configured in the contact center.
• Disable to turn off Call Auto Answer.
• Custom to change the timeout period.

Auto Answer Custom Setting Automatic call answering takes over after
the timeout entered here. This overrides the
timeout set for the secondary contact center.

5. Once the contact center is ready to accept calls then make it live:

Field Description

Is Live Whether the secondary contact center is ready to take
calls:

• Yes – the contact center unit is available to take calls.
• No – the secondary contact center is not able to accept

any calls.
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Disabling a contact center unit
You can disable a contact center unit to prevent the unit from receiving any activations, including
calls to any of its inbound numbers (DDI or DID). You cannot disable a contact center.

Note  You can also disable individual inbound phone numbers. See Disabling inbound
numbers.

Changing the Live status of the contact center unit

To change its Live status while preserving the contact center unit's configuration:

1. In the Admin Portal, go to Contact Center Unit > Access to Contact Center.
2. Locate the contact center and the unit.
3. On the Contact Center Access Detail pane, set the Is Live field to No. Set this to Yes to re-

enable it later.

Suspending or terminating the contact center unit

To disable a contact center unit:
1. In the Admin Portal, go to Contact Center Unit > Contact Center Units.
2. Locate the contact center unit.
3. On the Contact Center Unit Detail pane, set the Status field to Suspended - Deny Calls or

Terminated.

Status option Description

Suspended – Deny Calls Suspends all activations for this contact center unit. For
example, callers will hear an engaged tone.

This status reserves the resources used by the contact
center unit allowing you to switch on the contact center unit
later.

Terminated This status releases the resources used by this contact
center unit, such as inbound phone numbers and email
addresses so that they can used elsewhere.

You could switch on the contact center unit later, but it
would probably require additional configuration as the
same phone numbers, for example, might not be available
anymore.
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Public holidays and open hours
This topic includes the coverage plans that determine when a contact center unit is open.

Public holidays and open hours are used to determine call routing behavior on week days that are
not normal working days for the contact center unit. You may also need to use these later when
scripting queue progression where a calculation is required for a day.

Because public holidays are not the same in all countries, you need to set up public holiday zones.
Depending on the location of the contact centers, it is possible that some of the public holidays
are the same in all the geographies covered by the tenant. Where this is the case, you can set up
public holidays that will apply globally.

Coverage plans are used to determine what is in and out of hours for a contact center unit when
scripting queue progression (using the IsOpen action).

Note  You need to be an administrator with Global Operator status to manage public holidays
and coverage plans.

Configuring public holidays
There are two types of public holiday:
• Dates that apply to all the tenant's contact centers without any exceptions — these are global

holidays.
• Additional dates that apply to individual contact centers. For example, because there are

different national holidays, or where there are other events such as training days that need to
be handled.

Global holidays will apply to all the contact centers belonging to the tenant. These dates are in
addition to any dates that you might add to the public holiday zones belonging to the contact
centers.

To add global public holidays

There are two steps. First create a public holiday zone and then add the dates:

1. In the Admin Portal, go to Contact Center > Public Holiday Zones and set up a zone:
a. Click New.
b. In Public Holiday Zone Detail, make sure that nothing is selected in the Contact Center

field.
c. Enter the name of the zone. For example, Global.
d. Click Save.
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Note  To list the new global public holiday zone, make sure that the Contact Center
field in the List area is empty.

2. Go to the Contact Center > Public Holidays page and add the global public holidays:
a. Click New.
b. On the Public Holiday Detail area, make sure that Contact Center is empty.
c. In Zone, select the global zone you created above.
d. Enter the name of the holiday.
e. Select the date of the holiday from the date picker. Using the date picker, ensures you enter

the date in the right format.
f. Click Save.
g. Repeat these steps for other public holidays that apply to all the tenant's contact centers.

Note  To list the global public holidays, make sure that the Contact Center field in the
List area is empty.

To add national or regional public holidays

These are the public holidays that are the exception to the global public holidays. For example, a
tenant with UK and US offices will need separate public holiday zones to record national holidays.
Each contact center has its own public holiday zone and will inherit all the global public holidays.

Note  For example, if there are two contact centers in the US and one in the UK then you
need to create two US public holiday zones and one UK zone.

There are two steps. First create a public holiday zone for the contact center and then add the
dates:
1. In the Admin Portal, go to Contact Center > Public Holiday Zones and set up a zone:

a. Click New.
b. Select the contact center.
c. Enter a name for the public holiday zone.
d. Click Save.

2. Go to the Contact Center > Public Holidays page and set up the public holidays that are
specific to the selected contact center:
a. Click New.
b. Select the contact center, for example the US contact center.
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c. Select the zone you created above. The zone appears in the list because it is already
assigned to the contact center.

d. Enter the holiday name.
e. Enter the date.
f. Click Save.
g. Repeat these steps to add additional dates for this contact center.

Note  To list the public holidays for this contact center, select the contact center in the
Public Holiday List. Note that the global holidays aren't listed when a contact center is
selected.

Configuring open hours
Coverage plans are used to determine what is in and out of hours for a contact center unit when
configuring media scripts (using the IsOpen action or timer events).

About the default coverage plans
When the tenant is created, a set of coverage plans with different open hours is automatically
created for you.

Listing the default coverage plans

1. In the Admin Portal, go to Contact Center > Coverage Plans.
2. In the Coverage Plan List area, make sure that the Contact Center field is empty.

Deselecting the contact center will list all the default plans.
3. Review the coverage plan descriptions. There may be a coverage plan with open hours that is

suitable or which could be modified.

Where a coverage plan excludes public holidays then the public holidays are:
• The global public holidays set on the Contact Center > Public Holidays page
• Plus any other public holidays set up for the contact center units

Note  You can modify a default coverage plan and assign it to one of your contact center
units, but you cannot add or modify default coverage plans.

Modifying a default coverage plan

1. Select the plan from the Coverage Plan list.
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2. In the Coverage Plan Detail area, select the contact center that will use this plan.
3. Modify the name, description and regular expression if required.

For an explanation of a regular expression example, see Adding or modifying a coverage plan.

Assigning a coverage plan to a contact center unit

1. In the Admin Portal, go to Media Management > Advanced Settings.
2. Select the contact center unit.
3. In the Coverage Plan field select the coverage plan with the required open hours.

Adding or modifying a coverage plan
To add or modify the open hours in a coverage plan:
1. In the Admin Portal, go to Contact Center > Coverage Plans.
2. You can do one of the following:

• To create a new plan from scratch, click New.
• To modify an existing plan, in the Coverage Plan List area, deselect the contact center and

then select an existing coverage plan from the list.
3. In Contact Center, select the contact center that will use this coverage plan.
4. Enter a descriptive name for the plan. You will use this to identify the coverage plan later.
5. Enter a description of the hours that the plan covers. This will help someone else understand

the regular expression.
6. Using a regular expression, enter the active hours. Note that formatting of this rule is important.

Regular expression: working weekdays rule

The following example defines a rule active on working weekdays between 08:30 and 17:00.

0 [1-5] ..../../.. (08\:[3-5]\d|09\:\d\d|1[0-6]\:\d\d)

Here is a breakdown of same expression with an explanation.

0 The number 0 is used to determine whether the rule is applied on a public
holiday. If = 0, the rule is not applied to public holidays, if = 1, then it is. For
both, enter 01.

Public holidays are determined by the public holiday zones set up for the
tenant.

CE Admin Portal Guide - Configuring contact centers and units | 42



IFS Customer Engagement 25R1 GA

[1-5] Looks at the days of the week the rule is to be applied to. Days run from 0-6
with 0=Sunday and 6=Saturday.

By placing the section in square brackets, we can look at a range of numbers,
so [1-5] is equal to Monday to Friday.

If I wanted a rule to just run on a Sunday I could dispense with the brackets
and state 6.

..../../.. Specifies the date when the rule applies in YYYY/MM/DD format. In this case
we want the rule to apply on all dates, so it is set to blank, expressed as
..../.../..

(08\ From here we move on to specifying the time of day and using round
brackets we can specify more than one parameter to match. In this case we
are looking for a match for 08 before the colon in the time. This is for the
hour.

:[3-5] After the colon in we are looking for a match in a range of numbers between
3 and 5, so a square bracket is used for the range, containing 3-5. This is for
the minutes.

Note, it is only looking for a match in the number immediately after the colon,
like hh:3m –

\d \d denotes it is disregarding the last digit, or to be more specific any digit
here will be a match. So because the first part of the minute match was
[3-5], and we’re accepting a match to any digit next, the rule will apply from
08:30 to 08:59.

| The pipe character is used to allow for another match, if the first part does not
find a match.

09\ Now we’re looking for a match where the hours are equal to 09.

:\d\d We want the rule to apply throughout the hour, so minutes are matched as \d
\d

| Another pipe to continue the query.

1\ Now we’re looking for a match where the time contains 1 in the first digit, so
1h:mm

[0-6] Looking at the second digit of the time, square brackets are used again to
specify a range of numbers, so with the first digit matched, it will find a match
with any number between 10 and 16.
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\:\d\d Looking for a match with any digit in the minutes, so /d/d is used.

) A round bracket is used to close the query.

So, the following string in date/time will provide a true or false value

0 0 2011/12/04 10:00 – FALSE

0 1 2011/12/05 10:00 – TRUE

1 1 2011/12/05 10:00 – FALSE

0 1 2011/12/05 17:00 – FALSE

Regular expression: different time pattern for Saturdays

The times in the above example could be extended by enclosing the original expression in
brackets and a second one also in brackets. You need an OR (|) between the two expressions.

The expression below would return a value of true for hours of operation 08:30 to 16:59 Monday to
Friday and 08:30 to 12:59 on a Saturday.

(0 [1-5] ..../../.. (08\:[3-5]\d|09\:\d\d|1[0-6]\:\d\d))
|(0 6 ..../../.. (08\:[3-5]\d|09\:\d\d|1[0-2]\:\d\d))

Note  If you copy and paste the above expression to use it in the Admin Portal then you must
remove the line break.

Skills and skills-based routing
Skillsets act as hunt groups, seeking out the best agent to handle a voice call, email or chat. Each
skillset has at least one required skill and optionally one or more preferred skills. When seeking
the best available agent, the skills in the skillset are matched against the skills assigned to users.
The skillset to be used is determined by the skillset assigned to each activation type (inbound
number, email address, chat), and optionally by the default skillset assigned to the contact center
unit.

Skills overview
Skillsets act as hunt groups, seeking out the best agent to take calls. All skillsets should
contain at least one required skill and could also contain a preferred skill. After a period, if the
communication is still in the queue, the system can also seek out agents with the skills from an
overflow skillset.
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The required, preferred and overflow skills in a skillset

Skillsets are used to move calls around a contact center, changing the profile of agents sought
as a communication remains in a queue for longer. Typically, this is done by widening the pool of
agents able to take the call, email or chat. First CE seeks out agents with both the required and
preferred skills and then if no one is available it seeks agents with the required skill.

How the search for an agent with suitable skills widens

When you set up skills and skillsets, you set them up for the tenant. If needed you can also set up
additional skills and skillsets for a contact center. You then assign a default skillset to the contact
center unit and to each media type: voice call, inbound email, chat or work object.
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Setting up skillsets for the tenant and optionally for contact centers

Note  Queue progression rules let you change the skillset required to handle a call, email or
chat before or after adding it to the queue.

Note  You can add skillsets to control who has access to the reports that are configured in
Report Designer.

Routing activations to agents
For the purposes of this section, an activation is defined as any inbound call, email, chat or work
object. To receive an activation, an agent must be both idle and logged in (not in Do Not Disturb
mode).

Skills are weighted on a scale 1 through 10, where 10 is the highest.

Note  For details of how to test this, see Testing skills-based routing.

Routing to preferred skill

Where a skillset is defined as having a preferred skill the activation will always seek out a
preferred agent first.
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Routing to agent with higher precedence

In the agent profile (User Skill) it is possible to set one agent with a higher precedence than
another. So, whilst two agents may both have exactly the same skills one may still be weighted
above another and this agent will be presented with the activation first.

Routing by number of skills

Where two agents have same required skill, preferred skill and same precedence level, the
system will check which agent has the least skills and present to that agent, as the agent with
more skills may match the profile of the next (unknown) call.
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Routing to agent by idle time

Where all other factors fail to produce a suitable agent, the activation will present to whichever
agent has been idle longer.
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Adding skills
You set up the skills required by the tenant and/or contact center and group them into sets. You
also need to assign the skills to users (agents).

Adding skills

To add a skill:
1. In the Admin Portal go to Contact Center > Skills.
2. In Skill Detail pane, leave the contact center empty if you want to set up a global skill or select

the contact center if this skill is specific to one contact center.
3. Enter the name of the skill. For example,

• A specific skill such as Customer Services, Dispute Handling, Speaks Spanish and so on.
• Personal skill for a user. The name should match the user's User ID. This allows you to

route an activation, such as a work object, directly to an individual.
4. Click Save.

Adding skills to skillsets
You need to group skills into skillsets.

Creating a new skillset

1. In the Admin Portal go to Contact Center > Skillsets.

Enter the details of the new skillset in the Skillset Detail pane.
2. Leave the contact center empty if you want to set up a global skillset or select the contact

center if this skillset is specific to one contact center.
3. Enter the details of the skillset.

Field Description

Skillset Name The name of the skillset.

Skillset Minimum Preferred skill weighting For a skillset with preferred skills, the
threshold that must be met for an agent to be
found. See the example below for details of
how to use this.
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Field Description

Transferable Voice calls can be transferred by agents to
a skillset: in Agent Desktop go to Address
Book > Queues.

This is intended for use in contact centers
with clearly defined teams. To allow the agent
to select the skillset to make an outbound call
or transfer the call, select the Transferable
option.

The agents will only be able to dial from idle
if the agent has a default associated contact
center unit.

Skillset Overflow Timeout The number of seconds after which the
activation will also begin to queue for agents
with skills in the overflow skillset.

Overflow Skillset Activations will overflow to this skillset if they
are still on the queue after the timeout set
above.

Relative Priority When the overflow timeout occurs, you
can increase or decrease the priority of an
activation in the queue. For example:
• High increases the priority of the activation

in the queue by 1
• Low lowers its priority in the queue by 1
See below for an example of how to use this.

4. Select the skills for the skillset. For each skill, enter the following details and then click Add
Skill:

Field Description

Name Select a skill to add to the skillset.
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Field Description

Type Decide whether the skill is:
• Required: A required skill forms the minimum requirement.
• Preferred: A preferred skill is a desirable requirement. The activation

will be presented to agents with this additional skill before presenting
it to agents with only the required skill. Enter the weighting for this
preferred skill.

See below for an example that explains the difference between required
and preferred.

Weighting Factor See below for details of how you can use this.

5. Click Save to save the skillset.

Required and preferred skill example

For example, a skillset has the following skills:

Skill Type Weighting Factor

Customer Services Required 0 (required skills aren't
weighted)

Spanish Preferred 2

Dispute Resolution Preferred 1

Authorize Refunds Preferred 1

In the above example, there are various ways of setting the threshold in the Skillset Minimum
Preferred skill weighting field depending on what you want to achieve. For example, entering:

Weighting Factor Result

2 The system will find:
• EITHER an agent who speaks Spanish
• OR an agent who has both the Dispute Resolution and Authorize

Refunds skills

3 The system will find an agent who speaks Spanish AND has one of the
other two skills.

4 The system will find an agent who has all three of the preferred skills.
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Overflow threshold, skillset and relative priority example

For example, if you have a Service Level Agreement that requires support emails to be answered
within 10 hours, then you might:
1. Set the Skillset Overflow Timeout to 28,800 seconds (8 hours). This means that after 8 hours

in the queue, the activation will escalate to someone with the skills in the overflow skillset.
2. Set the Overflow Skillset to a suitable skillset.
3. Set the Relative Priority to increase the priority of the activation in the queue. For example, to

Highest.

You can also set a timeout, overflow skillset and relative priority on the overflow skillset itself.

Assigning skills to agents

Note  For background information on how skills work in CE, see Skills overview.
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Overview of the User Skills page

Listing users and their skills

1. In the Admin Portal go to Users > User Skills.
2. Go to the User List area.
3. List all the users and their skills by selecting Select an option in the User list.
4. Click a column heading to sort the information by user, skill or precedence.

Assigning skills to users

You can use these steps to assign skills to a single user or to many users.

1. In the Admin Portal go to Users > User Skills.
2. Go to the User Skill Detail area.
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To clear this area, you may need to click New.
3. In the User table, select the user(s) who requires the skill. Hold down the Ctrl or Shift keys to

select multiple users.
4. Click Add.

The users listed in the Remove column will be assigned the selected skill(s).
5. In the Skill table, select the skill(s). Hold down the Ctrl or Shift keys to select multiple skills.
6. Click Add.

The skills listed in the Remove column will be assigned to the selected user(s).
7. In Precedence, enter the additional weighting that you want to give to the selected user(s).

This is used when several agents have the same required and preferred skills. The activation
will present to the user with the highest precedence:
• 5 is the default precedence
• 10 is the highest precedence
• 1 is the lowest precedence

Copying the skills assigned to one user to other users

If you have a user who already has the right combination of skills then you can copy that set of
skills to one or more other users.

1. In the Admin Portal go to Users > User Skills.
2. Begin by selecting the user who has the right combination of skills:

a. In the User List area, select the user who has the right skills.
b. Select the option Load All Skills of Selected User.

The user's skills are listed below.
c. Click on any of their skills.

The selected user and all their skills are displayed in the Remove columns in the User Skill
Detail area.

3. Now select the other users that require these skills:
a. Go to the User Skill Detail area.
b. In the User table, click the user who requires these skills. Hold down the Ctrl key or Shift

key to select multiple users.
c. Click Add.

All the users listed in the Remove column will be assigned the selected skill(s).

At this stage, you could add or remove skills if you wanted. Any changes you make to the
selected skills will affect all the users listed in the Remove column of the User table.

The same applies to the precedence. The precedence shown in the Precedence field will
apply to all the selected users and skills.
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d. Click the Add and Update Selected button to apply your changes.

Modifying and deleting the skills for a single user

In the User List area, you can add, modify and delete the skills for a single user:

1. In the Admin Portal go to Users > User Skills.
2. In the User List area, select the user:

• To delete a skill, select it and click Delete
• To modify a single skill, select it and then select a different value from the Precedence list

(on the right)
• To add a skill, follow the steps in Assigning skills to users above

Deleting skills from one or more users

1. In the Admin Portal go to Users > User Skills.
2. Go to the User Skill Detail area.
3. Select the users who have the skill(s) that you want to delete. Hold down the Ctrl key or Shift

key to select multiple users.
4. In the Skill table, select the skill(s) that you want to delete and then click Add.

The selected skills will be deleted from the users listed in the Remove column.
5. Click Delete Selected.

The selected skills are deleted from the users.

Setting default skillsets
You can set a default skillset for a contact center unit in the Admin Portal, on the Media
Management > Advanced Settings page.

When skills based routing is used, then eventually an activation will be routed to someone with
a skill in this default skillset if no more qualified person is available. This allows, for example,
someone from IFS Support to investigate an issue without needing to change the configuration
elsewhere.

Default skillsets for each media type are set in their respective definitions. For example, you can:

• Set a default skillset for each workflow definition listed on the Workflow Management >
Workflows page. This skillset becomes the default for all work objects or campaigns created
from the workflow definition.

• Set a default skillset for each phone number listed on the Media Management > Voice page.
This skillset becomes the default for all calls to and from that number.
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Testing skills-based routing
You can test skills-based routing with a minimal number of users. In this example, there is:
• One skillset called Testing which contains one required skill called Testing.
• There are two users who have the Testing skill (and no other skills).
• One user has the Testing skill with a high precedence of 8 and the other user has the same skill

but with a low precedence of 2.

You set this up, in the Admin Portal, on the Users > User Skills page.
• The skillset is assigned to an inbound number on the Media Management > Voice page.

To test the skills-based routing of activations:

1. Both users sign on to Agent Desktop and stay in DND mode.
2. Go to the Monitoring page. Notice that you are on different iMedia instances (for example,

station 1 and 501).
3. You must both be on the same iMedia instance. To do this, one of you monitors the other user:

a. On the Monitoring page, click the other user.
b. Click Monitor and then Stop.
c. Refresh the Monitoring page - you are now both on the same instance (for example,

stations 1 and 2).
4. The person with the lowest precedence goes available first.
5. The other person then goes available.
6. Dial the number.
7. The call goes to the person with the highest precedence and not the person who was idle the

longest.

For an explanation of this, see Routing activations to agents.

Time recording in Agent Desktop
You can define the reason codes that agents select when they switch between activities in Agent
Desktop. The reason codes are shown on the Monitoring page in Agent Desktop and in reports
configured in Report Designer (using the Agent Time Recording report module). Agents must sign
out and in again to see changes to the default time codes.
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Selecting a reason code in Agent Desktop

Note  The reason codes apply only to agents who have Require Time Keeping selected in
their user account.

About the activity types

You can define any combination of Online Activity and DND Activity codes to replace the default
reason codes:

Online Activity Use this type for any activity performed by agents where agents remain
available to take calls and so on.

For example, a CE Studio app presents agents with a list of tasks to
perform (emails, social media) in between handling live callers. By
selecting an Online Activity code, the agents categorize their available
time.

Selecting an Online Activity is optional since agents can leave themselves
in Available mode.

DND Activity Use this type for any activity performed by agents where they are not
available to take calls, and need to place themselves in Do Not Disturb
mode.

Selecting a DND Activity is mandatory for agents wanting to go to Do Not
Disturb mode.

Both Use this type for any activity that could be done while agents are either
Available or in Do Not Disturb mode.

You can configure reason codes for use by all the contact centers (global reason codes) or
specific reason codes for a single contact center. A contact center that has no reason codes
defined for it, will use the global reason codes. If there are no global reason codes then all contact
centers will use the defaults.
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Configuring time recording states (reason codes)

To configure the time recording states (reason codes):
1. In the Admin Portal, go to the Contact Center > Time Recording State page.
2. Click New to add a new state.
3. Select the contact center if required or leave it blank if you are defining reason codes that will

be used by all contact centers.
4. Fill out the details:

Field Details

State The name that you want to display in Agent Desktop and in reports.

Activity Type The activity type is one of the following:
• DND activity: activities where agents are not available to receive

calls and so on.
• Online activity: activities where agents remain available to

receive calls and so on.
• Both: activities where agents can choose to remain available or

put themselves into Do Not Disturb mode.
• Deleted: for time recording states that you no longer require.

System use only Select this when creating time recording states that you do not want
to show in Agent Desktop, such as Signing on, Ring Timeout, Tel
delivery error, Caller ringoffs, and Screen-pop error. This will then be
included in the standard reports.

Signing on When agents sign on, they are automatically put into Do Not Disturb
mode. No reason is recorded for this event. Define a Signing on
code if you to report on this event type.

Ring Timeout When agents fail to accept the activation presented to them:
• They are automatically put into Do Not Disturb mode.
• No time recording code is assigned to this event.
Define a Ring Timeout code if you want to report on this event type.

Tel delivery error When a call cannot be delivered to the agent:
• They are automatically put into Do Not Disturb mode.
• No time recording code is assigned to this event.
Define a Tel delivery error code if you want to report on this event
type.
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Field Details

Caller ringoffs Typically, occurs when there is a long ring timeout configured, and
the caller hangs up before the agent picks up. When this occurs, the
system retrieves the call and makes the agent available again. If this
happens 3 times in a row then the agent is automatically put into Do
Not Disturb mode. By default, no time recording code is assigned to
this type of event.

Define a Caller ringoffs code if you want to report on this event type.

Screen-pop error For example, occurs when the agent is still signed on but their Agent
Desktop session is disconnected. By default, no time recording code
is assigned to this type of event.

Define a Screen-pop error code if you want to report on this event
type.

Twilio regulatory requirements
From June 2024, Twilio requires tenants purchasing phone numbers to verify themselves with
Twilio and create a regulatory bundle for any mobile and local phone numbers that they want to
purchase.

IFS Support can purchase phone numbers on your behalf after Twilio approves the regulatory
bundle.

To find out more about the regulatory requirements for your country, please go this website: https://
www.twilio.com/en-us/guidelines/regulatory.

Adding addresses to Twilio

The first step is to add the required addresses. This must be an address associated with the
business and in the same country as the phone numbers you want to purchase.

In the Admin Portal, go to the Twilio > Tenant Address page and enter the required details.

Note  Select the Suggest Valid Address check box in order to let Twilio auto-correct the
address you enter. If using this feature, please check that the updated address is correct.

Scroll the list of addresses on the right of the Tenant Address page to see whether Twilio has
validated the address.
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Note  In countries that require valid addresses, an invalid address will not be accepted.
• true indicates the address has been checked.
• false indicates the country doesn't require validation or the address is not valid.

Adding Twilio end users

To meet the Twilio regulatory requirements for purchasing phone numbers, you need to enter the
details of the authorized user who manages phone numbers for your business.

In the Admin Portal, go to Twilio > Twilio End User page and enter the required details. The
details depend on the country, and the tooltip associated with each field tells you what is required.
If there are any errors in the end user details then these are reported when you create and save
the Twilio regulatory bundle in the next step.

Creating Twilio regulatory bundles

Once you have created an address, and a Twilio end user for each type of number you want to
purchase (such as mobile or local), then you can create the regulatory bundle. It is at this stage
that the end user details are checked by Twilio.
1. In the Admin Portal, go to the Twilio > Twilio Regulatory Bundle page.
2. Enter the name you want to use. Names can contain spaces and you can change the name

later.
3. Enter the details required to create the bundle.

You must select an emergency address, however, this is only used if the address is configured
as an emergency address. Raise a Service Now request to ask for this additional configuration.

4. On saving, the selected end user and selected address is validated by Twilio:
• After saving, the bundle has in-review status. Acknowledgment and status emails are sent to

the email address you entered.
• If any errors are reported, edit the Twilio end user details and then come back to current

page to amend the bundle details. The bundle has Draft status while you do this.

Once approved, the status moves to twilio-approved. You can now request IFS Service Now to
purchase phone numbers from Twilio on your behalf.
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Call routing rules

Important  You require an understanding of the tenant's telephony infrastructure before you
can configure the call routing rules. Incorrect configuration may prevent calls into and out of
the tenant's servers. You also need to be familiar with regular expressions.

Note  You need to be an administrator with Technical status to manage call routing rules.

Call routing rules are used to modify the behavior and/or presentation of telephone numbers
passing into or out of the tenant's servers. A typical example is to reformat a telephone number
from a convention used for international numbers such as +44 (0) 115 96500 to one that can
be dialed over the PSTN such as 00441159658600.

A tenant has some predefined call routing rules, which are described in this section.

Hierarchy of call routing rules
Rules will be applied in the order displayed below. The hierarchy used allows for subtle application
of the rules in a multi-site contact center.

How call routing rules are applied

For example, call routing rules configured at the contact center unit level are the most specific and
will override other rules of the same type configured at a higher level.

Here are a few examples of how rules might be used at different scopes.

Contact center rules For example, use these rules to allow agents to dial local numbers and
translate that into a full number before presenting the number to the
PSTN.
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Server rules These rules apply to one of the server instances. For example, use
these to define what inbound number ranges are accepted into the
server.

Note  Not suitable for a cloud deployment where the servers
operate in a load-balanced cluster.

Tenant rules These are global rules. For example, use these convert all dialed
numbers from +441159658600 to 00441159658600 before
presenting to the PSTN.

Tenant-level call routing rules
This section describes the predefined call routing rules that apply globally to the tenant. If
required, you can edit these or add these to a contact center and then edit them.

To view the predefined rules:
1. In the Admin Portal, go to Contact Center > Call Routing Rules.
2. In the Call Routing Rule List, make sure that the Contact Center field is empty.

The first 6 rules use a To Match Pattern and therefore apply to outbound calls. This rule make it
easier for agents to dial. See Adding a call routing rule for an explanation of match patterns:

Priority Feature To match pattern
To deploy

format

1 2 Translate [-\(\)\s]+(.*) $1 Strip formatting characters at the
start of the To number

2 2 Translate (.+)\(\d\)(.+) $1$2 Remove the national break-
out/trunk code for international
numbers if it is enclosed in
brackets - e.g., +44 (0)1926
623500

3 2 Translate ([\d\+\*#].*)[-\(\)\s]+(.*) $1$2 Strip formatting characters from
the middle or end of the To
number

4 2 Translate 0([1-9]\d{7,9}) +44$1 Convert UK national number to
international format
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Priority Feature To match pattern
To deploy

format

5 2 Translate (00|011)(\d{9,}) +$2 Replace the common
international break-out/exit
codes with a generic +

6 2 Translate 141(.*) $1 Support dial prefix to withhold
called ID

The next 6 rules use a From Match Pattern and therefore apply to inbound calls.

Priority Feature From match pattern
From deploy

format

7 2 Translate [-\(\)\s]+(.*) $1 Strip formatting characters from
the start of the caller ID

8 2 Translate ([\d\+].*)[-\(\)\s]+(.*) $1$2 Remove formatting characters
for the middle or end of the
caller ID

9 2 Translate 0?([1-9]\d{7,9}) +44$1 Convert UK national caller ID to
international format

10 2 Translate (user|ss|ivr):.* $2 Strip the caller ID for internal
user and skillset calls

11 2 Translate (00|011)(\d{9,}) +$2 Replace the common
international breakout/exit codes
with the generic +

The next 3 rules apply to features in Agent Desktop:

Priority Feature Notes

12 6 Invoke User Matches on user:.* Allow users to be dialed
directly internally by user
ID or user name

13 7 InvokeSkillset Matches on skillset: ss:.* Allow skillsets to be dialed
directly internally
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Priority Feature Notes

14 2 Translate • To match pattern: (12678|
162|166|1840)(.*)

• To deploy format: $2
• Prefix match pattern: ^$
• Prefix deploy format: $$1

Strip explicitly supplied
LCR access codes for
Gemini, Callstream,
Worldcom and Opal
respectively from the start
of the dialed number and
add it to the prefix

Contact center-level call routing rules
This section describes the call routing rules that relate to the contact center's trunk groups. To
view these rules:
1. In the Admin Portal, go to Contact Center > Call Routing Rules.
2. In the Call Routing Rule List, select a contact center from the Contact Center list and leave the

Server field empty.

Priority Feature To match pattern Notes

1 4 InvokeDDI \+(.*) Invoke DDI Rule, PSTN trunk group

2 4 InvokeDDI SCD.* Invoke SCD DDI, SCD trunk group

10 1 Dial SCD.* Dial SCD prefix numbers

11 1 Dial SCD.* Dial SCD prefix numbers Failover rule (targets a
different SIP Border Gateway)

15 1 Dial TD.* Dial TD prefix numbers, for agent delivery
(targets any of the SIP Border Gateways)

20 1 Dial Dial PSTN numbers

21 1 Dial 141(.*) Dial PSTN numbers Failover rule (targets a
different SIP Border Gateway)

Adding a call routing rule
To add a call routing rule:
1. In the Admin Portal, go to Contact Center > Call Routing Rules.
2. Click New.
3. Decide on the scope of the rule:
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Field Description

Global Select Global to add a rule with global scope. You can add
global rules for reject, translate and invoke but not for dialing.

Important  Do not configure global rules for dialing. The
system must be able to match the rule to the trunk group
and trunk groups are specific to a contact center.

Server
Note  Not suitable for a cloud deployment where the servers
operate in a load-balanced cluster.

Select a server instance if you want to add a rule that applies to
one of the servers:

• <tenant>hub: the pair of server instances on which the
MediaHub service runs. These servers are responsible for
call distribution within the center.

• <tenant>im: the instance that handles inbound, outbound and
transferred calls.

Contact Center To add a rule with a more specific scope, select the contact
center.

Contact Center Unit To add a rule that's restricted to one of the contact center units,
select the contact center unit.

User Use this scope when you want to, for example, prevent an agent
from dialing a specific number.

4. In Feature, choose the rule type. See Examples of call routing rules.
5. In Priority, enter a numerical value that determines the order in which the rule is applied,

where 1 is the first rule to be applied. To make it easier to insert additional rules later, you can
leave gaps in the sequence of priority numbers.

Note  You cannot add a rule with an existing priority. For instance, where rules exist with
priority 1, 2, 3 already then you cannot add another rule with priority 3.

6. For a rule that checks dates and times, set up the following:
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Field Description

Public Holiday Zone If time of day patterns are used, then select
the public holiday zone that determines the
public holidays.

Time of Day Pattern Enter a regular expression to set the active
times for the rule.

For an example of a regular expression, see
Regular expression: working weekdays rule.

7. Use the following for a rule that needs to match and change patterns on inbound and outbound
calls:

Field Description

From Match Pattern (inbound calls) Used to find matches on inbound calls, via the
use of regular expressions.

In this example:

[-\(\)\s]+(.*)

the regular expression is used on a translate
rule to match incoming calls that contain –
or + at the start and strip the character from
the number. The position it is stripped from is
denoted in the Deploy format field.

From Deploy Pattern (inbound calls) Indicates the part of the string to which the
From Match Pattern formatting is to be
applied. This could be:
• $0 for all the string
• $1 for first part
• $2 for second part
• A combination of $1$2
• Other combinations, like $$ or $$1
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Field Description

Store Unmasked CLI Select this to encrypt and then save the
original phone number. In reports, authorized
users see the original phone numbers
in the Restricted Caller Id column, while
unauthorized users see the masked phone
numbers as transformed by the rule.

Note  Where there are multiple translate
rules then you need to select this option
on the first translate rule that is applied.

To Match Pattern (outbound calls) Used to find matches on outbound calls, via
the use of regular expressions, similar to
From Match Pattern.

Particularly useful if agents are dialing out
from data which includes formats like +44 (0)
1159658600 to reformat the number before
call is placed to match international breakout
codes for the country the agent works in.

Suppress Overflow Match Pattern Use this to suppress specific codes that result
in unwanted calls, for example when calls are
redialed when they shouldn't be.

The Outbound Call report shows which codes
are returned by the provider. They are listed
in the Clear Code column.

You should not need to do this if your
telephony provider uses the standard codes.

To Deploy Format (outbound calls) Same as From Deploy Pattern.
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Field Description

Prefix Match Pattern Allows for a prefix already accounted for
by another rule, but explicitly entered by an
agent on dialing out to be stripped from the
number when dialing and placed back into the
number.

For example, a rule uses least cost routing to
prefix all number with 641. If this rule is not in
place then an agent dialing: 64101159658600

will end up dialing:

64164101159658600

Prefix Deploy Formats Indicates the part of the string to which the
Prefix Match Pattern formatting is to be
applied.

8. If required set the following options. Not all options apply to all the rule types.

Field Description

Sending Complete Filtering criteria relating to overlap dialing.
Can be set as

• Ignore
• Match only if sending complete
• Match only if sending incomplete

Call Direction A filtering criteria that allows a rule to target
just inbound or outbound calls.

Rematch From Top Allows you to reapply the rule to the resulting
inbound number. For example, after mapping
a number to a new number, you might need
to reapply the rule to the new number rather
than continue matching from the next rule
onwards.

Set Sending Complete Select the check box to indicate that the rule
is to be actioned once sending is complete in
overlap dialing.
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Field Description

Target Trunk Group

Associated Inbound Number

In Dial rules, allow outbound calls to be
placed on a specific trunk group and/or an
inbound number.

Associated Trunk Group A filtering criteria for inbound calls that allows
a rule to be associated with a particular trunk
group.

Note  Relevant in deployments with
multiple PSTN trunk groups.

Channel Allocation Order Allows rules to be applied in a particular order
on the trunk (bottom up or top down). On
inbound calls this is done by default on a top
down basis, outbound dial rules should use
bottom up to prevent call collision.

Note  Relevant in deployments with
infrastructure that uses time division
(TDM) multiplexing.

Failover Rule Only really applicable to dial rules, this allows
for a failover rule to be set if the first rule fails
for some reason.

Existing rules are listed by priority and the
description entered in the Notes field.

VOIP Codec Allows one or more VOIP codecs to be set for
a dial rule.

Where more than one codec is specified, they
will be used in the order in which they are
listed. This means that the first codec will be
used and, if this cannot be used, the second
one will be used and so on.

Target Address Allows you to specify a SIP trunk address. For
example, when using a skype trunk along with
others.
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9. In the Notes field, we strongly recommend that you add details about how the rule works. This
is for the benefit of others administrating the system and makes it easier to select a failover rule
(where the note will be used as a description).

Examples of call routing rules
• Dial rule example
• Translate rule example
• Reject rule example
• InvokeUser rule example
• InvokeSkillset rule example
• InvokeDDI rule example
• WaitForMoreDigits rule example

Dial rule example

Dial rules allow systems to make calls out and specify which trunk group outbound calls are made
through.

In this server-level example:
• The To Match Pattern determines which trunk group outbound calls will be made through
• The target trunk group specifies which trunk calls will be made through according to the number

dialed (To match pattern).
• The channel allocation specifies in which order the channels are used, in this case bottom up to

allow inbound calls to use the trunk from the top down. The reason is to prevent call collision.
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For example, if using E1 connection, it has 30 channels, inbound calls are presented to a specific
channel by the network and normally present from lowest number channel. Making outbound
calls through highest numbered channels prevents call collision in all but the most exception
circumstances when trunk is full.

Translate rule example

Use translate rules to modify the dialed number and rematch using the translated number, that is
to change the number before it is presented to the PSTN.

Translate rule to strip characters

This example strips all formatting characters from the outbound numbers entered by the agent,
before the number is block dialed.
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• The To Match Pattern contains a regular expression specifying the characters to remove.
• The To Deploy Format indicates which part of the number are to be stripped ($1, first, $2

second).

Translate rule to add a prefix

This server-level example adds a prefix to telephone numbers dialed by agents to make use of a
least cost routing facility. A regular expression defines the active times and days of week and the
prefixes to match. The actual prefix is determined in the Prefix Deploy Format field.
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Reject rule example

Reject rules can perform blacklisting, either by blocking calls coming into the contact center unit or
by preventing agents from dialing out to particular numbers.

Note  The DoNotReject rule allows for exceptions to be built into the Reject rule. So where
Reject rules are used at global level, exceptions could be configured at a lower level to allow
an exception.

This example sets a rule against a contact center unit to prevent agents from dialing the speaking
clock (in the UK this is done by dialing 123).
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InvokeUser rule example

Note  This example is one of the predefined rules set at tenant level. Where this feature
is used, it should always be configured in the manner described here because this is the
required format for Agent Desktop.

Invoke User rules allow calls to be passed internally from one agent to another by dialing a
unique identifier for the agent. (GUID, username, name or initials). As the GUID is the one
item guaranteed to be unique, this is the method used by Agent Desktop built-in controls. If, for
example, initials are used to dial and two agents share the same initials, it simply won’t work.
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In this example a regular expression passes the agent’s details as the dialed number.

InvokeSkillset rule example

Note  This example is one of the predefined rules set at tenant level. Where this feature is
used, it should always be configured in the manner described here because this is the format
expected by Agent Desktop.

InvokeSkillset rules allow calls to be passed internally from one agent to a skillset. When using
Agent Desktop the method uses the skillset GUID, although the agent could dial using the skillset
name.
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This example uses a regular expression to pass the skillset’s GUID or name as the dialed number.

InvokeDDI rule example

InvokeDDI rules allow inbound calls to be passed into the server via the specified method (that is
from the PSTN, PBX or internally).

Example 1

In this example
• The regular expression in To Match Pattern specifies the available inbound number range.
• The regular expression in To Deploy Format specifies a prefix to add to the inbound number

as calls come in, so they will be shown as +4419264827nn rather than 4827nn.
• The target trunk group specifies the trunk to be used for this rule.
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This is a server level example.

Example 2

This example doesn't use a regular expression. The target trunk, associated inbound number and
associated trunk group are used to pass calls from PBX to the PSTN.
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The example shown below is the reverse (PSTN to PBX):

WaitForMoreDigits rule example

WaitForMoreDigits rules allow for overlap dialing. These rules are used in environments where
iMedia is interfaced with a local PBX that uses overlap dialing as opposed to block dialling, where
all the numbers to be dialed are presented at once.

This example uses the To Match Pattern field to specify a number of inbound number ranges that
could be dialed by an agent to an internal inbound number (hence call direction of inbound) and
tells the system to wait for more digits before attempting to call.
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5
Credentials, certificates and domains

You can configure the credentials needed to connect to a specific environment (endpoint) in the
Admin Portal on the Credentials Manager > Manage Credentials page. You then use these
credentials in CE Studio Designer when creating providers. This removes the need for users in CE
Studio Designer to know the endpoint URLs and what's required to authenticate.

On the Manage Credentials page, you can:

• Save the endpoint and the authentication details for the target environments.
• Change the endpoint, for example, when there is a metadata change. When this happens, you

can trigger automatic creation of new versions in CE Studio Designer.
• You don't need to create new provider versions when the password changes (as previously).
• Set default credentials to use when importing CE Studio apps from the Central Template

Repository. Each default applies to either IFS Cloud and a specific endpoint, or to Field Service
Management.

See also Adding credentials for Last-Mile Customer Portal.

Adding credentials
To add new credentials for an environment that will be used in CE Studio Designer to create
providers:
1. In the Admin Portal go to Credentials Manager > Manage Credentials.
2. Enter the details:

CE Admin Portal Guide - Credentials, certificates and domains | 80



IFS Customer Engagement 25R1 GA

Field Description

Contact Center Leave this field empty if creating credentials for portal and public portal
apps, or if you want to create a credential with global access.

Select a contact center only if the environment and credentials are
specific to a contact center.

Contact Center Unit Leave this field empty if creating credentials for portal and public portal
apps, or if you want to create a credential with global access.

Select a contact center unit only if the environment and credentials are
specific to a contact center unit.

Name A name to identify this environment and its credentials.

Description Additional information about these credentials.

Endpoint The URL of the endpoint without the service name.

For IFS Cloud:

https://<environment>.ifs.com/main/ifsapplications/

projection/v1/

where MainCaseHandling.svc is an example of a service name.

For IFS Field Service Management: http://<environment>/
metrixintegrationservice/M5WebService.asmx/

where ProcessXML is an example of a service name.

Provider Type The supported provider types. The required fields for the authentication
are only displayed when you select both the provider type and the
authentication scheme.

Authentication
Scheme

The supported authentication schemes for the selected provider type.

Note  Not all endpoints require authentication, for example,
the readonly Northwind service. However, you still to select an
authentication scheme and then leave the credentials empty.

Default Credential In 6.7 and later, select this if the credential is to be used when
importing CE Studio apps from the Central Template Repository. There
is a single default credential for IFS Cloud and another for FSM.
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3. Fill in the required credentials. For Custom authentication schemes, you need to click the 
button to add each required property as a key-value pair:

Authentication scheme Required credentials

FSM Custom • Username
• Password
• ClientId (optional)

PSO Custom • Username
• Password

4. Save the credentials. This makes the credentials available in CE Studio Designer.

Note  Users need to refresh CE Studio Designer to see any credentials added after they
started CE Studio Designer.

Updating credentials
You can edit the credentials for an environment to:
• Change the authentication credentials, such as username, password, secret, token.
• Change the endpoint when there is a metadata update.
• Change the authentication scheme, such as change from OAuth 2.0 to SSO.

To edit existing credentials for an environment:
1. In the Admin Portal go to Credentials Manager > Manage Credentials.
2. Select the credentials you want to update.

Update the credential

You can update the credential on the Manage Credentials page whenever the credentials for a
target environment changes. You do not need to do anything else. It is not necessary to create
new provider versions.

Update the metadata

Existing providers will continue to use the metadata associated with the previous version of the
credentials. This is because the metadata is part of the provider. When you are ready, you can
push the metadata change to the providers and trigger a new provider version to be created. This
will create a new version in any provider that uses these credentials.

1. Change the endpoint in the credentials.
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2. Save the credentials.
3. Click Update Metadata. This will create a new version in any provider that uses these

credentials, with a note "Metadata updated from Admin portal".

Configuring Captcha type and keys
Customer Engagement uses Google reCAPTCHA. reCAPTCHA uses an advanced risk analysis
engine and adaptive challenges to keep malicious software from engaging in abusive activities on
your website.

You need to register a site on Google reCAPTCHA at reCAPTCHA (google.com).

You use the Admin Portal to set up a list of Captcha sites which will then be utilized on Studio
Designer.

The Captcha element uses three different types: Score Based, Challenge Checkbox and
Challenge Badge.

To record a site that you have already registered:

1. In the Admin Portal, go to the Studio > Manage Captcha page.
2. On the Captcha detail tab, enter the necessary details and click Save.

Domain The domain of the website

Captcha Type Select the Captcha type. You can change this
later if required. In CE Studio apps, you can
add:
• One scorebased element
• A checkbox or badge element
• Multiple checkbox and badge elements

If adding both checkbox and badge elements
then you need a site key that is configured for
both types.

Site Key Enter the site key from your site registration.

Secret Key Enter the secret key from your site
registration.

Certificates and domains
You need to purchase an SSL certificate to cover the domain you want for your public portal.
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For example, to access the public portal at:

https://ce.ventechi.com/

you need a certificate such as https://ce.ventechi.com or *.ventechi.com. The
customer must also configure their system to add the required DNS records.

Note  You can only configure one domain per public portal.

Uploading the SSL certificate for the tenant's public portal

In the Admin Portal, on the Contact Center > Certificates page, you can upload a .pfx file that
contains the SSL certificate (public key), the private key, and the Certificate Chain information. If
the .pfx file is protected by a password, you will need to enter the password as well.

Once you have uploaded the SSL certificate, you can configure a dedicated domain for your public
portal.

Configuring the domain for the tenant's public portal

Important  The domain is owned by the customer and the customer must configure their
system, ie add the DNS records for the domain, referencing the correct cluster cname. Until
this is done, the public portal is inaccessible.

In the Admin Portal, on the Contact Center > Domains page, you can configure the domain that
you want to use for the public portal.
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6
Voice configuration

How to configure a contact center unit for voice calls.

Important  The information in this section applies to fully-featured tenants only.

There are three levels of configuration in the Admin Portal:

• For the contact center – settings for Automatic Call Answering.
• For the contact center unit – you configure a media script for managing inbound calls, for

example, you can configure a menu of options to direct calls to the right place, and determine
what happens while the caller is waiting in the queue.

• For each inbound number (DDI or DID) – some of these settings can override what's set for the
contact center unit. You can also configure a different media script for each number.

You require a CE Studio app for voice calls. This is what the agent uses when they accept a voice
call in Agent Desktop.

In addition, you can set up:
• Call backs, for example, when someone hangs up before connecting to an agent. This requires

a workflow definition and a different type of CE Studio app. When someone hangs up while in
the queue, the caller's details are captured, the system generates a work object which is added
to the queue for an agent, and the agent can then make the call.

• Automated outbound phone calls, for example, using pre-recorded messages. This requires a
workflow definition and a standalone media script.

Introduction to voice calls configuration in CE
When a customer phones a CE contact center, their call can be:

CE Admin Portal Guide - Voice configuration | 86



IFS Customer Engagement 25R1 GA

• Handled automatically by configuring an IVR system (Interactive Voice Response). You can use
the same system for all the inbound phone numbers or you can configure a different system for
specific phone numbers.

• Added to a queue if no agents are available in Agent Desktop. Calls progress through the
queue depending on the type of inbound number, and how queue progression is configured.

• A combination of the above.

The two different inbound number types are IVR and Customer:
• IVR – for this type of phone number you use an IVR script. You can set up a default IVR queue

for all inbound numbers of the IVR type, or script a different queue for each number. This
requires a media script.

• Customer – for this type of inbound number you can configure a simple queue where
messages are periodically played to the caller. No media script is required.

The call details are saved and you can run standard and custom reports on inbound and outbound
calls. You can mask phone numbers to protect the identity of the caller. See Masking phone
numbers for details.

Standard queue progression

This controls how inbound phone calls are placed on the queue when there is no IVR to control
the flow of calls and all agents are busy.

When you configure a contact center unit, you can set options to change the configuration of the
standard call queue. The options are described in Configuring voice settings for the contact center
unit.

Overriding standard queue progression with custom IVR queues

You can configure an alternative call queue (IVR) in the Media Script Editor. For this type of queue
progression, you disable Automatic Call Answer. This leaves the media script to handle any
preprocessing that's required before the call is added to the queue.

See Configuring voice (IVR) queue progression for further details.

Disabling queue progression so calls go straight to an agent

You can also disable Automatic Call Answering for an inbound number so the call goes straight
through to an agent (if one is available). To do this:
1. For the contact center unit, set the option Enable Automated Call Answer to No.
2. When setting up the inbound number, select the Customer type.
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Purchasing phone numbers
You either need to purchase the phone numbers that will be used by the contact center or you
need to add your existing phone numbers.

Twilio Your tenant uses Twilio as the SIP provider unless your organization has
existing telephony infrastructure.

You can purchase phone numbers for voice and/or SMS through the IFS
Service Center after you have verified your business with Twilio. See Twilio
regulatory requirements.

You can configure additional providers for SMS. See Configuring SMS
providers for details.

Note  A SIP trunk provider such as Twilio connects VoIP calls to the PSTN
phone lines. Each contact center has a separate trunk group. Where there
is no existing telephony infrastructure then your tenant is configured to use
Twilio as the SIP trunk provider.

Note  You can request the IFS Service Center to delete unwanted Twilio
phone numbers. Deleting the phone number will automatically delete any
configuration for this number in the Admin Portal.

Existing
infrastructure

If your tenant has existing telephony infrastructure then you can add the
existing phone numbers that you want to use in the Admin Portal, on the
Media Management > Custom Trunk Group DDI Ranges page. See Adding
custom inbound numbers.

You can also configure additional providers for SMS.

Adding custom inbound numbers
When the tenant has its own telephony infrastructure or uses a different SIP trunk provider then
you need to record the details of the existing voice and/or SMS numbers provided by that trunk
group. These will be phone numbers from the tenant’s PBX system or an alternative SIP provider.

To add existing voice and/or SMS numbers to a contact center:

1. In the Admin Portal, go to Contact Center > Custom Trunk Group DDI Ranges page.
2. Click New.
3. In the Custom Trunk Group Detail pane:

a. Select the trunk group.
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b. Select the type of phone number depending on what the phone number supports.
c. In DDI Range Start, enter the phone number — you always configure one phone number at

a time.
d. In Count, enter 1 — you always configure one phone number at a time.

4. Click Save.
5. The next step is to configure the inbound number for voice or for use with SMS. You can

configure the same number for both voice and SMS. See:
• Configuring an inbound number
• Creating SMS definitions

Configuring voice settings for the contact center unit
This topic describes how to configure a contact center unit for voice calls. Further configuration is
needed for individual inbound numbers.

Steps

1. In the Admin Portal, go to Media Management > Advanced Settings.
2. Select the contact center and then the contact center unit.

Note  Fields that aren't relevant to voice calls can be left at their default settings until you
are ready to configure email and chat. General settings for the contact center unit are
described in Configuring contact center units. Other settings for configuring chat and SMS
are described separately.

3. If required, disable patch through for agents in Agent Desktop.

Field Description

Allow Patch Through By default, all agents can transfer a call to
someone else. In Agent Desktop this lets the
agent make an outbound call, connect the
inbound call to that person, and then leave
the call. Select No to disable this feature.

4. If using standard queue handling, configure Automated Call Answer — you should disable this
for IVR queues:
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Note  For details of the standard queue progression for voice calls, see Introduction to
voice calls configuration in CE.

You can record custom messages on the Contact Center > Voice Prompts page.

Field Description

Enable Automated Call Answer By default, Automated Call Answer is used for
voice and chat.

Select No if you not want Automated Call
Answer. This means that calls to the contact
center unit are not automatically answered.
If required, you can configure a Call Answer
Timeout as part of an agent's user account.

Note  The network eventually disconnects
unanswered calls. The cut-off is
determined by local regulations.

Seconds Between Courtesy Message When using Automated Call Answer, the
number of seconds to wait before playing the
next message to the caller.

5. Important: The Disable Caller CLI Forward field is selected by default. We recommend that
you do not change its setting. See below for details.
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Field Description

Disable Caller ID Forward By default, the use of Caller ID (caller line
identification) numbers when forwarding calls
to agents is disabled.

Important  We recommend that you do
not to change this setting as you may
prevent the dialing of outbound calls.

• Disable this setting for Cloud deployments
where there isn’t a direct connection to the
private network (PBX), and you need to
dial numbers on the public network. The
virtual connection to the public network
uses Twilio to provide the lines. This does
not support Caller IDs.

• You can enable this setting for phones
where the number is dialed over the public
network (PSDN).

• This setting doesn’t apply when using
a soft phone (VoIP) embedded in the
Chrome browser because there’s no
restriction on what is passed.

6. The following fields provide additional options for how inbound calls are handled when added
to the standard queue for any of the inbound numbers, and whether contact center agents can
dial.
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Field Description

Outbound Call Ring Timeout The number of seconds to allow the outbound
call to ring before disconnecting it.

Note that the initial outbound call will retry the
phone number if the line is busy for the time
period configured here. The number is retried
only when the outbound call is made using
the CE Studio app. The number is not retried
if the outbound call is made using the Agent
Desktop toolbar.

To disable this feature for the contact center,
raise a request in IFS Service Center.

Default: 30 seconds

Disable Manual Dialling By default, agents in Agent Desktop can
dial any numbers using the keypad. Select
this option to restrict agents to selecting
only from the numbers in the Agent Desktop
phonebook.

Enable Ability to Abort Outbound Calls By default, agents cannot disconnect a call
before it reaches the timeout. Select this
option if you want to let agents disconnect
calls earlier.
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Field Description

Answer Call and Play Ringtone Select this option if you want callers to always
hear a ringtone. For example:

• For calls from non-geographic landline
numbers where the call is disconnected
and redialed if it isn’t answered within a
time period.

• When the system answers the call, but you
want the ringtone to play for a while longer
(before the voice menu is played).

This is a UK ringtone.

Important  Calls are charged from the
point you answer the call. Consider the
regulatory impact of this.

Record Patch Through Call By default, only the conversation with the
caller is recorded but select this option to also
record the part of the conversation where the
call is transferred.

Play Comfort Message
Note  Applies to standard queues.

By default, no comfort message is played to
callers waiting in the queue. Select this option
to play a standard message.

You can record a custom message on the
Contact Center > Voice Prompts page.
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Field Description

Allow Caller ID Black/White Listing Whether the contact center unit uses the:
• Blacklist for calls from blocked phone

numbers.
• Whitelist for calls to allow. For example, to

allow calls from local area numbers when
national dialing codes are blocked.

This applies to the phone numbers added to
the Media Management > Voice Blacklist
and Voice Whitelist options.

Note  If you only allow whitelisted
numbers then calls from non-whitelisted
numbers will get an engaged tone.

7. If required, you can set the options for voice mail, such as the Voice Mail PIN.
8. Set up the phone number that customers will see for outbound calls:

Important  You must enter a Caller ID number here. It is not possible to dial out using a
number that is unknown to the system.

Field Description

Default Outbound Caller ID The first inbound number that’s set up in the
system is automatically inserted here.

You can change the number that’s displayed.
For example, you may need to present a
non-geographic number instead of the actual
number. If you change the number to one that
is not one of your inbound numbers then you
will need to request that the number is verified
as belonging to you.

Note  Contact IFS Services to request
verification.
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Field Description

Abandoned Call Workflow Definition,
Abandoned Call Threshold

See the next step for details of this field.

Use Agent Caller ID for Outbound Calls If required, you can assign agents their own
external inbound numbers, as part of their
user account. Select this option if you want
this direct number to be exposed.

9. Specify how you want to handle abandoned calls.

Field Description

Abandoned Call Workflow Definition You can configure the standard call queue for
an inbound number to create a work object
for you. See also Create Work Object if Caller
Rings Off.

You will need to create a work definition for
abandoned calls, and then select it there.

See Configuring call backs.

Abandoned Call Threshold By default, call back requests (also known as
ring back or Auto Redial) are generated for all
abandoned calls regardless of the length of
the call. Use this option to set a minimum call
length.

For example, if you want call back requests to
be generated for calls that end after 5 or more
seconds then set the threshold to 5.

10.Click Save.

Configuring an inbound number
You can configure an inbound number (DDI or DID) on the Media Management > Voice page.
You define the type of number, such as IVR or Customer and whether a queue progression script
is needed.

Steps

1. In the Admin Portal, go to Media Management > Voice.
2. Select the contact center and the contact center unit.
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3. Click New.
4. Select the inbound number prefix and number from the list of numbers for the contact center.
5. Select the inbound number type. For general purposes the type is either Customer or

IVR. Use the other types for special cases, for example, when the number is temporarily
unavailable:

Inbound Number Type Purpose

Busy The number when dialed will return an
engaged tone.

Play Plays a recorded message (once only). To
record the welcome message go to Contact
Center > Voice Prompts.

Customer Puts the call through to an agent if one is
available or places the call on the standard
queue. For details of what is meant by the
standard queue, see Introduction to voice
calls configuration in CE.

IVR Preprocess the call or automate the call
handling depending on the media script. This
may include putting the call through to an
agent if one is available or places the call on
a custom IVR queue. Either the IVR queue
defined for the inbound number or the default
queue.

Queue Progression Script Associates the inbound number with a media
script that you already defined. See How to
configure standalone media scripts for voice.

Retrieval Used for customers (not agents) to retrieve
voice mail.

Office Closed Plays an office closed message. To record
a message go to Contact Center > Voice
Prompts.

Play [Repeat] Plays the recorded message on a loop.

Divert+ Diverts the incoming call to a different
number. Enter the number below in the Divert
Number field.
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6. Specify how this number will be used, and how calls to this number will be handled on the
standard queue. Some of these settings will not apply if you are planning to create a custom
IVR queue.

Field Description

Mailbox Leave this empty.

Inbound Number Name/Ref The friendly name for this inbound number,
for use in reporting.

Quota The maximum number of concurrent calls
to this number. For example, if the tenant
has 100 agent licenses, then set the quota
to 50 to reserve 50 concurrent calls for other
numbers.

Note  Leaving Quota empty sets the
maximum number to 100% of the agent
licenses.

Priority The priority to give to calls on this number
when added to the queue. Priority is a value
in the range 0–10 where:
• 9 is the highest priority
• 5 is the default priority
• 2 is the lowest priority
In the standard queue, for example, calls to
a number with a priority of 5 will go ahead of
calls to a number with the priority of 2.

Divert Number There are two uses for the divert number:
• Where the Inbound Number Type is

Divert+ then this is the number to divert to.
• Where the Inbound Number Type is

Customer then this is the fallback number
as described below. You also need to
select Use Divert Number as Fallback.
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Field Description

Use Divert Number as Fallback Select this option to use the above fallback
number when there's an incoming call to this
number but there isn't a suitably skilled agent
available. Instead of putting the call back on
the queue, divert the call.

Enable Pre Queue Announcement Message
Note  Does not apply to the IVR inbound
number type.

This is an additional in-built message that
can be played to the caller. You can record a
custom message on the Contact Center >
Voice Prompts page.

Use Source Unit Details for Internal Calls When calls are diverted to this inbound
number, or agents transfer the call to this
number, then log the call to the original
contact center unit.

Create Work Object if Caller Rings Off Select this option to automatically create
a standard work object whenever a caller
abandons their call. You require a workflow
definition for this. See Configuring call backs.

See Abandoned Call WD if you require a
custom work object.

Disable auto answer for IVR calls
Note  Applies to the IVR number type.

You should always select this option for
inbound numbers where Inbound Number
Type is set to IVR. It disables the standard
queue processing and passes the call straight
to the IVR queue.
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Field Description

Allow Black/White Listing By default, inbound calls to this number are
not checked against the contact center's
blacklist and/or whitelist.

Select an option to enable checking. For
example choosing Blacklist and Whitelist
allows calls from both blacklisted and
whitelisted numbers. The numbers must be
entered on the Media Management > Voice
Blacklist or Voice Whitelist pages.

Disabled Call Recording When the contact center uses call recording,
then calls to all inbound numbers are
recorded. Use this to exclude this number
from call recording.

Voicemail when Queuing, Voicemail when
Close

See Configuring voicemail.

Disabled See Disabling inbound numbers.

Greeting When an agent accepts a call, they will
immediately hear the caller and see the
CE Studio app for voice calls. This field
provides the agent with a welcome message
to use while reviewing what's shown in Agent
Desktop.

Skillset Select the skillset required to handle calls to
this number. Optional. For details of skills and
skillsets, see Skills and skills-based routing.

7. For inbound numbers that are configured as the IVR number type, then you can configure
where the error logs generated by the running IVR script are sent.
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Field Description

Script Trace Emails, Max Trace Level You can configure the media definition
to send an email with the debugging
information. The trace level sets the event
that triggers email sending. For example,
during development you might want to receive
an email every time the script runs but later
change the script trace level to only send an
email when an error occurs.

You can send the log to one or more email
addresses. Enter the email addresses as a
semi colon-separated list.

Note: The From: email address for script
emails is either the email address given as
the Main Contact Email for the contact center
or, if that is empty, the Support Email for the
contact center. If neither of these are set up,
then it is sent from the system mailbox for the
tenant.

8. Click Save.

For inbound numbers that are configured as the IVR number type, the next step could be
to configure queue progression for all your inbound numbers for the contact center unit (the
default queue progression) or just for this inbound number. See Configuring voice (IVR) queue
progression.

Disabling inbound numbers
Follow these steps to quickly block calls to an inbound number (DDI or DID) while preserving all
existing settings.

Steps

1. In the Admin Portal, go to Media Management > Voice.
2. Locate the inbound number.
3. On the Inbound Number Details pane, set the Disabled field to Yes.
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You could also:
• Change the inbound number type. For details, see Configuring an inbound number.
• Disable all the inbound numbers for a contact center unit. Go to Voice Service > Enable/

Disable Voice.

Configuring voice (IVR) queue progression
For inbound numbers of type IVR, you can script how inbound calls are managed by the IVR
system. You can automate simpler calls and leave agents to handle the more complex calls. For
example, media scripts can verify the identity of the caller, offer a menu, gather data from the
caller, update records in Entity tables, and where necessary route the call to the best skilled agent.
You can also extend the functionality further through custom JavaScript.

For example:

Figure: Example of a voice queue

There are two ways of configuring queue progression. You can:
• Set up a default media script that is used by all the inbound numbers for the contact center unit

that do not have their own script.
• Set up a media script that is used by specific inbound numbers.
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For details, see How to configure media scripts for voice.

How to configure media scripts for voice
There are two ways of configuring a media script for managing the IVR system:
• Set up a default media script that is used by all the inbound numbers for the contact center unit

that do not have their own script.
• Set up a media script that is used by specific inbound numbers.

Set up a default media script

To configure a default media script for all inbound numbers that do not have their own script:
1. In the Admin Portal, go to Media Management > Voice.
2. In the Inbound Number List, select the contact center and contact center unit.
3. Click Default Queue Progression — the media script applies to all inbound numbers for the

contact center unit that do not have their own script.
4. Click New to go to the Media Script Editor.
5. Set up the script by dragging options into the Enter Queue node of the queue. For a call that

will eventually be answered by an agent, you must add the Add to Queue action. For further
details, see:
• Configuring media scripts
• IVR queue progression events
• Voice system variables

6. Make the media script live:
a. Enter a descriptive version name.
b. Click Make Live.

You can also do this later on the Voice Queue Progression Version Detail page.
c. Click Save or Save & Generate. Use Save & Generate when you are ready to go live—this

will check the script for errors and then generate the script.

Set up a script for specific inbound numbers

Start by creating a new script for one or more of your inbound numbers:
1. In the Admin Portal, go to Media Management > Media Queue Progression.
2. Click New.
3. Enter the details of the media script: contact center, contact center unit and name.
4. Click Save.

You can now configure the media script.
5. Select the script from the Media Queue Progression List and then click Queue Progression:
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a. Click New to create the first version of the script.
b. Drag the required options into the Enter Queue node of the Queue Progression pane. For a

call that will eventually be answered by an agent, you must add the Add to Queue option.
For further details, see:
• Configuring media scripts
• IVR queue progression events
• Voice system variables

c. Enter a descriptive name for the script and save it.
6. When you are ready to test the script, make it live:

a. Click Make Live.
b. Click Save & Generate. Use Save & Generate when you are ready to go live—this will

check the script for errors and then generate the script.
7. You now need to associate the media script with the inbound number(s) that will use it:

a. Go to Media Management > Voice.
b. Select the inbound number.
c. In the Queue Progression field, select the script that you want to use.

Editing a media script for inbound numbers

There are two ways of editing the media script for an inbound number - the changes you make will
effect all inbound numbers that use the same media script:

• On the Media Management > Voice page, select the inbound number and then click Queue
Progression. Make your changes.

• On the Media Management > Media Queue Progression page, select the queue progression
script and click Queue Progression.
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IVR queue progression events
The following events can occur during an inbound or outbound voice call. Each event is
represented as a node in the Media Script Editor. You attach actions to the event to control what
happens in response to each event type.

Event type Description

Enter Queue For inbound calls only, add the actions to:
1. Preprocess the call: action to take based on open hours,

prompt caller to choose from an IVR menu, request data
from the caller, and so on.

2. Add the call to queue.
3. Add actions to handle the call while it is held in the queue.

Note: The system will automatically check that the call is still
active.

Call Ended For inbound calls only, occurs when the phone call is ended
by the caller while the call is in the queue. You can add actions
here to create a work object for custom call backs, for example
to request additional information from the caller.

Digit Detected Occurs when the caller presses a number on their keypad at
some unspecified point during the call.

For example, you can give callers the option to press a key
at any point while on hold to request a call back rather than
continue to wait.

Agent Available For inbound calls only, occurs when the agent accepts the call
and before the IVR exits.

Typically, you need the IVR to terminate as quickly as possible
because during this period the agent is waiting to receive
the call. However, you could use this event to perform quick
actions (maybe taking a few milliseconds) such as updating
database records.

Leave Queue For inbound calls only, occurs when the IVR is exiting because
the agent has taken the call or the call is terminated.

You can use this event to perform any final cleanup. For
example, if the script wrote any temporary records about calls
in the queue then you could clear these here. However, you
need the IVR to terminate as quickly as possible.
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Event type Description

Call Failed For outbound calls only, occurs when (for example) the callee
disconnects the call after answering.

Call Ringing For outbound calls only.

Call Answered For outbound calls only, occurs when the callee answers the
call.

Ring Timeout For outbound calls only, occurs when the callee doesn't
answer the call and the ring timeout on the LaunchScript work
action times out.

The Timers and Custom Functions nodes are placeholders for functions that run when timers
expire and custom JavaScript functions.

Voice system variables
You can use the following variables when developing media scripts for inbound voice calls.
Enclose these in % symbols. For example, %sys_DDI%.

System Variable Notes Condition Output

sys_CLI Caller ID

sys_DDI Inbound number (DDI
or DID)

sys_StartDate Format example: Fri
Aug 12 16:27:16 UTC
+0100 2016

sys_DayOfTheWeek Shows the day of the
week as a number 0-6

Mon 1

" " Tue 2

" " Wed 3

" " Thu 4

" " Fri 5

" " Sat 6

" " Sun 0
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System Variable Notes Condition Output

sys_TimeofDay Format example:
16:27:16 UTC+0100

sys_LastQueryResult Applies when the
Search Data Table
action is used

Search returns no
records

NO RECORDS

" " Search returns records RECORDS FOUND

sys_LastInvokeProviderActionResultSee Invoke Provider Action

Configuring call backs
You can configure IFS Customer Engagement to create a call back or ring back request (work
object) when a caller ends the call while waiting in the queue. The work object is created if the
caller stays on the call for the minimum number of seconds and didn't withhold their Caller ID and
has all the information needed by an agent to make the call.

IFS Customer Engagement can automatically generate call backs for you based on the workflow
you define.

You can define:
• Call backs containing one or more of the standard fields (work elements) listed in List of work

element names for standard call backs.
• Or, call backs containing custom fields.

There is a CE Studio template for call backs (IFS CE Callback Template). The template is
configured for a workflow definition that uses the standard element names.

Note  You can download a demo callback workflow definition from the Knowledge Base:
Download call backs example.

For full details, see Configuring custom workflows.

Configuring a contact center unit for call backs
Once you have created a workflow for call backs, you can configure the contact center unit.
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Configuring standard call backs

Note  You don't need to set these options if you are using a media script to create the work
objects.

In the Admin Portal, in Media Management > Advanced Settings there are two options to
configure for the contact center unit. They are:
• Abandoned Call Workflow: the workflow definition that will be used to create the work object

for the call back.
• Abandoned Call Threshold: the threshold in seconds after which work objects will be created.

In Media Management > Voice, for each inbound number that requires call backs, select the
Create Work Object if Caller Rings off option.

Configuring non-standard call backs

For call backs containing non-standard work elements then you need to use the media script to
generate the work object. See Create Work Object.

Testing the call back definition
To test the call back definition:
1. Phone the inbound number.
2. Wait for the configured number of seconds and then hang up once you've reached the

configured threshold as set in the Admin Portal, on the Media Management > Advanced
Settings page for the contact center unit.

3. The work object will be created (after the timer expires if you created a timed event).

In Agent Desktop the work object will be presented. You need a CE Studio app to open the
work object but you don't need one to see the activation appear on the toolbar.

To see the work object in the Admin Portal, go to Workflow Management > Work Objects.

Disabling call backs
The workflow definition is live once you save it, and the contact center is configured to use it.
There are no versions.

If there is an issue with the workflow definition, you can disable it. Disabling it will:

• Prevent work objects being created from the workflow definition
• Remove all work objects from the queue belonging to this workflow definition

To disable a definition, in the Admin Portal, go to the workflow definition and click More > Disable.
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Configuring automated outbound calls
You can configure CE to make automated outbound calls where the call data is determined by a
work definition. Work objects are created from the work definition for each automated call. For an
automated call, you need to record one or more voice prompts.

In summary, these are the steps to configure this type of voice call:

1. In the Admin Portal, configure a work definition that defines the details of the call and the
necessary logic to initiate, process and complete the call. The work definition needs to use the
LaunchScript action, with the Launch parameter set to Media Script. This action will invoke
the queue progression script that makes the actual call.

For details of how to create work definitions, see Configuring custom workflows. An example of
this type of workflow definition is described in Workflows for automated outbound calls.

2. Upload the message(s) required by the script on the Contact Center > Voice Prompts page.

See Play Message for details.
3. Create a media script to handle the call after it is dialed.

For details of how to create this type of media script, see How to configure standalone media
scripts for voice.

4. Assign the media script to one of the inbound numbers:
a. Go to the Media Management > Voice page.
b. From the Inbound Number List on the left, select an inbound number.
c. Enter the details of the selected number. You must select Queue Progression Script from

the Inbound Number Type list.
d. Select the required queue progression script.
e. Save your changes.

5. Configure the creation of work objects from the work definition. There are several ways of
doing this, for example:
• Use a CE Studio app (that you create) to let agents working in Agent Desktop schedule

automated calls.
• Use the Tenant API to create work objects from data in a third-party system.
• Import the calls using the Workflow Management > Import Work Objects page. You save

the call details in a csv file.

How to configure standalone media scripts for voice
You can configure a media script that is independent of the tenant's inbound numbers. You can
then assign the media script to one or more inbound numbers that are configured as type Queue
Progression Script.

1. In the Admin Portal, go to Media Management > Media Queue Progression.
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2. Click New.
3. Select the contact center unit and then enter the name of the script.

You can only create this type of queue progression script for contact center units.
4. Click Queue Progression to open the Media Script Editor.
5. Click New.
6. Set up the media script by dragging options into the EnterQueue node of the queue. For a

call that will eventually be answered by an agent, you must add the Add to Queue action. For
further details, see:
• Configuring media scripts
• IVR queue progression events
• Voice system variables

Note  For details of how to pass this type of call through to an agent, see How to pass an
automated outbound call to an agent.

7. Make the media script live:
a. Enter a descriptive version name.
b. Click Make Live.

You can also do this later on the Media Queue Progression Version page.
c. Click Save or Save & Generate. Use Save & Generate when you are ready to go live—this

will check the script for errors and then generate the script.

How to pass an automated outbound call to an agent
You can configure the media script to pass the recipient of the outbound call to an agent. This
requires a custom function with the JavaScript given below.

The example JavaScript makes an internal call to a skillset (Testing in the example below). If this
is successful then the call to the agent is connected to the automatically-dialled call:

host.SwitchConnect(firstCallDevice, secondCallDevice, SWI_OPT_DUP);

If this is unsuccessful then the call (secondCallDevice) is disconnected:

HangupCall(0,ERR_LIN_RES);

If the SwitchConnect command is successful, the script waits until one of the calls disconnects
and then disconnects the other call.

This is the full example:

var firstCallDevice = host.GetCurrentLineDevice();
var err = host.DialOut('ss:' + 'Testing', sys_CLI, true);
if (err === ERR_GEN_SUC)
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{
   var secondCallDevice = host.GetCurrentLineDevice();
   err = host.SwitchConnect(firstCallDevice, secondCallDevice,
 SWI_OPT_DUP|SWI_OPT_APP);
   if (err != ERR_GEN_SUC)
   {
      host.HangupEx(false, ERR_LIN_RES);
   }
   else
   {
      // Wait for one of the calls to end and then disconnect the
 other
      while (sys_ExitIVR !== 1)
      {
         // Check the first call
         err = host.SetCurrentLineDevice(firstCallDevice);
         err = host.CheckLine();
         if ((err !== ERR_GEN_SUC) && (err !== ERR_LIN_AAO) && (err !
== ERR_LIN_CSO))
         {
            err = host.SetCurrentLineDevice(secondCallDevice);
            host.HangupEx(false, ERR_LIN_HNG);
            break;
         }

         // Check the second call
         err = host.SetCurrentLineDevice(secondCallDevice);
         err = host.CheckLine();
         if ((err !== ERR_GEN_SUC) && (err !== ERR_LIN_AAO) && (err !
== ERR_LIN_CSO))
         {
            err = host.SetCurrentLineDevice(firstCallDevice);
            host.HangupEx(false, ERR_LIN_HNG);
            break;
         }

         //Wait for an event or timeout (ms) to minimize CPU
         host.WaitForEvent(5000);
      }
   }
}

Configuring voicemail
You can configure a contact center unit to let callers leave a voicemail, and then email the
voicemail as an email attachment.

Voicemails are initially reported in the Admin Portal, on the Standard Reports > Unretrieved
Voice Mail page, and then removed from this page once emailed.

CE Admin Portal Guide - Voice configuration | 110



IFS Customer Engagement 25R1 GA

Enabling voicemail

To enable voicemail for the contact center unit:

1. In the Admin Portal, go to the Media Management > Advanced Settings page.
2. In Contact Center Unit Uses Voice Mail, select Yes.
3. Specify where the voicemails are sent in the field Email Address(es) to Email Voice Main

Notification.

You can enter multiple email addresses separated with a semi-colon(;).

Configuring inbound numbers to accept voicemail

To configure the inbound numbers to let callers leave voicemail:

1. In the Admin Portal, go to Media Management > Voice page.
2. Select the inbound number that requires voice mail.
3. In Inbound Number Detail, choose when callers can leave voicemail using the following

options:
• Voicemail when Queuing
• Voicemail when Closed

4. For IVR numbers, edit the media script for the inbound number to include the Record Voicemail
option.

You can upload custom recorded messages to play before and after callers leave voicemails.
You do this on the Contact Center > Voice Prompts page.

Uploading queue and hold music
You can upload custom music to play music while callers are waiting in the queue or on hold.
1. In the Admin Portal, go to the Contact Center > Voice Prompt page.
2. Click New.
3. Set the prompt type to Queue Music.
4. To upload the default queue music, do not select a language.

If you want to use this music as the default hold music then do not select a language. This will
result in the file upload being correctly named HoldMusic.wav.

5. Import the file.

To use the queue music:

• In the voice script, in the Play Message option, select Custom Prompt and then
QueueMusic.wav (Default).

• If you selected a language when setting up the wav file, such as English, then in the script,
select QueueMusic_en-gb.wav.
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Masking phone numbers
By default, the Admin Portal saves the original phone number as part of the call details, and this
could be used to identify the caller or the geographic location from which a call originated. Any
user with access to the standard or custom reports in the Admin Portal can then view those phone
numbers. This applies to both inbound and outbound calls.

Configuring phone number masking

You can mask the phone numbers that are saved, for example change +447888666555 to
+44XXXXXXXXX using a Translate call routing rule. The rule changes the phone number by
applying a mask, and it is the masked phone number that is saved in the call details and shown
in Agent Desktop. It is impossible to retrieve the original number from the masked phone number.
You can configure multiple translate rules.

Note  Do not configure phone number masks for outbound calls when using Twilio as the
provider because Twilio will reject the calls as it does not recognize the masked caller ID.

To configure masking for inbound calls, set up a Translate call routing rule on the Contact Center
> Call Routing Rules page. See Adding a call routing rule for details.

Retrieving the original phone numbers for reporting

You can retrieve the original phone numbers for use in reports by configuring the Translate call
routing rule(s) to save the original phone number in an encrypted format. When configuring the
rule, select the Store Unmasked CLI option.

Note  Where there are multiple translate rules then you need to select this option on the first
translate rule that is applied to the phone number.

Authorizing users to view unmasked phone numbers in reporting

You can restrict who can see the unencrypted phone numbers in both standard and custom
reports. Authorized users will see unencrypted phone numbers and unauthorized users will see
the masked phone numbers in a Restricted Caller Id column. Authorized users will also be able to
schedule custom reports to run that include unmasked phone numbers.

You can authorize a user to view the unmasked phone numbers provided that you have the Studio
Admin role:

1. Go to the User Management > Users page.
2. In the user details, select the option Allow to View Unmasked CLI.
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This means that the user will see unmasked phone numbers in all the standard reports.

Note  Once the system is operational, we recommend that you review who has the Studio
Admin role as anyone with this role can give access to other users to view unmasked phone
numbers.

Generating custom reports to show unmasked phone numbers

There are two ways of running a custom report created in Report Designer:

Previewing a custom report Shows masked or unmasked phone numbers depending on
whether the user is authorized to view unmasked phone numbers.

Scheduled custom report Depends on whether the user who schedules the report:
• Is authorized to view unmasked phone numbers.
• How they choose to run the scheduled report.
If the user is authorized then they can show unmasked phone
numbers in scheduled reports by selecting SELF from the Run As
list. To show masked phone numbers, they leave Run As empty.

If the user is not authorized then unmasked phone numbers are
never shown regardless of how they set Run As.

Text to speech API
For media scripts for voice calls, you can use text to speech as an alternative to pre-recorded
messages. This lets you combine plain text with data. It is suitable for any interactions between
the media script and the caller.

Note  IFS Customer Engagement uses Microsoft Azure Text to Speech. See https://
learn.microsoft.com/en-us/azure/ai-services/speech-service/speech-synthesis-markup.

To configure a media script in the Media Script Editor for text to speech, use the JavaScript option
and call the PlayAddText() function. For example:

host.PlayAddText('Thank you for calling Ventechi today.',
 'config:Female', 0, 0);
host.Play();
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You must supply the text in the language that you want to play. The text can be spoken by voices
in a range of accents but the API cannot translate it to another language.

The PlayAddText() function

Syntax:

host.PlayAddText('<text>', 'config:<voice name>', <flags>, <options>);

Where:

Parameter Description

text Is the text to convert to speech, in the required language. You can use a
combination of plain text and variables.

Note  Alternatively, you can use a SSML-configured string.

voice_name The voice to use for the text to speech. Enter the prefix config:
followed by the name of the audio setting to use as

defined on the Media Management > Audio Settings page. The
language set in the audio setting must match the language of the text in the
text parameter.

Leave it empty if there is only one audio setting.

Note  Not required if using a SSML-configured string.

flags Enter 0.

options The full list of options available to any generated IVR script (as seen in the
debug logs). The most useful options for text to speech are:
• 0 - Play full message
• 1 - Stop playing the message if a DTMF digit detected

Playing text in different languages

To play a text in a different language:
1. In the Admin Portal, add the required language on the Contact Center > Manage Languages

page.
2. On the Media Management > Audio Settings page, select the correct language for the voice.
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3. In the JavaScript option, in the PlayAddText() function, make sure that the text argument is
in the correct language for the voice.

Using SSML markup

Assign the SSML markup to a variable, using the Add Variable option:

<speak version="1.0" xmlns="http://www.w3.org/2001/10/synthesis"
 xmlns:mstts="https://www.w3.org/2001/mstts" xml:lang="en-US">
 <voice name="en-US-GuyNeural">How can I help you <emphasis
 level="moderate">today</emphasis>. </voice></speak>

Then call the PlayAddText() function as shown below, where ssml is a variable containing the
SSML markup:

host.PlayAddText(ssml,"" , 0, 0);
host.Play();
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7
SMS configuration

As standard, you use Twilio as the SMS provider, but you can also use other third-party vendors
(custom providers).

Configuration for Twilio phone numbers

For each Twilio phone number you plan to use to send and receive SMS, you need to configure an
SMS definition. See Creating SMS definitions for details.

Note  The trunk group of the phone number must be configured with Twilio as the SMS
provider. See Configuring trunk groups for SMS for details.

Configuration for other third-party vendors

For all other providers, you need to follow the steps in Configuring SMS providers.

Note  Some example custom SMS providers are included in the release. These are examples
only and you must not use them in a production environment.

Configuring SMS providers
You can use multiple SMS providers to send and receive SMS messages. Twilio is the standard
provider for both voice and SMS.
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Twilio Twilio is already configured as an SMS provider. This is a predefined
provider that all contact centers can use.

Note  To view the Twilio provider, go to the Contact Centers >
SMS Provider page and then deselect the contact center.

The following steps do not apply if you use Twilio as the only SMS
provider.

Other third-party vendors For any other third-party vendors that you use (called custom
providers), you must:
1. Create a custom trunk group.
2. Add the SMS numbers to the custom trunk group.
3. Configure an SMS provider definition.
4. Configure an SMS provider from the definition.

See below for details.

Note  The following steps do not apply if you use Twilio as the only SMS provider.

Step 1 - Create a custom trunk group

For details of how to create a trunk group for a custom SMS provider, see Configuring trunk
groups for SMS.

Step 2 - Add a definition for a custom SMS provider

Note  Some example custom SMS providers are included. These are examples only and you
must not use them in a production environment.

To add a definition for a custom SMS provider:

1. Go to the Contact Center > SMS Provider Definition page.
2. Enter the details for the provider definition:

Field Description

Name Enter a name for the provider definition.
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Field Description

Javascript If required, edit the JavaScript that is used by IFS Customer
Engagement to convert inbound messages from the message
format of the third-party vendor into the CE message format, and
vice versa for outbound messages.

Note  If there is an error in the JavaScript then you will see an
error message when you save the SMS provider created from
this provider definition.

Pull Message Interval The frequency with which the service checks for new messages
(in seconds).

Parameters Click + to add one or more parameters. Use this to define the
parameters required in the script, such as URL, login, password
and so on. You enter the values later when configuring providers
from this definition.

3. Save the SMS provider definition. You can add further SMS provider definitions for third-party
vendors if required.

4. The next step is to configure the actual SMS provider.

Step 3 - Configure a custom SMS provider

Note  Some example custom SMS providers are included. These are examples only and you
must not use them in a production environment.

The next step is to configure an SMS provider. This can be:
• A provider for a third-party vendor using the definition created in step 1.
• An additional Twilio provider, for example, if a contact center requires a different Twilio provider.

You can configure multiple SMS providers from the same provider definition.

As part of this you specify whether the provider is used by all the contact centers, by one contact
center or just by a single contact center unit. You may need to do this if, for example, EU and US-
based offices require different URLs.

To configure the SMS provider:

1. Go to the Contact Center > SMS Provider page.
2. Enter the provider details:
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Field Description

Contact Center To configure:
• The same SMS provider for all contact centers, leave this field

blank.
• A separate SMS provider for each contact center, then select

the contact center from the list.

Contact Center Unit To configure:
• The same SMS provider for all units belonging to the contact

centers, leave this field blank.
• A separate SMS provider for each unit, then select the contact

center unit from the list.

Name Enter an informative name to identify this SMS provider.

Type The provider type:
• Twilio: the default provider for all tenants that use telephony.
• Custom: for other third-party vendors.

Disable Select this option if you do not want to immediately use the SMS
provider.

Note  You can disable this SMS provider at any time by
selecting this option and saving the provider. This will
effectively disable any SMS number that uses this provider.

3. For custom providers enter the following details:

Field Description

Script Trace Emails When the JavaScript in the provider definition executes logs are
collected and any errors captured. To receive a debug email with
this information, enter one or more email addresses, separated
with semi-colons.

Max Trace Level Select the amount of detail required in the debug email.

Alternate Provider Optionally, select an alternative SMS provider. If the SMS provider
fails, then the alternate provider is used to send and receive SMS
messages.

Custom Provider Select the SMS provider definition.
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Field Description

Parameters Enter the required value(s). The parameters depend on the SMS
provider definition selected from the Custom Provider list.

4. Save the new provider.

Step 4 - Assign the SMS provider to the custom trunk group

To assign the SMS provider to a custom trunk group:

1. Go to the Voice Service > Trunk Groups page.
2. Select the custom trunk group.
3. In SMS provider, select the custom SMS provider.
4. Save the custom trunk group.

If you create an additional Twilio provider then you also need to assign the provider to the
appropriate trunk group. See Configuring trunk groups for SMS for details.

Step 5 - Add the SMS numbers to the custom trunk group

You need to add each SMS number that you intend to use for SMS messages to the custom trunk
group:
1. Go to the Contact Center > Custom Trunk Group DDI Ranges page.
2. Enter each SMS number as explained in Adding custom inbound numbers.

Step 6 - Create the SMS definition

After completing the above steps, you are ready to start creating queue progression scripts for
handling SMS messages. See Creating SMS definitions for further details.

Note  You may be a delay before the SMS number appears in the SMS Number list of the
social media definition page.

Configuring trunk groups for SMS
Before you can use phone numbers on a Twilio or custom trunk group for SMS you need to
update the trunk group to use one of your configured SMS providers.

Finding the trunk group for Twilio phone numbers

If you do not know which trunk group a Twilio phone number is on then follow these steps:
1. In the Admin Portal, go to the Voice Service > Inbound Number Ranges page.
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2. Select the phone number that you want to configure for SMS.

The name of the trunk group is shown in the Inbound Number Range Detail pane.

Update the Twilio trunk group with an SMS provider

To update the trunk group with an SMS provider:
1. In the Admin Portal, go to the Voice Service > Trunk Groups page.
2. Select the trunk group.
3. In the trunk group detail area, select the provider from the SMS Provider list.

You can select Twilio as the provider or a custom provider if one is configured.
4. Save the trunk group.

Creating a custom trunk group for SMS

To create a custom trunk group for SMS that is not provided by Twilio:

1. In the Admin Portal, go to the Voice Service > Trunk Groups page.
2. Select the contact center that will use the trunk group.
3. Enter a unique name for the trunk group, such as BulkSMS_EU.
4. Leave the other fields empty.
5. Click Save.

There is a short delay while the custom trunk group is created for you.
6. Update the custom trunk group with an SMS provider as described above.

Creating SMS definitions
You can monitor and respond to SMS messages. This requires a social media definition for
SMS. Once you have a social media (SMS) definition, you can then configure how inbound SMS
messages are handled. You do this by creating a queue progression script.

To create an SMS definition:

1. In the Admin Portal go to Media Management > Social Media.
2. In the Social Media Detail area, select the contact center and the contact center unit.
3. Enter the details of the social media definition:

Field Description

Name The internal name of the SMS definition.
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Field Description

Type Select the SMS type as social media
definitions vary depending on the digital
channel.

Disabled The service will not monitor the account
for new messages when the definition is
disabled. For details, see Disabling a social
media definition.

Description Any notes that you want to enter, for internal
use.

SMS Number Select the SMS number that you want to use
for inbound SMS messages.

Flood protection timeout (in hours) Helps to protect the SMS number from an
SMS flooding attack by setting a timeout
period during which an identical message can
be sent once only.

Webhook URL This is inserted automatically. If it is empty
then the configuration of the trunk group
or SMS provider is incomplete. See
troubleshooting below for details.

CE Admin Portal Guide - SMS configuration | 122



IFS Customer Engagement 25R1 GA

Field Description

Priority Adjustment Priority is determined by the default priority
for the activation type as set for the contact
center unit and, optionally, by the relative
priority set for the media definition. If used,
the relative priority adjusts the default priority
up or down.

Note  To check the default priorities for
the contact center unit, go to Contact
Center Unit > Access to Contact
Center.

If you want to:

• Queue activations according to an
adjusted (relative) priority then select an
option from Lowest to Highest.

• Queue activations using the default priority
that's set for the contact center unit then
select No Change.

The relative priorities are:
• High, Highest: raises the priority by

adding 1 or 2 points respectively to the
default priority.

• Low, Lowest: lowers the priority by
subtracting 1 or 2 points respectively from
the default priority.

Skillset Optionally, select the skillset required by
agents to handle SMS messages.

See Skills and skills-based routing.

Coverage Plan Select the open hours that will apply to the
SMS definition. Out of hours, the service will
not start a session.

The contact center or self-service portal is
always open if you do not select a coverage
plan.
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Field Description

Script Trace Level, Script Email List You can configure the media definition
to send an email with the debugging
information. The trace level sets the event
that triggers email sending. For example,
during development you might want to receive
an email every time the script runs but later
change the script trace level to only send an
email when an error occurs.

You can send the log to one or more email
addresses. Enter the email addresses as a
semi colon-separated list.

Note: The From: email address for script
emails is either the email address given as
the Main Contact Email for the contact center
or, if that is empty, the Support Email for the
contact center. If neither of these are set up,
then it is sent from the system mailbox for the
tenant.

4. Click Save.
5. The next step is to configure a queue progression script to control how the system handles

inbound messages sent to the SMS number. See Configuring media scripts.
6. For contact centers only, on the Contact Center Unit > Access to Contact Center page, you

can set:
• The number of social media messages to hold in memory ready for agents to become

available: the Social Media Queue Quota field. This covers all the social media types
including SMS.

• The default priority of social media messages including SMS – see Setting default activation
priorities.

Troubleshooting SMS definitions using Twilio providers

You may see the following error if the configuration of your Twilio provider is incomplete.

• SMS Provider is not configured to this number: The SMS number is assigned to
a Twilio trunk group but the trunk group does not have an SMS provider associated with it. See
Configuring trunk groups for SMS for details.
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Troubleshooting SMS definitions using custom SMS providers

You may see the following errors if the configuration of your custom SMS provider is incomplete.

• SMS Provider is not configured to this number: The SMS number is assigned to
a custom trunk group but the trunk group is not assigned to an SMS provider. You assign the
trunk group to an SMS provider on the Voice Service > Trunk Groups page.

• Error: System.InvalidOperationException: <function name>: There is an issue
with the JavaScript in the SMS provider definition. See Configuring SMS providers.

Scripting queue progression for SMS
For details of how to configure a script for handling inbound SMS messages, see Scripting queue
progression for social media.

Important  The information in this section applies to fully-featured tenants only.

Legacy SMS configuration
In 6.4 and later, the Media Management > SMS page shows the SMS phone numbers that were
configured in earlier releases. You cannot add or configure SMS phone on this page in 6.4 and
later.
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8
Email configuration

How to configure a contact center unit for email.

Note  The information in this section does not apply to self-service tenants.

In IFS Customer Engagement, new tenants have one system mailbox for sending system emails,
such as automatically-generated reports. If required, you can use this for sending outbound
emails. You can add as many additional email addresses as required.

In the Admin Portal, you need to:
• Add the mailboxes. You configure one mailbox per email address on the Contact Center >

Mailboxes page. These are either shared or customer mailboxes. See Setting up shared
mailboxes for details.

• Configure the email addresses on the Media Management > Email page. A system email
address is preconfigured.

• Configure media scripts for inbound email to be handled through automation or by agents.
• Optional. For end-to-end testing of the email configuration, create a basic CE Studio app

for email or use the IFS CE Email Template. On a new tenant, this template is already
preconfigured as the default app for email.

Setting up shared mailboxes
You begin by adding the mailboxes. Shared mailboxes are tenant-specific mailboxes created on
IFS Cloud.

Steps

1. In the Admin Portal, go to Contact Center >Mailboxes.
2. Click New.
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3. Select the contact center.
4. Enter the following details for each mailbox.

Field Description

Mailbox Type Select:
• Shared if using the default mailbox created for the tenant on

IFS Cloud.

Mailbox Mailbox names are in this format:

username-ce-tenant-number-
environment@ifscloud.onmicrosoft.com

where:
• username is how you want to identify the mailbox, such as

Sales, Support, Accounts. You enter this part of the mailbox
name.

The following is added to it when the mailbox is created.

• ce-tenant-number: the unique number of the tenant.
• environment: the environment hosting the tenant such as prod,

preprod.

Note  You enter the username part of the mailbox name,
such as Sales, Support, Accounts. The rest of the mailbox
name is appended

5. Save the mailbox. It will take a few minutes for shared mailboxes to be created. Once this
completes additional details are filled in for you.

Once the shared mailbox is configured, the IFS Customer Engagement Email service
will automatically create IFS_CE_Processed and IFS_CE_Ignored subfolders under
the corresponding Inbox folder. Once successfully processed, email is moved into the
IFS_CE_Processed folder. Email received and sent to an email address that is not to one of
the configured email addresses is moved to the IFS_CE_Ignored subfolder.

6. Complete the configuration of each mailbox.

Field Description

Process CC Addresses Select this option to send to any email addresses in the CC list.

Disabled See Disabling mailboxes and email addresses.
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Field Description

Auto Responses Limit

Auto Responses Gap
Duration

To mitigate against the effect of a mail bomb attack, you must set
these two fields if you intend to send automatic replies.

For example, if:
• Auto Responses Limit = 1000 (replies)
• Auto Responses Gap Duration = 30 (minutes)

then a reply will not be sent if 1000 replies have already been
sent to either or both of the following:
• The sender's email address
• The configured email address for the mailbox

Outbound SMTP Server

Outbound User Name

Outbound User Password

In some cases, there may be a requirement to use a separate
SMTP server for outbound email. Normally, however, outbound
emails are sent using the same mailbox, in which case, these
fields should be left empty.

7. Click Save.

The next step is to add the email address(es) for this mailbox.

Setting up the email addresses
In this step you configure what inbound emails to process. The emails to be processed will have
email addresses (configured as below) in either the To: or Cc: fields. Each email address must
already be set up. You can check whether this has been done by viewing the mailbox list (in the
Admin Portal, go to Contact Center > Mailboxes).

Steps

1. In the Admin Portal, go to Media Management > Emails.
2. Click New.
3. Select the contact center and contact center unit.
4. From the Email Address list, select the email address.

The email address prefixed System-ce must be configured as the system email address. See
About the system email address for details.

5. Enter the following details.
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Field Description

Priority Priority is determined by the default priority
for the activation type as set for the contact
center unit and, optionally, by the relative
priority set for the media definition. If used,
the relative priority adjusts the default priority
up or down.

Note  To check the default priorities for
the contact center unit, go to Contact
Center Unit > Access to Contact
Center.

If you want to:

• Queue activations according to an
adjusted (relative) priority then select an
option from Lowest to Highest.

• Queue activations using the default priority
that's set for the contact center unit then
select No Change.

The relative priorities are:
• High, Highest: raises the priority by

adding 1 or 2 points respectively to the
default priority.

• Low, Lowest: lowers the priority by
subtracting 1 or 2 points respectively from
the default priority.

Skillset Optionally, select the skillset required by
agents to handle incoming emails to this
email address.

See Skills and skills-based routing.

Disabled See Disabling mailboxes and email
addresses.
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Field Description

Inbound Enabled Whether the email address is for outbound
email only or for both:
• Select the option to use the email address

for both inbound and outbound emails.
• Clear the option to use it for outbound

email only. Inbound emails to this address
are ignored.

Allow HTML Content Preserve the HTML content in emails or just
send and store them as plain text.

6. In most cases, you will need to develop a media script for controlling how email activations are
handled in the queue for an agent:

Field Description

Use Progression This option determines how emails are added
to the queue for an agent.

• When the option is selected: you use a
script to control how email handling is
automated and/or how emails progress in
the queue. How the emails are processed
depends on the queue progression rules
that you configure.

• When the option is deselected: the emails
are added to the queue without any
preprocessing or other processing. If a
media script exists then it will be disabled.
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Field Description

Script Trace Level, Script Email List You can configure the media definition
to send an email with the debugging
information. The trace level sets the event
that triggers email sending. For example,
during development you might want to receive
an email every time the script runs but later
change the script trace level to only send an
email when an error occurs.

You can send the log to one or more email
addresses. Enter the email addresses as a
semi colon-separated list.

Note: The From: email address for script
emails is either the email address given as
the Main Contact Email for the contact center
or, if that is empty, the Support Email for the
contact center. If neither of these are set up,
then it is sent from the system mailbox for the
tenant.

System Email See About the system email address.

The next step for inbound email addresses is to define the media scripts that will be used to
process the emails.

About the system email address
The system email address for the tenant is used to send outbound emails and system emails,
such as automatically-generated reports.

To see the system email address:

1. In the Admin Portal, go to Media Management > Emails.
2. From the Email Address list, select the email address prefixed System-ce.

The System Email option is selected and this indicates the system email address. You cannot
change this.
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Creating media scripts for email

Important  The information in this section applies to fully-featured tenants only.

You use the Media Script Editor to script how inbound emails are handled by IFS Customer
Engagement. A media script can automate email handling or you can use a script to handle the
email while it is in the queue before it is accepted by an agent.

The following figure shows a simple example of queue progression for emails, where an Auto
Response is sent and the email is then added to the queue where it will eventually be presented to
an agent.

Basic queue progression for emails

To configure a media script:
1. In the Admin Portal, go to Media Management > Email.
2. Select the contact center and contact center unit.
3. Do one of the following:

• Click Default Queue Progression — the script will handle all the email addresses for the
contact center unit that do not have their own media script.

• Select an email address and then click Queue Progression — the media script is for the
selected email address only.

4. Click New to open the Media Script Editor.
5. To set up a basic media script. For example:

a. Drag and drop the Auto Reply Email option on the EnterQueue box.
b. Fill out the auto response. You need to send the email from a system email address

configured for the tenant.
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See also Email system variables.
c. To add emails to the queue so that they will be seen by an agent, drag and drop the Add to

Queue option on the EnterQueue panel.

See Configuring media scripts.
6. To test the media script:

a. Enter a version description.
b. Click Make Live.

You can also do this later on the Email Queue Progression page.
c. Click Save & Generate. This will check the media script for errors and then generate the

script.

You can now send a test email. The email will appear as an activation in Agent Desktop. To accept
the activation, see the details of the email and reply to it, you need a CE Studio app. Use the
debug email to troubleshoot any problems with the media script. See Debugging media scripts
and script debug settings.

Use the Email Script Host Debug Info to understand how to fix any issues with your media script.

Queue progression events for emails
There is only one event for emails. You add options to the media script to determine what happens
before the email enters the queue and while it is in the queue.

Queue progression events in the Email Script Editor
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Email event nodes Description

EnterQueue Contains all the actions that will process the email before it is added to
the queue. For example:
• To identify spam and remove it before it gets to the queue.
• To search for specific keywords and change the priority if they are

found or send an automatic response.
• Check whether it is a new conversation.

The last action in this node would be Add to Queue for emails that will
be handled by an agent, or Hangup to remove the email from the queue.

The Timers and Custom Functions nodes are placeholders for functions that run when timers
expire and custom JavaScript functions.

Note  Timers only exist while the email is in the queue and are automatically stopped once the
agent closes the email (which removes it from the queue) or the media script hangs up.

Email system variables

You can use the following variables when developing media scripts for email. Enclose both system
variables and script variables in % symbols. For example, %sys_Subject%.

sys_DayOfTheWeek Numeric for the day of the week from
0-6 where 1 is Monday. For example:
sys_DayOfTheWeek=1

sys_StartDate Format example: Fri Aug 12 16:27:16 UTC
+0100 2016

sys_TimeofDay Time. For example: 13:17:01 GMT+0000
(GMT)

sys_Subject The subject line.

sys_Body The content of the message.

sys_CCList Email addresses in the CC field.

sys_TOList Email address in the To field.

sys_ReplyTo Reply to email address.
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sys_SkillSet The GUID of the skillset set on the email
address.

sys_Priority The relative priority set on the email address:
• 2 highest priority
• 1 high priority
• 0 No change
• -1 low priority
• -2 lowest priority

sys_FromName Sender's name.

sys_FromEmail Sender's email address.

sys_EmailSentDate Sent date. For example:
sys_EmailSentDate=Thu Jan 16 2020

13:16:46 GMT+0000 (GMT)

sys_ReceivedDate Received date.

sys_CurrentEmailAddress The email address receiving the inbound email.

sys_CurrentClientId GUID

sys_EMailID GUID

sys_LastQueryResult Applies when Search Data Table action has
been used:
• When the search returns no records: NO

RECORDS

• When the search returns records: RECORDS
FOUND

sys_LastInvokeProviderActionResult See Invoke Provider Action

Note on system variable arrays

The values returned to system variable arrays will be output to individual variables declared in the
script (where required). The first one is for Search using NLP, and the second one is for Detect
Language.

sys_NlpCatArr = [];

sys_NlpLangArr = [];
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However, it is possible to see the result of the array in a template if this is needed for testing or
development purposes.

The example given is based on Detect Language.

The variable used in the template does not need to be declared in the script. Here, it is called
lang_arr:

lang_arr = %JSON.stringify(sys_NlpLangArr)%

The output will be in the following format:

lang_arr = [{"code":"en","name":"ENGLISH","percentage":0}]

In normal usage, if the script requires Detect Language or Search using NLP, the output will be
split into variables declared in the script.

Disabling mailboxes and email addresses
Follow these steps to quickly disable an email address. The emails are received in the inbox but
are not processed.

Steps

1. In the Admin Portal, go to Media Management > Emails.
2. Select the contact center.
3. Select the email address and then select the Disabled field.

You can also disable an email address by disabling the mailbox.

Note  You can re-enable the email address or mailbox at any time, and processing will restart
for all the emails in the inbox.
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9
Chat configuration

How to configure a contact center unit for chat, and how to use the example chat client.

Important  The information in this section applies to fully-featured tenants only.

In IFS Customer Engagement you can configure chat to:
• Act as a chat bot, engaging the web caller in a conversation
• Find out what the web caller wants using elements such as adaptive cards, choice lists and

custom elements
• Identify the keywords in a message by using regular expressions and natural language

processing
• Access and update data in Entity tables
• Send SMS messages and email, for example to confirm the outcome of the chat
• Escalate the chat to an agent when required
• Translate the strings in the chat window depending on the locale
• Make API calls (web requests) to access data in a third-party system

Each chatbot is defined by a chat definition and an associated media script.

A demo chat client (web site) is available for testing your chat definitions. Use the chat API to
develop your own production-ready chat client.

Enabling chat for the contact center unit
To configure a contact center unit for chat:
1. In the Admin Portal, go to Media Management > Advanced Settings.
2. Select the contact center unit.
3. Select the Enable Chat option.
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4. In Chat Idle Timeout, set the default chat timeout. You can also set this when you configure a
chat definition.

The next step is to configure the chat definition. See Creating chat definitions.

Note  Agents can have handle simultaneous chat sessions. The maximum number of
sessions is set in the agent's profile in User Management > Users.

Creating chat definitions
You configure how chat works for a contact center unit by creating one or more chat definitions
and media scripts:
1. In the Admin Portal go to Media Management > Chat.
2. In the Chat Detail area, select the contact center and the contact center unit.
3. Enter the details of the chat definition:

Field Description

Name The internal name of the chat definition. Use a descriptive
name, such as Tech Support Chat, Sales Chat - Out
of Hours. The name is used by the chat client (web page),
which sends it to the chat service as part of the initial start
chat parameters.

For example, if the URL for your web page is: https://
company.net/sales/chat.html

then for chat, you append the URL with the querystring
parameter ?chatdefinition=name:

https://company.net/sales/chat.html?

chatdefinition=TechSupport

Default Definition Select this to make the chat definition into the default for the
contact center unit. This means that the chat definition will be
used if a specific chat definition is not given when starting a
chat session.

Description Any notes that you want to enter. For internal use.
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Field Description

Priority Priority is determined by the default priority for the activation
type as set for the contact center unit and, optionally, by
the relative priority set for the media definition. If used, the
relative priority adjusts the default priority up or down.

Note  To check the default priorities for the contact center
unit, go to Contact Center Unit > Access to Contact
Center.

If you want to:

• Queue activations according to an adjusted (relative)
priority then select an option from Lowest to Highest.

• Queue activations using the default priority that's set for
the contact center unit then select No Change.

The relative priorities are:
• High, Highest: raises the priority by adding 1 or 2 points

respectively to the default priority.
• Low, Lowest: lowers the priority by subtracting 1 or 2

points respectively from the default priority.

Disconnect Timeout (secs) The session ends if the chat service detects that the
communication with the chat client is lost (such as no internet
connection, browser crash). The timeout is the number of
seconds to wait before terminating the session.

We recommend selecting a timeout value that lets callers
minimize their browser or put the browser tab into the
background. The maximum timeout is 255 seconds.

Idle Timeout (secs) The session ends if it does not receive an event, including key
presses, from the client after the given number of seconds.
This setting applies before the session is added to the queue.

We recommend selecting a timeout value that lets callers
minimize their browser or put the browser tab into the
background. The maximum timeout is 300 seconds.

Skillset Optionally, select the skillset required by agents to handle this
chat definition.

See Skills and skills-based routing.
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Field Description

Ignore DND Select this to queue messages for the best skilled agent even
if their status is Do Not Disturb.

Record Chat Conversation Select this option to save all the messages sent by the client
and agent to the database. For example, for audit and training
purposes.

Record Associated
Application Data

Select this option to save application data (AppData) to the
database.

When initiating a chat, the chat client must send the
application data as part of the initial request. AppData must
contain the caller's initial message and, optionally, any other
data which may be relevant to the processing of the chat
request such as:

• The locale of the application and browser to be used by
the chat window.

• List of web pages, which the caller visited prior to initiating
the chat.

For an example, see the Chat Demo (Using the demo chat
client).

Allow Script to Manage
Session

Select this option to use a media script to:
• Preprocess chat sessions in the queue before they are

presented to the agent.
• Manage the whole chat session.

When this option is deselected, the chat session is put on the
queue in order to be presented to the next available agent
without any prior processing.

Keep Script Active After
Delivery to Agent

Select this option if you want the media script, for example, to
perform actions, such as inspect messages, after the agent
has accepted the chat.
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Field Description

Forward Messages While in
Queue

The caller's first message is added to the queue. This option
determines what happens to subsequent messages sent by
the caller while the first message remains in the queue:
• Select the option to deliver the subsequent messages to

the chat service along with the first message.
• Select this option to ignore any subsequent messages,

until the agent accepts the chat.

Call Quota This sets the maximum number of concurrent chat sessions
that the chat service will handle.

The primary reason to set a quota is to help prevent a denial
of service attack. The quota you set will depend on a number
of factors:

• The expected number of simultaneous chat sessions to be
handled by the contact center unit (including the number of
sessions that will be handled by chatbots).

• Whether you want to allow capacity for a sudden increase
in call rates.

• Whether you have several chat definitions at the same
contact center unit, in which case the quota should be
divided between them.

Note  The maximum number of simultaneous chat
sessions per agent is set in their user profile.

Coverage Plan Select the open hours that will apply to the chat definition. Out
of hours, the chat service will not start a session.

Chatbot name The name that will be displayed in the chat window when
displaying the scripted responses to the web caller. In this
example, the name is CE Bot:

Chatbot Avatar For uploading an image to represent the agent or chatbot.
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Creating media scripts for chat
You use the Media Script Editor to configure how chat is handled once a web caller starts a chat
session. You can configure a media script to handle the entire chat session and, where necessary,
add the chat to the queue to be presented to an agent. Once the chat is accepted by an agent, the
script can continue to monitor the session.

To pass data from the chat session to a CE Studio app, use the Set Script Element option. For
details, see Set Script Element.

The following figure shows the simplest example where the caller receives a message, possibly a
welcome message, and then waits for an agent to become available:

Note  In the chat definition, make sure that the Allow Script to Manage Session field is
selected. Deselecting this field with disable the script. Note also that the chat idle timeout is
set by the chat definition. See Creating chat definitions.

To configure a media script:
1. In the Admin Portal, go to Media Management > Chat.
2. Select the contact center and contact center unit.
3. Do one of the following:

• Click Default Queue Progression — the script will handle all chat definitions for the contact
center unit that do not have their own script.

• Select a chat definition and then click Queue Progression — the script is for the selected
chat definition only.

4. Click New to open the Media Script Editor.
5. To set up a simple script. For example:

a. Drag and drop the Send Text option on the EnterQueue box.
b. Complete the details for the option. You can include data from the initial message by using

system variables.

See Chat system variables.
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c. To add chats to the queue for an agent, drag and drop the Add to Queue option on the
EnterQueue panel.

See Configuring media scripts.
6. To test the media script:

a. Enter a version description.
b. Click Make Live.

You can also do this later on the Chat Queue Progression page.
c. Click Save & Generate. This will check the script for errors and then generate the script.

If you have a chat client for this chat definition, open it in a browser tab and send the start
message. Alternatively, use the Demo Chat client.

The chat will appear as an activation in Agent Desktop. To interact with the chat client, you need
a CE Studio app. You can use the IFS CE Chat Template for this purpose. On a new tenant, this
template is preconfigured as the default app for chat.

Queue progression events for chat
The following events can occur during a chat session. Each event is represented as a node in the
Media Script Editor. You add options to the media script to determine what happens in response to
each event type. Some of these event types are notifications that are sent to the web page.

Queue progression events in the Chat Script Editor
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Chat event nodes What happens when...

Enter Queue A web caller starts a chat session, which is either presented to an
agent or handled by the script. Here are some examples of things
that can happen in this node:
• Initial message and AppData received by the chat service as part

of the event that starts the chat. Chat service (script) may then
act upon the received data. For example, assign a specific skillset
based on the AppData or/and the initial message.

• The information messages sent to the user for which no reply is
expected.

• Script can engage the web caller in a dialog, using simple text
messages, choice lists and custom HTML.

The user's responses are handled with custom functions.

Caller Message How the script handles other messages that the user that might send
at any point during the chat, for example, when the user wants to
cancel the chat and start again. This is only used when there is no
handler (function) running.

Caller Notification Any notification sent from the web page to the chat service (which
may relay it to the agent). For example, that the caller is typing.

Agent Available A notification sent to the web page that an agent is available.

Agent Notification A notification sent to the web page that an agent has joined the chat.

Agent Message Similar to CallerMessage but sent to the web page.

Leave Queue The chat is accepted by an agent.

For example, any data (script element) that is required in Agent
Desktop should be made available.

Chat Ended The chat session is closed by either the user or the agent. Use this
event to perform any actions that need to happen once the chat
session ends.

For example, use Data Insert to save the data stored in the script's
variables or send a closing message.
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Chat event nodes What happens when...

Chat Ending The user or agent clicks to end the chat session but before the chat
session ends, you can perform additional actions, for example, send
a final message.

For surveys, use the Add Survey Candidate option to show a survey
in the chat client or browser tab. The survey responses are part
of the survey responses and also captured as part of the chat
conversation history.

The Timers and Custom Functions nodes are placeholders for functions that run when timers
expire and custom JavaScript functions.

Chat system variables
You can use the following variables when developing media scripts for chat. Enclose both system
variables and script variables in % symbols. For example, %sys_Message%.

System Variable Notes

sys_CallersName As entered by the user when initiating the chat session.

Default: host.GetCallerName()

sys_StartDate Today's date.

Default: new Date()

sys_DayOfTheWeek Current day.

Default: sys_StartDate.getDay()

sys_TimeofDay Current time.

Default: sys_StartDate.toTimeString()

sys_CallID Unique caller or chat ID.

Default: host.GetCallId()

sys_ChatBotName Configured name of the chatbot.

Default: host.GetChatBotName()

sys_Locale Provided that locale was detemined and set, for example, by
the chat client. You can use sys_Locale, for example, to send
a localized version of a response template.

Default: host.GetLocale()
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System Variable Notes

sys_Message The last message as sent by the web caller. By default,
host.GetCallerName()

The very first sys_Message is the Initial Message obtained as:
host.GetScriptElement('INITIALQUESTION').

The format of sys_Message depends on the
sys_MessageType (see below). For type=0 (text), it’s a plain
text, for the rest of the types it is a JSON-formatted string.

Note  Use this system variable to access the AppData.

sys_MessageType The message type as sent by the chat client or chat service.
Message types are integer (strictly speaking, byte) values
from 0–255. Currently defined values are:

0 – A simple text message, the default and the most common
type.

1 – Choice list query, sent to the web caller, which contains
structured data to build a “multiple choice” question for the
web caller.

2 – Caller’s response to the “choice list” query.

3 – Custom HTML query, sent to the web caller, which
contains structured data for building an arbitrary HTML
element. Use this to collect information from the web caller,
or simply to inform or entertain the caller while in the queue
(such as playing a YouTube video).

4 – Caller's response to the custom HTML query.

6 - Caller's response to an adaptive card.

254 – Caller or agent joined the chat.

255 – Caller or agent is typing.

sys_AdaptiveCardResult Selection made in response to an adaptive card.

sys_ChoiceResult Selection made in response to the Send Choice query.
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System Variable Notes

sys_HtmlResult Selection made in response to the Send Custom HTML
action.

sys_EndChatReason Responses to the chat messages that are returned to the web
page embedding the chat client. It's up to the web designer to
handle the codes appropriately:

0, SUCCESS – the message sent successfully. For example,
if received in response to StartChat message, it means “chat
started”.

1, CHAT_CLOSED – in response to an attempt by a caller to
communicate with a session, which this caller has already left.

2, INVALID_PARAMETER – in response to StartChat
message, it means that the parameters required to start a
session, such as a chat defintion, caller name, are wrong or
missing.

3, UNEXPECTED_ERROR – indicates an exception thrown
by the chat service. This should not normally happen. Contact
Support.

4, TIMEOUT – same as 3 except that this is due to a specific
timeout exception.

5, SESSION_ID_ALREADY_ASSIGNED – a request to start
a session that has already started. This should not happen
normally.

6, OUT_OF_MEMORY – for future use.

7, SESSION_NOT_FOUND – wrong session ID passed as a
part of the request.

8, NO_DATA_AVAILABLE – in response to GetChatEvent
request from chat client, it means that nothing happened in
the chat session that needs to be communicated to the chat
client.

9, ACCESS_DENIED – in response to StartChat message, it
means a timing issue when the chat is sent to an agent, but
it’s already has been picked up by a different agent, or left the
queue for some other reason.
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System Variable Notes

10, NO_SUITABLE_OPERATOR_AVAILABLE – no logged-in
agents with the skills matching the chat’s skillset.

11, SERVICE_UNAVAILABLE – no active iMedia servers.
Contact Support.

12, RETRY_ON_PRIMARY_SERVER – when a primary
server is available and the initial StartChat request lands on
a backup server, a normal response, which also contains the
URL of the primary server. Chat client should be designed to
expect this situation and handle it accordingly.

13, WAIT_FOR_OPERATOR – suitable agents are logged in
but are not available to accept this chat call.

14, OFFICES_ARE_CLOSED – sent in response to StartChat
message, if according to the coverage plan configured for the
chat definition, it is currently out of hours.

15, QUOTA_EXCEEDED – sent in response to StartChat
message, if the number of ongoing chat sessions has reached
the maximum configured value for the chat definition (the Call
Quota setting).

16, SCRIPT_FAILED – an error in the script prevented it from
running. Check the script for errors.

17, HANDLED_BY_SCRIPT – the message has not been
relayed to the web caller, but otherwise handled successfully.

18, INVALID_NAME – sent in response to an attempt to join
a session in which a web caller with the same name and the
same IP address already exists.

sys_NlpCatArr See Email system variables

sys_NlpLangArr See Email system variables

sys_LastInvokeProviderActionResultSee Invoke Provider Action
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Using the demo chat client
IFS Customer Engagement provides an example chat client (and web page) if chat is selected as
a service for the tenant. You can use this to test your own chat definitions.You can also download
the example chat client from the Knowledge Base for installation locally.

Note  After installing the chat client, you need to request IFS Support to install the API key.
The API token will be linked to a specific user, typically the Azure User Principal Name of the
tenant's account manager.

Default URL for chat demo client

The default URL for the example chat client is at:

https://{data region FQDN}/tenant_name/ce/chat/main/index.html

On the above URL, chat sessions automatically use the default chat definition if this is configured.
See Creating chat definitions.

If you use the following URL, it will try to access a chat definition called Chat Demo. To use
the example chat client with a differently named chat definition, append the query string: ?
chatdefinition="My Demo" where "My Demo" is the name of your chat definition. For
example:

https://{data region FQDN}/tenant/ce/chat/main/index.html?

chatdefinition="My%20Demo"

Note  By default, the example chat client will return an INVALID_PARAMETER error if the
URL contains a chat definition that does not exist.

Example web page

There is an example web page, index.html, that contains a form for starting a chat and a popup
chat window:
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JavaScript files

Important JavaScript files are located under:

https://{data region FQDN}/tenant_name/ce/chat/main/assets/js/
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chat.js Contains the CE Chat API consisting of a Chat object and its
methods. It acts as a middle layer between the chat client UI and
the chat service.

The methods are wrapper methods. For information on the chat
API, see Chat API.

Do not modify this file when making modifications to this web
page or when creating your own chat client.

chatClient.js Example of JavaScript functionality required to communicate
between chat client web page and chat.js. It shows how to make
functional calls to chat.js and receive event notifications from
there. You can modify it or create your own JavaScript as long as
you preserve the way it interacts with chat.js

index.js Example of “click here to start a chat with our staff” functionality. It
must define AppData, a JSON-formatted, dictionary-like object, of
the following structure:

{
   "InitialQuestion": "an initial question or
 message",
      "name 2": "value 2",
      "name 3": "value 3, etc"
}

"InitialQuestion" is directly put into agent’s chat window as a
first line of the conversation, and is the only mandatory name/value
pair. Others are optional. Some possible examples are:
• ApplicationLocale
• BrowserLocale
• LoggedInUserName
• PagesVisited
• ItemsClicked
• ShoppingBasketItems

The values in the AppData JSON object must be strings.

Other assets

Other assets for the chat client web page are located in folders:
• tenant_name/ce/chat/main/assets/js/css

• tenant_name/ce/chat/main/assets/js/img
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Chat API
IFS CE Chat service combined with the web chat client lets internet users communicate with a
chat bot, which is configured using a media script, or with a contact center agent via a chat web
page, or both. The REST API endpoints are listed below.

Overview

Integration

You can integrate the chat client with your website or any other web application that you expose to
your customers, such as a smart phone app. It is your decision how to implement the chat client,
how to integrate it with a website or web application, and what level of security is required.

Example/demo chat client

IFS Customer Engagement provides a demo chat client. The wrapper methods in the demo chat
client are examples of how to use the API. It is important to note that the demo chat client is not
production ready – for example, if does not cover any security considerations. See Using the
demo chat client for further information.
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The code responsible for interacting with the REST API is in the chat.js file. This file contains the
code, which is totally agnostic of the web UI. The functionality responsible for the interaction with
the UI is separated into the chatClient.js file.

The REST API methods are invoked by calling the appropriate methods in chat.js file.

In addition, a built-in chat client for testing and debugging purposes is included with every chat
service installation, and can be accessed by a user authenticated by logging onto either admin
portal or agent desktop at

https://{data region FQDN}/tenant_name/ce/chat/main/index.html?

chatdefinition={definition name}

Chat service REST API endpoints

Web chat client (chat web page) communicates with the Chat service by accessing REST API
endpoints exposed by the chat service:

Chat service REST API endpoints

Endpoint API method HTTP method Description
Wrapper in

demo chat client

{base uri}/start Start POST Initiate or join a
new chat session

startNewSession()

{base uri}/
getevent

GetEvent POST Receive
immediate events
notifications from
the chat service

GetChatEvent()

{base uri}/
sendmessage

SendMessage POST Send information
from the chat
client to the
server, either to
the agent or the
chat bot (queue
progression
script)

SendChatMessage()

{base uri}/stop Stop POST Terminate the
session from the
client side

requestStop()
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Endpoint API method HTTP method Description
Wrapper in

demo chat client

{base uri}/
translate

Translate POST Get the list
of configured
translations for
chat client labels

Translate()

The base uri takes the form:

https://{host}/{tenant-path}/ce/chat/api/chathub

where:
• host is the fully qualified domain name
• tenant-path is the tenant path label, which you can get from the chat definition displayed in the

Admin Portal.

For HTTP POST requests, parameters, if any, are provided as post data with the content-type:
application/json; charset=utf-8.

These API methods and their properties are discussed in the following sections.

Note  Future extensions may add additional properties to the API methods which should be
ignored by earlier versions of the chat client.

Authorization headers

Each HTTP request sent by the chat client to the chat API must have an Authorization header,
containing a bearer token. For example: "Bearer eyJhbGciOiJIUzUxMi…". The value of
the bearer token is an API key, required for accessing chat API, and is configured for you by IFS
Support. To obtain this, please raise a request in IFS Service Center.

Start method - chat API
Initiate or join a new chat session.

Start request

An example of Start payload:

{
  "SessionID":"6dac45f5-dde7-41a5-a206-fecf03f49e65",
  "CallerName":"John Doe",
  "DefinitionNameOrID":"Sales Support",
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  "AppData":"{\"InitialQuestion\":\"Hello, do you have item #65A9 in
 stock?\",\"ApplicationLocale\":\"en-GB\",\"BrowserLocale\":\"en-US\",
\"OtherInfo\":\"\"}",
  "CallerTimeDelta":-60,
  "Redirected":false
}

Start properties

Request property Description

DefinitionNameOrID Definition name is configured in the Admin Portal and you can copy
it from there. The definition name can be changed at any point but
not the ID (Guid). We recommend using the ID.

SessionID Session ID (Guid) is required to start a new session. If the web caller
starts a new session, then this is a new guid, generated by the client.
Also used if the caller’s browser crashes and the caller rejoins an
existing session from a different browser or device.

If the web caller joins the existing session, that is joins a group chat
(future functionality), then the value will be given to them.

CallerName There must be a caller name or alias, either the one entered by the
caller or, if the caller has already authenticated with the website,
from the customer record. The name provided is displayed to the
agent and will be part of the chat history.

When joining a group chat (future functionality), the name
must be unique. If a web caller, who joins a group chat,
provides a name that is already provided by another web caller,
CHAT_RESULT.INVALID_NAME = 18 is returned. This caller
does not join the session, and the appropriate message should be
displayed, such as the name taken, please choose another.
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Request property Description

AppData AppData is any application-related data. Use this to pass the context
from which chat starts to the chat service. For example, if the caller
is logged in on the website, it may contain the user ID. Or, for an
anonymous user, it may contain browsing history, shopping cart
contents, and so on.

AppData is expected to be a JSON object, such as:

{
    "InitialQuestion": "Can I cancel my order?",
     "name2": "value 2",
     "name3": {
         "prop1": "value 3",
         "prop2": true,
         "prop3": 42
     },
     "name4": [
         { "field1":"one", "field2":"two"},
         { "field1":"three", "field2":"four" }  
     
     ]
  }

We recommend that AppData contains the predefined property
"InitialQuestion". If it exists, it is displayed to the agent.

Other predefined optional properties are:

• "ApplicationLocale" – can be forced by the web page.
• "BrowserLocale" – typically provided by the browser.

ApplicationLocale takes precedence. BrowserLocale is used only if
ApplicationLocale is not given.

Locale is based on ISO-639 Language Codes and on ISO-3166
Country Codes. For example, en-US, en-GB, pt-PT, pt-BR, and so
on.

You can add more properties to AppData if required.

CallerTimeDelta Difference between UTC and local time in minutes, that is,
CallerTimeDelta = UTC – local.

For example, for the UK during British Summer Time, it is #60, for
the US East Coast outside of daylight saving time (winter), it is 300,
etc.
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Request property Description

Redirected A flag (Boolean value) required by the service. True means that
the initial request (with the value false) was redirected to a different
URL.

Start response

An example of a response to the Start request:

{ 
   "result": 0, 
   "participantID": "2e549608-52ba-4f5a-a3da-c972ec1e613b", 
   "redirectTo": null, 
   "participantNames": null 
}

Response properties

Response property Description

Result Enumeration of possible outcomes:

let CHAT_RESULT = {
    SUCCESS: 0,
    CHAT_CLOSED: 1,
    INVALID_PARAMETER: 2,
    UNEXPECTED_ERROR: 3,
    TIMEOUT: 4,
    SESSION_ID_ALREADY_ASSIGNED: 5,
    OUT_OF_MEMORY: 6,
    SESSION_NOT_FOUND: 7,
    NO_DATA_AVAILABLE: 8,
    ACCESS_DENIED: 9,
    NO_SUITABLE_OPERATOR_AVAILABLE: 10,
    SERVICE_UNAVAILABLE: 11,
    RETRY_ON_PRIMARY_SERVER: 12,
    WAIT_FOR_OPERATOR: 13,
    OFFICES_ARE_CLOSED: 14,
    QUOTA_EXCEEDED: 15,
    SCRIPT_FAILED: 16,
    HANDLED_BY_SCRIPT: 17,
    INVALID_NAME: 18,
    REJECTED: 19,
    MAX: 20 // Keep as last entry
};

participantID Participant ID is a Guid assigned to the caller by the chat service.
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Response property Description

redirectTo If not null, it contains a URL of the chat server to which the request is
redirected.

participantNames Contains the names of all the participants of the chat session, if it is
already in progress.

GetEvent method - chat API
Receive immediate events notifications from the chat service.

GetEvent request

GetEvent is an implementation of the long polling technique. It is used by the chat client to
receive the immediate events notifications from the chat service.

Initial GetEvent call occurs following the successful return of the Start method. GetEvent http
request is configured to time out in five seconds if an event is not returned sooner. In the demo
chat client, the timeout of 5 s (5000ms) is configured in GetChatEvent method of chat.js.

Immediately upon either the return of the event, or upon a timeout, the next GetEvent is called.
The exception is when the returned event contains Session Ended information, such as when the
session is terminated by the agent, script or as a result of some other server event, in which case,
no further GetEvent request is made.

It is essential to call GetEvent immediately upon the return or timeout of the previous GetEvent.
Server chat sessions will time out if GetEvent is not invoked for the configured session
disconnect timeout period.

An example of GetEvent payload:

{
  "SessionID":"812431c2-e521-4c22-826f-cbd1238899d8",
  "ParticipantID":"42fc37b5-f629-4c73-a66f-9d5984074812",
  "Timeout":5000,
  "LastEventId":4
}

GetEvent request properties

Request property Description

SessionID Session ID (Guid) of the current session.

ParticipantID Participant ID (Guid) of the caller, returned as a part of the Start
method response.
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Request property Description

Timeout Timeout of the request, ms.

LastEventId The event Id of the last received or sent event. See EventID for
details.

GetEvent response

Some examples of GetEvent response.

Example 1 initial response from the chat bot (HAL 9000):

{ 
   "result": 0,
   "type": 4,
   "eventId": 1,
   "senderName": "HAL 9000",
   "messageType": 0,
   "message": "Hello from Bot",
   "avatarType": "png",
   "avatarB64": "iVBORw0KGgoAAAANSUhEUgAAAJ4AAACeCAYAAADD... " 
}

Note  eventId=1, that is the very first event in the chat history. If a chatbot avatar is
configured, then the very first event would contain avatarType and avatarB64 fields.

Example 2 message from chat bot:

{
   "result": 0,
   "type": 4,
   "eventId": 4,
   "senderName": "HAL 9000",
   "messageType": 0,
   "message": "Please hold on a little, out agent will be with you
 shortly" 
}

Example 3 GetEvent request timed out without getting any event:

{
   "result": 8,
   "type": 0,
   "eventId": 0,
   "senderName": null,
   "messageType": 0,
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   "message": null 
}

Note  eventId=0 and type=0 (ie no event) and result=8 (ie “no data available”, see the
Chat result codes).

Example 4 chat ended by chat bot:

{
   "result": 0,
   "type": 1,
   "eventId": 5,
   "senderName": "HAL 9000",
   "messageType": 0,
   "message": "" 
}

Note  type=1 (Session Ended).

GetEvent response properties

Response property Description

Result Same as CHAT_RESULT for Start method.

Type Integer values for basic server event types:

NONE = 0,

SESSION_ENDED = 1,

PARTICIPANT_JOINED = 2,

PARTICIPANT_LEFT = 3,

INBOUND_MESSAGE = 4, // sent to the receiver of the event

OUTBOUND_MESSAGE = 5 // sent by the receiver of the event
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Response property Description

Message For message type 0, this is a string, containing plain or
HTML-formatted text, which was either generated by a queue
progression script or typed by an agent. For all the other types,
message is a json object, for example:

• CHOICE_LIST: data required to display Choice buttons to
the caller.

• CHOICE_RESULT: data resulted from the caller making the
choice.

If the message is a json object, then the data is interpreted by
the recipient according to the messageType (below).
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Response property Description

messageType A byte value which identifies the message type (as opposed to
the event type called Type above).

Some of the message types are the same for both outbound
and inbound messages. Others are used exclusively in one
direction.

The following chat message types are defined (more can be
added in the future):

let MESSAGE_TYPE = {
    TEXT: 0,
    CHOICE_LIST: 1,
    CHOICE_RESULT: 2,
    CUSTOM_HTML: 3,
    CUSTOM_HTML_RESULT: 4,
    ADAPTIVE_CARD: 5,
    ADAPTIVE_CARD_RESULT: 6,
    JOINED: 254,
    TYPING: 255
};

You can extend the enumeration to allow more message types
for interaction with chat bots only, for example to push a URL to
the web client. Custom message types are not supported in CE
Studio.

Message types with values from 0 to 127 can be recorded as a
part of the chat history.

Message types with values from 128 to 255 are informational
events, which are not recorded as messages. For example,
"Typing" (255) is simply passed in either direction between
chat client and agent.

See Message Types for the message type description.

EventId Unique long integer (or bigint in SQL terms) is the number
of the events either sent by the chat client or received from
the chat service. Event IDs start from 1 and are always
incremented.

senderName Sender’s name, that is the name of the agent, chat bot, or in the
future, other callers participating in the chat session.
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Response property Description

avatarType Image MIME subtype, such as: jpeg, png, gif, or webp.

File extensions jpg, jpeg, jfif, pjpeg, pjp are all handled as the
jpeg subtype.

avatarB64 Base64-encoded image.

unsupported or deprecated
property names

You may see other response property names, not listed here.
They should be ignored by the chat client.

Message types

See also Chat message type schema.

Parameter
Message

originates from Description

TEXT: 0 either server or
client

Text message sent by web caller, agent,
or queue progression script.

CHOICE_LIST: 1 from server JSON object with the data required
to display a list of clickable buttons or
images for the caller to answer simple
choice questions.

CHOICE_RESULT: 2 from client JSON object containing the result of the
caller response to CHOICE_LIST.

CUSTOM_HTML: 3 from server JSON object with the data required to
display an arbitrary HTML form.

CUSTOM_HTML_RESULT: 4 from client JSON object containing the result of the
caller response to CUSTOM_HTML.

ADAPTIVE_CARD: 5 from client JSON object with the data required to
display adaptive cards to the caller.

ADAPTIVE_CARD_RESULT: 6 from server JSON object containing the result of the
caller response to ADAPTIVE_CARD.

JOINED: 254 either server or
client

Reserved for future use.
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Parameter
Message

originates from Description

TYPING: 255 either server or
client

JSON object containing the current length
of the unsent input, for example:

{"count":42}

SendMessage method - chat API
Use the SendMessage method to send information from the chat client (web caller) to the server,
either to the agent or the chat bot (queue progression script).

SendMessage request

An example of the SendMessage request payload:

{
    "SessionID": "4f5eea8e-879d-438a-acdd-f1c3642a1ef0",
    "ParticipantID": "c23c2b7c-5024-4e53-af07-e6e6325389b5",
    "MessageType": 0,
    "Message": "Hello there!" 
}

SendMessage request properties

Property Description

SessionID Same as for GetEvent request.

ParticipantID Same as for GetEvent request.

MessageType Same as for GetEvent response.

Message Either plain text or JSON string, containing either caller's message or
form data being send to the server.

SendMessage response

Example of SendMessage response:

{ 
    "result": 0,
    "eventId": 5 
} 
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SendMessage response properties

Property Description

result Same as for GetEvent response.

eventId Same as for GetEvent response.

Stop method - chat API
Terminates the session from the client side.

Stop request

Example of the Stop request:

{ 
    "SessionID": "e1fa6fe4-7148-4e0f-8ada-f6590bcab28d", 
    "ParticipantID": "d2795058-e51a-47b5-91a8-542727a8587a" 
} 

Stop request properties

Property Description

SessionID Same as for GetEvent request.

ParticipantID Same as for GetEvent request.

Stop response

No data is sent in response, and the result is reflected in the HTTP status code, for example 200
OK.

Translate method - chat API
Gets the list of configured translations for labels used by the chat client.

Note  You can configure message IDs and message translations for use in the chat client. You
can do this in the Admin Portal, on the Studio > Message Store page. Use the Chat_Label
message type.
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Translate request

Get the list of configured translations for chat client labels, defined by the TranslationLabel
Chat_Label.

Example of the Translate request:

{
   " TargetLocaleCode ": " en-GB" 
}

Translate request properties

Property Description

TargetLocaleCode Locale, based on ISO-639 language codes and, optionally, on
ISO-3166 country codes. For example, en, en-US, en-GB, pt-PT,
pt-BR, and so on.

Translate response

Example of Translate response:

{
 "messages": [
    {
       "id": "Chat Closing",
       "localeCode": "en-GB",
       "type": "Chat_Label",
       "text": "Chat Closing"
    },
    {
       "id": "Chat ended",
       "localeCode": "en-GB",
       "type": "Chat_Label",
       "text": "Chat ended"
     } 
   ], 
   "translationError": "" 
} 
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Translate response properties

Property Description

messages An array of available message translations from the Message Store,
and defined by the TranslationLabel Chat_Label. See Properties
of the members of the messages array.

translationError Error, if any.

Properties of the members of the messages array

Property Description

id Message ID

localeCode Locale code, such as en or en-US

type Only the "Chat_Label" type is returned by Chat API

text Translation according to locale, as configured in the Message Store

Chat result codes
This section describes the CHAT_RESULT codes.

CHAT_RESULT Int value Description

SUCCESS 0 Chat request completed without errors. The
intended goal of the request (Start, GetEvent,
SendMessage) is achieved.

CHAT_CLOSED 1 Chat request references chat session which is
already closed.

INVALID_PARAMETER 2 Can be one of the following:

• (Usually) an attempt to use a non-existing or
deleted chat definition

• (Unlikely) caller’s message is sent on behalf
of an agent, in which case activation ID for the
chat participant is not null
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CHAT_RESULT Int value Description

UNEXPECTED_ERROR 3 An unforeseen exception thrown during one of the
following:

• Starting chat
• Running queue progression script
• Sending either agent’s or web caller’s message

to other chat participants
• Closing chat

TIMEOUT 4 System.Timeout exception thrown during one of
the following:

• Starting chat
• Sending either agent’s or web caller’s message

to other chat participants
• Closing chat

SESSION_ID_ALREADY_ASSIGNED5 An attempt to start a chat session with the already
existing Session ID.

OUT_OF_MEMORY 6 Reserved for future use.

SESSION_NOT_FOUND 7 Chat request (GetEvent, SendMessage, Stop)
references a chat session which does not exist.

NO_DATA_AVAILABLE 8 GetEvent method returns
NO_DATA_AVAILABLE if no events were put into
the participant’s event queue.

ACCESS_DENIED 9 Can be one of the following:

• (Common) attempt to start a chat for a disabled
chat definition.

• Attempting to start a chat for a suspended or
terminated contact center unit.

• (For future use) attempt to join a chat not
configured for multiple participants.

NO_SUITABLE_OPERATOR_AVAILABLE10 No appropriately skilled agent is available and no
queue progression script is configured.

SERVICE_UNAVAILABLE 11 Attempt to start a chat when there are no
operational contact centers available.
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CHAT_RESULT Int value Description

RETRY_ON_PRIMARY_SERVER12 Normal redirect response at the beginning of
a chat session. Such response also contains
RedirectTo property containing the actual
redirection URL.

WAIT_FOR_OPERATOR 13 When web caller attempts to send a message
before agent joined the chat and the chat definition
does not allows sending messages while in
queue.

OFFICES_ARE_CLOSED 14 Web caller attempts to send a message outside of
the office hours configured for the chat definition.

QUOTA_EXCEEDED 15 “Call quota”, that is maximum number of
simultaneous chat sessions for this chat definition,
is exceeded.

SCRIPT_FAILED 16 Returned upon a failure to execute a queue
progression script function.

HANDLED_BY_SCRIPT 17 When handling chat events in queue progression
script, it is possible (currently only from custom
JavaScript) to set a custom current event result.
When set to HANDLED_BY_SCRIPT, messages
will not be passed to other chat members, but will
be saved in the chat history.

INVALID_NAME 18 (For future use) in multi-participant chat, a web
caller attempts to join a chat with another web
caller with the same name as another participant.

REJECTED 19 For future use

Chat message type schema
This section describes the JSON schema for the different chat message types:

• Type 1: CHOICE_LIST
• Type 2: CHOICE_RESULT
• Type 3: CUSTOM_HTML
• Type 4: CUSTOM_HTML_RESULT
• Type 5: ADAPTIVE_CARD
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• Type 6: ADAPTIVE_CARD_RESULT

Type 1: CHOICE_LIST
CHOICE_LIST messages are configured as part of a queue progression script.

Example:

{ 
   Name: 'yes or no',
   Prompt: 'Please choose:', 
   AllowOnce: true, 
   DisableFreeInput: true, 
   ChoiceOptions: [
      { 
         Order: 1, 
         Txt: 'yes', 
         Val: '1', 
         BkgSrcB64: null, 
         BkgStyle: '', 
         BkgType: null, 
         TxtStyle: '' 
      }, 
      { 
         Order: 2, 
         Txt: 'no', 
         Val: '2', 
         BkgSrcB64: null, 
         BkgStyle: '', 
         BkgType: null, 
         TxtStyle: '' 
      } 
   ] 
} 

CHOICE_LIST object properties

Property Type Description

Name string Name of the choice

Prompt string Message to be displayed on behalf of the chat
bot, describing the choice that needs to be
made.

AllowOnce boolean Normally, should be false. Defines whether the
buttons stay enabled after the selection is made.
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Property Type Description

DisableFreeInput boolean Normally, should be true. Defines whether the
caller’s text input field is disabled to prevent
them from doing anything else, other than the
selection (choice).

ChoiceOptions array Array of choice options, see below.

Properties of the members of the ChoiceOptions array

Property Type Required
Value if

not given Description

Order number Yes Ordering position
in the row of
buttons

Txt string Yes Button label, such
as “Yes!”

Val string No Empty string Value,
corresponding to
the button, such
as “1”, or “y”, or
“yes”.

BkgSrcB64 string No null Base64-encoded
image for the
button.

BkgType string No null Type of image
format, such
as png, jpeg,
required for
adding a correct
MIME type for
the image, for
example image/
png.
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Property Type Required
Value if

not given Description

BkgStyle string No Empty string Value for the
'style'

attribute of the
<img /> tag for
the button.

TxtStyle string No Empty string Value for the
'style'

attribute of the
<span /> tag
containing the
label for the
button.

Type 2: CHOICE_RESULT
CHOICE_RESULT is sent by the chat client in response to a CHOICE_LIST message.

Example :

{ 
   name: 'yes or no', 
   value: '1', 
   text: 'yes' 
}

CHOICE_RESULT object properties

Property Type Description

name string Name of the choice that was passed to the
chat client in the CHOICE_LIST message.

value string Value assigned to the button in accordance
with the 'Val' property in the CHOICE_LIST
message.

text string Button label created in accordance with
the 'Txt' property in the CHOICE_LIST
message.

CE Admin Portal Guide - Chat configuration | 172



IFS Customer Engagement 25R1 GA

Type 3: CUSTOM_HTML
Using the CUSTOM_HTML message you can configure queue progression to display arbitrary
HTML. This functionality overlaps with the one provided by Adaptive Card message types, and
it is generally recommended to use Adaptive Cards for this purpose, if possible. However, in
many cases, especially, when you don’t need to collect an input, it is more straightforward to use
CUSTOM_HTML.

Note that this HTML is configured in the Admin Portal as a part of queue progression script and
sent from the server to the caller’s browser.

Example 1. Show a video to web callers while they wait in queue

{
    "Name": "youtube forthechallengers",
    "Prompt": "Our friendly staff will be with you shortly. In the
 meantime, <del>drink some wine</del> please, watch the video",
    "AllowOnce": true,
    "DisableFreeInput": true,
    "HTML": "<iframe width=\"320\" height=\"180\" src=\"https://
www.youtube.com/embed/1MeKUwnjmJI?autoplay=1&mute=0\" frameborder=
\"0\" allow=\"autoplay; encrypted-media;\" allowfullscreen></iframe>"
}

This is how the chat message from chat box would look:
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Example 2. Ask a customer to fill in a form

This functionality is also provided by Adaptive Card message types, and although it is generally
recommended to use Adaptive Cards for this purpose, CUSTOM_HTML is still an option.

{
    "Name": "Engineer Visit CustomHTML 01",
    "Prompt": "Please select: ",
    "AllowOnce": false,
    "DisableFreeInput": false,
    "HTML": "<hr/>\nEngineer's visit date: <input type=\"date\" id=
\"newDate\" 
name=\"newDate\" value=\"2022-04-06\"> \nContact  name: <input type=
\"text\" 
id=\"contactName\" name=\"contactName\" value=\"John Doe\"> \nContact
 phone: 
<input type=\"text\" id=\"contactPhone\" name=\"contactPhone\" value=
\"01234567890\"> 
\n<button name=\"btnSubmitDate\" 
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onclick=\"sendButton( MESSAGE_TYPE.CUSTOM_HTML_RESULT, {'value':
 '{date:\\'' + 
$v('newDate') + '\\',name:\\'' + $v('contactName') + '\\',phone:\\''
 + 
$v('contactPhone') +'\\'}', 'innerText':$v('newDate'), 
'name':'btnSubmitDate'}); return false;\">\n Submit new time\n  </
button>\n  <hr/>"
}

Note  The HTML property contains input fields, such as "contactName", and a JavaScript
snippet, which takes advantage of the $v function defined in the chatClient.js file of the
demo chat client.

In this case the chat message from the chat bot would look like:

CUSTOM_HTML object properties

Property Type Description

Name string Name of the custom HTML
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Property Type Description

Prompt string Message to be displayed on behalf of the chat bot,
describing the choice to be made.

AllowOnce boolean Normally, should be false. Defines whether the buttons
stay enabled after the selection is made.

DisableFreeInput boolean Normally, should be true. Defines whether the caller’s
text input field is disabled to prevent them from
doing anything else, other than making the selection
(choice).

HTML string HTML to be displayed to the caller.

If the caller’s input is required, then it needs to contain
a submit button, for example:

<button name="btnSubmitDate"
   onclick = "sendButton(
     
 MESSAGE_TYPE.CUSTOM_HTML_RESULT, 
      { 
         'value':$v('newDate'),  
         'innerText':$v('newDate'),  
         'name':'btnSubmitDate' 
      }); 
      return false;"> Submit new time
 </button>

Type 4: CUSTOM_HTML_RESULT
The message type CUSTOM_HTML_RESULT is sent by the chat client in response to a
CUSTOM_HTML message.

Example:

{ 
   "name": "btnSubmitDate", 
   "value": "{date:'2022-04-06',name:'John
 Doe',phone:'01234567890'}", 
   "text": "2022-04-06\" 
} 
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CUSTOM_HTML_RESULT object properties

Property Type Description

name string Name of the submit button that was passed to the chat client in the
CUSTOM_HTML message.

value string Data, in arbitrary form, collected from the form fields defined in the
CUSTOM_HTML message.

text string Any text that can be, for example, displayed back to the web caller.
It could be based on the data collected from the form fields defined
in the CUSTOM_HTML message.

Type 5: ADAPTIVE_CARD
The ADAPTIVE_CARD message type contains a template and a data payload in order to display
an adaptive card to the caller, as well as display instructions for the chat client (options). This is
configured as part of a queue progression script.

Example of an ADAPTIVE_CARD message:

{
    "template": {
        "type": "AdaptiveCard",
        "body": [
            {
                "type": "TextBlock",
                "text": "Is this your name?",
                "wrap": true
            },
            {
                "type": "FactSet",
                "facts": [
                    {
                        "title": "First name",
                        "value": "${firstname}"
                    },
                    {
                        "title": "Last name",
                        "value": "${lastname}"
                    }
                ],
                "$data": "${contact}"
            },
            {
                "type": "ActionSet",
                "actions": [
                    {
                        "type": "Action.Submit",
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                        "title": "Yes"
                    },
                    {
                        "type": "Action.Submit",
                        "title": "No"
                    }
                ]
            }
        ],
        "$schema": "http://adaptivecards.io/schemas/adaptive-
card.json",
        "version": "1.3"
    },
    "data": {
        "$root": {
            "contact": [
                {
                    "firstname": "John",
                    "lastname": "Doe"
                }
            ]
        }
    },
    "options": {
        "disableFreeInput": true,
        "hideBotDetails": false
    }
}

This is how the chat message from the chat bot would look:

In the above example, the structure of the ADAPTIVE_CARD message can be seen as follows:

{ 
   "template": { ... }, 
   "data": { ... }, 
   "options": { 
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      "disableFreeInput": true, 
      "hideBotDetails": false 
   } 
} 

The first two properties ("template" and "data") are required in order to implement Adaptive
Card Templating scenario of “separating the template from the data” (See Option B here). The
"template" and "data" thus adhere to Microsoft Adaptive Cards specification.

The "options" property is to control chat web client behavior.

ADAPTIVE_CARD object properties

Property Type Description

template string Name of the custom HTML

data string Message to be displayed on behalf of the chat
bot, describing the choice to be made.

Options.DisableFreeInput boolean Normally, true. Defines, whether the caller’s
text input field is disabled to prevent them
from doing anything else, other than making
the selection.

Options.hideBotDetails boolean Normally, false. Defines whether to display the
chat avatar and name. Sometimes, you may
want to hide them for a cleaner UI.

Type 6: ADAPTIVE_CARD_RESULT
An ADAPTIVE_CARD_RESULT message is sent by the chat client in response to an
ADAPTIVE_CARD message. It contains action(s) which are submitted to the server. The action,
responsible, for submitting data, has a type "Action.Submit". Example:

{ 
   "type": "Action.Submit", 
   "title": "Yes" 
} 

ADAPTIVE_CARD_RESULT object properties

Property Type Required Description

type string Yes Has value
"Action.Submit"
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Property Type Required Description

title string Yes Action title, that is a
label for the submit
button. In situations,
such as the example
above, this may be all
the data that you need
to collect.

Data object No Form data from input
fields of the card.

Disabling a chat definition
You can disable a chat definition, which will disable the chat service for this chat definition:

1. In the Admin Portal go to Media Management > Chat.
2. In the Chat Detail area, select the contact center and the contact center unit.
3. Select the chat definition.
4. Select the Disabled checkbox.

Note  Attempts to start a chat will result in a CHAT_RESULT code (ACCESS_DENIED) being
sent back to the web page. It is up to the web designer to handle this appropriately in their
chat client.
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WhatsApp, Twitter and Facebook.

Important  The information in this section applies to fully-featured tenants only.

You can monitor and respond to social media messages, whether Twitter, Facebook, WhatsApp or
SMS. This requires a social media definition for each social media type. Once you have a social
media definition, you can then configure how the messages are handled by the system by creating
a queue progression script.

Note  Using SMS requires an SMS provider. For further details, see SMS configuration.

Facebook and Twitter
A contact center can monitor and respond to both Twitter and Facebook social media messages.
This requires a social media definition for each service. You create this in the Admin Portal.

Configuring the Twitter or Facebook account

You require a fully configured Twitter or Facebook account before you can create any social media
definitions.

For Facebook, you must complete the app review process for the account. For details, see https://
developers.facebook.com/docs/app-review. Full approval is needed, for example, if you need to
respond to direct messages.

In the Twitter or Facebook account, you need to set the callback URL for your tenant. For
example, if your tenant is:

https://<environment>/<tenant-name> then the callback URL will be:
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https://<environment>/<tenant-name>/ce/admin/api/ce/UpdateTwitterToken

You need to be aware of the rate limit set on your Twitter or Facebook account. This limits the
number of API requests that can be made to the account.

Important  Exceeding the rate limit for the account may temporarily lock the account.

Configuring CE access to the Twitter or Facebook account

You configure how social media works for a contact center unit by creating one or more social
media definitions and queue progression scripts:
1. Before you can do this, and depending on the target, you need to get the Facebook application

id and secret, or Twitter key and secret. You will need these when you set up the definition.
2. In the Admin Portal go to Media Management > Social Media.
3. In the Social Media Detail area, select the contact center and the contact center unit.
4. Enter the details of the social media definition. The configuration details for Facebook and

Twitter are slightly different:
• Configuring definitions for Twitter and Twitter DM
• Configuring definitions for Facebook and Facebook DM

Important  When setting the Poll Interval, you need to be aware of the rate limit set on
your Twitter or Facebook. This limits the number of API requests that can be made to the
account - exceeding the rate limit may temporarily lock the account.

5. You need to authorize the social media definition for use with a specific Facebook or Twitter
account using the credentials you entered in the social media definition. This is a once only
step unless there are security reasons for obtaining a new key. You do not need to reauthorize
the definition when you make changes to the definition.
a. Click the Authorize button.

You go to the Facebook or Twitter account. Sign in if necessary.
b. The outcome of the request is reported.

If successful, this saves the access token and secret that will be required by the service to
access the Twitter or Facebook account.

c. Once you have successfully authorized the definition, the service will immediately start
querying Twitter or Facebook provided the definition is not disabled.

d. When testing the definition, you can click Reset Poll so that the service immediately queries
the account rather than waiting for the polling interval to expire. Note that the table shows
the number of social media messages added to the queue and not the total number of
messages.
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6. On the Contact Center Unit > Access to Contact Center page, you can set:
• The number of social media messages to hold in memory ready for agents to become

available: the Social Media Queue Quota field
• The priority of social media messages – see Setting default activation priorities.

Configuring definitions for Facebook and Facebook DM
This describes the information needed for either Facebook or Facebook Direct Message social
media definitions. See Facebook and Twitter for background information on creating new
definitions.

Field Description

Name The internal name of the social media
definition.

Type Select the type as social media definitions vary
depending on the target application or account.

Disabled The service will not monitor the account for new
messages when the definition is disabled. For
details, see Disabling a social media definition.

Description Any notes that you want to enter, for internal
use.

Use Default Multi-Tenant App Do not select this.
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Field Description

App ID, App Secret You need to give Customer Engagement
access to read and process messages in
your Facebook account. To do this enter the
application ID and secret for the Facebook
account.

Important  CE uses page access tokens
and these expire in about 60 days.
Please refer to the Facebook developer
documentation for further details.

Important  Your Facebook account limits
the number of API requests that can be
made within a 24-hour period so you may
require separate credentials for each social
media definition.

Max Message Age (Days) Only messages that are less than the Max
Message Age number of days are monitored.

Poll Interval (Seconds) The interval at which the service checks for
new messages.

Important  Your Facebook account limits
the number of API requests that can be
made within a 24-hour period so it is
important to select a poll interval that does
not exceed this limit. Please refer to the
Facebook developer documentation for
further details.
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Field Description

Call Quota The number of messages to download and hold
in the queue. Once you reach the call quota,
monitoring stops until the number in the queue
falls below the quota. For example, if the quota
is 100 then monitoring stops when there are
100 messages in the queue. The purpose of
this is to prevent too many downloads in the
event of something going viral.

Note  This is different to the Social Media
Quota set on the Contact Center Unit >
Access to Contact Center page which
determines how many messages from the
queue are held in memory ready to be
presented to the next available agent.
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Field Description

Priority Adjustment Priority is determined by the default priority for
the activation type as set for the contact center
unit and, optionally, by the relative priority set
for the media definition. If used, the relative
priority adjusts the default priority up or down.

Note  To check the default priorities for the
contact center unit, go to Contact Center
Unit > Access to Contact Center.

If you want to:

• Queue activations according to an adjusted
(relative) priority then select an option from
Lowest to Highest.

• Queue activations using the default priority
that's set for the contact center unit then
select No Change.

The relative priorities are:
• High, Highest: raises the priority by adding

1 or 2 points respectively to the default
priority.

• Low, Lowest: lowers the priority by
subtracting 1 or 2 points respectively from
the default priority.

Skillset Optionally, select the skillset required by agents
to handle social media messages.

See Skills and skills-based routing.

Coverage Plan Select the open hours that will apply to the
social media definition. Out of hours, the
service will not start a session.

The contact center is always open if you do not
set a coverage plan.
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Field Description

Script Trace Level, Script Email List You can configure the media definition to send
an email with the debugging information. The
trace level sets the event that triggers email
sending. For example, during development
you might want to receive an email every time
the script runs but later change the script trace
level to only send an email when an error
occurs.

You can send the log to one or more email
addresses. Enter the email addresses as a
semi colon-separated list.

Note: The From: email address for script emails
is either the email address given as the Main
Contact Email for the contact center or, if that is
empty, the Support Email for the contact center.
If neither of these are set up, then it is sent
from the system mailbox for the tenant.

Monitor Only Tagged Posts Facebook only.
• Deselect this option if you want the service

to only monitor posts on the page configured
for the Facebook account. (Default)

• Select this option if you want the service
to collect messages from anywhere in
Facebook where your Facebook account is
tagged (using the @ character).

Configuring definitions for Twitter and Twitter DM
This page describes the configuration options specific to Twitter and Twitter Direct Messages. For
details of priority, skillset, coverage plan, script trace level and script email list, see Facebook and
Twitter.

Field Description

Name The internal name of the social media
definition.

Type Select the type as social media definitions vary
depending on the target application or account.
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Field Description

Search Query Twitter only.

For Twitter, you must enter a search query. For
details of the query format, see this reference
page https://developer.twitter.com/en/docs/
twitter-api/tweets/search/integrate/build-a-
query:

All tweets for the Twitter account are found if
the search query is empty.

Disabled The service will not monitor the account for new
messages when the definition is disabled. For
details, see Disabling a social media definition.

Use Default Multi-Tenant App

App ID, App Secret

You need to give Customer Engagement
access to read and process messages in
your Twitter account. Twitter access tokens
do not expire. See the Twitter developer
documentation for details.

Important  Your Twitter account limits the
number of API requests that can be made
within a 24-hour period so you may require
separate credentials for each social media
definition.

You can either use the standard CE identity for
authentication or define your own.

• To use the standard identity, select Use
Default Multi-Tenant App. This option is
only available if your tenant is configured to
use this.

• To use your own credentials, enter the
Twitter key and secret for the Twitter
account.

Max Message Age (Days) Only messages that are less than the Max
Message Age number of days are queried.
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Field Description

Poll Interval (Seconds) The interval at which the service checks for
new messages.

Important  Your Twitter account limits
the number of API requests that can be
made within a 15-minute period so it is
important to select a poll interval that does
not exceed this limit. Please refer to the
Twitter developer documentation for further
details.

Call Quota The number of messages to download and hold
in the queue. Once you reach the call quota,
monitoring stops until the number in the queue
falls below the quota. For example, if the quota
is 100 then monitoring stops when there are
100 messages in the queue. The purpose of
this is to prevent too many downloads in the
event of something going viral.

Note  This is different to the Social Media
Quota set on the Contact Center Unit >
Access to Contact Center page which
determines how many messages from the
queue are held in memory ready to be
presented to the next available agent.
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Field Description

Disable Soft Start This feature optimizes calls to the Twitter API,
which is a paid for service with an allowed rate
limit. Exceeding the rate limit may temporarily
disable the Twitter API linked to your Twitter
account.
• When you enable the definition and the

option is deselected (the default), the
service starts by collecting the most recent
messages first, and then over a number of
days works back to the full time range. For
example, it takes the messages posted in
the last few hours rather than the last few
days.

• If Disable Soft Start is selected, then the
service will instruct twitter API to collect all
the messages between the time of the last
message and now, which may exceed the
allowed rate limit.
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Field Description

Disable Auto Download of Linked Tweets Twitter only.

By default, both replies and tweets linked from
the original tweet or reply are automatically
downloaded to CE. This gives agents the
context they may need to respond a tweet.
Replies are always downloaded but you can
decide whether you need the linked tweets.

• For replies, the linked tweet is the tweet to
which you are replying.

• For quotes, the linked tweet is the tweet you
are quoting.

• For retweets, the linked tweet is the original
tweet.

When:
• Disable auto download of linked tweets

is seselected (the default), both replies
and retweets of the original tweet are
downloaded. Use the option Enable
automatic queuing of additional/linked
tweets to decide how to handle them in CE.

• When Disable auto download of linked
tweets is selected, only replies are
downloaded.

Enable Auto Queuing of Additional/Linked
Tweets

Twitter only.

This option only applies when linked tweets are
being downloaded (Disable auto download of
linked tweets is deselected).

By default, tweets linked from the original tweet
are not added to the queue but are saved as
part of its history. They are therefore available
as part of the conversation but don't need to be
handled by the agent.

Select this option if you want each linked tweet
to be added to the queue.
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Field Description

Save Raw Message Details in MSG_JSON App
Data Element

Twitter only.

You can save additional information from the
tweet to the database for use in CE Studio.
The data is exposed through the Social Media
provider.

Disable queueing of retweets Twitter only.

By default, retweets of the original tweet are
added to the queue and will therefore require
processing either by an agent or automatically.

Select this option if you don't want retweets to
be added to the queue.

WhatsApp
You can use WhatsApp as one of your social media channels. This requires:

• A Facebook Business account.
• You to complete a client agreement form.
• Approval from Twilio and WhatsApp.

Please request IFS Support to start the WhatsApp enablement process on your behalf as Twilio
has recently changed the approval process, and it is not currently possible to do this through the
Admin Portal.

Create a social media definition for WhatsApp
In this step, you need to create a social media definition for WhatsApp, selecting the Twilio phone
number to use. When you save the definition, you automatically start the process for Twilio and
WhatsApp to approve the phone number as a WhatsApp enabled sender.

Note  The details are sent to IFS Services who will submit the request with Twilio on your
behalf.

To create a social media definition for WhatsApp:

1. In the Admin Portal, go to Media Management > Social Media.
2. Click New.
3. Enter the following details.
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Field Description

Name A descriptive name identifying the purpose of
the social media definition.

Contact Center The contact center that will handle WhatsApp
messages.

Contact Center Unit The organizational unit within the contact
center that is responsible for WhatsApp.

Type Select WhatsApp.

Disabled Select this later if you need to disable this
social media definition.

Description Any additional information that you want to
save with the social media definition. This is
for internal use only.

Display Name The name that will be displayed in the
WhatsApp profile description. For detailed
information on the WhatsApp profile, see the
Twilio guide here: https://www.twilio.com/
docs/whatsapp/tutorial/connect-number-
business-profile.

WhatsApp Number Select the phone number to use for
WhatsApp messages.

Priority Adjustment Select No Change if you are not ready to
configure this or you want to use the default
priority.

For here for details of what priority
adjustment.

Skillset Optionally, select the skillset required by
agents to handle WhatsApp messages.

See Skills and skills-based routing.
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Field Description

Coverage Plan Select the open hours that will apply to the
social media definition. Out of hours, the
service will not start a session.

The contact center is always open if you do
not set a coverage plan.

Script Trace Level, Script Email List You can configure the media definition
to send an email with the debugging
information. The trace level sets the event
that triggers email sending. For example,
during development you might want to receive
an email every time the script runs but later
change the script trace level to only send an
email when an error occurs.

You can send the log to one or more email
addresses. Enter the email addresses as a
semi colon-separated list.

Note: The From: email address for script
emails is either the email address given as
the Main Contact Email for the contact center
or, if that is empty, the Support Email for the
contact center. If neither of these are set up,
then it is sent from the system mailbox for the
tenant.

4. Click Save. This saves the social media definition.

Note  Ignore the Authorize button. This does not apply to WhatsApp social media
definitions.

This sends the details to IFS Services who will request Twilio and WhatsApp to approve the
phone number as a WhatsApp enabled sender on your behalf.

5. You will receive a notification in your Facebook Business Manager account from Twilio. You
need to approve Twilio to message on your behalf in Facebook Business Manager.

6. Twilio will also ask you to verify your Facebook Business Manager account. To do this, go to
your Facebook Business Manager account and submit a business verification. See Facebook’s
help article for details of this step.
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Configure and get approval for WhatsApp templates
WhatsApp templates enable you to send unsolicited messages to WhatsApp users. Each template
and language variant of the template must be approved by Meta. The Media Management >
WhatsApp Content Template page automates the approval process for you. You can only use
approved templates in WhatsApp queue progression scripts (in the WhatsApp Template Reply
option).

Note  You can add as many templates as you need but you can't edit them (this is a Twilio
restriction).

Note  To understand Facebook's approval process and common reasons for rejection, see
https://developers.facebook.com/docs/whatsapp/message-templates/guidelines/.

To add a WhatsApp template:

1. In the Admin Portal, go to the Media Management > WhatsApp Content Template page.
2. Enter the template name. This must be lowercase, without any spaces or special characters

apart from underscores.
3. Select a category.
4. Select a language and then enter the message body.

The body can contain placeholders that are substituted when the media script runs.

Use double curly braces to indicate where you plan to use dynamic content. For example,
to send "Your login code for Twilio is 1234", the template would be: "Your login code for
{{1}} is {{2}}." Then, when you use the template in a queue progression script, you map the
placeholders with variables that will supply the data at runtime.

5. Click Add Translation to add another language variant.

You can add multiple languages to the same template. Each language variant is approved
separately.

6. Click Save. This automatically submits the template to Facebook for approval.

After saving, the template is at Pending status. This will update to Approved status once
Facebook has reviewed the template.

Whatsapp content templates with parameters:

You can now create a Whatsapp content template with parameters directly through the Admin
Portal.To increase the likelihood of WhatsApp approving the template, we recommend including
sample data for all parameters in the template.If the template is rejected, the admin portal will
display the reason WhatsApp provided for the rejection.
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Note
• The approval or rejection of templates is determined by Whatsapp based on their

guidelines.
• See: https://developers.facebook.com/docs/whatsapp/message-templates/guidelines/

Disabling a social media definition
You can stop monitoring of social media accounts by disabling the social media definition for the
account. This will also stop the presentation to the agent of any existing messages that are in the
queue at the time the definition is disabled.

Note  You cannot reset the polling interval for disabled Facebook and Twitter definitions.

To start monitoring again, you can enable the definition. New messages are added to the queue
again and any old messages in the queue will go to the agents.

Note  For Facebook and Twitter definitions, only messages less than the configured maximum
age are added to the queue.

To disable a social media definition:

1. In the Admin Portal go to Media Management > Social Media.
2. Select the definition from the Social Media List.
3. On the right, select the Disabled check box to stop monitoring.
4. Click Save to disable the definition.

To restart monitoring, clear the Disabled check box again and save the definition.

Scripting queue progression for social media
You use the Media Script Editor to script how inbound social media messages are handled by CE.
A media script can automate message handling or you can use a media script to preprocess the
message in some way before it is passed to an agent.

In WhatsApp and SMS, for example, all inbound messages from the same sender are treated as
the same conversation, regardless of the interval between sending. Data for use by the script is
stored in script elements and automatically saved as part of the conversation.

Typically, you need to use the following options when scripting queue progression for social media:
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Option Description

Is New Conversation Use the Is New Conversation option to check whether an
incoming message is part of an existing conversation or a new
one. For SMS and WhatsApp this is determined by the sender's
number.

See Is New Conversation.

Set Script Element Use the Set Script Element option to save the data obtained from
the current social media message. You can then refer to the data
when handling a later message in the same conversation.

See Set Script Element.

See Configuring media scripts.

System variables for social media messages
You can use the following variables when developing media scripts for handling any type of
inbound social media message. Enclose both system variables and script variables in % symbols.
For example, %sys_MessageText%.

System Variable Description

sys_MessageText Body of the social media message.

sys_MessageType The type of social media message:

• Facebook = 0
• FacebookDM = 1
• Twitter = 2
• TwitterDM = 3
• WhatsApp = 4
• SMS = 5

sys_SenderId Sender's id:

• The from number for SMS or WhatsApp
messages

• For Facebook, it's the userid provided by the
FaceBook API (such as 12345678901234).
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System Variable Description

sys_SenderName Sender's name:

• The from Number without the prefix for
WhatsApp message (such as whatsapp:
+123456789012)

• The from Number for SMS
• For Facebook, it's the name (such as John

Doe)

sys_RequestID Activation ID once an activation is created for
the message.

sys_DefinitionName Name of the social media definition.

sys_StartDate Today's date.

Default: new Date()

sys_DayOfTheWeek Current day.

Default: sys_StartDate.getDay()

sys_TimeofDay Current time.

Default: sys_StartDate.toTimeString()

sys_NlpCatArr See Email system variables

sys_NlpLangArr See Email system variables

sys_LastInvokeProviderActionResult See Invoke Provider Action

sys_MessageExternalId ID of the inbound message.

sys_MessageID ID of the queued message.

sys_ClientID ID of the contact center unit set in the social
media definition.

CE Admin Portal Guide - Social media configuration | 198



11
Configuring media scripts

How to use the Media Script Editor.

Important  The information in this section applies to fully-featured tenants only.

You use the Media Script Editor, part of the Admin Portal, to configure queue progression for each
communication channel, based on the actions needed for that channel and the required level of
automation.

For voice calls, the script will control the IVR system. For emails, you might need to identify the
content of the email:
• Identify spam and remove the email.
• Identify keywords to determine the next action.
• Identify the language and then change the skillset needed to handle the email.

To save any data collected by the script for use later, for example in a CE Studio app, you can use
script elements or custom entities.

You can configure:
• Default scripts to be used if there is no more specific script for an inbound number, email

address or chat/social media definition belonging to the contact center unit.
• Custom scripts that are specific to an inbound number, email address or chat/social media

definition. However, you can share scripts by exporting and importing.

A JavaScript file is generated from your script. We recommend that you have some knowledge of
JavaScript when developing and troubleshooting queue progression.

To open the Media Script Editor, go to:
• Media Management > Voice
• Media Management > Emails
• Media Management > Chat
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• Media Management > Social Media (includes SMS)

Creating a media script for queue progression

Note  If an error occurs in the running media script, for example, a caller enters something
that the script is not configured to handle then the script ends and the caller is immediately
added to the queue for an agent without any further preprocessing by the script.

To create a new media script:
1. In the Admin Portal, go to Media Management and select the media type. For example, Chat.
2. Do one of the following:

• Click the Default Queue Progression button. For example, for chat the script will be used
by any chat definition for the contact center unit that does not have its own script.

• Select a definition from the list, for example a chat definition, and then click the Queue
Progression button. The script you develop is for this definition only.

3. Click New to start a new media script.

In the editor, script options are on the left. An outline script with nodes for the standard events
is on the right. This is where you will drag and drop the options required by the script.

4. Drag an option, such as Add Variable, and drop it onto the EnterQueue node. This adds it as
the first option for that event. Any further options are added to the end.

5. Enter a description to help others understand what each step in the script does.
6. Complete the option’s details. See Media script options for details.
7. Add other options as required.

You can change the order in which the options will run by dragging and dropping the options
onto the EnterQueue node.

8. You must finish the script with one of the following options:
• Add to Queue
• Disconnect Call
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• Hangup
• Remove Call from Queue
• Play Message

This ensures that the script ends correctly rather than timing out. For example, for voice
calls when the script times out, the caller will hear a Twilio error message An application
error has occurred.

9. When you have finished:
a. Enter a name for the version and then click Save.

If the version exists already and you don't want to overwrite it, select Save As New
Version.

b. When you have added all the options and you are ready to test the script, click Save &
Generate. This validates the script and generates it as a JavaScript file.

Note  If the button is unavailable then check the mandatory settings in each option in
the script. You cannot generate a script if any mandatory settings are missing.

10.If the script is ready to run, and you have generated it:
a. Go to the Queue Progression Version page for the media type. For example, for voice calls

go to Media Management > Voice, select the inbound number and then click either Default
Queue Progression or Queue Progression.

b. Select the version and then click Make Live. Once you make a version live, you can't delete
it—you need to make another version live first.

11.Test the live script by phoning the number or starting a chat session. When you hang up the
call or end the chat session then a debug email is sent to the email addresses in the Script
Trace Emails field for the inbound number, email address, chat definition. Use the information
in the email to fix any problems with the script. See Debugging media scripts and script debug
settings for details.

Media script options and events

Some events are standard to every media script. For example, the EnterQueue event. Options
added to the EnterQueue node define what happens to an inbound call, email or chat. Options
must be added here for any queue progression to occur that requires agent intervention.

Other events are optional. For example, Timer events. If you require a delay, add it to Timers node
along with the actions that should take place once a Start Timer has expired. The Start Timer
option is set in the EnterQueue event.

Custom Function events are optional. You can call them from other points in the script.

For more details, see:
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• IVR queue progression events
• Queue progression events for emails
• Queue progression events for chat

Managing media scripts

On the Queue Progression Version page for the media type, click the required version of the
media script.

Note  For example, for voice calls go to Media Management > Voice, select the inbound
number and then click either Default Queue Progression or Queue Progression.

Deleting a media script

To remove a script version, select the version and click Delete. You cannot delete the live version.

Editing a media script

Select the version that requires editing and click Edit Script. Generating (saving) the script after
editing will not create a new version unless you explicitly choose this option on saving.

Making a media script live

The live script is the version of the script that will be used by the queue. Select the version that
you wish to use and click Make Live. You need to generate a script first. Click Edit Script to do
this.

Importing a media script

You can import a script that you have exported from another queue. To import a script, click
Import to select a file to import. Importing a file will create a new version number.

Note  You need to ensure that all resources referred to within the imported script are
available. In the case of voice scripts, .wav files may need to be re-imported and re-set if you
export a script from one inbound number and/or contact center unit and import it into another.
For emails, you may need to recreate templates if a script is imported from another contact
center unit. You may also need to check skillsets.

CE Admin Portal Guide - Configuring media scripts | 202



IFS Customer Engagement 25R1 GA

Exporting a media script

To export a script, select the version and click Export. This will create a file called
<media>QProgression.xml which you can then re-import.

Debugging media scripts and script debug settings

To assist with configuration and troubleshooting, there are debug options available. To set any of
these options, in the Admin Portal, go to Media Management and then select Voices, Emails or
Chat. You require a system email address to send debug emails.

Note  If this option isn't set then the trace log is emailed to the email address of the manager
of the contact center unit. To set this go to Contact Center Unit > Contact Center Units.

Script Trace Level

The suggested meaning of each of the trace/severity levels is as follows:
• None – disables the script trace.
• Critical Error – highest severity failures where there is a significant loss of service
• Error – failure resulting in partial loss of service
• Warning – unexpected condition encountered, but not resulting in a loss of service
• Information – low frequency success conditions/actions which are worthy of human attention
• Trace – low frequency diagnostic events for troubleshooting purposes
• Debug – diagnostic events where each successive level represents increasingly more verbose/

detailed information.

Script Email List

The email address to which the trace logs should be sent. Information will be emailed on the
inbound activation for any version of the queue progression script. Separate multiple email
addresses with a semi-colon (;).

Using the Debug Log option in a script

You can add a debug option to a script to provide additional information that is reported in the
trace log. To do this add the Debug Log option in one of the following parts of the script:
• Before the Add To Queue option in the Enter Queue event — the Debug Log option is ignored if

it is placed after Add to Queue.
• In the Timers event
• In the Custom Functions block
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Media scripts and system variables
System variables are available for use in media scripts. Enclose the variable in % characters. See:
• Voice system variables
• Email system variables
• Chat system variables

You can also include variables in text fields. You declare the variables using the Add Variable
action and then enclose them in % characters.

Media script options
The following options apply to scripts for all the media types unless indicated otherwise in the
Activation type column.

Note  Social Media includes Facebook, Twitter, WhatsApp, SMS.

Script option Activation type

Adaptive Card Chat

Add to Queue

Add Survey Candidate

Add Variable

Auto Reply Social Media

Auto Reply Email Email

Call Function

Close Work Object

Create Work Object

Data Delete

Data Insert

Data Update

Debug Log

Detect Language Email, Chat, Social Media
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Script option Activation type

Disconnect Call Inbound Voice Call, Outbound Voice Call

Function

Hangup Email, Chat, Social Media

IF

Invoke Provider Action

Is New Conversation Email, Social Media

Is Open

JavaScript

Open Work Object

Play Message Inbound Voice Call, Outbound Voice Call

Play Position in Queue Inbound Voice Call, Outbound Voice Call

Post Work Object

Record Voicemail Inbound Voice Call, Outbound Voice Call

Remove Call from Queue Inbound Voice Call, Outbound Voice Call

Request Caller Data Inbound Voice Call, Outbound Voice Call

Search Data Table

Search for Email Keywords Email

Search for Email RegEx Email

Search for Keywords Chat, Social Media

Search for RegEx Chat, Social Media

Search using NLP Email, Chat, Social Media

Send Choice Chat

Send Custom HTML Chat

Send Email

Send SMS
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Script option Activation type

Send Template Chat

Send Text Chat

Send WhatsApp Templated Message Chat, Email, Social Media

Set Priority

Set Script Element

Set Skill Set

Set Variable

Start Timer

Start Work Timer

Stop Timer

Timer

Transfer Call Inbound Voice Call, Outbound Voice Call

Web Request Email, Chat

WhatsApp Template Reply WhatsApp (for the old-style templates that
Twilio is phasing out)

WHILE

Adaptive Card (media scripts)
Input type: Chat

Use the Adaptive Card option for a richer style of interaction with the caller. Adaptive cards are
developed using the Microsoft Adaptive Card editor. For further details, see the CE Studio Guide.

After selecting the adaptive card, you need to map the placeholders in the card to variables (which
will be handled as expressions). Any operations required by the adaptive card are configured
using the Invoke Provider Action option.
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Example of placeholder mappings in the Adaptive Card option

To configure the Adaptive Card option in a media script:

1. Configure the Invoke Provider Action to return the data required by the card. See Invoke
Provider Action for details.

2. In the Adaptive Card option, select the category, adaptive card and version. The card details
are then displayed:

Field Description

Placeholder Mappings Map each placeholder in the adaptive card to an expression
defined in the script. In the example above:
• The contacts placeholder from the adaptive card is

mapped to an expression called results. This is the object
returned by an Invoke Provider Action option (see example)
but is handled as an expression here. results is the object
containing first_name, last_name and job_title. Expressions
unlike variables are not validated when the script is
generated.

• The first_name placeholder in the adaptive card is
mapped to an expression entered using the format
$.variable_name. The variable was declared earlier
using the Add Variable option.

Disable Free Input Prevents the caller from typing in the chat window's text input
box.

Handler In Handler, select the function that will run once the caller
responds to the card.
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Add to Queue

Input type: Email, Chat, Voice Call, Social Media

Adds the email, call or chat to the queue to be presented to an agent once a suitable agent is
found. Not required for communications that will be handled entirely by a script. Note that options
added after the Add to Queue option are not processed.

Note  Emails, calls and messages remain in the queue until closed by the agent. This means
that the script remains in control although no actions will run while the agent is working on
the activation, for example timers are suspended. If the agent cannot close the activation and
simply wraps up then the actions in the script resume, for example, the timer starts running
again.

Note  Phone calls remain in the queue for a limited period before the caller's network
disconnects them. To prevent this from happening, you can, for example, play messages to
the caller.

Note  If an error occurs in the running script, for example, a chat caller enters something that
the script is not configured to handle then the script ends and the caller is immediately added
to the queue without any further preprocessing by the script.

Preprocessing an email or chat before adding it to the queue
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Managing a communication while it is in the IVR queue

Add Survey Candidate
Input type: Email, Chat, Facebook Direct Message, Twitter Direct Message, WhatsApp, SMS,
Inbound Voice Call

Use this option to send a survey invite to a caller using any of the supported media channels.
Before you start, you need to create the following:
• A survey, either App or IVR - for details, see Creating a survey.
• For App surveys, the CE Studio app that will display the questions and gather feedback. This

must be live - survey links are not generated for non-live apps.
• Optional response templates for email or SMS if you plan to send the survey invites later - not

required if sending the invite immediately.

You do not need to specify the language of the survey as this is determined automatically based
on the caller's browser settings or by options in the queue progression script such as Detect
Language.

To use the Add Survey Candidate option:

1. Drag and drop the Add Survey Candidate option onto a suitable event in the Queue
Progression pane.
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Note  This must be the last option because, apart from Disconnect and Hangup, further
options are not processed.

2. Begin by selecting the survey and the app you will use to display the questions and gather
feedback:

Field Description

Description Optional description of the media script.

Category Select the survey category.

Survey Select the survey to use:
• Select an app survey for media channels

that only support app surveys, such as
chat and email. You can also select an app
survey for inbound voice when you want to
send the survey link by email or SMS.

• Select an IVR survey for inbound voice.
This immediately transfers the caller to the
voice survey.

You use the questions in the live version of
the survey. If there is no live version then it
uses the latest version.

Note  The survey version must be live
and the survey app (if using) must be live.
Survey links are only generated if these
are live.

Survey App For app surveys only, select the CE Studio
app to use. All the CE Studio apps that use
this survey definition are listed here.

3. Enter the variables for storing the caller's contact details. You need these to send scheduled
invites. Leave these empty if you want to send the invites immediately.

CE Admin Portal Guide - Configuring media scripts | 210



IFS Customer Engagement 25R1 GA

Field Description

Name Enter the variable that stores the caller's
name and select the variable data type. This
is always required to generate the survey
request regardless of the media channel.

Number To send an invite by SMS, enter the variable
that stores the caller's mobile phone number
and then select the variable data type.

You can configure both Number and Email
Address. If both the email address and
phone number are provided when the script
runs then:

• For Immediate invites:
• For email: system gives preference

to email and sends the survey link in
email.

• For voice call: system gives preference
to phone number and sends the survey
link as SMS.

• For SMS: system gives preference to
phone number and sends the survey
link as SMS.

• For scheduled invites, email is always
used.

Note  If sending invites by SMS then you
need to configure the SMS number here
even if replying to the caller.

SMS Template Optionally, select a response template to
use when sending the link to the survey app.
Leave this blank if you want to send just the
link without any additional wording.

For details, see Response templates for
surveys .
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Field Description

Email Address To send an invite by email, enter the variable
that stores the caller's email address and then
select the variable data type.

See Number above for what happens if
both email address and phone number are
configured.

Note  For scheduled invites, email is used
in preference to SMS.

Email Template Optionally, select a response template to use
when sending the email containing the link to
the survey app. Leave this blank if you want
to send an email containing only the link.

Placeholders are the same as for SMS
Template.

Timezone Sets the timezone of the survey. The default
timezone is UTC.

4. For app surveys, specify how the survey invites are sent - this does not apply to IVR survey
where the invite mode is always Immediate:
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Field Description

Invite Mode How the survey is distributed:
• Automatic: use the default distribution

settings for the survey.
• Immediate: Immediately send the survey

invite using the current media channel.
For example, this means chat if you are
configuring the media script for chat or
direct message if configuring the script for
Twitter Direct Message.

• Scheduled: Send the survey invite later
according to the configured distribution
settings for the survey. This means using:
• Email if an email address is known
• SMS if a mobile phone number is

known and there is no email address

The invite uses the default wording unless
you set up a response template for this
purpose.

Presentation Mode (chat only) Release 6.7 and later

For chat queue progression scripts, how the
survey is presented to the chat caller:

• Survey Link: shows a link that is clicked to
access the survey.

For immediate invites only:

• iFrame: shows the survey inside the
chat window, keeping the previous
conversation. You need to add the Add
Survey Candidate option to the Chat
Ending event. Immediate invites only.

• Whole Window: shows the survey inside
the chat window, removing the previous
conversation. You need to add the Add
Survey Candidate option to the Chat
Ending event.
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Field Description

Survey Candidate Result Variable Name Using the Add Variable option, declare a
variable to use here. This is required to
generate the survey candidate request.

Note  This variable references the
complex JavaScript object of the survey
request. You can read values such as
the candidate request ID and survey link,
from the object.

5. Save the media script.

To test survey sending, select Make Live and then click Save & Generate button.

Add Variable (media scripts)

Input type: Email, Chat, Voice Call, Social Media

You can define the variables for use in the media script using a single Add Variable action or a
series of Add Variable actions. These are global variables.

Note that:
• It is important to select the correct data type for a variable (see below for details). The

generated script is JavaScript so most of the script options expect the variables to be strings.
• You can set or update the value later using the Set Variable action.
• To include variables in messages enclose them in % characters.

To add a variable:

1. Drag and drop the Add Variable option into the Queue Progression pane.
2. In Description enter any comment that you want to add.
3.

Click  to add the first variable.

a. Enter the Variable Name. Normal variable naming conventions apply, such as no white
space. Names are case sensitive.

It is the name that is referenced in any scripts.
b. Enter an initial value (if required). You do not have to include quotes, even for a string. You

can also set the value later, or evaluate multiple variables in an expression, using the Set
Variable action.

c. Click in the Data Type column to set the variable type:
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 for numeric values or Booleans

 for alphanumeric values

 for a reference to an existing variable
4. Repeat these steps to add additional variables.

Auto Reply Email

Input type: Email

Use the Auto Reply Email option in a media script to send an automatic email response to the
sender from an email address that is configured for the tenant. To ensure that an auto reply is sent
once only, use the Is New Conversation option.

You can add an application reference for use later. Note that for Custom Recipients, you need to
enclose variables such as sys_ReplyTo in % characters. For example %sys_ReplyTo%.

Sending an automatic response to the sender

You can select an Auto Reply email template which has been set up in Media Management >
Response Template or create a new Auto Reply. Use a template to format the text, insert images
(maximum file size 760KB) and links.

Use system variables to include values from the received email. See Email system variables.
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Adding an application reference

Use the App Ref field in the option to attach a value to the auto reply that could be used later
when filtering or aggregating emails as part of the script. For example, a script with conditional
logic might use several auto replies and could set the App Ref depending on which condition sent
the auto apply.

Call Function

Input type: Email, Chat, Voice Call, Social Media

Use the Call Function option from anywhere in the media script to call a function that you have
defined in the Custom Functions node of the script.

1. Select the function from the Signature list.
2. If the function has parameters then map each parameter to either plain text or to a variable.

Note  If you change the function after selecting the function in the Call Function option,
then you have to reselect the function in order to update the parameter list

For more details, see Function.

Close Work Object
Input type: Email, Chat, Voice Call, Social Media

Use the Close Work Object option in a media script to close the processed work object.

Note  For background information on this type of workflow definition, see Workflows for
automated outbound calls.

Field Description

Lock Id The variable that stores the mandatory lock ID. Use the Add
Variable option to declare a variable that you will use in all the
Work Object options.

Note  For background information, see Locks.

Object Id The variable that stores the mandatory object ID. Use the Add
Variable option to declare the variable that you will use in all the
Work Object options..
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Create Work Object

Input type: Email, Chat, Voice Call, Social Media

Use the Create Work Object option in a media script to generate work objects that can then be
added to the queue. A typical example is a work object for a call back where the work object
contains the details of the call that the agent needs to make. The Create Work Object option
requires a workflow definition. For an example of how to create a workflow definition, see
Configuring call backs.

Note  You do not need to use this option if the only requirement is to generate a standard call
back object. You need to use this option for call backs that capture additional information from
the caller. An example of this might be letting the caller request a time for the call back.

To create a work object:
1. Drop a Create Work Object option into the Queue Progression area.
2. Enter the details of the workflow definition:

Field Description

Workflow Definition Select one of the existing workflow definitions.

Work Object Reference Enter a reference that you can use later to
search for the work objects created by this
media script.

Lock Text The reason why the work object is locked.

Work objects are locked while agents are
working on them. When you list workflow
objects in the Admin Portal, this text appears
in the Lock with Reason field.

Initial State Select the state for new work objects.

3. Enter the values or previously declared variables that will provide the data required by the
workflow definition to create the work objects.

Data Insert, Update, Delete
Input type: Email, Chat, Voice Call, Social Media

The Data Insert, Data Update and Data Delete options in a media script let you write and delete
records in Entity tables. To read records use the Search Data Table action (see Search Data
Table).
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Consider this example which updates a mobile number field in an entity record if the caller's name
is in the entity table. It leaves the other values unchanged:

Example of updating a record in a custom entity

In this example, the following variables and variable types are used:

•
StaffMobile is updated from the system variable sys_CLI. This is referenced using the 
variable type.

• There is a previously declared string variable for StaffName called v1. This is declared in an

Add Variable option using the  variable type.
•

In the Data Update condition v1 is referenced as a string variable . Using this variable
type encloses the variable in quotes, like this StaffName ='%v1%', and ensures that the correct
syntax is used for the SQL update.
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Debug Log
You can add extra information to the trace log to help with trouble shooting. See Debugging media
scripts and script debug settings for details.

Detect Language

Input type: Email, Chat, Social Media

Use the Detect Language option in a media script to manage instances where input may not be
in your main language. If, for example, a company deals with the UK, France and Germany, there
could be separate skillsets for agents who speak these languages. Refer to the IFS Customer
Engagement Release Notes for a list of supported languages.

Note  Numbers and certain strings, such as URLs, are discounted in the analysis.

The result is comprised of the detected language code and name, and the confidence percentage.
It is possible for up to three separate languages to be identified. The values are saved to an array
and its components are output to individually defined variables. You define these variables first
using the Add Variable action.

Field Description

Input Text Var Unless Input Text Var is defined, the subject
and body of the email will be analyzed. Input
Text Var would most likely be used if the
content of an email attachment was extracted
for analysis.

Reliable Result Var Optional. Gives an outcome of either true or
false.

Optional code variable Enter the variable to store the language code
of the detected language. These are ISO-639-1
codes.

Optional name variable Enter the variable to store the name of the
detected language.

Optional % variable Enter the variable to store the confidence % of
the detected language. The lower the value, the
higher the confidence.
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Disconnect Call
Input type: Inbound Voice Call, Outbound Voice Call

Use the Disconnect Call option in a media script to disconnect a voice call.

A typical use for this would be to follow a previous option where no further action is required. For
example, when an “office is closed” message has been played.

Disconnecting a call

Function
Input type: Email, Chat, Voice Call, Social Media

Use the Function option in a media script to define a set of actions that can be called multiple
times from any part of the script. The function can take any number of parameters. Use the
parameters as variables within the function.
1. Add the Function option to the Custom Functions section.
2. In Name, enter the function name. The function name cannot contain special characters such

as underscores.
3. Click + to add one or more parameters.

When you call the function, you can assign the parameters to either strings or variables.
4. Implement the function by declaring variables and adding options.
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Function example
5. Call the function by adding the Call Function action in the Enter Queue node of the script. For

chat, call it from another option such as Send Choice, Send Text:
a. Select the function from the Signature list.

If there are parameters then assign the parameters to either strings or variables.
b. If a return value is needed then enter a previously declared variable in the Variable field.

Hangup

Input type: Email, Chat, Social Media

Use the Hangup option in a media script to remove an email or chat that you do not want to add
to the queue. The reason for removing the communication can be reported on using the value
defined in the Description field. Note that:

• Any options after the Hangup option will be ignored.
• Any functions in the EnterQueue section will not run if followed by the Hangup option. The

Hangup option should be placed inside the function(s).

For example, use this for a communication that could be handled with an automatic reply or to
remove spam from the queue.
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Note  If an error occurs in the running script, for example, a chat caller enters something
that the script is not configured to handle then the script ends and the caller is immediately
added to the queue without any further preprocessing by the script (even if the script ends with
Hangup).

Discarding spam emails – other emails are added to the queue

Get Element and Get Elements
Input type: Email, Chat, Voice Call, Social Media

Use the Get Element and Get Elements options in a media script to get the data stored in the work
object.

To assign the value to a script variable, use the Set Variable option and syntax similar to this:
results['W_FIRSTNAME']. The data type must be a variable.

Note  For background information on this type of workflow definition, see Workflows for
automated outbound calls.

Field Description

Object Id The variable that stores the object ID. Use the Add Variable
option to declare a variable for use in the script.

Workflow Definition The workflow definition that defines the work elements that you
want to access.

Element names Select the elements that you want to access
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Field Description

Result Variable Name The variable that stores the data from the work object. Use the
Add Variable option to declare a variable for use in the script or
use the system variable sys_LastActionResult.

If you declare a variable then use the Set Variable option to get
the value. Use this syntax to get the value:

<Result_Variable>['<my_work_element>']

The data type should be Variable.

IF
Input type: Email, Chat, Voice Call, Social Media

Use the IF option in a media script to build an IF statement using the script variables. These are
either system variables (see Media scripts and system variables) or global variables declared
using the Add Variable option.

When an IF statement has been added to the script, subsequent child options are nested beneath
it. Child options are only executed if the IF condition is met.

In this simple example:

There is:
1. A keyword search that identifies emails that do not need to be passed to an agent. The

keyword search variable is named IsSpam.
2. The IF statement checks whether the keyword search returned true.
3. Under the IF statement, there is a child option to bypass the queue (the Hangup option) if the

condition is true.
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4. If the result is false, the script ignores the Hangup option and moves to the next step, which is
to add the email to the queue for an agent.

Note  You could add a second IF statement to check if the keyword search returned as false
and, if so, have the option to queue the email as the child action.

To define an IF condition:
1. In the IF option, enter the global variable declared earlier using the Add Variable option.

Variable names are case sensitive.
2. To remove an existing condition, click Clear before starting.
3. Depending on the type of condition, enter the comparison that is to be evaluated. Note that:

• The comparison is case sensitive.
• The equals operator used in the comparison is ===. This means that it returns true only if

both values and types are identical for the two variables being compared.
• Quotes are added automatically to the condition where needed.
• When entering a value on the righthand side of comparisons such as Contains, click the

icon to select the data type.
4.

If you are finished, click  to insert the condition in the Condition box.

Note  You can edit the condition manually by typing directly into the Condition box. The
debug log will report if there any problems with the condition.

5. Repeat these steps to add further AND OR comparisons.

To clear the condition and start again, click Clear and then select Not Set from the first IF list.
6. To pass the result to a variable, enter the name of a previously-declared variable in the

Variable field.

Invoke Provider Action
Input type: Voice, Chat, Email, Voice Call, Social Media

You can use data from an external data source in a media script, as well as create, modify and
delete data in the data source. This requires that there is a global action set configured for this
purpose in CE Studio.

You need to use an option such as Set Variable to get the result from Invoke
Provider Action. If the returned result is a single value then you use syntax such as
<result_variable>['<variable>'] but if is an array then use this syntax:
<result_variable>[0]['<variable>'].
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Using JavaScript, you can test the outcome of the request using the system variable
sys_LastInvokeProviderActionResult.

Note  In the 6.2 release, the syntax for accessing the data is simplified: object[0]
['property'], for example, results[0]['last_name']. Previously the syntax was
object[0]['property_type|property'] but the property type is no longer needed.

Simple example

This is a simple example for chat and the IFS Field Service Management provider.

Example using the Invoke Provider Action

In the above example:
1. A function getCallerDetails() adds a new contact to IFS Field Service Management

using a global action set configured for the FSM provider in CE Studio. The global action has
placeholders for the values needed to create new contacts.

2. The script uses the Invoke Provider Action option to send the request to FSM.

The response from FSM is a JSON object. You can see the structure of the response in debug
emails from the chat script host.

3. The function gets the success or failure status from the response and handles failed requests
appropriately.

Using the Invoke Provider Action where the result is an array

To access the data from a CE Studio provider in a script:
1. Using the Add Variable option, declare a variable for the object that is returned from the

provider endpoint, and its data.
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In the following example, four string variables are declared. results is the object and first_name,
last_name and job_title is the data inside it. The results object is an array.

2. Add the option Invoke Provider Action to the script.
3. Fill out the fields in the Invoke Provider Action option:

Field Description

Global action set Select the global action set – all the global action sets created in
CE Studio are listed. However, if you need to use data from the
provider in the script, then you need to make sure that you select
a global action set that returns properties.

Variable Enter the variable that you previously defined using the Add
Variable option. The external data you select will then be
available to other options in the script through this variable. In the
example given above this is the variable called results.

Note  System variables, such as sys_Message are not
currently supported. As a workaround add a variable and
then set this to the system variable you want to use.

Placeholders The placeholders (if any) are defined in the global action. You set
a placeholder to one of the following:
•

A static value (click  for a string or  for a numeric
value)

•
A previously-defined string variable (click )
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Field Description

Type Properties Select one or more properties from those listed. All the selected
properties will be formatted as JSON when the script is
generated.

4. Using the Set Variable option, set the variables you declared to the data in the response.

Continuing the above example, the data is held in an object previously declared as results. You
access the data through the results variable, which is an array, as shown below.

5. Save and generate the script.

Note  When you do this, CE Studio records that you have used this global action set in
this version of the script. Before the global action set can be deleted in CE Studio, you will
need to delete the version of the script.

Handling the response

Using JavaScript, get the status and any error message from the system variable
sys_LastInvokeProviderActionResult:
• outcome status: sys_LastInvokeProviderActionResult.OutcomeStatus, such as

OnFailure or success
• any error message: sys_LastInvokeProviderActionResult.ErrorMessage

Important  You cannot use the Set Variable option for this purpose.
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Is New Conversation
Input type: Email, Social Media

Use the Is New Conversation option in a media script to check whether an incoming email or
social media message is part of an existing thread or a new one.

Media Default conversation

Email By default, the system automatically determines whether an email is part of
a conversation based on the email subject. It relies on the sender replying
to the original email. They can reply from a different email address if the
subject heading is the same.

Social media By default, the system determines whether a WhatsApp or SMS message is
part of a conversation based on the sender's phone number. It relies on the
individual sending from the same mobile device.

You can also determine whether the email or social media message is a new thread based on
some other criteria. For this you need to write a custom function.

Example: A different auto reply is sent for a new or old conversation

To determine whether it is a new conversation based on the subject line or sender's number

1. Use the Add Variable option to add a variable for the value returned by Is New Conversation.
2. In the New Conversation option, select the variable you declared.
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To determine whether it is a new conversation based on other criteria

For example, other criteria could be a customer reference in the email subject, body or message
text:
1. Using the Add Variable option, add two variables for the values returned by the custom

function:
• Custom reference
• Whether it is a new conversation

2. In the Custom Functions option, configure a function to search for the custom reference. For
example, you could use an option such as Search for Keywords, Search for RegEx, Search
Email RegEx, Search for Email Keywords. If it is a new conversation then the function must
return true and, optionally, return a reference to identify the conversation.

3. Set up the New Conversation option:

Field Description

Custom Reference Variable The new conversation is identified by a unique
value, which is returned by the custom function.

New Reference Function The custom function that checks whether the
email or message is a new conversation. It
must pass true to the New Conversation
variable if the email or message is a new
conversation.

New Conversation Variable The variable for the result of the New
Conversation option: true for a new
conversation otherwise false.

Is Open
Input type: Email, Chat, Voice Call, Social Media

Use the Is Open option in a media script to determine whether the communication has arrived in
or out of open hours. The open hours are obtained from a coverage plan.
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In the above figure, the IF statement tests whether the call arrived out of hours (IsOpen ==
false ). If it arrived out of hours then the call is removed from the queue and a message is played
to the customer.

To use the Is Open option:

1. Using the Add Variable action, add a variable for the result of the Is Open option.
2. In the Is Open option:

a. Select an existing coverage plan. For details, see Configuring open hours.
b. Enter the variable name that you created above.

JavaScript
Input type: Email, Chat, Voice Call, Social Media

Use the JavaScript option to insert JavaScript directly into the media script.

Note  Terminate each statement with a semi-colon, for example, var sys_Locale = 'en-
US';

For examples, see:

• Search Data Table
• Play Message
• Text to speech API for IVR scripts

Open Work Object
Input type: Email, Chat, Voice Call, Social Media
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Use the Open Work Object option in a media script to get a lock on the work object to be
processed. This, for example, prevents the work object being presented to an agent.

Note  For background information on this type of workflow definition, see Workflows for
automated outbound calls.

Field Description

Object Id The variable that stores the object ID. Use the Add Variable
option to declare a variable for use in the script.

Lock ID Variable The variable that references the lock for the work objects. Use
the Add Variable option to declare a variable for use in the script
or use the system variable sys_LastActionResult.

Time Out The attempt to acquire a lock on the object fails after the
specified number of seconds and sets the Lock Reason variable
to false.

Lock Reason Enter the text to use as the lock reason. Use the Add Variable
option to declare a variable for use in the script.

Play Message
Input type: Inbound Voice Call, Outbound Voice Call

Use the Play Message action in a media script to determine what the caller will hear played.

You upload the messages as WAV files on the Contact Center > Voice Prompts page. See
below for details.

Field Description

Custom Prompt Select this option to play a WAV file that you have uploaded
on the Contact Center > Voice Prompts page. You need to
upload the file as an IVR Resource. See Uploading queue
and hold music.

System Prompt Select this option to select one of the system recordings.
You can upload WAV files for each of the prompt types on
the Contact Center > Voice Prompts page.

Variable Enter the name of the variable whose value is a WAV file.

See below for details of how to set this up.
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Field Description

Silence After Message (ms) The number of milliseconds to wait after playing the
message. The default is zero (0) milliseconds.

Stop on DTMF detection Select this option to stop the file playing if another event is
detected, such as digit being entered.

Note that these digits are handled as strings not numbers.

File may not exist Select this option if you need to allow for the possibility that
someone may delete your WAV file. Selecting the option
allows the script to continue without crashing.

Using the Variable option

An example of use is having a data table containing WAV files. Using the Search Data Table
action, the correct WAV file can be selected into the variable.

Playing a message using the WAV file referenced in a variable

The variable name is given in the Search Data Table action, in which case the array position
is required. For instance, if the table was called langcode, and the data table column was
called wavfile, the JavaScript action would declare langCode[0].wavfile. As the variable
langCode is declared in the Search Data Table action, it does not also need to be declared using
the Add Variable action.

You could then use custom JavaScript to extracts the WavFile value into another variable called
wavVar by using code such as that shown below:

//Extract VarFile value into a variable called wavVar
//wavVar has been declared using the Add Variable action
wavVar = (langCode[0].wavfile);
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Then wavVar would be entered in the Play Message action. You need to declare wavVar using the
Add Variable action.

Uploading the wav files

You upload the messages as WAV files on the Contact Center > Voice Prompts page.

Note  The WAV file format must be 8kHz mono (one channel) and the audio encoding must be
either 16-bit linear PCM or 8-bit m-law/a-law PCM.

Field Description

Prompt Type The following prompt types are system prompts:

• Welcome
• Hold
• Queue Music
• Voice Mail Offering
• Offices Closed
• Hold For Voice Mail
• Voice Mail Prompt
• Goodbye
• Pre-Queue Announcement Message

To upload WAV files for use as custom prompts in queue progression
scripts use the IVR Resource type.

Language Lets you upload a voice prompt for a specific language. Manage the
available languages on the Contact Center > Manage Languages
page.

IVR Type One of the following:
• MediaQP - the voice prompt is available for the queue progression

script you select.
• Voice - the voice prompt is available for the inbound number that you

select.
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Field Description

Media Queue
Progression Definition

When the IVR type is MediaQP then you need to select a media queue
progression script. Only scripts with live versions are listed.

You configure the scripts on the Media Management > Media Queue
Progression page. The voice prompt you upload is available for all
inbound numbers that use the queue progression script.

To find out which inbound numbers use the voice prompt, go to the Media
Queue Progression page, select the script, and click View Usage.

Inbound Number When the IVR type is Voice then you need to select the inbound phone
number that will use the voice prompt. The voice prompt is available for
the single inbound number that you select.

Play Position in Queue
Input type: Inbound Voice Call, Outbound Voice Call

Use the Play Position in Queue option in a media script to periodically play the caller their position
in a queue.

Important  Use this option with caution. The caller’s position in the queue could go up in
environments where some calls are higher priority than other calls. It also does not tell the
caller how quickly their call will be answered.

Specify which WAV files are to be played:

Field Description

Prefix Message Determines which WAV file is to be played before the
position in the queue is played.

Suffix Message Determines which WAV file is to be played after the
position in the queue is played.

Stop on Detect Stops the message from playing if a DTMF tone is
detected.

You could then add actions to the DigitDetected event to
determine what happens next, such as allow the caller to
request a call back.
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Post Work Event
Input type: Email, Chat, Voice Call, Social Media

Use the Post Work Event option in a media script to send an event to the work object that will
trigger a work action or change of state. Open the work object first using the Open Work Object
option. Use the Start Work Timer option if you do not want to open the work object.

Note  For background information on this type of workflow definition, see Workflows for
automated outbound calls.

Field Description

Lock Id The variable that stores the mandatory lock ID. Use the Add Variable
option to declare a variable for use in the script.

Note  For background information, see Locks.

Workflow Definition Select the workflow definition. This is the definition that defines the
work objects that you want to process with your media script.

Workflow Event The workflow event that you want to trigger. Work events are defined
as part of the workflow definition.

For example, once the actions in the media script are executed, you
need to close or complete the work object. You do this by posting a
work event that triggers the workflow service to change the state of
the work object to closed or completed.

Note  For background information, see Events.

Event Id Entered automatically when you select the workflow event.

Auto Unlock To process a work object, you need to lock the work object. This
option specifies whether the lock is released when the work event is
posted:

• Select Yes to automatically release the lock on the work object.
• Select No to keep the lock on the work object. For example, if

further processing of the work object is done by your media script.
Use the Close Work Object to release the lock.

Name, Value, Data Type The work element(s) that you want to update.
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Record Voicemail
Input type: Inbound Voice Call, Outbound Voice Call

Use the Record Voicemail option in a media script to let the caller record a message to be
retrieved later by an agent.

The Prefix Message plays before the caller is connected to the voicemail. The Suffix Message
plays after the Max Recording Length (in seconds) elapses.

Voicemail can be retrieved either by dialing into the system or by setting up the voicemail to email
the recording (potentially back to an agent). See Configuring voicemail.

Remove Call from Queue
Input type: Inbound Voice Call, Outbound Voice Call

Use the Remove Call from Queue option in a media script if you do not want the call to be
presented to an agent. For example, you might then:
• Transfer the call
• Gather data from the user for a call back

This will automatically cancel any timers.

Example: calls are removed from queue and then transferred to another number

Request Caller Data
Input type: Inbound Voice Call, Outbound Voice Call

Use the Request Caller Data option in a media script to collect data from the caller which can be
stored in a variable for subsequent processing via an IF or WHILE option. Typically, you collect
this data, such as a case number, caller name etc, before adding the call to the queue. You can
save the caller data for use once the media script ends with script elements. See Set Script
Element.
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The Request Caller Data option ends when the caller enters the maximum number of characters
or the termination character, or when a timeout occurs.

Field Description

Min Length Specifies a minimum number of characters to accept.

Max Length Specifies a maximum number of characters to accept.

Variable Name Enter a variable name if the action is to be used by an IF or WHILE
statement. You must also declare the string variable using the Add
Variable action.

Note  The variable must be a string as the entered values are
DTMF digits not numbers.

Initial Prompt Specifies the WAV file that prompts the caller to enter data.

Retry Message Specifies a WAV file to be played if the caller fails to select the
correct (or any) digit. Can be left blank if required, in which case
the Initial Prompt will just replay.

Termination Char Lets the caller indicate they have finished entering data. For
example, by entering a 4#digit pin followed by #. The # character is
the terminating character.

Retry Count Lets you specify how many times to allow the caller to retry if an
incorrect (or no digit) is detected.

Initial Digit Timeout Allows you to specify in seconds how long to wait for the initial digit
before concluding no digit has been entered and then, depending
on the retry count, play the Retry Message. For example, you
might enter 10 as the number of seconds to wait.

Inter Digit Timeout Is the time in seconds to allow between characters. For example,
you might enter 5 as the number of seconds to wait.

Stop on Detect Stops playing the Initial Prompt file if a digit is detected. Use this
to let the caller select a menu option without having to listen to the
whole message. This also overrides any configured silence.

Accept Empty Lets the user press nothing, for example “Press 1 for Sales or hold
for Customer Services”.
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Field Description

Play Beep Plays a beep when the message ends to indicate to the caller that
they can now enter something.

Search Data Table
Input type: Email, Chat, Voice Call, Social Media

Use the Search Data Table option in a media script to search against a custom entity (table), using
one or more columns, and then use the search result in an IF statement. The WHERE condition
returns the matching entry or entries in the entity. For details on entities, see Entities for use in
media scripts.

Example – using Search Data Table in a script
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Example showing how to set up a Search Data Table action

This example sets up a search where two columns of a custom entity (table) called Staff  are used.
• StaffNo for the condition, which checks if anything is found by the regex search. The search

result is held in a result variable (previously declared using the Add Variable action).
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• StaffEmail and StaffName where the value of these fields in the Entity table will used if the data
table search finds the staff number returned by the regex search.

• TableRow which stores the result of the data table search, making the value of the Entity table
fields StaffEmail and StaffName available at a later stage.

Setting up the data table search

To set up the search, fill in the following mandatory fields:

Note  Columns are displayed using the column names rather the message associated with
column's message ID.

Field Description

Custom Entity The custom entity that you want to search.

Top The maximum number of records to be
returned by the data table search.

Select Column The entity column to search on.

Selected Columns The columns to return by the data table search.

WHERE, Condition Using the WHERE fields, enter the search
criteria based on previously declared variables
and then click + to add the search criteria to the
Condition box. You can build complex search
criteria using the AND and OR operators.

For where conditions involving strings in an

entity table use the String Variable type .
The resulting syntax for the condition will be
similar to this:

StaffName = '%sys_CallersName%'

In this example, StaffName is an entity column
and sys_CallersName is a chat system
variable.

For details of the other variable types, see Add
Variable (media scripts).
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Field Description

Order By Column Select the column for sorting the records
returned by the search. Then, add the columns
to the table below, for searches that return
multiple records, this lets you specify ascending
or descending order.

Variable The previously declared variable that stores
the result of the data table search. This is the
whole object containing one or more records.
See below for an example.

Evaluating the result of the search

To use the Search Data Table result, you need to add an IF statement. The result of the Search
Data Table action, that is whether something was found or not, is held in a system variable called:

sys_LastQueryResult

After running a Search Data Table action, the value of sys_LastQueryResult is either:
• RECORDS FOUND
• NO RECORDS

Use an IF statement to test the value of sys_LastQueryResult. For example:

 sys_LastQueryResult == RECORDS FOUND

Using the data returned by the search

The result of the search is an object containing one or more rows from the custom entity table. For
the TableRow variable in the above example, the object is:

{
StaffNo = TableRow[0].StaffNo;
StaffName = TableRow[0].StaffName;
StaffEmail = TableRow[0].StaffEmail;
}

Use a JavaScript action to select the relevant part of the array. For example:

//Extract the StaffEmail value into a variable called emailVar
emailVar = (TableRow[0].StaffEmail);
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In the above example, the JavaScript references the contents of TableRow. It extracts the value
held in the data table column called StaffEmail and returns it in another variable called emailVar.
You need to declare the variable emailVar using Add Variable action. The variable emailVar can
then be used for whatever purpose required.

Search for Email Keywords
Input type: Email

Use the Search for Email Keywords option in a media script to identify keywords in an email
subject line or body of an email, and then use IF conditions for further processing depending on
whether the keyword(s) were found.

For example:

In this example, if the variable IsSpam tests as true, you could take the email out of the queue
(see the Hangup option).

You can add multiple words to the subject or body filters using a delimiter (^). Note that the search
is case insenstive.

For example:

autoreply^auto-response^auto reply^auto response

The variable for the value returned by the search must be declared separately using the Add
Variable option.

Search for Keywords
Input type: Chat, Social Media
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Use the Search with Keywords option in a media script to identify keywords in a message. For
details, see Search for Email Keywords.

Search for Email RegEx
Input type: Email

Use the Search for Email RegEx option in a media script to detect strings in an email subject line
or in the body of an email. You search using a regular expression. The search result is stored in a
variable and therefore available to the script actions that follow. You need to declare the variable
separately using the Add Variable option.

A regular expression finds 8-digit numbers in the email subject line (note the single quotes and the
escaped \d):

'/(\\d{8})/g'

If found, the 8-digit number is stored in the variable for later use.

Important  Enclose regular expressions in single quotes and follow JavaScript string escape
rules, for example:

• Horizontal tab: \t
• Nul char: \0
• Form feed: \f
• Newline: \n
• Carriage return: \r
• Single quote: \'
• Double quote: \"
• Backslash: \\

Search for RegEx
Input type: Chat, Social Media

Use the Search for RegEx option in a media script to detect strings in a message using a regular
expression. The search result is then stored in a variable. To test the variable, you need to use the
following conditions in an IF:
• Is Empty instead of Is False
• Is Not Empty instead of Is True

This option is similar to the email equivalent. See Search for Email RegEx for further details.
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Search using NLP
Input type: Email, Chat, Social Media

Use the Search using NLP option in a media script to categorize an email or message based on a
pre-existing model which has two or more defined categories.

Note  You need to define the NLP model before you can use this option. See Natural
language processing (NLP) for details.

The categories can be determined by:

• Content, such as “Refund” and “Cancellation”
• Sentiment, such as “Happy” and “Annoyed”

There are many ways in which a person may write something, and there is always the chance
of typos. NLP processes human language and can identify nuances in the email that keyword or
regular expression searches could not.

The result is comprised of the detected category name and the minimum confidence percentage.
You can specify up to three separate categories. Add these variables using the Add Variable
option.

Field Description

Input Text Var Unless Input Text Var is defined, the subject
and body of the email will be analyzed.

1st Match Vars First detected category:
• Enter the name of a variable that you have

already declared using the Add Variable
action.

• Enter the minimum confidence percentage.
The default is set when the NLP model was
deployed. This will be a variable that you
have already declared.

2nd Match Vars Variables for the second detected category.

3rd Match Vars Variables for the third detected category.

Model Select the NLP model.
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Assuming an inbound email has been sent that the Search using NLP reaches the minimum
confidence level, the output is as follows:

catName = Cancellation 
confLevel = 0.720413515370499 

catName2 = 
confLevel2 = 0 

catName3 = 
confLevel3 = 0

Note  It is possible that the Search using NLP action will not find any category that meets the
minimum confidence level. If the requirement is to only identify emails or chats that match
certain categories, this is not a problem. However, if every email or chat received needs to be
categorized, provision should be made in the script. For example, if nothing is returned, you
could use a Java Script action to set the relevant variable to, say, “Other”.

Send Choice
Input type: Chat

Use the Send Choice option in a media script to find out what the user wants to do next, and to let
them know what their choices are. An alternative to the Send Choice is the Adaptive Card option.
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Choice list in the Chat Demo definition

To set up a Send Choice option:
1. Before you start, you need to write the function that will run when the user selects an item from

the choice list.
2. Choose a template for an existing choice list (optional) and enter a prompt:

CE Admin Portal Guide - Configuring media scripts | 246



IFS Customer Engagement 25R1 GA

Field Description

Template You can either select an existing choice list from a template, or
you can leave this blank to create a new choice list.

You can save the choice list you create here as a template for
use elsewhere in the script. To save it as a template, select the
Save As New Template option.

Important  Note that subsequent changes to the choice list
will be saved to the existing template (even if you change
the template name). To save it as a different template,
reselect the Save As New Template option.

When importing a script you will to select Save As New
Template for each choice list in the script.

Template Name Enter a descriptive name for the template. For example,
Choice Engineer Visit Yes No.

Prompt Enter the message that is shown before the choice list.

3.
Define the choices in the list. You can enter these as text or images. Click  to add multiple
choices, however the size of your chat window will in practice limit the number:

Field

Text The label to appear on text buttons. For example, Change
Date.

Value The payload. For example, date. This is also what the agent
sees in Agent Desktop.

Image The image to display on the button. Upload these on the Media
Management > Import Images page.

Image Size The button sizes to fit the image but you can enter height and
width in pixels, such as 100px. You must add px after the
value.

Text Padding The number of pixels to add to the top and left of the text, in
pixels. You must add px after the value.
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Field

Text Color This is the foreground color of the text. Enter the color as a
name or use its hex value.

Order The left to right order of the buttons in chat window. Where 1 is
the left-hand button.

4. In Handler, select the function that will run once the user selects one of the options.
• Allow Once: prevents the user from making another choice after they have sent the first

one.
• Disable Free Input: prevents the user from typing in the chat window's text input box.

Send Custom HTML
Input type: Chat

Use the Send Custom HTML option in a media script when you need to enter your own HTML. For
example, for a non-standard widget such as a date picker. An alternative is to use the Adaptive
Card option.

Custom HTML widget in the Chat Demo definition

To set up a Send Custom HTML option:
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1. Before you start, you need to write the function that will run when the user interacts with the
custom HTML.

2. Choose a template for an existing custom HTML configuration (optional) and enter a prompt:

Field Description

Template You can either select an existing custom
HTML configuration from a template, or you
can leave this blank to add a new one.

You can save the HTML you enter here as
a template for use elsewhere in the script.
To save it as a template, select the Save As
New Template option.

Note that subsequent changes will be
saved to the existing template (even if you
change the template name). To save it as a
different template, reselect the Save As New
Template option.

Template Name Enter a descriptive name for the template. For
example, Get New Date Widget.

Prompt Enter the message that is shown before the
custom HTML.

3. Enter the custom HTML. You do not need to include tags such as <html> or even <p>
(including a <p> tag will force an indent).

The following is an example of valid HTML:

<hr/>
New Date: <input type="date" id="newDate" name="newDate"
 value="%ApptDate%"><br/>
Contact  Name: <input type="text" id="contactName"
 name="contactName" value="%Customer%"><br/>
Contact Phone: <input type="text" id="contactPhone"
 name="contactPhone" value="%CustPhone%"><br/> 
  <button onclick="sendButton(MESSAGE_TYPE.CUSTOM_HTML_RESULT,
          {'value':$v('newDate'),
          'innerText':$v('newDate'),'name':'NewDate'});return
 false;">
    Submit new time
  </button>
<hr/>

4. In Handler, select the function that will run once the user selects one of the options.
• Allow Once: lets the user select a button once only.
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• Disable Free Input: prevents the user from typing in the chat window's text input box.

Send Email
Input type: Email, Chat, Voice Call, Social Media

In a media script, you can use the Send Email option to send an email from one of the system
email addresses configured for the tenant.

Note  Note that you need to enclose variables such as sys_ReplyTo in % characters. For
example %sys_ReplyTo% or select the Variable data type.

You can write a simple email as part of the action or select a response template. Response
templates let you format the text, insert images and links:
• Create email templates on the Media Management > Response Template page.

You add the email templates on the Media Management > Response Templates page. If the
response template contains variables (enclosed in % characters) then set these in the script
using the Add Variable option.

You can add templates for different locales and the service will automatically select the correct
template for the locale. You can add templates for different locales. By default, only US English,
UK English and English are supported but you can add additional languages on the Contact
Center > Manage Languages page.

• When sending email templates, select HTML as the body type.
• Maximum image size is 760KB

Depending on the type of the original communication, you may be able to use system variables in
the email and email body. See:

• Voice system variables
• Email system variables
• Chat system variables

Send SMS
Input type: Email, Chat, Voice Call, Social Media

Use the Send SMS option in a media script to send an SMS message for which you do not require
a reply. For example, as a confirmation or maybe to verify the identity of the caller before the
communication is presented to an agent.

To use the Send SMS option:
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1. Add any required variables using the Add Variable action. For example, a variable for the
recipient's mobile number. You can also add the variables needed for response templates that
contain variables.

2. Add the message to send. You can write a text message or select an SMS template. Using a
template lets you format the text, add images and links.

You add the sms templates on the Media Management > Response Templates page. You
can add templates for different locales and the service will automatically select the correct
template for the locale. You can add templates for different locales. By default, only US English,
UK English and English are supported but you can add additional languages on the Contact
Center > Manage Languages page.

3. In the From field, select an SMS-enabled inbound number.
4.

In the To field, select the variable that has the number to call. Change the variable type to .

Send Template
Input type: Chat

Use the Send Template option in a media script to send a text using an existing chat response
template and then, optionally, run a function on receiving the user's reply.

You add the template on the Media Management > Response Templates page. You can add
templates for different locales and the chat service will automatically select the correct template
for the locale. By default, only US English, UK English and English are supported but you can add
additional languages on the Contact Center > Manage Languages page.

Select a function in the Handler field if you want the script to handle the reply from the user.

Send Text
Input type: Chat

You can define text messages that will be sent as part of the media script.
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To add a Send Text option:
1. If this part of the chat session is to be handled by the script, then you need to add a custom

function that will run when the user replies to this message. See Function.
2. In the Send Text option, enter the text you want to send.

You can use system variables to include data from the session. See Chat system variables.
3. In Handler, do one of the following:

• Select the custom function that will run when the user replies to this message. If you do not
use a handler then the script will just move onto the next option configured in the script. For
example, it will not wait for the user to reply.

• Leave this field empty. The script will then immediately move onto the next configured
option. For example, if there are three Send Text options then the user will see three
messages one after the other.

Send WhatsApp Templated Message
Input type: Chat, Email, Social Media

In 6.8 and later, use the Send WhatsApp Templated Message option in a chat, email or social
media media script to send automated replies. Automated replies are configured using the
templates created on the Media Management > WhatsApp Content Templates page.

Only approved templates are available for selection.

Set Priority
Input type: Email, Chat, Voice Call, Social Media
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Use the Set Priority option in a media script to change the priority of a communication in the
queue. An email, message or call will be added to the queue at its default priority. The default
priorities are set for the contact center unit. See Setting default activation priorities.

For example, the defaults at the contact center unit are:
• Calls: 5
• Chat: 2
• Email: 1
• Workflow: 4

The default priority can be adjusted as part of the email address, chat definition or inbound
number configuration using a relative priority. For example:
• High, Highest: raises the priority by adding 1 or 2 points respectively to the default priority.
• Low, Lowest: lowers the priority by subtracting 1 or 2 points respectively from the default

priority.

For example, a chat definition might adjust the priority to Highest which in the above example
gives chats a priority of 4 in the queue.

To override the adjusted priority set for the inbound number, email or chat definition, use the Set
Priority option. For example, enter 2 to set a specific email to the highest priority. You can enter a
number in the range -2 to 2:
• 2: Highest priority
• 1: High
• 0: Normal
• -1: Low
• -2: Lowest

Note  If two communications in the queue have the same priority then the communication that
has been in the queue longest will go first.

Set Script Element
Input type: Email, Chat, Voice Call, Social Media

Use the Set Script Element option in a media script to save the data obtained during script
execution for use later. For example, you can use the data:
• During script execution to refer to data obtained from one email or SMS message when

handling a later email or text message in the same conversation.
• In a CE Studio app to refer to data requested from the caller. Application data is made available

through the IFS CE System provider (version 5 or later). For chat, application data is made
available through the IFS CE Chat provider.
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Note  You do not need to use script elements when configuring work objects.

Saving data in a script element

To use Set Script Element:
1. Using the Add Variable option, add one or more variables to store the value for the duration of

the media script execution.
2. Capture the data. For example:

• For voice, you could use a Request Caller Data option.
• For email, search for keywords.
• For chat, save the selection from a choice list.
• For social media, save the value in the system variable sys_MessageText.

3. In the Set Script Element option, configure the script element:

Script Element Name Enter the name that you want to use to store the data.

Value Enter the name of the script variable that will store the data
during the script execution.

You need to set the data type to Variable .

Getting the data in a script element

To get the data saved in a script element, you need to use the JavaScript option. You get the value
from the script element and assign it to a variable. The syntax depends on the media channel.

Note  In the following examples, callersName is the name of the script element and v1 is a
variable declared earlier using the Add Variable option.

Social media, email v1=host.GetConversationElement('callersName')

Voice v1=host.GetScriptElement('callersName')

To use the data in a message, use the following syntax:

%@callersName%

Where:
• % identifies the variable to be substituted
• @ identifies that the following text is the name of a script element.
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Set Skill Set
Input type: Email, Chat, Voice Call, Social Media

Use the Set Skill Set option in a media script to set or change the skillset required to handle the
communication.

Setting the skillset based on the detected language (email or chat)

Set Variable
Input type: Email, Chat, Voice Call, Social Media

Use the Set Variable option in a media script to set the value for a variable previously declared
using the Add Variable option. When you set the value, you must select the data type:

 for a numeric value or a Boolean

 for an alphanumeric value

 for a reference to an existing variable

 for an expression that will be evaluated, for example to concatenate two strings, firstName
+' '+lastName where firstName and lastName are variables

For details of how to set the variables when using the option Invoke Provider Action, see Invoke
Provider Action.

Start Work Timer
Input type: Email, Chat, Voice Call, Social Media
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Use the Start Work Timer option in a media script to send an event to the work object that will
trigger a work action or change of state after an interval. You do not need to open the work object
before using this option.

Note  For background information on this type of workflow definition, see Workflows for
automated outbound calls.

Field Description

Object Id The variable that stores the object ID. Use the Add Variable option to
declare a variable for use in the script.

Workflow Definition Select the workflow definition. This is the definition that defines the
work objects that you want to process with your media script.

Workflow Event The workflow event that you want to trigger. Work events are defined
as part of the workflow definition.

For example, once the actions in the media script are executed, you
need to close or complete the work object. You do this by posting a
work event that triggers the workflow service to change the state of
the work object to closed or completed.

Note  For background information, see Events.

Event Id Entered automatically when you select the workflow event.

Time The number of minutes to wait before triggering the workflow event.
For details of the timer interval, see Timers.

Name, Value, Data Type The work element(s) that you want to update. It is mandatory to
enter a minimum of one work element.

Timers
Input type: Email, Chat, Voice Call, Social Media

Timers are added to the Timer node of the media script. A timer defines what actions take place
• When a timer fires after the configured interval
• And while the call is still in the queue
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Note  Emails, calls and messages remain in the queue until closed by the agent. This means
that the script remains in control although no actions will run while the agent is working on
the activation, for example timers are suspended. If the agent cannot close the activation and
simply wraps up then the actions in the script resume, for example, the timer starts running
again.

You add an option to start the timer. The previous timer is automatically cancelled by the next
timer in the script, and all timers are automatically cancelled when the communication is removed
from the queue. A timer will fire once only.

For example, you might start an initial timer before adding a call to the queue. When the timer
expires, the IVR system plays some hold music; then another timer starts with the purpose of
checking the caller is still happy to hold. The second timer automatically cancels the initial timer.

Example using timers to transfer calls

For a media type such as emails that may remain in the queue for a while, multiple timers can be
configured. For example, a first timer can be configured to start a second timer.

To add a timer:
1. Optional. Declare any variables that you need using the Add Variable action — timer intervals

can be set in a variable. Make sure you select the correct data type as explained below.
2. Drop a Timer option into the Timers node.
3. Enter the timer name. Time names must not contain spaces.
4. Inside the Timer option, add the options that define what events take place when the timer

expires.
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Note  Scripts cannot be set live if an empty timer has been added to the Timers node, that
is the timer contains no options to define what happens when the timer expires.

5. Define when the timer should start:
a. Drop a Start Timer option into, for example, the EnterQueue node. Add it before the Add to

Queue option.
b. Select the timer you defined above and enter the following details:

Timer Interval Do one of the following:
• For any media type, you can enter the name of a variable that

sets the timer interval. Select the variable data type.
• For chat and inbound number definitions, enter the timer interval

as a number of milliseconds. Select the numeric data type.
• For email definitions, enter the timer interval as a relative

datetime. Select the string data type. The period specifiers are:

• W=weeks
• D=days
• H=hours
• M=minutes (the default if a period specifier is not included)
• S=seconds

For example, the following are the same timer interval: 2h30m or
150m or 150.

Cookie A value (string only) that you want to pass to the next stage of the
script. For example, when you want to send a different message to a
chat caller based on the length of time they have been in the queue.

6. Optionally define when the timer stops (is cancelled).

Transfer Call
Input type: Inbound Voice Call, Outbound Voice Call

Use the Transfer Call option in a media script to transfer a call elsewhere (either internally or
externally to the system). Typically used by an IF statement, such as diverting the call to another
department if it is not handled by the contact center.
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The telephone number entered in Transfer Number should contain numeric characters only, with
no gaps.

Web Request
Input type: Email, Chat

Use a Web Request option in a media script to send a GET or POST request to a web service.

Field Description

Method Either a GET or POST.

Request URI The request URI of the web service.

Content Type Mandatory for POST requests. The format of
the data in the response.

Timeout (Milliseconds) Mandatory for both GET and POST requests.

Http Headers Click + to add key-value pairs to the HTTP
header.

Data The data that you expect to be receive as part
of the response body. The format of the data
depends on the content type.

Variable Name A predefined variable through which to access
the response.

WhatsApp Template Reply
Input type: WhatsApp
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Use the WhatsApp Template Reply option in a media script to send automated replies to the caller.
Automated replies are configured using the templates created on the Media Management >
WhatsApp Content Templates page.

Only approved templates are available for selection.

Field Description

Template Select from the list of approved templates.

Language Select the language variant for the template.
Only approved language variants are listed.

Parameter Shows the placeholder(s) from the template, 1,
2, 3 and so on.

Value Enter the static text or the name of the variable.

Type Enter the data type of the value or whether it is
a variable.

While
Input type: Email, Chat, Voice Call, Social Media

Use the WHILE option in a media script to build a WHILE statement using:
• System variables (see Media scripts and system variables)
• Variables declared using the Add Variable option

When you add a WHILE condition to a script, subsequent child options are placed beneath it
which are only carried out whilst the WHILE condition continues to be met.

To build a WHILE statement:

1. To remove an unwanted, existing condition, click Clear.
2. Select the variable to be evaluated from the WHILE list.
3. Select the operator.
4. Enter the comparison. The comparison is case sensitive and you may need to specify the data

type of the value.
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5.
Click  to add the condition to the Condition box. You can edit the condition here.

6. Optional. You can build more complex statements by using the AND or OR operators:
a. Enter a second condition.
b. Select either the AND or OR operator.
c.

Click  to extend the existing condition.

Entities for use in media scripts
You can create entities for storing the data required for use in media scripts, in outbound dialer
campaigns, for use with Report Designer and in CE Studio apps. These are SQL tables where the
data, for example, might be preloaded for use by scripts, or created, updated and deleted by the
running scripts. Entities can also be used in Report Designer when configuring custom reports.

There are actions in the Media Script Editor for:
• Searching entities: Search Data Table
• Inserting a record: Data Insert
• Updating a record: Data Update
• Deleting a record: Data Delete

Entities are specific to a contact center unit.

Note  Entities are not currently supported by CE Studio Designer.

Creating custom entities

You can either create custom entities by importing the XML that defines the SQL table or you can
create them in the Admin Portal by going to the Studio > Custom Entities page.

To obtain the correct XML format for the import, create a test entity and then export it. Use the
XML output as a template.

Note  When viewing entities, the column heading defaults to its internal name. For example,
a staffno column is displayed as {{staffno}}. To see a display name instead, add a label on
Studio > Message Store page. The label is automatically used if the message id matches the
column name.

Viewing the data

To view the entity data, go to the Studio > Manage Data page. Select the entity and then click
Data.
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If necessary, you can add, edit or delete individual records. However, it is good practice to export
the data, amend it and then re-import it. This reduces the likelihood of a subsequent data import
overwriting your manual updates. Note also that using the Restore Data option may overwrite your
manual updates.

Note  In order to avoid errors, you need to understand the structure of the SQL tables. For
example, whether there is a restriction on the number of characters allowed in a field, whether
a field is mandatory, or if it is a unique field.

Importing data

You can import the data from a CSV file. The previous version of the data is automatically
archived.

Import option Description

Append Inserts all the records from the import file into
the table. An error is reported if any existing
records in the table are also in the import file.

Replace Overwrites existing records and inserts any
new records from the import file.

Update Before the import, you select the column that
uniquely identifies each record. The import then
updates the data in existing records—this will
not insert new records.

Note  This will not report on the number of
updated records.

• On a successful append or replace, the number of records are reported:

• Any errors are reported. The import is terminated if any errors are detected:
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Deleting records

You can delete single records:
• Go to Studio > Manage Data. Select the entity and then click Data to list the records.
Or, you can delete all the records that match a SQL query:
• Go to Studio > Delete Data. Select the entity and enter the query in the Data Filter field.

Before deleting, review the results of the query by clicking View. Click Delete All to delete all
the records returned by the query.

Archiving and restoring records

When you import records into an entity, CE automatically archives the existing records before
importing the new or updated records. You can restore the previous version if required. However,
when deciding whether to restore the previous version, consider whether there were any manual
changes to the data since the import as these changes will not be in the archived version. Prior to
restoring, and as a backup, you could export the existing records.

To see the entity and its data, or to restore the data to a point in time:
1. Go to Studio > Restore Data.
2. Select the entity.
3. Select the date—dates are in UTC format.
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12
Configuring custom workflows

Important  The information in this section applies to fully-featured tenants only.

In the Admin Portal, you can configure workflow definitions to handle:

• Call backs or ring backs. This is when a caller phones the contact center, is added to the queue
and then hangs up before they are connected to an agent. A call back work object is generated
and then presented to the agent who will dial the caller manually. The workflow definition
defines what information is captured and when the call is presented to the agent.

• Campaign dialing. For background information on the different types of dialer campaigns, see
Outbound campaigns.

• Any custom task that will be presented to an agent working in Agent Desktop. Typically, these
are handled by agents working in Do Not Disturb mode.

In Agent Desktop, work objects are presented to agents as activations. A CE Studio app is
required as the default workflow media app, and this is used to show the details of the work object.
The app is loaded when the work object is presented.

You can download some example workflow definitions from the Knowledge Base.

About states, events, actions and locks
A workflow definition defines:
• The data required for the configured task, for example, for dialing a phone number. These are

the work elements.
• The sequence of states, events and actions that determine how the call is dialed and what

happens if the call is unsuccessful.

A work object is the task that will run, for example, the call that is dialed and then presented to an
agent. Locks are used to synchronize write access.
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States

A work object is always in one state at a time and transitions between states occur as the result of
a ChangeToState action being executed. The state is either an active state or a completion state.

State name Type of state Notes

S_START Active state Further processing is required
—you can add the active
states needed in the workflow

S_COMPLETE Successful completion state No automatic processing will
occur unless done manually by
the agent

S_CANCEL Successful completion state No further processing required

user defined Failed completion state You can add these states
depending on what is required
for the workflow

Events

To progress a work object, you define work events. Events are generated by a script or
automatically in response to a timeout expiring (timed events). Actions run in response to the work
event and change the state of the work object. For example, if a supervisor cancels a work object
from a CE Studio application then an E_CANCEL event could be sent.

There are several event types:
• Normal – the actions to perform when the event happens.
• State Change – the next state to go to when this event happens and no further processing is

required.

You can use these predefined system states:
• OnEnterState – on entering a state
• OnLeaveState – on leaving a state, for example, to validate the current state. Do not use with

State Change.
• OnLockExpired – when the write lock on the work object is released
Events are specific to each workflow definition.

Actions

The action that runs when a work object in a specific state receives a work event. The actions run
in the order in which they are listed on the Workflow Actions page of the workflow. This means that
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an action for the start state that saves information in the work object (the ApplyUpdates action)
must run before the action that changes the work object to the next state.

You can use these actions:

Work actions

Action Description

ChangeToState Changes the state of the work object when an event is triggered or
when a timer expires.

For example, when a cancel event is triggered by an agent clicking a
button in a CE Studio app, the state changes from a Start state to a
Cancelled state.

FireTimedEvent Starts a timer that expires after:

• A fixed period, such 2h for 2 hours, 180m for 180 minutes.
• A value in a work element. Prefix the work element name with @,

such as @ringback_time.

Defaults to seconds.

CancelTimedEvent Cancel a timed event for the work object.

CancelAllTimedEvents Cancel all timed events for the work object. For example, completed
events should run this work action.

SetWorkColour Predefined action that sets the colors of work objects.

LaunchScript Add the work object to the queue for an agent working in Agent
Desktop. Additional parameters let you override the default skillset and
priority. Select a coverage plan to determine the hours when the work
object can be added to the queue. See LaunchScript work action.

Run Queue
Progression Script

Run a queue progression script, for example, to dial an automated
outbound call. See Configuring automated outbound calls.

ApplyUpdates Use this when you need to store data in the work object. For example,
when agents enter information into a field that is associated with a work
element.

Note  Use this when you are not using a queue progression script.
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Action Description

RunScriptlet For conditional logic, or any action for which there isn't a predefined
action type, you can write a JSscript or VBscript. For details of the
RunScriptlet action and its methods, see RunScriptlet methods.

Invoke Provider Action To send a request to the endpoint that's configured in CE Studio but
only for static text. As an alternative use the RunScriptlet work action.

The action parameters are:

• Action ID: Select the name of the global action set configured in CE
Studio.

• Response Properties as JSON. Only required if the action returns
data otherwise [""].

• Placeholder Mapping as JSON. You can also use this to map
to a variable(s) defined by the RunScriptlet action, for example
@Placeholder_Mapping. See Invoke provider action for an example.

Note  You can download an example workflow definition that
shows how to use the Invoke Provider Action to create records at
the provider from the samples page in the webhelp.

CancelLaunchScript Remove the work object from the queue.

UpdateLaunchScript Change, for example, the priority or skillset for the work object without
changing its position in the queue.

SendEmail Send an email to email addresses that are passed in work elements. To
reference a work element, prefix the work element name with @.

Note  Do not use the Status Update Event and Reply Event
options. These will be removed in a future release.

SendSMS Send an SMS message to mobile numbers that are passed in a work
element. To reference the work element, prefix the work element name
with @.

Locks

Locks are used to synchronize access to work objects. For example:
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1. A new work object is in its start state. The system locks the work object and queues an
OnEnterState event for processing the work object.

The work object is listed on the Work Objects page as Locked/Open.
2. The system looks for any actions configured for the start state and runs them. After running the

actions, the system releases the lock. Locks also expire automatically after a configured period
(such as the Work Editor Max Lock Time set in the workflow definition).

The work object is shown as Not Open.

The same applies when work objects are added to the queue for an agent. The iMedia server
obtains a lock on the work object before presenting the work object to an agent as an activation.
When the agent accepts the activation, the lock is passed to the CE Studio app. When the agent
completes their work, for example, completes an outbound call then the CE Studio action releases
the lock as part of closing or updating the work object.

Example workflow for call backs
This is an example of a workflow for call backs.

Note  You can download the workflow definition used in this example from the Knowledge
Base.

When a caller hangs up after waiting in the queue for an agent, a call back work object is created
which will schedule a call back. When the timer expires, the E_POP event is fired and the call back
is added to the queue to eventually present to an agent. Agents use a CE Studio app to cancel
the call back, retry it (if the number is engaged when the agent calls) and wrap up when the call is
completed successfully.
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Example of the events, states and actions in a call back workflow

This example has these states:

State name Notes

S_START An active state

S_COMPLETE A successful completion state

S_CANCEL A successful completion state

Note  This example doesn't have a failed state.

The example uses these events:

Event name Event type Notes

E_CANCEL State change Triggered by a CE Studio app when the agent
cancels the call back.
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Event name Event type Notes

E_POP Normal Triggered by the system. Runs action to add to
queue.

E_COMPLETE Normal Triggered by a CE Studio app when the agent
completes the call back.

E_RETRY Normal Triggered by a CE Studio app when, for
example the agent can't make the call and
reschedules it.

OnEnterState Predefined Triggered by system creating the work object.

The example uses these actions:

State Work event or timer Work action Notes

S_START OnEnterState FireTimedEvent
(E_POP)

Starts timer

S_START E_POP LaunchScript Adds to queue

S_START E_COMPLETE ChangeToState
(S_COMPLETE)

Sets work object to
complete

S_START E_RETRY CancelLaunchScript Removes from queue

S_START E_RETRY FireTimedEvent
(E_POP)

Starts timer again

List of work element names for standard call backs
For standard call backs, there are fixed names for the work elements that are automatically saved
by IFS Customer Engagement.

If you want IFS Customer Engagement to generate the work objects for you then you must use the
work elements listed here. If you want to use different names or you require other work elements
then you will need to generate call backs as part of an IVR script.

Work element name Description

W_CALL_ID Use this if you need to link to the actual call
record.
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Work element name Description

W_CALL_REF Use this to provide a 8-character call reference
that could, for example, be used in a CE Studio
app as a tracking reference.

This is not the same as the GUID that uniquely
identifies each activation.

W_QUEUE_DURATION Time in the queue before the call back is
created.

W_CLI The number the user is calling from.

W_DDI The inbound number dialed by the user.

W_QUEUE_SKILLSET_ID The GUID for the skillset.

W_QUEUE_SKILLSET_NAME The skillset name.

Workflows for automated outbound calls
There is an example of a workflow and queue progression script for making automated phone
calls using a media script. You can download this example from the Knowledge Base.

Purpose of the workflow definition

When a work object is created from a workflow definition, the service will:

1. Run the LaunchScript action of the workflow definition. This runs a queue progression
script which dials the call and manages the call, for example, what happens when the call is
answered, unanswered or the line is engaged.

2. When the call is answered, the script could, as in this example, play a pre-recorded message
and then disconnect. However, it could also offer a menu with a range of self-service options.

What happens when the outbound call is made is controlled entirely by the media script that you
configure. You create this type of script on the Media Management > Media Queue Progression
page.

For details of how to configure this type of media script for outbound calls, see Configuring
automated outbound calls.

Creating the work objects (planned calls)

You create work objects from the example workflow definition in different ways:
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• You can import the work objects, from an Excel file, on the Workflows > Import Work Objects
page.

• Use the Tenant API to create the work objects programmatically from a third-party system.
• Agents working in Agent Desktop can create work objects using a CE Studio app (that you

create).

About the example workflow definition

This example has these states:

State name Notes

S_START_DIALOUT An active state for newly created work objects

S_COMPLETE_DIALOUT A successful completion state

S_CANCEL_DIALOUT A successful completion state

Note  Other states would be required in a production example, such as a failed state.

The example definition uses these events:

Event name Event type Notes

E_CANCEL Configurable Triggered by a Post Work Event in the media
script posting a work event to the work object.
Changes the state to canceled.

E_COMPLETE Configurable Triggered by a Post Work Event in the media
script posting a work event to the work object.
Changes the state to completed.

OnEnterState Predefined Triggered by system when you create the work
object.

E_POP Configurable Triggered by the system (the FiredTimedEvent
action).

The example uses these actions:
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State Work event Work action Notes

S_START_DIALOUT OnEnterState LaunchScript On entering this state,
system triggers the
associated media
script to run.

S_START_DIALOUT E_COMPLETE ChangeToState
(S_COMPLETE_DIALOUT)

Sets work object to
complete

S_CANCEL_DIALOUT E_CANCEL ChangeToState
(S_CANCEL_DIALOUT)

Sets work object to
canceled

Example workflow for campaigns
This is an example of a more complex workflow for campaign dialing.

Note  You can download the workflow definition used in this example from the Samples page
in the Admin Portal webhelp.
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Example events and states in a campaign dialer workflow

This example has these states:

State name Notes

S_START An active state

S_COMPLETED A successful completion state

S_CANCELLED A cancelled/failed state for outbound calls that
were dialed but where the call is unsuccessful,
for example, wrong number.

S_RESCHEDULED A normal intermediate state where the callee
asked to be called another time.
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State name Notes

S_FAILED A cancelled/failed state, for example, the line
was engaged.

The example uses these events:

Event name Event type Notes

OnEnterState Predefined Triggered by system creating the work object.
Runs action to add to queue.

E_CANCEL Normal Triggered by a CE Studio app when the agent
cancels the call.

E_RESCHEDULE_CALL Normal Triggered by a CE Studio app when, for
example the agent reschedules the call at the
callee's request.

E_CALL_COMPLETED Normal Triggered by a CE Studio app when the agent
completes the call successfully.

E_CALLER_RANG_OFF Normal Triggered when the callee answers the call and
then disconnects before being connected to an
agent.

E_RETRY Normal The system tried to connect the call but failed. It
will try again for the configured number of retry
attempts.

E_CONTACT_TIMEOUT Normal The system tried to contact the callee on the
given number but was unable to make contact
within the configured time period.

E_CALL_NOT_ANSWEREDNormal The system dialed the number but no one
answered.

E_CALL_ABANDONED Normal The definition of an abandoned call depends on
the local regulations. In the UK, an abandoned
call is defined as one where the callee
answered but the system did not connect the
call to an agent quickly enough. UK regulations
set a limit on the number of abandoned calls
permitted within a 24-hour period.
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Note  Events are defined as normal event type because separate actions are configured that
perform the state change.

The example uses these actions:

State Work event or timer Work action

S_START OnEnterState SetWorkColour, RunScriptlet (gets the
data for making the call and adds the
work object to the queue)

E_CALL_COMPLETED ApplyUpdates,
ChangeToState(S_COMPLETED)

E_CALL_ABANDONED RunScriplet

E_RETRY RunScriplet (gets the data for redialing
the call and adds the work object to the
queue)

E_CONTACT_TIMEOUT RunScriplet (determines if there is
another number to try else changes
state to S_FAILED)

E_RESCHEDULE_CALL ApplyUpdates, RunScriplet (gets the
data for making the scheduled call and
adds the work object to the queue)

E_CALL_FAILED ApplyUpdates, RunScriplet (determines
if there is another number to try else
changes state to S_FAILED)

E_CANCEL ApplyUpdates,
ChangeToState(S_CANCELLED)

E_CALL_NOT_ANSWERED RunScriplet (removes the work object
from the queue and increments the retry
counter. The call will be tried again after
the configured retry interval.)

E_CALLER_RANG_OFF Similar to E_CALL_NOT_ANSWERED

S_COMPLETED OnEnterState SetWorkColour, RunScriptlet (updates
the log)
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State Work event or timer Work action

S_CANCELLED OnEnterState SetWorkColour, RunScriptlet (updates
the log)

S_RESCHEDULED Similar to S_START Similar to S_START

S_FAILED OnEnterState SetWorkColour, RunScriptlet (updates
the log)

Creating a workflow definition

Note  For background information on workflows, states, events and actions, see About states,
events, actions and locks.

1. In the Admin Portal, go to Workflow Management > Workflows.
2. Click New.
3. Select the contact center and contact center unit.
4. Enter the details of the workflow:

Field Description

Name The name of the workflow definition.

Description A description to help others who might need to modify the
workflow.

Work Noun A suffix that is added to internal names.

Work Editor Max Lock Time Work objects are locked once agents accepts them. Only
the agent who accepts the work object can update the
details although other agents can still see the details if
they want.

Enter the maximum number of minutes the agent has
to complete their work before the write lock is removed
and the work object returned to the queue. It should be
sufficient time for the agent to make the phone call and
complete any other required steps.

CE Admin Portal Guide - Configuring custom workflows | 277



IFS Customer Engagement 25R1 GA

Field Description

Cancel Event You need to create a cancel event before you can select
it here. Once you've created a cancel event, you can edit
the workflow definition to add the cancel event.

Important  A cancel event is mandatory for all
workflow definitions.

Date and Time are in UTC This applies to dates supplied by the agent application
(such as a queue progression script) where imported
dates may not be in a UTC format. Select this option to
avoid ambiguity with datetimes.

Campaign Definition Select this if configuring a workflow definition for a dialer
campaign. You will then need to configure some additional
event types used in a campaign as explained in Event
types for campaign workflow definitions.

Add work elements

To add work elements to the work definition:

1. In the Admin Portal, go to Workflow Management > Workflows.
2. Select the work definition.
3. Go to the Work Elements section and define the work elements required by the workflow. Enter

the first work element in the Work Elements table (click Add Element to add more rows to the
table):
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Field Description

Name A name for internal use in the workflow definition and later
when configuring the CE Studio app.

Note  To reference this work element when
configuring work actions you prefix a @to the work
element name.

Call Backs Only: Standard work element names are
available for call back workflows:

• If you want CE to automatically generate the work
object for you (rather than configure this step as part of
the IVR script) then you need to use the standard work
element names. See List of work element names for
standard call backs.

• If you are planning to use an IVR script to generate the
work object then you can name the work elements as
you want.

Description A description to help others who might need to modify the
workflow.

Searchable The data is stored as JSON in one column of the
database. To search for a specific work object, for
example to cancel it, you need to specify the element(s)
you want to search by. You can only search for work
elements that are configured as Searchable.

Work elements are also searchable when configuring
reports in Report Designers, and CE Studio actions.

Add events

1. In the Admin Portal, go to Workflow Management > Workflows.
2. Select the work definition and then click More > Event.
3. Define the first event in the workflow: on the Workflow Events tab, click New. Repeat this for

each required event.
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Important  You must define a cancel event for all workflow definitions. To refresh the list of
events on the Workflows page, right-click on the Workflow Detail page and select Refresh
Tab from the popup menu.

Field Description

Name The event name. By convention, starting with E_

Description A description to help others who might need to modify the
workflow.

Work Event Type Configure events that:
• Run actions as the Normal event type. Only this type

of event is available when configuring actions.
• Perform a state change as the State Change event

type.

State For events that perform a state change, select the state to
change to.

Note  After defining the events, go back and update your workflow definition. You may
need to refresh the page before you see the list of events.

Add actions

1. In the Admin Portal, go to Workflow Management > Workflows.
2. Select the work definition and then click More > Action.
3. Define the first action for the workflow: on the Workflow Actions tab, click New. Repeat this

for each required action.

Field Description

Work State Select the state. The work object must be in this state
before the action can run. For example, choose the start
state if the action runs when the work object is in its start
state.

You can define multiple actions for the same state - they
will run in the order in which they are listed.

Further settings depend on the chosen state.
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Field Description

Work Event/Timer Select the event. Only normalevent types are listed here.
The action runs in response to this event. See About
states, events, actions and locks for a list of event types.

Work Action Select the action to run. See About states, events, actions
and locks for a list of action types.

Action Parameters The parameters depend on the chosen action. For
example, if you choose LaunchScript then you can
optionally set:
• lock text (the reason why the work object is locked)
• work element to a static value (select from the element

Queue Priority list) or enter the work element name
prefixed with a @.

• queue priority to a numeric value
• skillset to a specific skillset
• coverage plan if different from the coverage plan set for

the work definition or the contact center itself
• timezone

See LaunchScript work action for details.

Note  To make it easier to read the Workflow Action List on the left, only the first or top
most action for an event is shown with a state name and event. To change the running
order of the actions within an event, click Move Up or Move Down.
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Event types for campaign workflow definitions
This topic describes the additional event types that are needed in workflow definitions for
campaigns. As a minimum, you will need to configure the Cancel Event, Failed Call Event and
possibly the Abandoned Call Event.

Note  You can download an example of a workflow definition for campaigns from the
Knowledge Base.

Event Type Description

Failed Call Event Triggered when a call fails, for example, the line was
engaged.

Note  If multiple destination numbers are specified then
this event will only relate to one of those numbers.

Unanswered Call Event Triggered when the target does not answer the call within
the ring timeout period.

Abandoned Call Event Typically, you do not need to configure this event if your
campaign uses automatic answering.

Note  In the UK, an abandoned call is defined as one
where the callee answered the call but the system did
not connect the call to an agent quickly enough. UK
regulations set a limit on the number of abandoned
calls permitted within a 24-hour period.

Disconnected Call Event Triggered when the callee answers the call and then
disconnects before being connected to an agent.

For details of the cancel event, see Creating a workflow definition.

Testing workflow definitions
To help with the development of workflow definitions, you can create work objects and then test
the events and actions configured in the defnition.
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Note  To receive debug emails for work objects, in the Admin Portal, go to Contact Center >
Contact Centers page and add your email address in the Main Contact Email and Support
Email fields.

Create a work object

Important  If you are creating work objects for testing campaigns then you need to use the
Workflow Management > Create Campaign Data page.

You can create work objects for test purposes on these pages , in the Admin Portal:

• The Workflow Management > Work Objects page (click New).
• The Workflow Management > Create Workflow Object page.
• For campaigns, on the Workflow Management > Create Campaign Data page.

Edit a work object or view its details

1. Search for the work object, for example by workflow definition, date and/or reference.
2. Select the work object from the Workflow Object list and click Edit.
3. To view the events, click Event History. Only the events configured in the definition are

selectable from the Event list - system events such as OnEnterState and OnLockExpired are
always listed in the table.

4. To edit the values in the work elements, lock the work object: in Lock with Reason, enter a
descriptive name for the lock.

5. Edit the values and then click Save.

Test the events and state changes configured in a workflow definition

Note  You cannot always test events and actions that are scripted using RunScriptlet methods
as the events and actions may require values configured in the script.

1. In the Admin Portal, on the Workflow Management > Work Objects page, find the new work
object and then click Edit.

2. To test an event configured in the workflow definition:
a. In Lock with Reason, enter a descriptive name for the lock.
b. Click Lock to acquire a lock on the work object.
c. Select the event you want to test from the Fire Event list.
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You can only test the custom events configured in the workflow definition, you cannot
directly test the system events such as OnEnterState.

d. Click Fire to trigger the event.

The system will then perform any actions and state changes configured for the event.
3. To test a state change configured in the workflow definition

a. Lock the work object as described in the previous step.
b. Select the state from the Change State list.
c. Click Change to perform the state change.

Fixing OnEnterState errors

When testing a workflow definition that you are developing, it is possible to create work objects
that the system cannot change to the start state. To fix this:

1. On the Work Objects page, select the work object from the Workflow Object list and click Edit.
2. Click Initialize to move the work object to its start state.

Disabling work objects

When testing a workflow definition that you are developing, you should always configure a cancel
event. This enables you to cancel a work object when necessary using the steps described above
in Test the events and state changes configured in a workflow definition.

If you do not have a cancel event, then you can select the work object on the Work Objects page
and click Disable.

LaunchScript work action
The LaunchScript work action defines:
• How the generated work objects are added to the queue for an agent (the Add to Operator

type)
• For campaigns, whether the phone number in the work object is dialed before presenting the

call to an agent.
• Whether the incoming call is processed using a queue progression script (the Media Script

type).

Depending on the type, you can configure any of the following:
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Field Description

Launch The type of action to run:
• To Operator: select this to create work objects from this

work definition that will be presented to agents working in
Agent Desktop. Select the CE Studio app to use from the
Agent Media App list.

• Media Script: select this to process the inbound call using
a queue progression script. Select the queue progression
script to use. For background information, see How to
configure standalone media scripts for voice.

Queue Progression The queue progression script to use for work objects that are
processed automatically. If the script is configured to pass
the work object to an agent then you can also select the CE
Studio app to use from the Agent Media App list.

Agent Media App If the work object is handled by agents working in Agent
Desktop then select the CE Studio app to use. Only media
apps with a live version are listed here.

Tag Short application-specific string (maximum 30 characters)
to be passed through to the script as a WORK_TAG URI
parameter.

Lock Text Brief description of the action the agent is expected to
perform. This description is used when locking the work
object and will therefore be visible to other agents who
attempt to lock the work object whilst it is still being worked
on by the agent.

Queue Priority Select one of the following:
• Numeric Value and then select from the adjacent list.

• Select Default to use the default queue priority for the
contact center unit.

• Select an adjustment that will be applied to the default
queue priority, for example +1 will increase the default
priority by 1.

• The work element that will define the queue priority. This
means that the priority is determined by the work object.

For background information on queue priority, see Setting
default activation priorities.
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Field Description

Processing Timeout The number of seconds to allow for the system to execute
the work object before setting it to Not Open status. To
investigate why a work object was not processed:
1. Go to Workflow Management > Work Objects.
2. Find the work object and then click Edit.
3. Click Event History.

Preferred Agent Delay Queue delay (in seconds) for waiting for an agent with one or
more preferred skills to become available before the object
is delivered to an available agent with only the required/
mandatory skills (that is without a preferred skill). Leave
blank (or enter 0) to use of the default preferred agent delay
that is configured for the contact center unit.

Skillset Select one of the following:

• Use Default to use the default skillset set in the campaign.
• A skillset configured for this contact center unit.
• Custom Element to use the skillset defined in the work

object.

For background information on skillsets, see Skills and skills-
based routing.

Coverage Plan For background information on coverage plans, see Public
holidays and open hours.

Timezone Defines the default time zone for this workflow definition.

Greeting For campaigns only: The text shown to the agent before the
call is presented to them.
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Field Description

Mode For campaigns only: the dialing mode:

• Preview: the number(s) in the work object are not dialed.
Work objects present as workflows in Agent Desktop using
the CE Studio app associated with the workflow media
type.

• Progressive: the number(s) in the work object are dialed
automatically. Work objects present as campaign calls in
Agent Desktop using the CE Studio app associated with
the workflow media type.

• Predictive: the number(s) in the work object are dialed
automatically. Work objects present as campaign calls in
Agent Desktop using the CE Studio app associated with
the workflow media type.

If the workflow definition and the campaign are configured for
different dialing modes then the campaign will use the lowest
mode where
1. Preview is the lowest
2. Progressive
3. Predictive is the highest

For example, if the campaign is configured for Preview mode
and the definition is configured for Progressive dialing then
the actual campaign will use Preview mode.
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Field Description

Destination Number For campaigns only and media scripts: You can enter any
of the following:
• Phone number(s)
• One work element prefixed with @ - multiple work

elements are not supported

For campaigns only: You can enter multiple numbers
either in the Destination Number field or inside the work
element, such as +441926623509,+4419854324711;
+447968093280).

If multiple numbers are specified, then the numbers can be
attempted in sequence or in parallel:

• For sequential dialing, use a comma as the separator. This
means that the first number is called and, if that fails, then
next one, and so on.

• For parallel dialing, use a semi-colon as a separator. This
means that all the numbers are dialed simultaneously and,
then depending on which number is answered first, hangs
up the other calls.

Important  If multiple sets of numbers are specified
then all of the numbers must relate to the same callee
otherwise this would contravene some dialer regulations
such as those in the UK.

Caller ID For campaigns only: Sets the default caller ID for any
campaign that uses this workflow definition. This overrides
any caller ID set elsewhere. For further details of caller IDs,
see Creating campaigns (preview dialing).

Ring Timeout For campaigns only: Maximum time (in seconds) to wait
for calls to be answered before automatically disconnecting.
Enter 0 to use the default campaign ring timeout; otherwise
the system will ensure that the timeout used is not smaller
than the minimum campaign ring timeout (to ensure
compliance with dialer regulations).
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Field Description

App Data For campaigns only: Optional application-specific 50-
character string (such as a reference) to stored in all the
outbound call records associated with this request.

RunScriptlet methods
The RunScriptlet action allows one or more JavaScript or VBScript statements to be executed.
The script can contain any valid statement (including functions/subroutines) as supported by the
script engine and can interact with the workflow engine by means of the host object.

Note  Unlike script embedded in a HTML page, you cannot access browser-based objects
(such as document or window) because the script is hosted by the workflow engine and not
a web browser.

For example, in a dialer campaign, to redial a number three times before giving up.

var number = '';
var num1 = host.GetObjectElement("MobilePhone");
var num2 = host.GetObjectElement("WorkPhone");
var skillset = ''
if (num1 != '')
  number = num1;  
if (num2 != '')
  number = (number == '') ? num2 : number + ','+ num2;
if (number=='')
  host.ChangeToState("S_CANCEL_DIALER");
else {
  host.PopToAgentEx(2, 0, "", 0, "", 60, 
        "Dialling...", "", skillset, 0, 0, "", 
        2, number, "", 0, name);
}

For further scriptlet examples, see the IFS CE Example Campaign Workflow Definition. You can
download this from the Knowledge Base.

Add to Queue
Use the PopToAgent and PopToAgentEx RunScriptlet methods both add work objects
to the queue - the PopToAgentEx methods takes a wider range of parameters. Use
CancelPopToAgent to remove the work objects without changing their state.
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PopToAgent
The PopToAgent RunScriptlet method adds the work object to the queue for delivery to
a suitably skilled agent. Returns 0 if successful or a negative number if an error occurs.
Performs the same action as the LaunchScript work action.

PopToAgent[in] 
int queuePriorityDelta, 
[in] ULONG nPrefOprDelay, 
[in] BSTR sScript, 
[in] ULONG nScriptPage, 
[in] BSTR sScriptTag, 
[in] ULONG nLockTimeout, 
[in] BSTR sLockText, 
[in] BSTR sOcu, 
[in] BSTR sSkillset, 
[out,retval] LONG* pResult

Parameters:
• queuePriorityDelta: Relative queue priority between -5 and +5. 0 will use the default

workflow priority for the current contact center unit. A positive number increases the default
priority accordingly and a negative number decreases it. The actual queue priority is limited
to the range 1..9 where 9 is the highest possible level.

• nPrefOprDelay: Queue delay (in seconds) for waiting for an agent with one or more
preferred skills (if applicable) to become available before the object is delivered to an
available agent with only the required/mandatory skills that is without a preferred skill). A
value of 0 will result in the use of the default preferred agent delay that is configured for the
contact center unit.

• sScript: not used
• nScriptPage: not used
• sScriptTag: Short application-specific string (max 30 characters) to be passed through to

the script as a WORK_TAG URI parameter.
• nLockTimeout: Timeout (in minutes) to use when locking the work object before delivering

it to an agent. This value should be set as low as possible, but it must also be large enough
to cater for the longest amount of time that an agent can reasonably spend dealing with the
work object.

• sLockText: Brief description of the action the agent is expected to perform. This description
is used when locking the work object and will therefore be visible to other agents/users who
attempt to lock the work object whilst it is still being worked on by the agent.

• sOcu: Unique id or name of a specific contact center at which the work object should be
queued, otherwise the object will be queued at all the contact centers that have been given
access to the contact center unit.
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• sSkillset: Id or name of a skillset to use when queuing the work object, otherwise the
default skillset that is configured for the contact center unit is used.

CancelPopToAgent
Cancels any outstanding LaunchScript action without necessitating a state change.

PopToAgentEx

For example:

host.PopToAgentEx(0, 0, "", 0, "MakeInitialContact", 30, 
"Making initial contact...", "", skillset, "coveragePlan", 
0, greeting, mode, numbers, "", 20, "name");

PopToAgentEx[in] int queuePriorityDelta, 
[in] ULONG nPrefOprDelay, 
[in] BSTR sScript, 
[in] ULONG nScriptPage, 
[in] BSTR sScriptTag, 
[in] ULONG nLockTimeout, 
[in] BSTR sLockText, 
[in] BSTR sOcu, 
[in] BSTR sSkillset, 
[in] ULONG coveragePlan, 
[in] ULONG timezone, 
[in] BSTR sGreeting, 
[in] ULONG mode, 
[in] BSTR sNumber, 
[in] BSTR sCLI, 
[in] ULONG ringTimeout, 
[in] BSTR sAssocAppData, 
[out,retval] LONG* pResult

Performs the same action as the LaunchScript work action. It adds the work object to the
queue for delivery to a suitably skilled agent. Returns 0 if successful or a negative number if an
error occurs.

• queuePriorityDelta: Relative queue priority between -5 and +5. 0 will use the default
workflow priority for the contact center unit. A positive number increases the default priority
accordingly and a negative number decreases it. The actual queue priority is limited to the
range 1..9 where 9 is the highest possible level.

• nPrefOprDelay: Queue delay (in seconds) for waiting for an agent with one or more
preferred skills to become available before the object is delivered to an available agent with
only the required/mandatory skills that is without a preferred skill). Enter 0 to use the default
preferred operator delay that is configured for the contact center unit.

• sScript: not used.
• nScriptPage: not used.
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• sScriptTag: Short application specific string (max 30 characters) to be passed through to
the script as a WORK_TAG URI parameter.

• nLockTimeout: Timeout (in minutes) to use when locking the work object before delivering
it to an agent. Set this value as low as possible, but it must also be large enough to cater
for the longest amount of time that an agent can reasonably spend dealing with the work
object.

• sLockText: Brief description of the action the agent is expected to perform. This description
is used when locking the work object and will therefore be visible to other agents who
attempt to lock the work object whilst it is still being worked on by the agent.

• sOcu: Unique id or name of a specific contact center at which the work object is queued,
otherwise the object is queued at all the contact centers that have access to the contact
center unit.

• sSkillset: Id or name of skillset to use when queuing the work object, otherwise the default
skillset configured for the contact center unit is used.

• coveragePlan: coverage plan that defines the times-of-day that the object can be queued.
Enter "0" to use the default coverage plan for the campaign or contact center unit instead.

• timezone: timezone to use in conjunction with the coverage plan to determine the times-of-
day that the object can be added to the queue. Enter 0 to use the default timezone for the
campaign or contact center unit instead.

• sGreeting: Greeting text to be displayed in a pop-up window in Agent Desktop for cases
where the agent might be connected to a live call before the CE Studio app has completed
loading (such as campaign outbound calls in progressive or predictive mode). If a blank
string is supplied, then the default greeting text for the contact center unit will be used
instead.

• mode: Requested campaign dial mode: 0=Preview, 1=Progressive, 2=Predictive. Non-
campaign objects always operate in preview mode. Campaign objects should request the
highest dial mode that is supported or required as the actual dial mode that will be used will
be the lower of that requested by the work objects and that configured for the campaign.
See also About the dialing modes.

• sNumber: Destination number(s) to dial. If multiple numbers are supplied, they need to be
separated by either a comma or a semi-colon. In the progressive and predictive dial modes,
the specified number is automatically dialled and only presented to an agent when the call
is answered. For further details, see Destination number.

• sCLI: The caller ID that should be presented for the outbound calls associated with this
request. If blank, the default caller ID associated with the campaign, contact center unit or
agent is used instead.

• ringTimeout: Maximum time (in seconds) to wait for calls to be answered before
automatically disconnecting. Supply 0 to use the default campaign ring timeout; otherwise
the system will ensure that the timeout used is not smaller than the minimum campaign ring
timeout (to ensure compliance with dialer regulations).
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• sAssocAppData: Optional application-specific 50-character string (such as a reference) to
be stored in all the outbound call records associated with this work object.

Work object
RunScriplet methods to get information about a work object:

GetObjectId
GetObjectId[out,retval] BSTR* pResult

Returns the work object’s unique identifier (guid).

GetObjectReference
GetObjectReference[out,retval] BSTR* pResult

Returns the work object’s alphanumeric reference string.

Work object color
RunScriplet method to set the color of a work object, for example, on a state change.

SetObjectColour
SetObjectColour [in] BSTR strColour

Performs the same function as the SetWorkColour work action. It updates the object’s display
color to the value specified by strColour:
• BLUE
• GREEN
• ORANGE
• PURPLE
• RED
• WHITE
• YELLOW

Work object element
RunScriptlet methods to get, set and update the elements in a work object.

GetObjectElement
GetObjectElement [in] BSTR strName, [out,retval] BSTR* pResult

Returns the value of the work object element specified by strName or returns an empty string if
the element is not found.

GetObjectElements
GetObjectElements [out,retval] BSTR* pResult
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Returns a JSON-encoded string containing all the object’s elements, such as:

<RuntimeScript>
          <RuntimeVariable name="W_NUMBER"
                value="07970579339" />
          <RuntimeVariable name="W_TIME"
                value="2011-05-06 12:15" />
   </RuntimeScript>

SetObjectElement
SetObjectElement [in] BSTR strName, [in] BSTR strValue

Sets the value of the work element identified by strName to the contents of strValue. The
updated work elements are saved in the database when the scriptlet completes successfully.

As per UpdateObjectElementsFromEventData, if the element name has a ‘+’ or ‘-‘ suffix,
then the suffix is stripped off and the value specified in strValue is appended or pre-pended
respectively to the object’s existing element value.

UpdateObjectElementsFromEventData

Performs the same function as the ApplyUpdates work action. It saves all the event data
elements in the object’s work elements.

As per the ApplyUpdates work action, if an event data element name has a ‘+’ or a ‘-‘ suffix,
then it is stripped off and the value of the event data elements is appended, or pre-pended
respectively, to the existing value of the corresponding work object element instead of simply
replacing or overwriting it.

The updated work elements are saved in the database when the scriptlet completes
successfully.

Work object timer
RunScriptlet methods to start, stop and query the events used as timers in a workflow definition.

QueryTimerDueTime
QueryTimerDueTime [in] BSTR strIdOrName, [out,retval] BSTR* pResult

Returns the absolute UTC expiry datetime value (in ISO format) for the timer specified by
strIdOrName if it is still pending. It return an empty string if the timer is not pending.

StartObjectTimer
StartObjectTimer [in] BSTR strIdOrName, [in] BSTR strDueTime, [in]

LONG lockTimeout, [out,retval] LONG* pResult

Performs the same function as the FireTimedEvent work action. It starts (or restarts) a timer.
Returns 0 if successful or a negative value if an error occurs.

• strIdOrName: Id or name of the event to fire when the timeout expires.
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• strDueTime: Due time either as an absolute datetime in the form ‘yyyy-mm-dd hh:nn’ or as
a relative time in the form of a series of one or more decimal integers immediately followed
by either ‘m’ for minutes, ‘h’ for hours or ‘d’ for days. For example, a relative delay of one
and a half hours can be represented as 1h30m or simply 90m.

You should always enable the Date and Time are in UTC setting in the work definition so
that dates in the above form are interpreted as UTC times (otherwise you will use the local
time and current timezone on the server).

It is also possible explicitly supply absolute UTC datetimes by replacing the space between
the date and time components with a T, or example yyyy-mm-ddThh:nn.

• lockTimeout: Timeout (in minutes) to use when locking the object after the expiry of the
timer. Enter 0 to allow the system to select a suitable default.

StopObjectTimer
StopObjectTimer [in] BSTR strIdOrName, [out,retval] LONG* pResult

Performs the same function as the CancelTimedEvent work action. It stops or cancels the
timer specified by strIdOrName if necessary.

Returns 0 if successful or a negative number if an error occurs.

StopAllObjectTimers
Performs the same function as the CancelAllTimedEvents work action. It stops or cancels all
active or outstanding timers for the work object.

Work event
RunScriptlet methods to get information about the current event.

GetCurrentEventId
GetCurrentEventId [out,retval] BSTR* pResult

Returns the guid of the current event that is being processed.

GetCurrentEventName
GetCurrentEventName [out,retval] BSTR* pResult

Returns the name of the current event that is being processed.

GetEventElement
GetEventElement [in] BSTR strName, [out,retval] BSTR* pResult

Returns the value of the event data element specified by strName.

GetEventElements
GetEventElements [out,retval] BSTR* pResult
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Returns a JSON-encoded string (as per GetObjectElements) containing all the elements
supplied with the current event. An empty string is returned if the event does not have any
associated data elements.

Note  Currently, only events explicitly queued by custom applications can have associated
data elements.

Work states
RunScriptlet methods to get the current state of a work object and perform a state change.

ChangeToState
ChangeToState [in] BSTR sNewState, [out,retval] LONG* pResult

Performs the same function as the ChangeToState work action. It moves the object to the new
state identified by sNewState after the scriptlet has completed successfully.

Returns 0 if successful or a negative number if an error occurs.

GetCurrentStateId
GetCurrentStateId [out,retval] BSTR* pResult

Returns the guid of the work object’s current state.

GetCurrentStateName
GetCurrentStateName [out,retval] BSTR* pResult

Returns the name of the work object’s current state.

UpdateLaunchScript
RunScriptlet method to update a work object in the queue without changing its state or position in
the queue.

UpdateLaunchScript
UpdateLaunchScript [in] int iQueuePriorityDelta, [in] BSTR sSkillset,

[in] ULONG mode, [in] BSTR sNumber, [out,retval] LONG* pResult

Updates some of the attributes of an outstanding LaunchScript action without needing to
cancel the previous request and issuing a new one. See Add to Queue for a description of the
attributes.

Invoke provider action
A runScriptlet method to invoke a global action configured in CE Studio for a create, read, update
or delete operation:

InvokeProviderAction(action_set, response, placeholderMappings)
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Where:

• action_set is the guid of the global action set configured in CE Studio. Note that when
configuring the global action set, you must pass the primary key - you cannot set the primary
key to be 'Ignored' or 'Use Null'. Get the action set guid from the browser's developer tools:
1. In CE Studio Designer, go the Global Action Sets page.
2. Open the browser's developer tools and refresh the page.
3. In developer tools, go to the Preview tab and, in the Name column, click

GlobalActionSet?=

4. On the right, expand items. items lists the global action sets. Expand each in turn to
locate the global action set you are using. The guid of the action set is the first guid listed.

• response is "[]" for a CREATE method. For a GET method, you would parse the JSON that's
returned.

• placeholderMappings is a JSON blob.

This is an example that creates a new record from the values saved in the work elements:

var contact_sequence = host.GetObjectElement("contact_sequence");
var first_name = host.GetObjectElement("first_name");
var last_name = host.GetObjectElement("last_name");
var company_name = host.GetObjectElement("company_name");
var placeholderMappings = [
{
"Name": "contact_sequence",
"Value": contact_sequence
}, {
"Name": "first_name",
"Value": first_name
}, {
"Name": "last_name",
"Value": last_name
}, {
"Name": "company_name",
"Value": company_name
}
];
var result = host.InvokeProviderAction("A4020710-B373-4E1C-B2FD-
E132CF037CC3", "[]", JSON.stringify(placeholderMappings));

Locks
RunScriptlet method to get the ID of the lock belonging to the current work object.

GetLockId
GetLockId [out,retval] BSTR* pResult

Returns the id of the work lock that is currently in effect for work object.
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Campaign and contact center unit details
RunScriptlet methods to get the details of the contact center unit (referred to as the account) or
campaign.

GetAccountId
GetAccountId [out,retval] BSTR* pResult

Returns the guid of the work object’s contact center unit.

GetAccountNumber
GetAccountNumber [out,retval] BSTR* pResult

Returns the six-digit number of the work object’s contact center unit.

GetAccountName
GetAccountName [out,retval] BSTR* pResult

Returns the name of the work object’s contact center unit.

GetCampaignId
GetCampaignId [out,retval] BSTR* pResult

Returns the unique id of the outbound campaign to which the object belongs or a blank string
for non-campaign objects.

GetCampaignName
GetCampaignName [out,retval] BSTR* pResult

Returns the unique name of the outbound campaign to which the object belongs or a blank
string for non-campaign objects.

Print
RunScriplet method for writing messages to a log.

print
print [in] int level, [in] BSTR strMessage

Writes error or trace messages to the trace message logger for diagnostic purposes.

level : Severity level of the message [1..9]
• 1 = Critical error
• 2 = Error
• 3 = Warning
• 4 = Informational
• 5 = Trace
• 6..9 = Debug

strMessage: Message content
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Outbound campaigns

Important  The information in this section applies to fully-featured tenants only.

You can blend multiple outbound campaigns, inbound and outbound contacts, different dialing
modes and multiple media types to optimize campaign success and agent productivity. This
section explains what's need to run a campaign in the CE Admin Portal and how to set up new
campaigns.

Note  The following features are not currently supported: Answer Machine Detection (AMD),
Live Speaker Detection Mode and forwarding abandoned calls to an IVR system.

Note  An example CE Studio app for campaign dialling is pre-installed on tenants.
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Requirements for running an outbound campaign

Note  It is the responsibility of the contact center to fully understand and comply with
regulations concerning outbound campaigns.

IFS Customer Engagement set defaults that fall within current (UK Ofcom) requirements. It
also allows the prerequisite analysis required when answer machine detection (AMD) is used.

Requirements

Before you can set up a campaign you require:
• A work definition that defines the data needed by agents working on the campaign
• A CE Studio app that will be used by agents when working on the campaign in Agent Desktop

To derive maximum benefit from campaigns in CE, you should design the CE Studio app and work
definition with future campaigns in mind. For example, the design could allow agents to schedule
call back times, even though the first planned campaigns do not include such a feature.

Things to consider at the planning stage

Consider the overall objective of the campaign? Is it to make sales, or to check and update
customer details, or to book appointments? Or a combination of things?
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How is the data compiled? Is there just one telephone number per contact, or multiple ones? Will
the data need cleansing before it can be used by an automated system? For example, having the
following in a Telephone field will not work very well, “01234 567890 but only call in afternoons”.
The data table may need re-designing.

What data needs to be collected from the call? Some data, such as Time of Call, Length of Call,
are recorded as a matter of course (using system variables). But other variables will have to be
defined, for example, a Call Outcome field.

How many call attempts should be made to each contact if the first is a failure, for example the line
is engaged, goes to answer machine?

Should provision be made for the agent to arrange specific call back times? For example,
where the agent reaches the contact but is told they are busy and “to please call back tomorrow
afternoon”. Obviously, this would allow for better customer service. It could be taken further by
ensuring the same agent gets the call: there is continuity for the contact and, in the case of sales,
the agent who made the initial call gets the selling opportunity.

About the dialing modes
You can use all dialing modes concurrently within an individual campaign. Furthermore, the dialing
mode for each campaign can be adjusted in real-time. A brief description of each dialing mode is
given below.

Preview dialing

Once an agent becomes available, information about the call is presented to them. The agent can
review the information and then dial the number(s) manually or, depending on how the CE Studio
app is configured, click a button to dial automatically. When dialing automatically, multiple numbers
can be attempted for the same contact.

Preview mode is suitable where each case is complex, and the agent needs to be aware of
historic information before the call.

Note  In Agent Desktop, preview calls are presented as workflow activations and will use the
CE Studio app associated with the workflow media type.

Progressive dialing

As soon as an agent is available, the number is dialed immediately and the call is presented to the
agent when answered. Call progress is monitored by the dialer technology. Calls that do not result
in ‘ringing’ are automatically and immediately disconnected, whilst ‘no answers’ are disconnected
after a predefined number of seconds.
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As in preview mode, multiple numbers can be automatically attempted for the same contact,
however progressive mode adds the ability to attempt some or all the numbers in parallel.

Software call control minimizes agent involvement in the dialing process and eliminates call pickup
times for unsuccessful calls. Also eliminated is the time agents spend listening to call progress
tones or network announcements. If concurrent dial attempts are made, further efficiency gains
can be made to an agent’s idle time during call setup.

Note  In Agent Desktop, progressively dialed calls are presented as outbound campaign
activations and use the CE Studio app associated with the Outbound Campaign Call media
type.

Predictive dialing

Predictive dialing automatically initiates calls and only presents successful calls to the agent in the
same way as for progressive mode. However, it does not necessarily need to wait for an agent to
become available to do so and it may also concurrently initiate calls to multiple contacts.

The dial rate is automatically and continually adjusted to maximize efficiency whilst complying
with any legislation covering predictive dialers (such as those in the UK and US). The efficiency
gains for predictive mode will typically exceed those of progressive mode as the agent wait and
idle times during the call setup phase are reduced.

Note  In Agent Desktop, predictively dialed calls are presented as outbound campaign
activations and use the CE Studio app associated with the Outbound Campaign Call media
type.

Preparing to run campaigns
Before running a campaign you need to configure the system using the Admin Portal. This
configuration includes:
• Phone number(s). One of these numbers provides the default Caller ID required by the system.
• Nailed-up connection to maximize call efficiency
• User setup suitable for campaign calls
• Adequate queue quota for the number of agents working on the campaign
• Transferable skills and skillsets (optional)
• Custom entities (if you plan to import the call data into a table before using it to generate the

campaign call data)
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• A CE Studio app that will be used in Agent Desktop for the campaign, and a workflow definition
that defines the outbound calls to be made by agents.

Caller ID

A caller ID is required which is set for either the contact center unit, the campaign or the agents
involved in the campaign. It is not possible to dial out using a number that is unknown to the
system.

Note  If you enter a number that is not one of your phone numbers then you will need to
request IFS Services to verify that the number belongs to you.

The caller ID is set:
• For the contact center unit in Media Management > Advanced Settings. This is overridden by

any caller ID set in the campaign.
• In the campaign. This is overridden by any caller ID set for the agent.
• In the agent's user account.

Automated call answering and nailed-up connections

To maximize call efficiency, you should:

• Enable automatic answering. This is enabled for the contact center or the contact center unit.
• Configure either individual agents or the contact center to use nailed-up connections. For

background information on nailed-up connections, see Adding agents for staffed contact
centers.

You can configure nailed-up connections per user as part of their user account or you can request
IFS Services to set it for you at the contact center level, in which case the setting will apply to all
the organizational units in the contact center.

Agent setup

For agents handling campaign calls, the following settings are required in their user account:
• The default contact center should be the one that is running the campaign.
• Nailed-up connection (unless this is set for the contact center).
• Make sure that automatic answering is not disabled in the user acount.
Make sure that the agents have all the skills required by the campaign.
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Campaign queue and workflow quotas

When preparing to start a campaign, you can import a very number of calls, for example several
hundred thousand. However, not all these calls can be immediately converted to work objects
without causing delays and making the system unresponsive.

The Campaign Queue Target is used to manage the conversion of imported calls to work objects.
The Workflow Quota sets the maximum number of work objects that are added to queue at any
one time.

Campaign queue target Approximately every 10 seconds, the system gets the number of
agents signed on in Agent Desktop and, based on this number,
converts sufficient calls to work objects. We recommend you leave
the queue target as 0 so that the system can dynamically manage the
queue.

Work flow queue quota This determines the number of work objects (of any type) that are
added to the queue on each of the tenant's iMedia instance.

Check that the work object queue quota is high enough for the number
of agents working on the campaign. For example, the default quota is
5 which is too low for a campaign involving 100 agents - 20-50 is more
realistic. For further information, see Setting the queue quotas.

Note  Depending on the tenant and how workflows are used, you may need to configure an
additional contact center unit so that you can configure the default media apps and workflow
queue quotas separately for campaigns. Workflows configured for different purposes such as
call backs and campaign calls both use the same workflow queue quota.

Skills

You can use skill-based routing with campaigns. You can set the skillset for:
• Each call as part of the work object - a skillset is set as part of the call data. This overrides any

skillset set in the campaign.
• For all the calls made during a campaign - the skillset is set in the campaign. This overrides any

skillset set in the work definition.
• For all campaigns that use a specific work definition - the skillset is set in the LaunchScript work

action

The IFS CE Example Campaign Workflow Definition lets agents reschedule calls and set a skillset
for the call. This skillset must be configured as transferable.
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Workflow definitions for campaigns
You need to configure a workflow definition for campaigns. This defines:
• The data required for dialing, such as contact details, the phone numbers and optionally other

details such as skillset and queue priority.
• The sequence of states, events and actions that determine how the call is dialed and what

happens if the call is unsuccessful.

Work objects are the calls that will be presented to the agents. The work objects are generated
once the campaign goes live at its configured start date and time.

For details of how to configure a workflow definition, see Creating a workflow definition and also
Event types for campaign workflow definitions.

Creating CE Studio apps for campaigns
You need to create an app that will be used by the agents working on campaigns. You do this in
CE Studio Designer:
• Use the IFS CE Workflow provider
• The provider properties are the elements from the work definition

The standard IFS CE Campaigns Template is an example of how to design an app for a campaign
workflow. This template is installed on all tenants and you can open this template in CE Studio
Designer.

Note  In CE Studio Designer, after creating the app, make sure that it is added as the default
media app for the Outbound Call media type and/or the Workflow media type depending
on the dial mode used by the campaign. If this is not set then the app will not load in Agent
Desktop when a call is presented to an agent.

Handling dialing modes

The example IFS CE Campaigns Template can be used for any of the dialing modes. However, if
required you can configure two different CE Studio apps. One for Preview dialing and a separate
one for Predictive or Progressive dialing.

Preview mode Calls are not automatically dialed for preview mode so agents
can either use the dial icon on the toolbar or the CE Studio app
requires a dial button.

Activations present as workflows so the CE Studio app must be
associated with the Workflow media type.
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Predictive and Progressive
mode

Calls are dialed automatically so the CE Studio app does not
require a dial button.

Activations present as outbound campaign calls so the CE Studio
app must be associated with the Outbound Campaign Calls
media type.

Creating campaigns (preview dialing)
This section explains how to set up a campaign for preview dialing, which is the simplest of the
dialing modes. All the settings for Preview dialing also apply to the Progressive and Predictive
dialing modes. Once you save the campaign, the campaign is Idle (enabled) and will automatically
run at the configured start date and time, at which point it becomes Active. The work objects for
the campaign are generated and added to the queue at this time.

To set up an outbound campaign:

1. In the Admin Portal, go to Workflow Management > Campaigns.
2. On the Campaign Details page, select the contact center and contact center unit for the

campaign.
3. Enter the campaign details:
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Field Details

Definition Select the name of the workflow definition
to be used for the campaign. This controls
the dialer scheduling behavior, such as the
business logic of which number to dial and
when.

If the work definition and the campaign are
configured for different dialing modes then the
campaign will use the lowest mode where
a. Preview is the lowest
b. Progressive
c. Predictive is the highest

For example, if the campaign is configured for
Preview mode and the definition is configured
for Progressive dialing then the actual
campaign will use Preview mode.

Note  In a workflow definition it is the
LaunchScript action that sets the dialing
mode.

Initial State Defines the initial state of work objects
created from the selected work definition.
Typically, this is left as default to use the
default initial state of the workflow definition
(the Select an option setting).

Name Name of the campaign.

Description Description of campaign (informational).

Status Shows the current status of campaign: idle,
active, completed, disabled, cancelled.

Start The date the campaign will begin. The start
time is determined by the coverage plan you
select. You can change the start date later
provided that the campaign is in the Idle
status.
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Field Details

End The date the campaign will end. You cannot
change the end date once the campaign
reaches its end date.

4. Select Preview as the dialing mode for this campaign. For details, see About the dialing
modes.

For additional details of setting up campaigns for the other dialing modes, see:
• Creating campaigns (progressive dialing)
• Creating campaigns (predictive dialing)

5. Enter the details of the outbound campaign - these fields apply to all of the dialing modes:

Fields Details

Disable Call Recording Select this option to disable call recording for
the campaign.

Abandoned Call Threshold (ms) Time period, in milliseconds, that is used
to define abandoned calls. An abandoned
call is a dialer-initiated call that is answered,
but not then delivered to an agent within the
configured timeout.

Note  To ensure compliance with the UK
and US dialer regulations, set to 2000 or
less.

Forward Abandoned Calls to IVR Currently not supported.

Default Coverage Plan Defines the hours of operation for the
campaign. This is used if the work objects
created for the campaign do not explicity set
an alternative coverage plan.

Leave this empty to use the coverage plan
set for the contact center unit on the Media
Management > Advanced Settings page.

Timezone Defines the time zone in which the campaign
operates. Used in conjunction with the
campaign's default coverage plan.
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Fields Details

Queue Target We recommend that you leave the queue
target as 0.

This allows the system to dynamically
manage the number of work objects. Dynamic
management ensures that there is always
sufficient work to keep the signed-on agents
busy without creating an excessive number
of active work objects which would put extra
load on the system.

You also need to set the Work Flow Queue
Quota on the Contact Center Unit > Access
to Contact Center page to a figure suitable
for the maximum number of available agents.
For example, a quota of 50 for 100 agents.
See Preparing to run campaigns.

Default Ring Duration(s) Default time (in seconds) that calls ring before
being automatically disconnected by the
dialer and categorized as “no answer”.
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Fields Details

Default Caller ID Caller ID used by the automatic dialer, and
seen by the callee when they are dialed
by the campaign. Used if the work objects
created for the campaign do not explicity set a
caller ID.

If this is left blank, the default caller ID is the:
• Caller ID set in the workflow definition's

LaunchScript action.
• If the above is blank then the Default

Outbound Caller ID configured on
the Media Management > Advanced
Settings page.

You need to ensure that number presentation
is enabled on the trunks used by the dialer
and that the specific number configured
here can be presented (as some network
providers limit the Caller IDs that can be
presented to one of the inbound numbers
on the same trunk). If this is a number not
acquired through the provider then request
IFS Services to verify the number for you.

Note  To comply with the UK dialer
regulations, ensure that all outbound calls
present a geographic or non-geographic
Caller ID that satisfies the Ofcom guide to
the use of presentation numbers and to
which return calls can be made.

Default Skillset Default skillset to be used by the campaign.
Used if the work objects created for the
campaign do not explicity set a skillset. This
can be overridden by the skillset selected in
the workflow definition's LaunchScript action.
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Fields Details

Elements Shows the work elements from the selected
definition. For each element, you can either
enter a default value or you can leave it
empty in which case you can supply the
values when you create the data for the
campaign.

6. Click Save to save the campaign. The campaign is automatically enabled and will run at the
configured start date and time (selected coverage plan).

To prevent the campaign from running, click Disable.

Creating campaigns (progressive dialing)
This section explains how to set up a campaign for progressive dialing. For background
information on progressive dialing, see About the dialing modes.

1. In the Admin Portal, go to Workflow Management > Campaigns.
2. Create a new campaign as described in Creating campaigns (preview dialing).
3. Enter the additional settings required for progressive dialing:

Field Details

Don't Interrupt Abandoned Call Prompt Dictates whether an abandoned call can
be interrupted to allow abandoned calls to
be presented to an agent as soon as one
becomes available.

Note  Disabling this option may affect UK
dialer regulation compliance.

Retry on busy Effects dialer behavior when a call hits a busy
line:

• Default - currently this is Enabled.
• Enable: continue to retry the line in case it

becomes available.
• Disable: immediately move onto the next

number.

4. Configure the handling of progressive calls. These settings do not apply to Predictive dialing:
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Field Details

Don't Abort Reassigned Progressive Calls Progressive mode only

When an agent that is assigned to a
pending progressive call attempt becomes
unavailable, then the default behavior is to
abort (hang up) the pending progressive call
attempt for that agent.

This option allows you to disable that
behavior and instead allow the progressive
call to continue (as if it were a predictive call)
and, if answered, to be delivered to another
suitable agent if and when one becomes
available.

Note  Enabling this option will contravene
the UK dialer regulations because
progressive mode is automatically
used when the regulations require the
availability of an agent to be guaranteed.

Note  Agents become unavailable as a
result of being reassigned to another live
call when all other agents are busy.
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Field Details

Disable Reassignment of Progressive Agents Progressive mode only

Select this option to ensure that agents
assigned to pending progressive call attempts
are never reassigned to another live call if
necessary.

If deselected, the dialer will automatically
reassign agents assigned to pending
progressive call attempts if:
• All other agents are busy,
• And a live call is at risk of becoming

abandoned.

This automatic re-assignment is only
performed if the pending progressive call
attempt has not yet started ringing or if it has
been ringing for longer than the minimum ring
duration.

Always Reassign Progressive Agents Progressive mode only

If the automatic reassignment of agents
assigned to pending progressive call
attempts is not disabled, then selecting this
option allows agents assigned to pending
progressive call attempts to be automatically
reassigned even when the progressive call
has been ringing for less than the minimum
ring duration.

Note  Enabling this option will contravene
the UK dialer regulations.

5. Enter the remaining campaign details. These settings apply to both progressive and predictive
dialing.
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Field Details

Start Recording After Connecting To Agent If call recording is not disabled, then the
system will record calls from the moment the
callee answers. Select this option to change
that to the moment the call is delivered to an
agent.

Live Speaker Detection Mode Not supported in this release.

Don't Use Start of Salutation Based Timing Calls are considered abandoned if they
are not delivered to an agent within the
configured abandoned call threshold.

The timing for the abandoned call threshold
begins as soon as the call is answered
(picked up). The UK and US dialer regulations
also allow the threshold to be measured from
the point at which the callee starts to speak
(“start of salutation”).

By default, the dialer will only use the
“start of salutation” based timing if Live
Speaker Detection is enabled as the small
time extension allowed for by the “start of
salutation” timing allows a greater proportion
of answer machines to be accurately
detected.

Selecting this option limits the timing of the
abandoned call threshold to the call answer
point.

Pending Call Priority Boost When the dialer initiates a call request, it
boosts the queue priority of the resulting
pending call so that it is assigned to the next
agent that becomes available in preference to
other dialer requests that have not yet been
initiated. Defaults to 1.
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Field Details

Abandoned Call Priority Boost If a live call cannot be delivered to an agent
within the requisite timeframe and is therefore
classified as abandoned, the dialer will adjust
the queue priority boost (typically to a slightly
lower level so that any other live calls that
have not yet exceeded the threshold will
be delivered to the next agent to become
available in preference to those that have
already been abandoned). Defaults to 2.

Minimum Ring Duration(s) Minimum duration (in seconds) that a pending
call must be allowed to ring before it can be
aborted.

Note  To comply with the UK dialer
regulations, ensure that this is set to 15
seconds or greater.

Abandoned Call Prompt Wav file that will be played when call is
abandoned.

Note  To comply with the UK dialer
regulations, ensure that the selected
recordings contains a very brief
information message with the identity of
the company on whose behalf the call
was made and details of a no-charge or
basic rate number that the callee can use
to decline to receive further marketing
calls from that company. The message
must also not include any marketing
content.
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Field Details

Elements Lists the fields used by the work definition
and allows you to populate one of more of the
fields with a value that will be common to all
work objects created by this campaign, such
as the name of the campaign, so the agent
can see the name, when multiple campaigns
are running.

Creating campaigns (predictive dialing)
This section explains how to set up an outbound campaign for predictive dialing. For background
information on predictive dialing, see About the dialing modes.

1. In the Admin Portal, go to Workflow Management > Campaigns.
2. Create a new campaign as described in Creating campaigns (preview dialing).
3. Enter the additional settings required for progressive dialing:

Some of the options for progressive dialing also apply to progressive dialing. These options are
covered in Creating campaigns (progressive dialing) .

Field Details

Don’t Abort Unassigned Predictive Calls During predictive over-dial periods, calls
are abandoned or are at high risk of being
abandoned. By default, the dialer will try and
abort unassigned pending calls that:

• Have not yet started to ring,
• Or have been ringing for over the minimum

ring duration when the campaign is close
to the abandoned call limit.

It does this to maximize efficiency gains and
reduce the chance of the abandoned limit
being exceeded.

Calls that are aborted will be retried again as
soon as the over-dial state is cleared.

Select this option to disable this dialer feature.

Use Progressive Mode during AMD Embargo Not supported in this release.
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Field Details

Max Abandoned Call Rate (%) This is the maximum permissible percentage
of live calls that can be abandoned (to a
resolution of one decimal point).

In predictive mode, the dialer will
automatically adapt its dialing rate according
to the campaign conditions to maximize
performance whilst also keeping the
abandoned rate for the current calendar day
below the configured limit.

• In rare circumstances, it is possible
for the configured limit to be slightly
exceeded. If this occurs, the dialer will
immediately disable predictive mode until
the abandoned rate is again safely below
the limit.

• The dialer also automatically lowers its
dialing rate in the last few minutes of the
day (or current coverage period) if it is
close to the configured limit to further
reduce the chance of a last minute burst
of abandoned calls tipping the abandoned
rate over the limit.

Note  To comply with UK and US dialer
regulations, ensure that the limit is set at
or below 3%. If operating at or very close
to the 3% limit, it is important that the
abandoned rate is checked at the end of
each day to ensure that it is in fact within
the regulatory limit.
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Field Details

Abandoned Call Predictive Embargo The UK dialer regulations require users of
automated dialing equipment to guarantee the
availability of an agent if a number is redialed
in the 72 hours following an abandoned call –
this is referred to as the 72-hour policy.

The dialer ensures compliance with this policy
by automatically ensuring that predictive
redial attempts during the configured
embargo period are automatically processed
in progressive mode to guarantee the
availability of an agent.

Note  To comply with the UK dialer
regulations, ensure that the predictive
embargo period is set to a minimum of 3
days.

AMD FP Rate (%) Not supported in this release.

AMD Embargo Not supported in this release.

Predictive Queue Priority Boost When a pending call is answered and no
agent is immediately available, the dialer will
boost the queue priority of the call so that
it is assigned to the next agent to become
available in preference to all other campaign
requests (including inbound calls and other
media types). Defaults to 3.

Setting up and importing campaign data
After defining a workflow definition for a campaign, you need to create the data that will be used
for the outbound calls.

The predictive and progressive dialing modes require you to use the campaign functionality. In
campaigns, you do not directly create work objects individually; instead you import the details of
the work objects. The imported data is held in a campaign queue.

You can add entries to the campaign queue by importing the call details. You import it in the Admin
Portal, using the Workflow Management > Create Campaign Data page.
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The system will automatically convert the entries in the campaign queue to work objects at the
appropriate time. Once converted, you can view the work objects on the Workflow Management
> Work Objects page.

Note  Very large campaigns can be created efficiently by ensuring that only enough work
objects are active at any time to keep the available agents busy. This avoids unnecessary load
and also ensures that multiple campaigns can be managed together at the same priority level.

Recommendations

We recommend that you enter:
• All dates or datetimes using an ISO format, such as:

• yyyy-MM-dd — for example, 2021-11-23
• yyyy-MM-dd'T'HH:mm:ss.SSSXXX — for example, 2021-11-23T01:30:00.000-05:00

• Phone numbers in their international format, such as:
• [+][country code][area code][local phone number]

Import the data into CE

You can use either a CSV file or a custom entity for the data. A work object is created for each row
in the csv file (or entity).

CSV file Create the CSV file. Each column in the file will become an element in the
workflow definition. A work object will be created for each row in the CSV file.

Custom entity Create the custom entity in the Admin Portal, on the Studio > Custom
Entities page, and then upload or add the data to the custom entity. For
details, see Entities for use in media scripts.

Add the data to the campaign

Once you have created the CSV file or custom entity, you are ready to add the data for the
campaign on the Workflow Management > Create Campaign Data page. Enter the details of the
data to use and then click Import.

Campaign Select the campaign that you want to use. The campaign must not have reached
its end date.

Upload Type Controls whether you add to the existing campaign queue (Append) or whether
you replace all the data in the campaign queue (Replace).

Data Source Select the Custom Entity type if you are adding data from a custom entity.
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Object ID
column

If required, select the work element/column that will provide a unique ID for each
work object.

Object
reference
column

This provides the reference for each work object and is an important way of
retrieving call details later. We recommend that the reference associates the call
with the person dialed, such as their name or phone number.

You can:

• Select the work element/column that will provide the reference
• Enter a work element name that will be used to generate a unique reference.

For example, for a work element called W_NAME, you could enter
Test_@W_NAME@_##. Enclose the work element name in @ characters and
use ## characters as the placeholder for the number part of the reference.

Element
Name

Map each field in the CSV file or custom entity to an element in the workflow
definition. You can leave the remainder of the elements empty.

The work objects for the campaign are created and added to the queue on the campaign's start
date and time. The time is determined by the coverage plan for the campaign or the default
coverage plan for the contact center unit:
• Agents must be signed onto Agent Desktop, and available, before the work objects are

generated and appear on the Work Objects page.
• The agents must have the appropriate skills. If there are no agents with the right skills then the

calls remain in the queue and are not converted to work objects.

Note  When the campaign reaches its configured end date, any unused or canceled work
objects are automatically deleted. This also includes unprocessed work objects added to the
queue. The number of unprocessed work objects is shown on the Campaigns page in the
Queue Count column.

Enabling and disabling campaigns
Saving a new campaign automatically enables it. The campaign is then ready to run on its
configured start date and time (the start time is determined by the coverage plan selected for the
campaign).

If necessary, you can disable a work object, a campaign (and therefore all its work objects) or
the work definition (and therefore any campaigns created for that workflow definition). Disabling
pauses the campaign(s):
• Suspends system processing of any work objects
• Stops any timers that are running
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• Releases any expired locks

Enabling the work object, campaign or work definition will resume system processing and restart
any timers. The status of the campaign changes to Active or Idle.

Disable or enable multiple campaigns

To disable or enable a workflow definition and any campaigns (and their work objects) that use it:
1. In the Admin Portal, go to the Workflow Management > Workflows page.
2. Select the workflow definition.
3. Click More and select Disable or Enable.

Disable or enable a single campaign

To disable a single campaign and all its work objects:

1. In the Admin Portal, go to the Workflow Management > Campaigns page.
2. Select the campaign. It must have Active or Idle status.
3. Click Disable or Enable.

Viewing the queue count and work objects for a campaign
In the Admin Portal, the Workflow Management > Campaigns page shows summary details of
the campaign:

Column Description

Status The status is:
• Active: the campaign is running and has not reached its scheduled end

date.
• Idle: the campaign has not yet started because it has not reached its

scheduled start date or there are no agents available.
• Completed: the campaign has reached its scheduled end date.
• Disabled: an active or idle campaign has been paused. See Enabling and

disabling campaigns.

Mode For details, see About the dialing modes.
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Column Description

Queue Count The number of entries imported into the system by:
• Import from a csv file
• Import from a custom entity
• Inserted by a queue progression script

These will be converted to work objects that can be dialed when the
campaign starts or as needed depending on the queue quota, and the
number of agents available to make the calls.

Object Count The number of work objects generated for the campaign. These are the
calls that have been dialed during the campaign.

For detailed information on the work objects, use the Workflow Management > Work Objects
page. Using this page, you can see the individual status of the work objects created for the
campaign, and by editing the object, view its details such as work element values.

To view the work objects generated for a campaign

By default, the Workflow Management > Work Objects page shows all the work objects for
today that are in an Open or Disabled state.

1. You can select the work objects for a contact center or a contact center unit, for a workflow
definition and a date range.

2. You can then filter the work objects further:

Field Description

Campaign Shows only the work objects created for the
selected campaign.

Reference Shows the work object(s) having a matching
reference.

Show Open States Shows work objects in any state other than
cancelled, completed or disabled.

Show Completed States, Show Cancelled
States

Shows work objects in any completion or
cancelled state.

Elements Search for work objects with specific value(s).
Select a work element and an operator and
then enter the value that you want to filter by.
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Creating campaign work objects by using a queue progression
script

At this release, the queue progression script needs to insert records directly into the
WorkCampaignQueue table. As a general rule, extreme care is required when configuring
scripts that directly access system tables or views as future releases could alter their
schema and therefore potentially break any queue progression scripts that rely on the old
schema.

To do this use custom JavaScript, and the helper function, InsertDataIntoTable. You pass it
two parameters:

• Table name
• A serialized JSON dictionary of key/value pairs corresponding to the column names and

values. The values can be either static values or replaceable parameters (between two
percentage symbols/characters) that are evaluated dynamically. The replaceable parameters
can be

• The name of a variable
• The name of a script element prefixed with an @ symbol
• JavaScript expression to be evaluated

For example:

var skillset = 'A_SPECIAL_SKILLSET';
var isVip = false;
var elements = {
          NAME: '%@FIRST_NAME%' + ' ' + '%@LAST_NAME%',
          DESTINATION_NUMBER: '%@MOBILE_NUMBER%',
          DIAL_MODE: 2,
          SKILLSET: '%isVip?skillset:""%'
};
var dictionary = {
          wcqCampaignID: '%@CAMPAIGN_ID%',
          wcqReference: '%@OBJECT_REFERENCE%',
          wcqElements: JSON.stringify(elements)
};
InsertDataIntoTable('dbo.WorkCampaignQueue',
 JSON.stringify(dictionary));

To get data from the table use the read function GetDataFromTable (table, columns,
whereClause, top, ordering) that returns an array of objects; ie the rows you have
selected.

For example:

var campaigns = GetDataFromTable(
"dbo.WorkCampaignStatus",
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"ID",
"(Name = COALESCE(NULLIF(N'%@CAMPAIGN_NAME%', N''), Name)) 
          AND (Status IN ('Idle', 'Active', 'Disabled'))",1,
"[Start Time] DESC");
var campaignId = (campaigns && (campaigns.length > 0)) ?
 campaigns[0].ID : null;

Important  As a general point/warning regarding direct database access, extreme care is
required when you do access system tables or views as future releases could alter their
schema and therefore potentially break scripts that do so.
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Creating surveys

You can configure surveys to request feedback from your users in any of the following media
types:

Media channel Survey type

Voice IVR
survey

This survey type uses an automatically generated script
that is played to the caller to ask the questions and get
their responses.

Voice App
survey

Where an immediate response is not required, then you
can send a link to the survey using email or SMS. In
this case, you require a CE Studio app to display the
questions and get feedback.

Email, chat, SMS,
Facebook Direct Message,
Twitter Direct Message,
WhatsApp

App
survey

This survey type requires a CE Studio app to display
the questions and get feedback.

In summary, you need to:
1. Create a survey definition. See Creating a survey.
2. For both types of survey, click Survey Version and add the questions to the survey. See

Adding questions to a survey.
3. Make the survey version live - only the questions in the live version are used.

• You do not need a live version to configure the CE Studio app. This will use the latest
version of the survey.

• Making the survey version live for IVR surveys automatically generates the media script.
4. For IVR surveys only:
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a. Configure a media script to send the survey invite to the caller. You use the Add Survey
Candidate option and select your IVR survey. See Add Survey Candidate.

b. Make the script live.
c. Optionally, edit the automatically-generated script for your IVR survey, for example, you

might want to play a message before the survey starts.
d. You are now ready to test the IVR survey.
e. To view the survey results, go to Report Designer.

For details, see Sending invites for IVR surveys.
5. For app surveys only:

a. Configure a CE Studio app. See IFS Customer Engagement Studio Guide for details.
b. Configure a media script to send the survey invite to the caller. You use the Add Survey

Candidate option. See Add Survey Candidate.
c. Make the script live. You are now ready to test the app survey.
d. To view the survey results, go to Report Designer.

For details, see Sending invites for app surveys.

Creating a survey
The survey definition specifies the:

• Survey type (either IVR for voice or App for other supported communication channels)
• Whether you send the survey invites immediately or after a delay
• When the survey ends - this also sets the expiry date of the survey link
• The frequency for any reminders to complete the survey

To create a survey definition:
1. In the Admin Portal, go to Media Management > Surveys.
2. Select the contact center (mandatory) and, optionally, the contact center unit that will use this

survey.
3. Enter the following details:

Field Description

Survey Name A descriptive name to identify the survey here
and later in CE Studio. The name must be
unique to the tenant.
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Field Description

Survey Type Select IVR for voice only or App for any of
the supported media types. For background
information on the survey type, see Creating
surveys.

Category A way of grouping your surveys so they are
easier to find and manage.

Email From, SMS From The email address and phone number to use
to send the survey invites.

Retry Count Maximum number of times to resend the
same survey invite if it was not completed.
Applies to scheduled survey invites only.
• Candidate must not be selected for

this survey if the candidate has already
completed it in the current distribution
period.

• Candidate can be selected again for this
survey if the candidate has not completed
it in the current distribution period.

• If the candidate has more than one
scheduled invite for the current distribution
period and none of them is completed, only
the most recent invite is selected for retry,
and any previous retries are voided.

For example:

• Retry Count is 0. Scheduled to send the
invite after two hours. Only one scheduled
invite is sent after two hours.

• Retry Count is 1. Scheduled to send the
invite after two hours. Initial invite is sent in
two hours and then another invite is sent
again two hours later.

Disabled Select this to switch off sending of invites for
this survey.
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Field Description

Is System Identifies example surveys that may be
installed as part of the system. You can clone
these but not delete them.

There are no example surveys in this release.

Language Audio Settings Select the audio settings for IVR surveys only.

For details, see Audio settings for voice
surveys.

4. Set up the distribution of survey invites:

Field Description

Percentage for Immediate Distribution Percentage of callers who are immediately
sent an invite to do the survey. The survey is
sent using the current media channel so for
example chat callers receive the invite in a
chat message and SMS users receive it in a
text message.

This is a default setting and you can override
it for specific date ranges.

Percentage for Scheduled Distribution Percentage of callers who are sent the invite
later, either by text if a mobile number is
available or by email if the email address is
known.

This is a default setting and you can override
it for specific date ranges.

Interval Before Sending (Days/Hours) The default interval to wait before sending the
initial scheduled invite in days or hours. By
default reminders are sent three times.

Contact IFS Support if you require a different
number of reminders.

5. Set the start and end dates of the survey. You can enter multiple date ranges but they must not
overlap:
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Field Description

Start Date, End Date You must enter a start date for the survey -
the end date is optional. You can add several
date ranges but they must not overlap.

Survey invites expire after 7 days. Contact
IFS Support if you require a different value.

Note  In this release the survey invite
reminder is sent even if the customer has
already filled in the survey. They will see
an error if they try to fill it in again.

Immediate For this date range, the percentage of callers
who are immediately sent the survey invite.

Scheduled For this date range, the percentage of callers
who are sent the survey invite later after the
number of days or hours you enter in the
Interval field.

Interval The period to wait before sending a
scheduled invite.

Days to Wait Before Resending Survey Number of days to wait before resending the
incomplete, scheduled survey invite.

For example, if this field is set to 1 then the
initial invite is sent at the configured time after
1 day.

6. Select the language of the survey. You can set up the survey to be localized into multiple
languages.

To add to the list of available languages, go to the Contact Center > Manage Languages
page.

7. Save the survey.

The next step is to configure the survey version. Click the Survey Version button to continue.
For details, see Adding questions to a survey.
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Adding questions to a survey
Once you have created the survey (see Creating a survey) you can add the questions. You add
questions to a version of the survey. Versions let you modify the survey while continuing to use
an older, live version. You cannot make changes to a survey version once you use the version in
survey invites.

To localize the survey, select a message for each screen text and question. You add the
messages to the message store first. See Localizing the survey for details.

You can export a survey version and import it into another survey. Questions for surveys are
exported as json files. Save the export as a zip file when importing into IVR surveys.

To add questions to a survey version:
1. In the Admin Portal, go to Media Management > Surveys.
2. Select the survey.
3. Click Survey Version.
4. Click New to create a new version in the survey.
5. Enter a descriptive name for this version of the survey.
6. Enter the text that appears at the start and end of the survey.

• For App surveys, you can add placeholders, such as {name}, {address} that are mapped
later to static or dynamic data. Enclose each placeholder in curly brackets.

• For IVR surveys, you can upload audio files that are used instead of text-to-speech. You
must add and save the questions before you can upload audio files.

Field Description

Default Start Screen Text Text that appears at the start of the survey as
an introduction to the questions that follow.
The survey displays this text when:
• There is no message for the user's locale.
• The Start Screen Message field is empty.

Later, you can choose to hide the start screen
text or show it when configuring the app in CE
Studio Designer.

200 characters long.

Start Screen Message Select the message to display instead of
the default screen text. See Localizing the
survey for details of how to add languages
and messages.

CE Admin Portal Guide - Creating surveys | 330



IFS Customer Engagement 25R1 GA

Field Description

Default End Screen Text Text that appears after the last question.
Later, you can choose to hide it or show
it when configuring the app in CE Studio
Designer.

200 characters long.

7. The first question is added for you. Click  to add additional questions. For App surveys,
you can add placeholders to the splash text or question, such as {name}, {address} that are
mapped later to static or dynamic data. Enclose each placeholder in curly brackets:

Note  To delete a question, click  in the question header. You cannot delete the first
question.

Field Description

Splash Text Use splash text to introduce the question.
Optional.

200 characters long.

Question Name Enter the name of the question. This will be
used in CE Studio when configuring the app
survey.

Important  It cannot contain spaces or
any special characters.
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Field Description

Question Type Choose from:
• Multiple Choice: the option name is the

text that is displayed in the survey. This is
reported as the Answer. The option value
is for internal use, for example, in reporting
and is reported as the Answer Value.

• Single Input: you can also choose
whether to validate the input, for example
for a Number input type the minimum and/
or maximum allowed value. This tells the
user whether their answer is out of range
but does not enforce it.

Note  IVR surveys do not support the
string input type.

• Star Rating: you then choose the range
(1-10) and the shape to use in the scale.

Question Default Text The question that is displayed in the app.

Include "Not Applicable" Option For Single Input or Multiple-Choice question
types, this check box enables you to
designate a question as "Not Applicable" if
the provided answer is irrelevant.

Include "Other" Option This check box applies to Multiple Choice
questions. It allows survey candidates to
select "Other" as an answer when the other
choices do not apply.

Mandatory answer Whether the question is mandatory and must
therefore be completed by the caller before
continuing.

8. Click Save to save this version of the survey.

Note  You cannot make changes to this survey version once you start sending out survey
invites.
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Adding rules to a survey
You can configure rules for a survey (both app surveys and in version 6.7 to IVR surveys). There
are two types:

Conditions Conditions control which question is presented based on the user’s previous answer
or answers. For example, if the star rating is <= 2 then show a specific question or if
the star rating =>5 then show a different question.

Note that:
• This type of rule applies to stepped surveys which can only show progress by

using a progress bar (not a stepper).
• You cannot use the first question in the survey in a condition.

Flags Flags run actions after the survey is completed. Actions include sending email, SMS
messages or invoking an action in CE Studio.

Note  By default, the flags apply to completed surveys only. You can include
partially completed surveys once you reach the end of the distribution period.
This allows for candidates to go back and finish the survey later. To use this
feature, select the option Execute flags for partially completed surveys in the
survey definition.

You create questions first and then add the rules.

Note  When exporting and importing survey versions, note that the rules are not shown until
you save the new version.
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Example rule

Adding conditions

1. Go to the Survey Version page.
2. Select a survey version.
3. Under Rules, click + to add the first rule.

Rule Name The name of the condition.

Rule Description Additional information describing the condition.
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Rule Type Select Condition.

Target Question This is the question to show next if the condition is met.

4. Set up the condition:
a. Select an operator, either AND or OR. The selected operator applies to all the rows in this

condition.
b. Click Rule. To add a row that uses a different operator, click Ruleset.
c. Define the condition:

• Left side of the condition is the preceding question. The condition applies to the answer
to this question.

• Right side is the condition to be met in order to show the target question. For strings, you

can use any of the variables from the survey. Click  to list the variables in the survey.

Adding flags

Example rule using a flag
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When filling out the fields for the action, you can select from the variables in the survey. Click 
to list the variables.

You can also send to multiple email addresses and phone numbers - separate each with a semi-
colon.

Note  To prevent the flags in the survey from running, select the option Disable Flags in the
survey definition.

Audio settings for voice surveys
For voice (IVR) surveys, you need to configure the voice that you want to use. Each voice can
support multiple languages. This voice is used when converting the question text to speech. As an
alternative, you can upload an audio file for each splash text and question in the survey (save the
questions first).

Note  CE only supports the languages for which a voice is available in Microsoft Azure Text to
Speech.

To add audio settings for voice (IVR) surveys:
1. In the Admin Portal, go to Media Management > Audio Settings.
2. Set up the voice, speaking style, in the following fields:

Field Description

Contact Center Select a contact center if the voice is for use
by a specific contact center. Leave this empty
if the settings are available to all contact
centers.

Contact Center Unit Select a contact center unit if the voice is for
use by a specific contact center unit. Leave
this empty if the settings are available to all
contact center units.

Name A descriptive name for the voice, such as:

Ana-General
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Field Description

Default Language The default language of the voice. To add to
the list of available languages go to Contact
Center > Manage Languages.

You can select multiple languages at the
bottom of the page.

Default Voice Select the required voice for the default
language.

Speaking Style Select the required speaking style for the
default language.

Speaking Speed Speed is in the range 0.00 to 3.00 where 3 is
the default speed.

Pitch Pitch is in the range 0.00 to 2.00 where 2 is
the default pitch.

Additional languages Select the other languages that you want
to use. For each language, select the voice
and speaking style. CE only supports those
languages for which a voice is available.

Response templates for surveys
You can send scheduled survey invites using email and SMS response templates. You can also
send emails and SMS messages as an action triggered by the flags on the survey.

To create the response templates:
1. In the Admin Portal, go to the Media Management > Response Templates page.
2. Enter a unique name for the template.
3. Select the language of the template.

For example, if the customer's browser locale is German then the German-language template
is used. If there is no German language template then it falls back to the default language
which is US English.

4. Select either Email or SMS as the type.
5. In the Content field, use these placeholders:

• %surveycandidateid%
• %surveylink%
• %surveyexpirydate%

CE Admin Portal Guide - Creating surveys | 337



IFS Customer Engagement 25R1 GA

Sending invites for app surveys
The survey invite is sent once the user completes all the self-service steps in the configured
queue progression script. Sending the survey invite is always the last option in the script.

For IVR surveys, see Sending invites for IVR surveys.

App surveys

Note  For App surveys, you require a CE Studio app that will display the questions and gather
the responses. This needs to exist before you can configure survey sending.

When testing survey invites, make sure that both the Survey Version and the CE Studio app
are live. Invites are only sent if both are live.

To configure sending:
1. On the Media Management > Media Queue Progression page, configure a queue

progression script for the required media channels (this includes inbound voice if you want to
send the survey invite using email or SMS).

2. Add the option Add Survey Candidate to the script. This must be the last option in the script.
See Add Survey Candidate.

Immediate sending

The survey invite is sent using the current media channel. For example, for a chat caller, the link to
the survey is sent in a chat message.

Note  For immediate sending with inbound voice, see Sending invites for IVR surveys. For
voice where an immediate response is required you need to use an IVR survey.

Scheduled sending

The survey invite is sent using either SMS or email. The media script must capture the mobile
phone number and/or email address to use when sending the invite.

Sending invites for IVR surveys
The invite for the survey candidate is generated once the user completes all the self-service steps
in the configured queue progression script. For voice, generating the survey candidate is always
the last option in the script.
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How you send the survey invites depends on the survey type. For app surveys, see Sending
invites for app surveys.

Voice (IVR) surveys

When you make the IVR survey version live, a script is automatically generated for you. You use
this to play the questions to the caller and capture their answers. You can see the script on the
Media Management > Media Queue Progression page The script is a JavaScript file. You do not
need to change this. You need to configure how the survey candidate invite is generated.

Note  There are different steps if you want to preview and test the IVR survey. See Testing
IVR surveys.

To configure the survey candidate invite:
1. On the Media Management > Media Queue Progression page, configure a new queue

progression script.
2. Add the option Add Survey Candidate and select the IVR survey. Note that:

• If the caller is selected for the survey then this option is the last option in the script to be
processed by the system. This is because the caller is transferred to the survey and the
current call terminated.

• If the caller is not selected for the survey then the system can process further options in the
script. For example, you can record why the caller was not selected by retrieving values
from the results object.

See Add Survey Candidate.
3. Click Make Live and then save and generate the script.

You will use this version of the script.
4. Associate the script with an inbound number:

a. Go to the Media Management > Voice page.
b. Select the number to use.
c. In the Inbound Number Detail pane, select the script from the Queue Progression field.

Select the script configured in step 1 above and not the automatically-generated script for
the survey.

d. Save the inbound number.

Now, when a caller phones this number they hear the options in the script and then as the last
option in the script they are transferred to the IVR survey. This is the survey selected in the Add
Survey Candidate option. The caller hears the questions in the survey and the script gathers
their responses using an IVR menu. When the survey ends, the caller's answers are submitted.
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Testing IVR surveys

Note  This topic describes how to test or preview an IVR survey. Note that you cannot save
results when testing or previewing. When you are ready to use the survey then you need to
reconfigure your system as described in Sending invites for IVR surveys.

Previewing an IVR survey

Follow these steps to test or preview the survey.

1. Make sure that the IVR survey version is live. This is the step that generates the JavaScript for
the survey.

2. Go to the Media Management > Media Queue Progression page.

The automatically-generated script is listed on the Media Queue Progression page. It has the
same name as the survey you created.

3. Optional - edit the script, for example to play a message before the survey starts:
a. Select the automatically-generated script. It has the same name as the survey you created.
b. Click Queue Progression.
c. Edit the script by adding additional options. For example, play a message before or after the

script runs. Disconnect the call when the caller hangs up.

For details of working with voice scripts, see Configuring voice (IVR) queue progression.
d. Click Make Live.

You will use this version of the script.
4. To test or preview the script you need to associate the script with an inbound number - do not

do this for a script that is for production use:
a. Go to the Media Management > Voice page.
b. Select the number to use.
c. In the Inbound Number Detail pane, select the script from the Queue Progression field.
d. Save the inbound number.

5. Now you are ready to test or preview the survey. Phone the number. You hear the questions in
the survey and can answer the questions, however your results are not submitted.

Note  When you are ready to use the survey then you need to reconfigure your system
as described in Sending invites for IVR surveys. This insures that the survey results are
saved.
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Notes on completing the survey during testing

Notes on completing the survey:

• Enter a value after the beep.
• Skip non-mandatory questions by entering asterisk (*).
• Questions with validation are repeated if you enter an unexpected value.
• Mandatory questions are repeated if you fail to enter anything.
• If you do not enter anything then the script waits 10 seconds before moving to the next

question.
• The script waits 4 seconds between digits, for example when entering 21, it waits 4 seconds

after the 2 is entered.

Question type You enter

Number questions with
validation

Either enter the termination character # or wait until the input
timeout expires and the system accepts your input.

For example, the expected number range is 1 to 25:
• You enter 18 (a two-digit number), the system accepts the

input immediately and moves on to the next question
• You want to enter 7 (a single-digit number). You can either

end the input with # (7#) or enter 7 and then wait for a few
seconds for the system to accept 7 as input and move on to
the next question.

Multiple choice 1 for option 1, 2 for option 2 and so on

But if the option values are different lengths, such as 1 and 12
then you need to follow your entry with #.

The choice options are repeated if you enter something outside
of the option list.

Date Date format is always yyyymmdd and does not depend on the
locale.

Boolean 0 for No and 1 for Yes.

Set up scheduled sending as part of the script

1. Go back to your script and change the Add Survey Candidate option to scheduled invites.
2. You need to use a different survey definition.
3. Add a variable to the script with your email address or SMS number and use this in the Add

Survey Candidate option.
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4. See Admin Portal guide for details of setting up the script
5. Make the script live and test scheduled invites

Localizing the survey
You can add localized messages for use in surveys to the message store. These are used by both
the app and IVR survey types.

Selecting supported languages

To add additional locales to the languages supported in the Admin Portal:
1. In the Admin Portal, go to the Contact Center > Manage Languages page.
2. Select the language.
3. In Locale Detail, select the Is Active check box.
4. Save the locale.

This locale is now available on all the language lists in the Admin Portal.

Adding messages for the supported languages

To add messages for the different locales:

1. Go to the Studio > Message Store page.
2. Enter a message:

Field Detail

Language Select the target language.

Message Type Select:
• AppSurvey for app surveys
• IVRSurvey for IVR surveys

If the message type is not available, then enter AppSurvey
or IVRSurvey in the New Message Type field. This also
updates the Message Type list after a short delay.

New Message Type If the message type is not available from the Message Type
field, then enter AppSurvey or IVRSurvey in the New
Message Type field. This also updates the Message Type
list after a short delay.

Message Id Enter a unique message id. When configuring the survey
questions, you select the messages by the message id.
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Field Detail

Message Enter the text that you want to use in the survey.

3. Save the message.

Selecting messages for survey questions

To localize the start text, end text and survey questions:
1. Go to Media Management > Surveys.
2. Select the survey.
3. Click Survey Version and then select the survey version.
4. For the start screen text, end screen text and each question, select a message from the

message list. The list shows the message ids.

When you preview or run the survey, you will see the message rather than the default text.

Important note on date formats

The date format is always yyyymmdd regardless of the locale.
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15
Last-Mile Customer Portal

Note  Previously called Last-Mile Technician Portal.

You can integrate IFS Customer Engagement with PSO Event Hub for scheduling appointments
and allocating resources. You access PSO through one of the following endpoints:

• IFS Field Service Management
• IFS Cloud and Request Handling
• IFS Cloud and Work Task Handling (not available to new tenants)

Once you have configured IFS Customer Engagement and enabled the configuration, CE will
subscribe to the notifications broadcast by PSO.

Requirements

Requirement Description

Dataset You require a dataset in the backend system:

1. Create the dataset in either IFS Field Service Management or IFS
Cloud.

2. Note the dataset name. The dataset you create in the Admin Portal
must have the same name.

3. Configure the dataset on the Last-Mile Customer Portals > Dataset
Configuration page in the Admin Portal. See Configuring the dataset
for Last-Mile Customer Portal.

The dataset is specific to the backend system.
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Requirement Description

Rules Configure rules that determine what happens when a notification is
received from PSO, for example whether an email or SMS is sent with
a specific message. Rules can use response templates for sending
notifications.

The rules are specific to the endpoint.

See Configuring notification rules for Last-Mile Customer Portal.

CE Studio app There is a CE Studio app for displaying the appointment details. Import it
from the Central Template Repository.

The CE Studio app is specific to the endpoint.

For IFS Cloud, the providers are created for you when you import the
CE Studio app. You need to create credentials for the environment you
want to use in the Admin Portal on the Credentials Manager > Manage
Credentials page. Optionally, set the credentials as the default to use
when importing apps.

For information on configuring surveys for Last-Mile Customer Portal apps, see the help for CE
Studio.

Adding credentials for Last-Mile Customer Portal
For Last-Mile Customer Portal, configure the PSO endpoint in the Credentials Manager >
Manage Credentials page. This is required to communicate with the PSO system.
1. In the Admin Portal go to Credentials Manager > Manage Credentials.
2. Enter the details:

Field Description

Name Name to identify this set of credentials.

Description Additional information about these
credentials.

Endpoint The URL of the PSO API endpoint. This is the
same for all endpoints.

Authentication Scheme Select Custom.

Provider Type Select Planning and Scheduling
Optimization.
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3. The credentials consist of one or more properties such as accountId, username and password.

Click the  button to add each required property. Enter these as key-value pairs. For
example:

Key Value

For example password For example, enter the actual password
to use. Select Secure Field to encrypt the
actual password.

Configuration overview for Last-Mile Customer Portal
The following diagrams give a high-level overview of how to configure Last-Mile Customer Portal -
in this instance for Work Order Handling.

The below diagram shows the configuration process in the Admin Portal, CE Studio Designer and
on IFS Cloud. There is a similar process for Field Service Management.

Configuring Last-Mile Customer Portal

CE Admin Portal Guide - Last-Mile Customer Portal | 346



IFS Customer Engagement 25R1 GA

The below diagram shows the process of booking appointments in IFS Cloud - Field Service
Management has a similar process.

Booking the appointments

Add global action set to get customer details
You need to add a global action set in CE Studio Designer to get the customer details associated
with a particular task. For IFS Field Service Management, the task_contact type provides the
customer details.

Global action to get customer details from FSM
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Global action to get customer details for IIFS Cloud
Request Handling and FS Cloud Work Order Handling

In the global action, you need to add a condition to match the task id of the task contact to the task
id of the job notified by PSO Event Hub. You do this by using a placeholder on the right side of the
condition. The name of the placeholder must be TaskId.

Important  The name of the placeholder must be TaskId.

Configuring the dataset for Last-Mile Customer Portal
You need to configure the dataset that you created in the backend system. The backend is IFS
Field Service Management (FSM), IFS Cloud Requests or Work Orders. The dataset lets you
subscribe to PSO which broadcasts the appointment details. Each PSO subscription lasts 24
hours and the subscription starts at the Scheduled Start Time set below, plus an interval (we
recommend 15 minutes).

Note  Before you start, you need credentials to access PSO and a global action set to get
details of the customer.

To configure the dataset:
1. Go to the Last-Mile Customer Portals > Dataset Configuration page.
2. Enter the details as below:
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Note  After editing the details of an existing dataset, you need to wait for approximately 15
minutes or longer for the cache to update.

Field Description

Dataset name The dataset name must match the name of the dataset created in
the either IFS Field Service Management or IFS Cloud.

Scheduled Start Time When the dataset starts to receive notifications from PSO Event
Hub, plus an interval of 15 minutes or longer.

Enable Configuration Deselect this until you have finished configuring Last-Mile Customer
Portal.

Select it when you are ready to start receiving notifications from
PSO Event Hub.

Credentials Object Create this on the Credentials Manager > Manage Credentials
page.

For Last-Mile Customer Portal these are the credentials to subscribe
to notifications from PSO event hub. Only objects created for
Planning and Scheduling Optimization are listed here.

See Adding credentials for Last-Mile Customer Portal.

Get Customer Details A global action set that you create in CE Studio to return customer
details. For details, see Add global action set to get customer
details.
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Field Description

Customer Response
Properties

This is the data that will be returned from FSM or IFS Cloud. The
format is:

{ pso event required field:provider metadata
 property;}

For IFS Field Service Management, the provider type is
task_contact:

{
    "FirstName":"task_contact|first_name",
    "LastName":"task_contact|last_name",
    "PhoneNumber":"task_contact|mobile_phone",
    "EmailAddress":"task_contact|email_address",
    "AlternateEmailAddress":"task_contact|
alt_email_address"
}

Map the parameters to the correct response properties. For
example, if mobile phone numbers are entered in the phone
property, change "task_contact|mobile_phone" to
"task_contact|phone".

Note  These properties are mandatory, apart from
AlternateEmailAddress which is optional.

For IFS Cloud Request Handling, the provider type is ifs-App-
WorkTaskServiceHandling-JtTask:

{
    "FirstName":"IfsApp-WorkTaskServiceHandling-
JtTask|CustomerName",
    "PhoneNumber":"IfsApp-
WorkTaskServiceHandling-JtTask|ContactPhoneNo",
    "EmailAddress":"IfsApp-
WorkTaskServiceHandling-JtTask|EMail"
}

For IFS Cloud Work Order Handling, the provider type is IfsApp-
WorkTaskHandling-JtTask:

{
    "FirstName":"IfsApp-WorkTaskHandling-JtTask|
CustomerName",
    "PhoneNumber":"IfsApp-WorkTaskHandling-
JtTask|ContactPhoneNo",
    "EmailAddress":"IfsApp-WorkTaskHandling-
JtTask|EMail"
}
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3. If necessary, refresh the page to see the broadcast parameters. The values you set here must
match what is set in Field Service Management or IFS Cloud:

MaximumFrequencyMinutes The maximum frequency (minutes) for plan output.
Recommended minimum frequency is one minute.

MaximumWaitMinutes The plan is broadcast when either (a) the minimum plan quality
is attained, or (b) when the Maximum Wait is hit, whichever
occurs first. If there is no Maximum Wait, then the plan is
broadcast when the quality target is met.

MinimumPlanQuality The minimum quality target for plans, for example, if you enter
100 then all the criteria for the appointment in FSM or IFS
Cloud must be match by PSO.

4. For IFS Cloud only both Requests and Work Orders, specify the attribute that returns the task
number: WT No

Skip this step for Field Service Management where the attribute is always ActivityId.

Configuring notification rules for Last-Mile Customer Portal

Note  Before starting you need to have configured the dataset and the CE Studio app that you
will use to display the appointment details. You can download the app for your endpoint from
the Central Template Repository in CE Studio Designer.

About the triggers

Broadcasts from PSO can trigger one of the following event types. The rules you configure
determine what happens next. The trigger types are predefined in PSO:

Trigger Use for

ResourceChangeEvent Triggered when PSO Event Hub allocates a different resource to
the task.

ETAChangeEvent Triggered when something occurs to change the estimated time of
arrival.

CE Admin Portal Guide - Last-Mile Customer Portal | 351



IFS Customer Engagement 25R1 GA

Trigger Use for

StatusChangeEvent When the status is changed in the backend system. For example:

• Resource is allocated to the task
• Resource is confirmed
• Resource is on their way

Configuring the rules

As a starting point, you can download some example rules from here.

To configure the rules:

1. Go to the Last-Mile Technician Portals > Rule Configuration page.
2. For each rule, enter the details as below:

Field Description

Name, Description A name and description of the rule.

Dataset Select the dataset configured on the Dataset Configuration
page. See Configuring the dataset for Last-Mile Customer
Portal.

Trigger Select the required trigger. See above for details.

Enable Configuration Deselect this until you have finished configuring Last-Mile
Customer Portal.

Select it when you are ready to start receiving notifications
from PSO Event Hub.

Output Variables For email notifications, you need output variables for:
• MessageToSend: the body of the email
• CustomerEmailAddress: the email address to send to
• EmailSubject: the subject line

For each output variable you can do either of the following:
• Select a response template and map the variables in the

response template to placeholders, such as ctx.ActivityId
which will be the appointment rnumber.

• Define it as a string. For example define
CustomerEmailAddress as the placeholder
ctx.CustomerEmail.
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Field Description

Condition Expressions You can configure a rule to apply only in specific conditions.
Typically, at a specific status. For example:

ctx.NewStatus == PsoStatusType.Allocated 
OR ctx.NewStatus ==
 PsoStatusType.Committed

Use condition expressions to simplify the creation of
complex conditions. For example:

NewStatusAccepted OR NewStatusCommitted

Actions What you want to happen when the appointment reaches a
specific status:
• GenerateSecureLink: provides a secure link to the CE

Studio app. You can enter the link text here. Note that
secure links are only generated when the CE Studio app
is live.

• SendEmail: send an email notification using the
email output variables you defined or the predefined
placeholders.

• SendSMS: send an SMS using the SMS output
variables you defined or the predefined placeholders.

• StoreMessage: push a message, such as an On Travel
message, that displays in the CE Studio app. By default,
the message expires after 15 minutes but you can set a
different expiry period here.

• Max Successful Execution: Set the maximum number
of times to send an action. For example, when the plan
allocates a resource and then reallocates the resource.

Example rules for Last-Mile Customer Portal
Download example

Some example rules to show how rule configuration works in the Admin Portal. Import these on
the Last-Mile Technician Portals > Rule Configuration page:
• Engineer allocated.json
• New engineer allocated to task.json
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• ETA Change.json

Response templates for Last-Mile Customer Portal
You can configure the rules for Last-Mile Customer Portal to use response templates instead of
putting the message in the rule.

This is an example of a notification defined as text:

"Dear " + ctx.CustomerName + ", "  + ctx.ResourceName + 
" has now completed your service. " + sys.SecureLink

But you can set up a response template for the notification:

To create the response templates

1. In the Admin Portal, go to the Media Management > Response Templates page.
2. Enter a unique name for the template.
3. Select the language of the template.

For example, if the customer's browser locale is German then the German-language template
is used. If there is no German language template, then it falls back to the default language
which is US English.

4. Select either Email or SMS as the type.
5. In the Content field, add placeholders for information about the appointment and the resource.
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Natural language processing (NLP)

Important  The information in this section applies to fully-featured tenants only.

IFS Customer Engagement media scripts can search the content of inbound emails, chats and
social media messages using Natural Language Processing. Typically for the most common
queries handled by the contact center.

The Search using NLP action is available when creating a queue progression in the Media Script
Editor. NLP processes human language and can identify nuances in the inbound email or chat that
a keyword or regular expression could not.

Before you can use NLP in a script, you need to create and train an NLP model. How successful
the model is depends on the quality and suitability of your training data.

Note  IFS Customer Engagement uses Apache OpenNLP for natural language processing.

Why the training data is important

How successful the NLP model is in identifying the required categories depends entirely on your
training data. The training data must be:

• As large as possible (up to 10,000 samples).
• Contain no duplicates
• Relevant to the type of enquiries you want to handle.
• Real, ie from real emails, tweets, chat conversations.
• Derived from the intended the media channel because people interact differently with email,

chat, Twitter, WhatsApp and so on. You cannot use training data derived from emails to train a
model for Twitter messages.

• Sorted by real people into the required categories.

CE Admin Portal Guide - Natural language processing (NLP) | 355



IFS Customer Engagement 25R1 GA

In addition to the categories that you want to detect, you always need an other category. For
example, if you only have two categories then the NLP engine has a 50% chance of getting it right
or wrong. The other category should have substantially more training data (possibly in the ratio of
1:100).

You can have up to 10,000 samples in the training data. A random 90% is used to train the model
and the other 10% to test (evaluate) the model. The evaluation result tells you the result of the
training. However, it depends on the purpose for which you are using NLP whether the minimum
confidence level, detection rate and false matches are appropriate.

You may need to repeat the training with additional training data if the evaluation results show that
the NLP model is not yet ready.

Gathering the training data

If you do not already have a database of emails (for example) that you can use, then you could
follow this process in order to gather accurate data for NLP training. You initially allow all emails,
chats, and social media messages to be handled by agents. The agents categorize each email or
message as required. Once you have accumulated enough training data then you use this data to
train and evaluate the model.

Supported languages for NLP

NLP supports English (United States).

Detecting the language in use

In addition, queue progression scripts can detect the language of the inbound email, chat or social
media message. This does not require any configuration before you can use it. The following
languages are supported:

• English

• Dutch

• Norwegian

• Danish

• French

• German

• Italian

• Spanish

• Swedish

• Portuguese
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• Russian

• Korean

• Chinese

• Japanese

NLP training data
NLP sample data for training and testing the model consists of categories and samples for each
category. Each entry has a categoryname and a categorytext attribute. For example:

<row categoryname='delivery' categorytext='I haven't received the
 latest edition of the magazine.' />

The data is used to create the NLP model and evaluate its effectiveness.

Note  For background information, see Natural language processing (NLP).

Format and categories

You need to obtain as much training data as possible, up to a maximum of 10,000 entries. This
maximum is the total number of entries regardless of the number of categories. The data format
must be XML.

There are two attributes:

categoryname The name of the category. This is case
sensitive. It represents what you are interested
in, and how you want to classify the sample
data.

categorytext An example of data for the category. It should
not contain any special characters (see below).
This will be used to train the NLP model.

We recommend that you create and maintain the training data in a text editor rather than using
IFS Customer Engagement. Each time you update the training data, you will need to recreate and
evaluate the data. It is therefore preferable to do this in a new model so there is no disruption to
any live media scripts that use NLP.
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Note  If the right tools are available, and the data is held in a SQL table with columns called
Category and CategoryText, is to use the SQL command “FOR XML RAW”. The following is
an example where data is held in a table named “MessageExamples”, and the columns are
named “Category” and “CategoryText”:

SELECT Category, CategoryText
FROM MessageExamples
FOR XML RAW

Note  There are certain special characters that should be avoided or replaced with the
relevant escape characters. They are as follows:

Character Replacement escape characters

< &lt;

> &gt:

" &quot;

' &apos;

& &amp;

Overview of the NLP evaluation process
This process creates a model from your training data. In the creation phase, it defines the rules
that determine what the different categories mean for your training data. In the evaluation phase, it
uses your training data to test the quality of the model. The results of the evaluation are displayed,
and you use the results to judge whether the NLP model is ready or whether you need to import
new data.

The evaluation process randomly splits the NLP data into two: a higher proportion (90%) is used
for training, and the remainder for testing.

Evaluation training and test ratio

The number of records for training is 90% of the category with the fewest number of samples.
Therefore, this gives the same number of records for training each category, but the test samples
will vary.
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Model Data Summary example

Category Name negative postive

No. of Samples 5331 5330

No. of Samples since current Deployment 5331 53329

No. of Training data in current Deployment 0 0

No. of Test data in current Deployment 5331 5330

Min Confidence Level 0.8 0.8

Detection Rate (%) 70.09 24.694

False Match (%) 74.269 31.221

In the above example:
• You need to decide whether the minimum configure level is adequate for your needs. There is

no right or wrong result here.
• The detection rate is very high because there are a high number of false matches. You need to

find a balance between detecting the categories correctly while minimizing false positives.

In fact, the above model requires a third Other category with sufficient training data.

Evaluation figures

After evaluating, the evaluation result for each category is displayed. The results include the
minimum confidence level, detection rate % and false match %.

Model Evaluation Result example

Category Test Sample Count Detection

positive 533 027.205

negative 534 038.577

Each category can be viewed in detail to see the results for each confidence level increment.

Min Confidence Level The level of confidence in the result. This figure runs from 0.00
to 0.95, in 0.05 increments. Evaluation results, such as the
Detection Rate, are made for each increment.
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Detection Rate The selected category is identified correctly, for example, the
model correctly identifies Category A as category A. The rate is
the percentage of matches made in a sample:

(No. of Detections x 100) / No. of test samples

For example, 28 matches out of 29 samples will give a
detection rate of 96.55%.

Avg. Detection Confidence The level of confidence in the result. The average is calculated
as:

Sum ( Confidence level of detections ) / No. of detections

Misdetection Rate A misdetection occurs when the selected category is incorrectly
identified as another category, for example, the model
incorrectly identifies Category A as category B. The rate is
calculated as:

(No. of misdetections x 100) / No. of test samples

Avg. Misdetection Confidence The level of confidence in the result. The average is calculated
as:

Sum (Confidence level of misdetections) / No. of misdetections

False Match A false match occurs when another category is incorrectly
identified as the selected category, for example the model
incorrectly identifies Category B as category A. The rate is
calculated as:

(No. of false matches x 100) / No. of test samples not identified
as this category

False Match Confidence Calculated as:

Sum ( Confidence Level of false matches) / No. of false
matches

Adding a new NLP model

Note  This assumes that you already prepared your data. See NLP training data. For
important background information on how to select training data, see Natural language
processing (NLP).
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To add a new model:

1. In the Admin Portal, go to NLP Management > Models.

The Models page lists any existing NLP models along with their language, status, and
deployment date (if active).

2. You can add a model that will be used by the contact center and all its contact center units or
one that applies to a single contact center unit.

3. Click New to add a new model.
4. Complete the details (name, description and language).
5. Click Save.
The model is now ready for you to import the sample data. At this stage, the status of the model is
Inactive.

1. Go to NLP Management > Model Data.
2. Select your model from the list.
3. Click Manage Data.
4. Import the data:

a. On the Manage Model Data page, click Choose file (bottom right) and select the file. Only
files with the .xml extension are accepted. They must be in the correct format otherwise the
import will fail, and an error message will be displayed.

b. Click Import. The categories and the number of samples are then displayed.
5. Go back to the Model Data page. The Summary pane lists the categories you added and the

number of samples. The NLP model is still inactive and cannot be selected in the Media Script
Editor.

6. The next step is to evaluate the model. See Creating and evaluating the NLP model.

Note on importing vs adding data manually

We recommend that you maintain the data outside of IFS Customer Engagement. For example,
rather than edit the data manually on the Manage Model Data, edit the source data in a text editor
and re-import it.

Creating and evaluating the NLP model
To create the NLP model and evaluate its effectiveness and accuracy:

1. On the NLP Management > Model Data page, select the model.
2. Click Create and Evaluate.
3. It may take 5–10 minutes for the model to be created. Once it is created, the status changes to

Evaluated.
4. Click Evaluation Result to see the results.
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5. From the Model Evaluation Result screen, it is possible to drill down into the detail and select a
different confidence level/false match figure if applicable.

Note  Although you can edit the training data on the following pages, we recommend that you
edit the training data outside of IFS Customer Engagement.

Test Data List

The evaluation results for the training data in each category.

Min. Confidence Level Data List

The minimum confidence level for the training data in each category.

False Match Data List

The false matches for the training data in each category.

Deploying the NLP model
Once happy with the evaluation, on the Evaluate Model page, click Deploy. This updates the
model to active status and makes it available for selection in the Media Script Editor when using
the Search using NLP action.

You will need to create a new model and re-evaluate the model, every time you modify the sample
data. For this reason, we recommend that you always maintain your model data outside of IFS
Customer Engagement.
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Masking sensitive data

You use masking to hide the personal data of customers by replacing the data with random
characters, with a pattern, or by deleting it.

You create masking definitions, in the Admin Portal, on the Masking > Definitions page. To select
the data to mask, you add placeholders to the masking definition. To mask customer data, you
create a job from the masking definition and schedule it to run at a quiet time:

Page Description

Definitions View the list of masking definitions, create, edit
and clone masking definitions. Create jobs to
perform masking.

Queued Jobs View the list of queued, in progress, and failed
jobs.

Completed Jobs View the list of completed jobs.

For detailed information on the options for masking data, see Masking mechanism, rules, and
regular expressions .

Masking mechanism, rules, and regular expressions
Masking mechanism refers to a technique used in various fields to selectively hide or ignore
specific parts of data during processing or analysis.

Masking rules refer to specific guidelines for applying masking techniques to data.

A regular expression, often abbreviated as regex, is a sequence of characters that defines a
search pattern.
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You can use a masking mechanism, rules, and regular expressions to select any module/table
that contains sensitive data that want to mask. Each selected module/table, configure the masking
rules for each of its fields.

The time it takes to run depends on the number of masking fields, the amount of data in the fields,
and the type of selected masking rules.

The operation speed of masking rules from fastest to slowest as below,

• Delete
• Random Characters
• Pattern

Masking Mechanism Masking Rules Data Type

Random Characters Replaces sensitive data with
random characters that are
readable,but not recognizable.
For date fields, specify the
earliest and latest dates.

Text, Short Text, Phone,
Date, Email, Fax,Date/Time,
Address, URL

patterns Replaces sensitive data with
data generated using a defined
pattern. The pattern must
follow the following rules:

• %c= replace with a lower-
case letter (a-z)

• %C= replace with an upper-
case letter (A-Z)

• %d= replace with a digit
(0-9)

• %% = replace with % sign
• %ndor %nc= replace with

"n" number of digits or
characters

Text, Email Address
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Delete Deletes sensitive data entirely,
leaving an empty field.

Text, Phone, Date, Long Text
Area, Email,Fax, Date/Time,
Geo location, Address,Percent,
Number, Currency, URL

NOTE: This rule is not
available for required fields
and is the only masking option
available for long text fields
which can hold a large amount
of data, where masking them
would slow down the masking
process considerably.
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Example: In the above figure, the masking mechanism of all the maskable fields is Pattern. The
masking rule which describes the pattern of the data is set up as:

 %10c@%5c.%3c

The regular expression which indicates the data type is set up as email. According to the data
type, both the masking rule and regular expression are set up.
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Creating a masking definition
In the Admin Portal, go to Masking > Definitions page.

Add sections

You can add many sections from the following page by clicking New Section.
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Add contact centers

By default, you create masking definitions for the default contact center.
You can select a different contact centers and contact center unit from

here.

Selecting data for masking

You can select the fields that contain the personal data.

You can use Alter Join to join modules with any other module.
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Example: You can mask data relate to when there are the outbound calls made when the agent
was in an inbound call or there could be another report showing all the inbound calls, and showing
any outbound calls made to any of those inbound calls.

Masking work objects using custom

fields

You can select custom-defined fields which do not belong to any module that can use to mask
work objects by selecting work definition.

Go to the Mask tab to view the selected fields.

Column Description

Type If the field is maskable, the data type is
displayed other it displays No Masking.

Masking Mechanism If the field is maskable, the masking
mechanism is displayed. If not displayed as
'No Masking', you can change the masking
mechanism if the field is maskable.

Masking Rule If the field is maskable, you can change the
masking rule.

Reg.Exp You can add regular expressions related to the
field's data type.
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Group By You can ensure that the masking data
across the related columns retain the same
relationship.

Sort Option You can sort the data in the column.

Sort Order You can change the sort order of the fields.

Note  These changes are available only for masking fields, not the additional fields selected
for filtering purposes.

Adding placeholders

You can add placeholders to the masking template on the Filter tab. You must add at least one
placeholder.

Note  The masking template only allows you to mask data by entering specific values.
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Saving masking definitions

After adding placeholders, you can save the definition on the Save tab.

Creating jobs
To run a job to mask sensitive data:

1. In the Admin Portal, go to Masking > Definitions page.
2. Select the definition.
3. Click Create Job.
4. Enter a value in all the placeholders (required before you can create the masking job).
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Queued Jobs

You can view the jobs in the queue from the Queued Jobs page.

Completed Jobs

You can view all the completed jobs on the Completed Jobs page. Delete completed jobs by
selecting the definition and clicking Delete.
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Designing reports

There are a wide range of standard reports that you can use in IFS Customer Engagement to
report on the contact center, portal, survey results and so on. To run these, in the Admin Portal,
go to Standard Reports. Depending on the report type, you can dig deeper to listen to the call
recording or view the activation detail.

You can design your own reports and schedule when these run. In the Report Designer, use:
• Reports to design your own reports.
• Queued Reports to see which reports are currently queued to be generated (and distributed

depending on the type of report).
• Delivered Reports to see the reports that have been generated (and distributed depending on

the type of report).

System reports are also available within Report Designer. These are designed for (fully-featured)
tenants with a contact center. To edit these, you need to first clone the report.

Designing a new report
You can design a new report in the Report Designer by adding a section for each type of data. You
then configure the sections using the Report Designer (a standard section) or by writing your own
SQL script query (a manual section). You can reformat the fields and set up filters on the data.
Reports can be generated as Excel or PDF files.

To create a new report:
1. In the Admin Portal go to Report Designer > Reports.
2. Click New.

Note  At any point you can save the report. Go to the Save tab. To save it as a report that's
available for any contact center, select the Standard Report option when you save.
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3. Click New Section to add the first section of the report. The report should contain one section
only unless you are planning to export the report to Excel.

Note  Scheduled reports must only contain one section.

4. Select the type of section:
• Standard—select this option to use the facilities of the Report Designer.
• Manual—use this to extract data directly from the database using a SQL script query.

Access to this is restricted to users whose user role is Technical.
5. Go to the Contact Center Unit tab. For each report section, select the contact center and

contact center unit to include. Leave this empty to automatically filter by the default contact
center.

Note  These settings filter the data in the report regardless of how the Standard check box
is set on the Save tab.

6. Go to the Field tab to select the data for each section of the report:

• Standard Fields: to include data on the contact center, activations, and agents.
• Custom Fields: for the work elements from work definitions that you want to report on.
• User Defined Fields: to include any custom fields that you define.
• Global Action Sets: to include external data.

On the Fields tab you can:
• Hover over each field to see a definition of the field.
• When there are multiple modules selected, you can alter the joins between modules to filter

the reports. See Using joins between modules in reports.
7. Optionally, go to the Format and Filter tabs to complete the setup of the report. Use the

Format tab for example to rename fields so they are suitable for use in CE Studio data
transformations. See:

• Formatting report fields
• Filtering data in report fields

Selecting data
You select the data for the report on the Field tab of the report definition. You can include any of
the following:

• Standard Fields: to include data on the contact center, activations, and agents. See Including
data on activations and agents.
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• Custom Fields: to include the work elements from work definitions that you want to report on.
See Including work elements as custom fields.

• User Defined Fields: to include any custom fields that you define. See Creating user-defined
fields for reporting.

• Global Action Sets: to include external data. See Including external data in reports.

Including data on activations and agents

Note  This section does not apply to self-service tenants.

In the Report Designer, you can add standard fields to the report to include data on activations
and agents working in the contact center:

1. In the Admin Portal, in the Report Designer, select the report section.
2. Go to the Fields tab.
3. Expand the required module and select the standard fields that you want to include:

Module Description

Activations Relates to the activations in the contact centers, such as agent
name, time call activated, durations, skills, priority.

Agent Availability Data for reporting on overall session duration and time in
DND.

Agent Signon Data for reporting on when agents signed on, how long
they were idle before each activation, handling duration (the
chargeable duration), wrapup duration (unchargeable duration)
and so on.

Agent Time Recording Covers the time codes that agents select whenever they go
online or place themselves in DND. This only applies to agents
where their user account is configured for time recording. The
system only time codes are not included in this module.

For further details, see Time recording in Agent Desktop.

Chat, Chat Message Data for all chat sessions, for example those handled by a
script and those that were handled by agents.

Custom Entities Shows the Entity tables and fields created by the user. See
Entities for use in media scripts.
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Module Description

Inbound Calls Data about the calls received at a contact center unit, such as
call times, date call received, account name, call type.

Outbound Calls Data about any calls made at a contact center unit, such as
call times, date call made, call type.

Inbound Emails Data relating to inbound emails, such as email received date/
time, email subject, email status. This includes emails in the
queue and those still on the server.

Inbound Emails Follow-Up Emails in the same conversation or thread as the first email
received.

Inbound Emails History Data on all closed emails.

Inbound SMS, Outbound
SMS

SMS data

Work Objects Data on work objects. These are the objects that are created
from work definitions.

Including work elements as custom fields

Note  This section does not apply to self-service tenants.

In the Report Designer, you can add work elements from work definitions as fields in the report.

1. In the Admin Portal, in the Report Designer, select the report section.
2. Go to the Fields tab.
3. Click the Custom Fields button.
4. From the Work Definition list, select a work definition. You can then select which work

elements you want to include in the report.
5. Click the Fields tab to go back to the main page.

The selected work elements will appear in the Custom Fields module on the Field page.

Including external data in reports
You can design reports that make use of external data. To do this, you first create one or more
global actions in CE Studio to get data from the external data source and then you create the
report using Report Designer. In Report Designer, you can use the fields from the external data
source to:
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• Provide data for the report
• Filter or sort report data
• Configure joins

You can use multiple global actions in the same report definition and also use the same global
action in different report definitions. Configuring the global action with placeholders increases its
flexibility.

Note  For details of how to create global actions, see the help for CE Studio.

To include external data in a report definition:

1. In the Admin Portal, go to Report Designer > Reports.
2. Create a new report or edit an existing report definition.
3. On the Field tab, click Global Action Sets:

a. Select a global action set:

Field Description

Module Name A label to identify the data accessed through the global action
set. The data will appear under this name on the Field tab.

Global Action Sets Lists all the readonly global action sets created in CE Studio.

Placeholders If the global action set was created with a placeholder then
you must enter the static value to use. For example, if the
placeholder is for a status then you enter one of the possible
status values.

Type Properties Lists all the properties available in the provider. Select all the
properties that you need for the report.

b. Click Save to continue.

At any time you can add additional properties by clicking the Edit button next to the module
name or remove the module from the Field tab by clicking the Delete button.

4. You can select another global action set and define another module as described above.
5. Complete and save the report definition in the usual way.

Formatting report fields
In the Report Designer, when setting up a new report, you can change the name of the headings,
format field groupings, set sort orders of the fields, and select or deselect the fields not required.

Once all the required fields for the report section are selected:
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1. In the Admin Portal, in the Report Designer, go to the Format tab for the selected report.
2. Select the report section.
3. Change the order of the columns on the report. Select the field by clicking the lefthand end of

the row and then click an arrow button (top right of the page).

4. All the fields in the report section are listed. You do any of the following to each of the selected
report fields.

Option Description

Heading
Note  Copy these headings when
configuring CE Studio components for
report data. Values are case sensitive.

If you intend to use this data in a CE
Studio data transformation then remove
spaces from the heading.

The headings are automatically generated
when you selected the fields. To rename
a heading, click the field and type over the
default heading.
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Option Description

Format There are a wide range of date formats. By
default, a date is stored as a datetime object.
You can either change how the datetime is
stored or change the way the datetime is
formatted:.
• To preserve it as a datetime and just

change the formatting, choose one of the
Date (dd/mm/yyyy) formats.

• To change the datetime to a date, choose
Date Time As Date.

For fields intended for use in data
transformation calculations in CE Studio, you
may want to change numeric fields to Whole
Number or Decimal Number fields.

For more complex formatting, use a user-
defined field as described in Creating user-
defined fields for reporting.
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Option Description

Group By
Note  It can be more efficient to
aggregate data in Report Designer rather
than send the data to CE Studio for
aggregation.

How the fields are processed in the report:

• Group By to make a group of rows based
on the values of a specific column or
expression (the default)

• Sum total sum of a numeric column
• Average returns the total average of a

numeric column
• Count Of returns the total count of a

column
• Minimum Value shows the minimum value

of a numeric column
• Maximum Value show the maximum value

of a numeric column
• Standard Deviation returns the statistical

standard deviation of all values in the
specified expression

Use these functions to show the numerical
results of the data, as opposed to the details.

Sort Option You can change the sort method of each field
(unsorted, ascending or descending). There
can be more than one field used to sort the
data. You can specify the order in which the
data is sorted in the Sort Order column.

Sort Order You can set the order of the fields in the
report section by clicking the arrow icons on
the side. To change the sort order, select the
field and then click to move the field to the
desired position. We recommend that you
always check the order of the fields, as they
can move when you edit the report.
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Option Description

Show You can sort by a field and also exclude that
field from the report. To do this, select the
Show check box.

Note  Fields are included in the report
when the check box is not selected.

Formatting example

In this example, you want a report to show the numerical values of the inbound calls by the month
the call was received. Instead of running the report details and manipulating the data within Excel,
you can achieve the requirements by formatting the fields:
• Inbound Call Date – To group by Month only.
• Inbound Call Time – The user originally was going to show the maximum value of the call

time, which would have shown the latest call, however they decided against it and deselected
this field so that it would not appear in the report.

• Inbound Call Client Name – Changes to a Count of to show the number of clients that
called per month.

• Inbound Call Duration – is showing an Average call duration per month.
• Inbound Call Queue Time – is copied to show the Maximum and Minimum Queue time.
• Operator Name – has been deselected to exclude the field from the report.
• Inbound Call Type – is deselected to exclude the field from the report.

Filtering data in report fields
In the Report Designer, when setting up a new report, you can filter the data to exclude certain
data. You can also select which date field to use when running the report for a date range.

1. In the Admin Portal, in the Report Designer, go to the Filter tab for the selected report.
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2. Select the report section.

Date Filter field

Many of the report modules have multiple date fields, for example:
• Chat has chat start time, chat end time
• Inbound Emails History has email start time, email end time
• Activations has activation time, wrap up time, activation end time

When you select a date range for a report, the report is run for the first date field selected for the
report definition as listed on the Format tab. To apply the date range to a different date field, for
example to select data based on email start time rather than email end time, set the field that you
want to use in the Date Filter Field on the Filter tab of the report definition.

Filtering example

You can now filter on any of the fields in the report section. The value in the Value column must be
enclosed in single quotes. In this example there are two filters applied to the report section:
• The Inbound Calls section is filtered by the Call Type of the call where the type is a Normal

Operator Call.
And:

• The report section excludes any calls picked up by agent Carly Cole

Filtering example

In this example, as the user wants to apply a second filter, the first filter ends with And. If there
was only one filter, Done would have be selected.

Saving reports
1. In the Admin Portal, in the Report Designer, go to the Save tab for the selected report.
2. Enter the details for the saved report:
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Field Description

Report Name Enter a meaningful name for the report.

Visible To For fully-featured tenants only: The report can be run by everyone
who has the Agent role and higher. To restrict access to a specific
group of people set up a skillset and assign this skillset to the
people who need to run the report.

Description A description that will be shown on the Report List page.

Standard Whether the report is available to all contact center units:
• Select this option to make the report available to all the contact

center units.

Note  The report will be filtered by the settings on the
Contact Center Unit tab. Review these settings to check
that they are appropriate for a Standard report.

• Deselect this option to make the report available only to the
contact centers selected on the Contact Center Unit tab.

Note This information is for your use and won't be shown on the Report
List page.

Report output settings
In the Report Designer, the Setting page allows you to configure the output settings of the report
for Excel, using an Excel template. The type of report that is required can be specified at the top
of this page. How the report is sent is set on the Schedule page.

Any section that has been created in the report will be listed in the Sections table. Each section
will appear on a different Excel sheet:

Sheet Number If left unchanged, the sections added to the report will appear in the order
that they were selected. To reorder them, enter the sheet number.

Sheet Name By default, the sheet number is the sheet name. You can set it to the
name of the section in the report definition.

Starting Cell By default, the data starts in cell A1. This may override your column
headings.
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Copy Data If selected this will overwrite the column headings in the template.

On the Setting page you can also:
• Download a template created in the Report Designer.
• Upload a template created in Excel. See Creating report templates in Excel for details.
• Compress reports that you plan to distribute by email.
• Prevent the export of the field headings. You might use this option when headings are already

included in the template.

Note that fields such as CLI numbers, dialled numbers and so on will be exported to Excel as the
general text type.

Scheduling reports
Scheduling reports in Report Designer allows you to automate the reports so that they can be sent
out at specific times, days of the week or months to stake holders or generated for display in a
CE Studiowallboard. You can also create multiple schedules for the same report as some stake
holders may want the report at month end and others every day, for example.

To access these settings in Report Designer, select the report on the Reports page and click
Schedule.
1. When creating a Report Schedule, you need to enter a schedule name. The name must be

unique for in-memory reports.
2. Select the timezone that will be used when entering the report delivery time. The delivery time

is then converted to UTC when you save the report.
3. If you are authorized to view unmasked phone numbers then you can show unmasked

numbers in the report by selecting SELF from the Run As list. Leave this empty to use masked
numbers.

4. In Report Delivery Time, decide when the report is generated and for how long:

Report Delivery Time Details

From, To The first report will be generated on this date.

To The last report will be generated on this date.

Note  In-memory reports will also expire after this date.

Frequency How often the report should be generated. For example, to
generate a report every ten minutes, select Minute followed by
10 Time(s).
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Report Delivery Time Details

Time The time when the report is generated. For example, select 07 :
30 to generate the first report at 07:30 and then at the selected
frequency.

5. In Report Data Range, decide how much data is included in the report by selecting one of the
following options:

Report Data Range Details

Data For In Data For you can specify the number of days/weeks/months/
years the report generates data for. For example, if set for 3
hours, from the time the report is run, it will generate the last 3
hours of data.

You can run the report by day to date, week to date, month to
date, or year to date. For example, if the parameters are set to
month to date, the report will generate data from the beginning
of the current month up to the date the report was run.

You can run the report for a date range.

6. In Report Delivery Options, decide on the report format:

Delivery Option Details

Email For email, you enter the distribution details. The default from
address is the email address of the Account Manager but you
can select any system email address on the Email From list.
Separate multiple recipients with a comma. In Report File Name,
enter the title of the report attached to the email.

By default, the files are delivered as Excel files, but you can
deliver them as comma-delimited, by including the suffix .csv at
the end of the file (such as filename.csv).

FTP For FTP, you schedule a file to be uploaded to a location on a
server. The FTP Address is the address of the server that the file
is to be uploaded to. For example, ftp://ftp.drivehq.com/.
You must also enter the username and password to be used
when logging into the ftp server and optionally an SSH key file
and pass phrase. The Report File Name follows the same format
as the email delivered reports.
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Delivery Option Details

In Memory The report is cached in memory for display in a CE Studio
component, such as a data grid or chart. An action configured
in the IFS CE Reports provider will pull the report data into CE
Studio.

Only the latest version of the report is cached. The cached report
will expire on reaching the To set for the report schedule.

Note  In-memory reports are intended to hold a finite number
of records. The practical limit will depend on your data set.
For example, where the data set is simple, with a limited
number of columns, containing mainly numeric data or
short strings such as labels, then it may be several 100,000
records. However, where the data set is more complex, with
a large number of columns, and more complex data such as
long strings then the practical limit will be far less.

Max Record Count Since the report is intended for use in a CE Studio component,
you must limit the number of records in the report. See the above
note for details.

7. Enter a report filename with an appropriate file extension. Supported file formats are shown
in the field. For example, if the report template contains macros then you must use the xlsm
format.

Saving the schedule

To save the schedule, click Save. The schedule is validated to catch any errors and if everything is
OK, added to the list of available schedules. You can then edit, delete, or create another schedule.

Note  Editing the existing schedule will cancel any queued jobs for the schedule. You will need
to manually delete the cancelled jobs.

Checking that scheduled reports have run

To check that a scheduled report has run, go to Report Designer > Delivered Reports. This acts
as an audit trail and lists the top 1000 records for the selected contact center.
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Designing reports for CE Studio apps and templates
You can generate reports in the Admin Portal for:

• CE Studio apps and templates
• CE Studio apps for use as wallboards. Wallboards present agents working in Agent Desktop

with charts and reports that can be accessed on any device. The wallboard is accessed
through the Admin Portal on the Realtime Statistics > Wallboard page, and also using the
URL that's generated in CE Studio for previewing the app.

To create a report for a CE Studio app, you create the report definition in Report Designer and
configure a schedule for running an in-memory report. The report can then be consumed by the
IFS CE Reports provider in CE Studio. Timers configured in CE Studio are used to update the
apps with the latest generated report.

Note  For some example CE Studio templates that use scheduled, in-memory reports, see the
Samples page in the CE Studio help.

Data formatting and transformations

We recommend that you prepare the data that you want to use in the CE Studio app as far as
possible in Report Designer. For example:
• Rename the fields with shorter or friendlier names more suitable for use in data grids and

charts
• Aggregate data using the Group By option
• Reformat data, for example, change a decimal to a whole number. However, do not change the

date format if you intend to use it in data transformations. You need the As Stored type, which
is DateTime.

• Sort the data

You can also configure data transformations as part of CE Studio but, depending on what you
want to achieve, it is often more efficient to perform the transformation as part of the report
definition.

To design a report for a CE Studio app

1. In the Admin Portal, create a report definition in the usual way. See Designing a new report.

If required, you can:
• Include data from external data sources. See Including external data in reports.
• Filter the data in the report. See Filtering data in report fields.

2. Format the report fields on the Format tab. The field names in the Heading column become
the properties that you will use in CE Studio Designer. You can therefore rename the fields.
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Remove spaces from the names as these are not supported in CE Studio. Note that date fields
intended for use in data transformations should be left as the DateTime type, which is the As
Stored format.

See Formatting report fields.
3. Save the report definition. See Saving reports.
4. Schedule the report. Make sure that:

• The name of the report schedule is unique across all the contact centers belonging to the
tenant. See Saving reports.

• Make sure that you select the In Memory delivery option. This makes the generated report
available to the IFS CE Reports provider. See Scheduling reports.

• The To date for the report schedule is set correctly. The cached report will expire after this
date and will be deleted.

Running reports
You can first preview the report with a sample of the data using the View option and then export
the report.

To run a report in Report Designer in the Admin Portal:
1. Go to the Reports page.
2. Select the report and click Run.
3. Set the date range and optionally the timezone:

• The date range applies to the first date field in the report definition or to the date chosen on
the filter page of the report definition.

• The timezone defaults to the timezone set for the contact center unit.
4. Select a section. Some reports have more than one section to the report, usually done to

provide data on more than one tab in Excel.
5. Click View to preview the report with a sample of the data.

You can change the sort order of the report by clicking the column headers.
6. If required, export the report to a different format.

Note  The CSV format (comma delimited format) is not suitable for data that contains
commas.

Advanced report configuration
This section describes some of the advanced report configuration options.
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Creating user-defined fields for reporting
In the Report Designer, there are two types of user-defined fields. They are either a Calculated or
a Value Defining field.

1. In the Admin Portal, in the Report Designer, go to the Fields tab for the selected report.
2. Select the report section.
3. Click the User Defined Fields button.
4. For a calculated field:

a. Enter the name of the field.
b. Add the appropriate fields to the calculation by selecting from the Field list.
c. Enter the calculation. In this example, the field finds out how long the caller is on the phone

before the agent picks up the call. This is done by writing a formula to subtract the queue
time from the ring time.:

Inbound.dbo.sys_INBOUND_CALL_RING_TIME -
 Inbound.dbo.sys_INBOUND_CALL_QUEUE_TIME

5. Click Add Field. The field then appears in the User Defined Fields module. Hover over the field
to see the field definition. If you decide not to use the field in the report definition then you can
deselect it here rather than delete the field from the User Defined Fields page.

6. Click the Field tab to go back to the main page.

Changing field values

In addition, to a calculated field, you can change the value of the data. Instead of entering a
calculation, you enter a query. All queries are prefixed CASE and suffixed as END. They are similar
to If Functions in Excel. For example:

=If(Field Value =0, True Result, False Result)

is the same as:

CASE 'Field Value' WHEN '0' THEN True Result ELSE False Result

In this example, the field shows the calls where 0 oranges were sold as No Sale and the calls
where 1 or more sales were made as Converted:

CASE 'Oranges_Sold' When '0' Then 'No Sale' Else 'Converted' End

The query is asking the database to show a value of No Sale when the value in the ‘Oranges Sold’
field is 0, and to show ‘Converted’ in the calls with values of more than 0.
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Using joins between modules in reports
In the Report Designer you can combine data from different sources in the same report by using
joins. For example, you can combine:
• Call logs
• Real-time data for the contact center (provided by a global action configured in CE Studio

Designer)
• Third-party data (also provided by global actions)

Each data source is available as a separate module in the Report Designer.

Note  For information on using global actions, see Including external data in reports.

When there are multiple modules selected in a report section, you need to combine the fields from
two or more modules by using values common to each. For example, a module can be joined to
another module by the Activation ID field.

There are four type of joins:

• Inner Join returns all rows when there is at least one match in BOTH module tables
• Left Join returns all rows from the left table, and the matched rows from the right module table
• Right Join returns all rows from the right table, and the matched rows from the left module

table
• Full Join returns all rows when there is a match in ONE of the module tables
The Inner and Left joins are the most commonly used.

Note  Fields from external data sources can also be used in joins. See Including external data
in reports.

Example 1

You want to add the name of the agent that took the call to the data. However, the data in this
module table only includes the Activation ID. Therefore, you need to join the table that lists the
names to the table that holds the call data.

First, you need to determine the common field by comparing the two tables.

Table 1

Inbound
Call Date

Inbound
Call Time

Inbound Call
Client Name

Inbound Call
Ring Time Activation ID

05/06/2013 13:01 The Corner Shop 00:05:23 AC01101
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Inbound
Call Date

Inbound
Call Time

Inbound Call
Client Name

Inbound Call
Ring Time Activation ID

05/06/2013 13:15 The Local
Supermarket

00:07:01 AC01102

06/06/2013 13:17 The Café 00:03:49 AC01103

05/06/2013 13:23 The Juice Shop 00:06:48 AC01101

Table 2

Agent Name Activation ID

Amy Anders AC01101

Bill Brown AC01102

Carly Cole AC01103

The common field for this example is the Activation ID. Therefore you would use this in the join.
Once you have picked the fields that you want to include in the data, including the join to the other
module table, you could get results like this:

Result of the join

Inbound
Call Date

Inbound
Call Time

Inbound Call
Client Name

Inbound Call
Ring Time Activation ID

05/06/2013 13:01 The Corner Shop 00:05:23 Amy Anders

05/06/2013 13:15 The Local
Supermarket

00:07:01 Bill Brown

06/06/2013 13:17 The Café 00:03:49 Carly Cole

05/06/2013 13:23 The Juice Shop 00:06:48 Amy Anders

Note  The field used to join the modules does not need to be included within the results data.

Example 2

When using the module selection tool, the join fields are automatically selected for you, apart from
in the case of Entity fields. If you add any fields from Entity tables, you will need to select the joins
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themselves. This is not usually necessary although it is always best practise to check that the
automated joins provide what are you expecting.

In this example, you want to review an agent’s entire day in the contact center, from log on to log
off, with the details of the inbound calls they made, including the outcome of the calls.

You could do this by using the following joins:

Joining tables using data in a common field

In this example, the Inbound Calls are joined to the Activations module (agent activity) using the
Activation ID field that the two modules have in common. Then the Activations module was joined
to the Results module using the same field. This then includes details of the Results according to
what is in the Activations module. As an inner join has been used, the query that will bring back
data that matches in both tables.

If you wanted to see the results for all Inbound Calls, regardless of whether the Activation module
field (that is Agent Name) is completed, then you would join the Results module to the Inbound
module instead as shown below:

Joining tables using data in different fields

The same could be done for a second report section showing the Outbound Calls. However, in this
example, you want to show all Outbound Calls. Therefore there can’t be a join between Inbound
and Outbound calls (which is why there are two sections of data).

Note  You can change the module you are viewing, by selecting the section name at the top.
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Creating report templates in Excel
The use of an Excel template enables you to distribute the finished report from the system, rather
than just the data. It could be that you have a table of formulas that derive from the data, or a
macro that manipulates the data, or it may be that they have included a couple of cells that show
the date parameters of the data. Whatever the reason, this tool increases your options when
presenting the data pulled from the system.

To create a template, open up a new workbook, with all three blank sheets at the bottom. When
starting a new template, it is best to delete the Sheets that won’t be needed. Normally two sheets
are recommended as one can contain the data content that was exported to Excel and the other
can be used as a summary sheet, including graphs and tables. You can rename this worksheet,
but should make note of the worksheets names when adding the template to the system.

We recommend that you start with the data headings from the system. To ensure that the
headings will match the data added:
1. Run a report from the system as a CSV file.
2. Copy and paste the headings into the template.
3. Edit the headings as required, with the knowledge that the data will match.
4. Make a note of the starting cell of the data. You will need this when you add the template to the

system.
5. You can now:

• Change the format and layout of the report
• Add formulas
• Add macros to create tables and graphs when the document is opened

6. Once the spreadsheet is complete, check that the template is blank of any data that is not
required in the workings of the template.

7. Save the spreadsheet with the XLSM or XLTM extension. You can name and choose a location
for the template to upload to the system. For instructions on how to upload a template, see
Report output settings.
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19
Standard reports

IFS Customer Engagement offers several types of pre-designed reports, empowering businesses
to optimize customer engagement. Accessible through the Admin Portal under Standard Report,
these reports provide valuable insights on the performance of the contact center. Users can dig
deeper, reviewing call recordings, activation details and many more for better understanding of
operational activities.

Standard Report offers the following reports:

Report Name Description

Inbound Call This report provides information on all the
incoming calls received by your contact center.
You can filter the report by a specific User, Call
Type, Inbound Number etc.

Inbound Call Efficiency The Inbound Call Efficiency report provides
information on how effectively incoming calls
are handled in your contact center.

Outbound Call The Outbound Call report offers insights into all
the outgoing calls made by your contact center.
You can filter the report by a specific User, Call
Type, Inbound Number etc.

Agent Activity This report focuses on individual agents'
activities, providing information on their
performance and productivity. You can filter the
report by a specific agent to offer managers
easy access to their respective agents.
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Report Name Description

Agent Activity Summary The Agent Activity Summary report provides an
overview of the overall performance of agents.

Agent Logon This report provides you with the Logon
information of agents. It can also be filtered by
respective agents.

Monitoring Session This report provides you with information on
monitoring and coaching sessions conducted
by managers.

Contact Center Unit The Contact Center Unit report provides
information on the performance of different
units or departments within your contact center.

Users per skill This report lists the number of users (agents)
assigned to specific skills in your contact
center.

Contact Center Units per Skill The Contact Center Units per Skill report
displays the distribution of skills among the
various units or departments in your contact
center.

Audit History The Audit History report keeps track of changes
made to the system settings or user accounts.

Deleted User The Deleted User report logs information about
user accounts removed from the system.

Unretrieved Voice Mail This report provides information on un-retrieved
voicemail messages within the contact center.

Deleted Skillset The Deleted Skill set report provides
information on any skill sets removed or
deleted from the system.

Call Priority The Call Priority report categorizes and
analyzes calls based on their priority levels.

Unallocated Inbound Number This report shows any inbound phone numbers
that have not been assigned to specific agents
or units yet.
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Inbound Call Report
This report provides information on all the incoming calls received by your contact center. You can
filter the report by a specific user, call type, inbound number and so on.

1. In the Admin Portal, go to Standard Reports > Inbound Call Report.
2. Enter the selection criteria for the report.
3. Click View to preview the report.

The report has the following columns:

Column Heading Description

Call Start Time The start time of the call prior to processing and
thereafter delivered to the queue progression
for the agent to handle the call.

Contact Center The name of the contact center to which the
inbound call was delivered.

Agent Contact Center The default contact center of the agent.

Contact Center Unit The subunit of the contact center (such as
Marketing, Finance, Logistics) to which the
inbound call was delivered.

Agent The agent who accepted and handled the
inbound call.

Station Number A unique numeric ID which is associated to the
agent's login.

Caller ID The inbound phone number of the caller. Also
known as the Calling Line Identification (CLI) in
the UK.

Restricted Caller ID Indicates if the caller ID was masked. It
is impossible to retrieve a masked phone
number (for example+447888666555 to
+44XXXXXXXXX).

Inbound Number Indicates the number dialed by the customer.
This is the number associated with the contact
center unit.
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Column Heading Description

Call Reference The reference number associated with the
inbound call.

Call Type Indicates the type of inbound call. Click here for
further details.

Ring Duration (s) The number of seconds the inbound call
was ringing or allowed to ring before it was
answered.

Queue Duration (s) The number of seconds the inbound call was
queued or allowed to be queued.

Connected Duration (s) The duration of the call from the time it
was answered by the agent to the point of
disconnection.

Caller Hung-up Whether the caller hung up or not (Yes/No).

Call Diverted From Name of the contact center the call was
diverted from. The reference of the site.

Call Types

The below list indicates the type of calls that may be reported in the Inbound Call report.

1. DDI (inbound phone number) not found.
2. DDI (inbound phone number) disabled.
3. DDI (inbound phone number) quota exceeded.
4. CLI not in whitelist.
5. CLI in blacklist.
6. Too many internal diverts.
7. DDI context not registered.
8. Client account not found.
9. Client account is suspended.
10.Client account is terminated.
11.No suitable operator (agent) logged on.
12.Call diverted.
13.Call could not be diverted.
14.Office is closed.
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15.Call busied.
16.Caller rang off.
17.Normal operator call.
18.Caller left a voicemail message.
19.Caller declined option to leave a voicemail message.
20.Caller retrieved one or more voicemail messages.
21.Caller failed to logon to retrieve voicemail messages.
22.Other retrieval option.
23.Caller rang off during divert.
24.Operator (agent) not available for diverted call.
25.Call rejected.
26.Data was captured by a queue progression script.
27.User record not found.
28.IVR call (to an inbound number that has a queue progression script).
29.Skillset not found.
30.Test call failure.
31.Test call success.
32.Caller rang off in IVR.

Outbound call status types
The below list indicates the type of calls that may be reported in the outbound call report.

• No resources
• No lines
• Call collision
• Call failed
• Number engaged
• Not answered
• Call aborted
• Normal call
• Unknown

Status Types and Reasons :
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Status Type Reasons

No resources Automatically updated by the telephone network.

The telephone system could not allocate the required resources to
complete the outbound call. This issue may arise due to :

Insufficient Call Recording Resources.

For instance, when receiving a call from a media source, the system may
face a shortage of allocated recording resources. 

No lines Automatically updated by the telephone network.

The calls are routed through ZIPs in iMedia.

In the contact center, a specific number of outbound calls are allocated to
each line. If a calls made without an available allocated line, it will result
in a "no lines available" status.

Call collision Automatically updated by the telephone network.

We use Zip-trunk trunk groups to handle calls.Calls are managed through
a channel, and we check the channel's status (whether the channel is
free) to ensure it is available.The system does not support simultaneous
inbound and outbound calls on the same line, which can result in call
collisions.

The records will be stored.

Call failed Automatically updated by the telephone network.

This is due to failing a call because of unspecified error or timeout issue

Number engaged Defined Status

The line is busy when attempting the outbound call.

Not answered Defined Status

The outbound call is not picked up by the recipient

Call aborted Automatically updated by the telephone network.

When the agent initiates the outbound call but terminates or disconnects
it before the receiver/user answers.

Normal call Defined Status

A regular success outbound call
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Status Type Reasons

Unknown Automatically updated by the telephone network.

The status of the outbound calls is not included into any of the above
categories

Agent Activity Report
This report focuses on individual agents' activities, providing information on their performance and
productivity. You can filter the report by a specific agent.

1. In the Admin Portal, go to Standard Reports > Agent Activity Report.
2. Enter the selection criteria for the report.
3. Click View to preview the report.

The report has the following columns:

Column Heading Description

Call Start Time The start time of the call prior to processing
and thereafter delivered to the queue
progression for the agent to handle the call.

Wrap Up Time The time that the agent wrapped up the
relevant activity.

Contact Center The name of the contact center to which the
activity was delivered.

Agent Contact Center The agent who accepted and handled the
activity.

Contact Center Unit The subunit of the contact center (such as
Marketing, Finance, Logistics) to which the
activity was delivered.

Agent The agent who accepted and handled the
activity.

Station Number A unique numeric ID which is associated to
the agent’s login.

Call Reference The reference number associated with the
activity.
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Column Heading Description

Activation Type A task or activity handled by the agent.

Type (media type): call, voice mail, email,
social media, chat

Charged Duration (s) Total Time the agent was connected to the
caller (could be considered as chargeable).

Uncharged Duration (s) After call work to complete or wrap up the
call, such as updating notes, records, making
additional calls and so on.

The amount of time after the main activity is
also referred to as the Wrap up time, end of
an activation.

Total Duration (s) Start time to end time of the activation
(presented to dismissed).

Realtime Statistics for contact centers
The Queue Statistics page reports on absolute priorities of all the activations in the queue while
reports such as Today’s Email Summary reports on relative priorities as set for the activation type.

Queue Statistics

In the Admin Portal, priority ranges from 1 through 9 where 1 is the lowest priority. The Queue
Statistics page represents the values as follows, where Idle is the lowest priority:

• 1 Idle
• 2 Very Low
• 3 Lowest
• 4 Low
• 5 Below Normal
• 6 Normal
• 7 Above Normal
• 8 Sensitive
• 9 Emergency

How activations are reported on the Queue Statistics page depends on the default priorities of the
different activation types as set for the contact center unit. For example, if the default priority for
emails is 2 then the Queue Statistics page reports email priority as Very Low. For example:
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Default Priority for contact center unit Queue Statistics page

Inbound calls 5 Normal priority

Chat 3 Low priority

Email 2 Very Low

Workflow 4 Below Normal

Social Media 2 Very Low

Today’s Email Summary

This page shows the adjusted priorities relative to the default email priority.

You can adjust the default priority for an activation type in the definition or as part of the queue
progression script. You can raise or lower it by a few points relative to the default priority. For
example, if the default priority for email at the contact center unit is 2 then you can raise it to a 4
(Highest). However, Highest is actually a fairly low priority when compared to an activation type
with a higher default priority.

The relative priorities are:

Relative Priority Action

Highest Raise email priority to the highest (4)

High Raise the priority slightly (3)

No Change Keep the default priority (2)

Low Lower the priority (1)

Lowest Also 1 – you can’t lower it any further if the default priority is 2

Note  Where the default priority is already high, for example 8, then selecting High and
Highest will be the same.

Consumption reports
Consumption metering provides tenants with the capability to monitor usage. You can view the
usage for your tenant, in the Admin Portal, on the Standard Reports > Consumption Summary
or Consumption List report.

The reports show sign on durations in milliseconds:
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• Any IFS Customer Engagement app (Studio Designer, Admin Portal, Agent Desktop)
• Public portal
• Portal

The reports also show the number of:

• Appointments handled through Last-Mile Customer Portal (not the number of emails, SMS
messages or clicks)

• Call recording downloads
• Call recording retrieval requests (ie retrieval from cool storage tier)
• NLP categorization based on the trained NLP model
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20
Users

You can add users to control access to portals and other CE web apps such as CE Studio
Designer Agent Desktop in the Admin Portal.

Portal users

A portal user is someone, such as a customer, supplier, partner, who needs to sign onto the
tenant's portal. This type of user doesn't have access to the Admin Portal, CE Studio Designer or
Agent Desktop.

Access to the CE Studio portal apps on the tenant's portal is controlled by the use of the portal
user role, user groups and portal landing categories. For further details, see Adding portal users.

Note  You do not need to add portal users for access to public portal apps, either access is
open to all (anonymous users) or you can implement an alternative method of authentication.

Studio administrators

This role has the highest permissions. Studio administrator can, for example, grant the right to
view unmasked phone numbers. For details, see Masking phone numbers.

Note  Once the CE deployment is operational, you should review who has the Studio
administrator role in order to limit or remove third-party access to sensitive information.
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Agents, supervisors, contact center managers

Important  Changes to existing user accounts in the Admin Portal will not take effect until their
access token is refreshed, which will take approximately 15 to 30 minutes. Alternatively, the
affected user can sign off and on again, in which case the changes are immediately applied.

Each contact center is unique, but a common setup for agents is:
• Default Call Delivery Number set to Integrated VoIP End Point
• User Role set to Agent for all agents
• Require Time Keeping selected for all agents
• Call Recording Option set to Retain all Calls
• Default Associated Contact Center Unit should be set to the contact center unit where the

agent works most of the time and where they need to be able to dial out from idle or where the
Address Book is to be used to transfer calls from one agent to another.

Supervisors could be configured as above, but without Require Time Keeping and with Enable
Ability to Assist/Coach.

Users sign on to Admin Portal, CE Studio Designer Agent Desktop using the credentials for one of
the following:
• Their Microsoft account
• Their Azure Active Directory account - before you can configure user accounts with single sign

on, you need to request that an SSO deployment is configured for the tenant in IFS Service
Center. You can view the SSO deployment, and configure a user group for it on the Studio >
SSO Deployment page.

User roles
The user role determine what each user can do in the Admin Portal. The permissions for the roles
in the following table are cumulative, for example, a Supervisor also has all the permissions of an
Agent.

In the Admin Portal, go to the User Management > Page Permission page to see the pages to
which each role has access, and the type of permission.

User Role Notes

Portal User The lowest permission level. Lets users sign on
to the tenant's portal and run CE Studio Portal
apps. These users cannot access the Admin
Portalor Agent Desktop.
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User Role Notes

Note  Not available to self-service tenants.

Agent (Operator) Lets users access the Admin Portal to modify
existing users and sign on to Agent Desktop.

Note  Not available to self-service tenants.

Supervisor For contact center supervisors:
• Full control over users, such as setting skills

and deleting users.
• Manage, for example, the media scripts and

other resources for queue progression, the
address books and blacklists used in Agent
Desktop.

• All reports for the contact center.
• Force log out agents from Agent Desktop

(agents with the same or lower user role).

Note  Not available to self-service tenants.

Manager For managers of a single contact center (and
any contact center units it contains). Gives
additional permissions to change the way the
contact center is configured.

For tenants with contact centers, give the ability
to force log out supervisors from Agent Desktop
or any user with the same or lower user role.

Global Manager For managers of multi-center contact centers.

Studio Administrator For application configurers who develop and
maintain CE Studio apps.

Since this role has the highest permissions,
Studio administrator can also grant the right to
view unmasked phone numbers. For details,
see Masking phone numbers.
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User Role Notes

Note  Once the CE deployment is
operational, you should review who has the
Studio administrator role in order to limit
or remove third-party access to sensitive
information.

Technical The highest permission level and reserved
for IFS Services who set up and manage the
CEdeployments.

Custom A custom role. You start from one of the pre-
existing roles and then remove the Read, Write,
Edit and Delete permissions not required for
the role.

Note  You can only create a custom
role from your current role or lower. For
example, a Supervisor can't create a
custom role from the Manager role.

Note  To add a translation for the role
name so that it displays as A Role and not
as {{A Role}} go to Studio > Message
Store and add a message where the
message type is Label and the Message
Id is A Role.

Adding portal users
A portal user is someone, such as a customer, supplier, partner, who needs to sign onto the
tenant's portal.

Start by adding a portal user for each person who will use the portal as described below, and then
invite the end-users to sign up.
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Note  You must also assign each portal user to one or more user groups (see below). This
steps gives the user access to the corresponding area of the portal.

Each tenant has its own portal. If an organization has multiple tenants then a user may need
to register separately with each of the portals.

To add a portal user:
1. In the Admin Portal, go to User Management > Users.
2. Click New.
3. Enter their details.

Field Description

First Name, Surname, Initial Only the first name and initial is mandatory.

Contact Center Not required for a portal user (but the default
contact center is always selected).

Display Name The name that may be shown in the portal.

User ID The email address that identifies the user
when they register on the portal's sign up
page and later whenever they sign on. This
is also the email address that will be used to
verify the individual when they register on the
sign up page.

The user ID can be one of the following:

• Email address local to the portal.
• IFS Cloud email address – the email

address you enter must therefore match
the user email address in the user's IFS
Cloud user account.
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Field Description

Note  When using IFS Cloud as the
identity provider, users sign on by clicking
the Keycloak-oidc button and then
enter their username and password.
The email address recorded in their user
account will be validated against the
email address recorded in the Admin
Portal.

Email Address Optional, for example, for a secondary email
address.

User Role Select the Portal User role.

Portal Landing Category This determines which landing page the user
sees after signing on to the portal.
• Leave this empty if there is only one

landing page.
• If there is more than one landing page

category then you can leave this empty if
you want the portal user to use the default
landing page.

• Select the category that corresponds to
the landing page you want to use. Note
that the landing page must belong to the
same user/access group as the portal user
otherwise the portal user will see an error
after signing on to the portal.

Timezone The timezone of the user's current location.

Language Not required for a portal user (but the default
language will always be selected).

4. Click Save.
5. Assign the portal user to one or more user groups on the User Management > User Group

page. This step gives the portal user access to the corresponding area of the portal. A portal
user that does not belong to any user groups will see an access denied error after signing on to
the portal.
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Adding agents for staffed contact centers

Note  Users must have a Microsoft account as all users sign on to Agent Desktop and the
Admin Portal using their Windows credentials.

To add a user for an agent who will be working in Agent Desktop:
1. In the Admin Portal, go to User Management > Users.
2. Click New.
3. Enter their personal details.

Field Description

First Name, Surname, Initial Only the first name and initial is mandatory.

Contact Center Select the contact center for the agent. They
will be able to sign on to any of its contact
center units. A default contact center is
required for making outbound calls from the
home page.

Display Name The name that's shown in Agent Desktopand
the Admin Portal.

User ID The email address that identifies the agent's
Microsoft account and which is used when the
agent signs on.

Email Address For future use.

4. Set up the audio connection options that will be available to the agent in Agent Desktop.

Field Description

Work Number

Extension Number

These must be phone numbers configured for
the contact center.

Allow Call Delivery to... Select this option to set the number as an
audio connection option for the agent in Agent
Desktop.

Home Number For agents working remotely.

Mobile Number To deliver calls to a mobile phone.
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Field Description

Other Number For any other type of phone number.

Default Call Delivery Number The default audio connection option for the
agent in Agent Desktop.

Nailed-up connection Use this option for agents making campaign
calls.

The system will keep the connection (Agent
call) open until the agent either signs out
of Agent Desktop or manually disconnects
using the Audio options in Agent Desktop.
This maximizes dialing efficiency during the
campaign.

Note  When the first campaign call is
dialed for an agent, the system makes
a call to the browser (VoIP) - this is the
agent call. It also simultaneously dials the
outbound call.

If the agent call fails then the outbound
call is immediately disconnected and the
recipient of the call sees a missed call on
their phone (but the phone does not ring).
The Outbound Call report will show that
the agent call has Call Failed status and
the Progressive dialler call has the status
Call aborted.

Agent Call Disconnect Delay When the Nailed-up connection option is
cleared, you can enter a delay in the field
(where, for example, 1 is 0.1 of a second). If
nothing is entered then the disconnect delay
is the system default (2 minutes).

Call Answer Timeout (Secs) Automatic call answering takes over after the
number of seconds entered here.

Enable Integrated VoIP EndPoint Allows calls to be delivered to the agent over
the internet. Agents must use the Chrome
browser and the browser must have access
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Field Description

to the microphone. See IFS Customer
Engagement Agent Desktop User Guide.

5. Select their user role from the User Role list. See User roles for details.
6. Complete the setup of their user account:

Field Description

Require Time Keeping Select this option if you want to the agent
to select a reason every time they make
themselves unavailable.

Note  This can also be set for the contact
center on the Contact Center > Contact
Centers page.

Enable Ability to Assist/Coach Select this feature for supervisors who will
use Agent Desktop for:
• Monitoring: allows you to listen to the call

without the agent being able to hear you.
• Coach: allows you to listen to the call and

prompt the agent, without the caller being
able to hear you.

• Assist: allows you to join the call.

Do Not Allow Multiple Concurrent Logons For users working in the Admin Portal only,
select the option to prevent that person from
logging on to both the Admin Portal and
Agent Desktop.

Allow to View Unmasked CLI When selected, the user can view caller IDs.
You must have the Studio Administrator role
in order to grant this permission to the user.

For background information, see Masking
phone numbers.
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Field Description

Default Caller ID Enter a Caller ID (phone number) if the
agent needs to make outbound calls. It is not
possible to dial out using a number that is
unknown to the system.

You can hide the number from the recipient
and show the contact center unit default
caller ID instead. This is controlled by the Use
Agent Caller ID for Outbound Calls on the
Media Management > Advanced Settings
page.

Note  If you enter a number that is not
one of your phone numbers then you will
need to request IFS Services to verify that
the number belongs to you.

Default Associated Contact Center Unit The name of the contact center unit where the
agent works most often.

Call Recording Option Whether you want to record the agent's calls:
• Retain All Calls: stores recordings of

all the agent's calls for inbound numbers
where call recording is enabled. These are
stored for the maximum number of days
set for the contact center.

• Retain Sample: stores a percentage of the
agent's calls. The percentage is set for the
contact center.

• If you do not want to record any calls then
leave the field set to Select an option.
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Field Description

Disable Auto Answer Where the contact center is configured for
auto answering:
• Clear this option to use auto answering

for agents handling campaign calls. This
maximizes call efficiency.

• For agents working in other areas, select
this option to disable auto answering.
Agents must click to accept calls in Agent
Desktop.

No. of Chat Sessions Allows the agent to handle more than
one simultaneous chat session up to the
maximum you enter here.

Leave this empty if you do not want to deliver
chat sessions to this agent.

Timezone The timezone of the agent's current location.

Language Select a supported language, for example
English (United States).

Avatar You can upload an image. We recommend
uploading a small file.

7. Click Save.
8. Assign the user to a contact center: go to User Management > User Contact Centers.

a. Click New.
b. On the right, select the user you have just created.
c. Choose which contact centers they have access to:

Add The right column shows the access the user
has.

Select a contact center on the left and click
Add to give the user access to it.

Remove The left column shows the access they do
not have.

Select a contact center on the right and click
Remove to remove the user's access.

The final step is to assign skills to the user. See Assigning skills to agents.
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Adding managers
You can set a user as the manager of a contact center unit:

1. In the Admin Portal, go to the Contact Center Unit > Contact Center Units page.
2. Select the contact center unit.
3. Select the user's name in the Manager field.

To find out which contact center unit, a user is the manager of, use the Contact Center Unit List:
1. Go to User Management > User Contact Center Units.
2. Select the user.
3. The contact center unit managed by the user is listed below.

Removing and restoring users

Note  Whilst the user’s profile is deleted, their username remains in the system for purposes
of historical reporting.

You can remove users that are no longer required in the Admin Portal.

Removing a user

To remove users, go to the User Management > Users page, select the name of the user you
wish to remove, and then click Delete.

To report on users who are deleted, go to the User Management > Deleted Users page.

To find out when a user was deleted and who by, go to the Standard Reports > Audit History page.

Restoring a user

To restore a deleted user, go to the User Management > Deleted Users page, select the user
and click Restore.

Permanently deleting a user

To permanently delete a user, go to the User Management > Deleted Users page, select the user
and click Delete Permanently.

User groups
User groups are used to control access to tenants and to portal apps.
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Note  User group names can only contain alphanumeric characters, spaces and underscores.

Creating user groups

A user group can contain both individual users and other user groups.

You create user groups in the Admin Portal on the User Management > User Group page.

Portal access groups

You control access to CE Studio portal apps by creating user groups and then assigning the user
group to one or more portal apps. In CE Studio a user group is called an access group.

Anyone who requires access to a portal app must belong to the relevant user group. A user that
does not belong to any user groups can still register on the portal and sign on the portal but will
see an access denied error after signing on to the portal.

SSO deployments

When controlling sign on using SSO then you control how users sign on by configuring a user
group. Users belonging to the group sign on with their SSO credentials and users not belonging to
the group sign on with the credentials for their Microsoft account.

See User groups and SSO deployments for details.

User groups and SSO deployments
To create SSO deployments, you need to raise a request in IFS Service Center. Once the SSO
deployment is created for you, you can view the details in the Admin Portal, on the Studio > SSO
Deployment page.

You can control who the SSO deployment applies to by configuring a user group. Users belonging
to the group sign on with their SSO credentials and users not belonging to the group sign on with
the credentials for their Microsoft account.

Note  The SSO deployments are also used in CE Studio when creating providers for
endpoints that require single sign on.

SSO Deployment Name The name given to the SSO deployment when
it was created through the IFS Service Center
request.
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Type Is always type 1, that is OpenID Connect
(OIDC)

URL The URL of the Azure AD deployment used by
the tenant.

Disabled A readonly check box that shows the status of
the SSO deployment.

When Disabled displays as selected, then the
SSO deployment is not in use. This means that:
• Users cannot sign on with SSO credentials.
• In CE Studio apps, calls to any providers

using the SSO deployment will fail.
• Portal users cannot sign on with SSO

credentials even if the deployment is
enabled for the portal.

Enable for Portal Realm A readonly check box that shows the status
of the SSO deployment for the tenant's self-
service portal. When it displays as selected,
then the SSO deployment is used for sign on
to the tenant's portal (provided that the SSO
deployment is not disabled).

User Group Controls who must sign on with their Azure AD
credentials:
• Select a user group to require the users

in that group to sign on with Azure AD
credentials. Users not in the group sign on
with their Microsoft account credentials.

• When no group is selected then everyone
signs on with their Microsoft account
credentials.

Configuring SSO with a new IAM client

When configuring SSO with IFS Cloud, it is recommended that you create a new IAM Client. This
is because redirect URLs are reset in "IFS_ce" and "IFS_ce_sso" clients with every IFS Cloud
upgrade monthly.

When you create a new IAM client and specify a custom redirect URI, it remains unchanged even
after an IFS Cloud upgrade.
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You can create a new custom IAM client

1. In IFS Cloud, go to IAM Client.
2. Select the option to create a new client.

Important: Avoid using the default `IFS_ce` and 'IFS_ce_sso' clients in production

3. a) Configure Client Settings

b) Enable the following options :

Enabled , Public Client, Direct Access Granted

c) Set Redirect URI : You need to enter the required redirect URI(s) for the client.
4. Save the configuration
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